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1. Introduction

Merci d’avoir téléchargé Yamaha ProVisionaire Design.
ProVisionaire Design est une application logicielle pour Windows qui vous permet de concevoir et de configurer
un système audio intégré composé de produits Yamaha. Concevoir les circuits audio et ajuster les paramètres
de chaque composant vous permet de configurer des réglages de traitement du son optimisés dans le cadre de

diverses situations et applications.
Pour plus de détails sur les modèles pris en charge par le logiciel, reportez-vous aux manuels correspondants

sur le site Web de Yamaha Pro Audio. Téléchargez les manuels dont vous avez besoin.
https://www.yamahaproaudio.com/

1.1. Informations

• Tous les droits de propriété intellectuelle de ce logiciel et de ce guide d’utilisation sont la propriété de
Yamaha Corporation.

• Toute copie ou modification de ce logiciel ou de ce guide d’utilisation effectuée sans autorisation, en tout
ou en partie, est interdite.

• Veuillez noter que Yamaha Corporation décline toute responsabilité quant aux résultats ou aux
conséquences découlant de l’utilisation de ce logiciel et de ce guide d’utilisation.

• Toutes les illustrations et les captures d’écran contenues dans ce guide d’utilisation sont fournies dans le
but d’expliquer les opérations. Elles peuvent dès lors être différentes des caractéristiques techniques
réelles.

• Windows est une marque déposée de Microsoft Corporation USA aux États-Unis et dans d’autres pays.

• iPad est une marque déposée d’Apple Inc. aux États-Unis et dans d’autres pays.

• Soyez attentifs aux droits d’auteur lors de l’utilisation de sources audio à des fins commerciales. La
violation des droits d’auteur est interdite par la loi.

• Les noms de sociétés et de produits mentionnés dans ce document sont des marques commerciales ou
déposées de leurs propriétaires respectifs.

• Les logiciels sont susceptibles d’être mis à jour sans préavis à des fins d’amélioration. Vous pouvez

télécharger la dernière version du logiciel sur le site Web de Yamaha Pro Audio.
https://www.yamahaproaudio.com/

1. Introduction
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1.2. Termes et concepts à comprendre

Logiciels
Voici les logiciels liés à ProVisionaire Design disponibles :

Logiciels Description

ProVisionaire Control Logiciel utilisé pour concevoir les contrôleurs à distance fonctionnant sur des
ordinateurs Windows ou des iPad.

ProVisionaire Edge Logiciel utilisé pour contrôler des appareils sur un réseau local.

ProVisionaire Control KIOSK Logiciel optimisé pour la commande à distance depuis des ordinateurs
Windows.

ProVisionaire Touch KIOSK Logiciel optimisé pour la commande à distance depuis des iPad.

ProVisionaire Portal Logiciel utilisé pour activer la licence d’un appareil.

ProVisionaire Cloud Service cloud utilisé pour gérer les licences des appareils.

Terminologie
Dans ProVisionaire Design, les termes suivants sont utilisés pour parler de la structure d’un système :

Terme Description

Projet Groupe d’appareils géré par ProVisionaire Design.

Objet Terme générique utilisé pour désigner des appareils, des images, des
composants ou tout autre élément placé sur une feuille.

Style Valeurs par défaut attribuées à chaque objet, telles que la couleur et la forme,
ainsi qu’aux réglages de l’appareil Cet ensemble d’éléments, appelé « User
Style » (Style utilisateur) peut être personnalisé et stocké sur l’ordinateur.

Groupe de liaisons Groupe permettant d’éditer simultanément plusieurs canaux de la même série.

Fichiers
ProVisionaire Design utilise les types de fichiers suivants :

Type de fichier Description

Fichier de projet (extension
.pvd)

Ce fichier contient tous les réglages de ProVisionaire Design. Les informations
sur le style sont également contenues dans les fichiers de projet qui ont été
sauvegardés à l’aide de la commande [Save with Style] (Enregistrer avec le

style).
Lorsque ProVisionaire Design est en cours d’exécution, les fichiers de
sauvegarde sont enregistrés au format *.pvd dans le dossier suivant toutes les
5 minutes. Le fichier de sauvegarde est automatiquement supprimé lorsque

l’application est fermée normalement.
C:/Users/(user name)/Documents/Yamaha/ProVisionaire Design/Backup

Fichier de style (extension
.pvds)

Ce fichier enregistre les styles pouvant être utilisés sur ProVisionaire Design. Il
contient les informations de style créées dans un autre projet.

Dans ce guide d’utilisation, les signes < > indiquent une touche de clavier d’ordinateur. < Maj > représente la
touche Majuscule.

1. Introduction
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1.3. Configuration requise et installation

Afin de pouvoir connecter des appareils à l’ordinateur et de les utiliser, téléchargez ProVisionaire Design depuis

la page « Download » (Téléchargement) du site Web Yamaha Pro Audio.
https://www.yamahaproaudio.com/

1.3.1. Configuration requise

Système d’exploitation Windows 11 (64 bits) / Windows 10 (64 bits)

Processeur Core i ou supérieur

Mémoire 8 Go au minimum

Espace disponible sur le
disque dur

700 Mo au minimum

Écran 1280×1024 (SXGA) ou supérieur

Divers Installez Bonjour Print Service (logiciel Windows) lors de la mise à jour du
microprogramme PGM1 ou lors de la configuration des paramètres IP.
Connexion Ethernet requise (type 1000BASE-T ou supérieur).



La configuration requise ci-dessus est destinée à la version 1.1.0 de ProVisionaire Design.
L’URL suivante vous permet d’accéder aux informations les plus récentes concernant la

version actuelle du logiciel et la configuration requise pour son fonctionnement.

https://www.yamahaproaudio.com/
L’ordinateur que vous utilisez peut dépasser les exigences répertoriées ci-dessus.

1.3.2. Installation

Téléchargez les programmes d’installation de ProVisionaire Design depuis le site Web Yamaha Pro Audio.

Sur le site Web, les liens sont disponibles sur la page [Product information] → [Applications] (Information produit

→ Applications).
https://www.yamahaproaudio.com/

Décompressez le fichier compressé que vous avez téléchargé et double-cliquez sur Install_PVDesign.exe.
Installez ensuite le logiciel selon les instructions données par le programme d’installation.

1. Introduction
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1.4. Présentation de ProVisionaire Design

• De façon générale, ProVisionaire Design est divisé en une feuille « Project » (Projet), une feuille « Tuning »
(Accord fin) et une feuille d’appareil. La feuille « Project » répertorie les appareils et permet d’effectuer des
réglages pour ceux-ci. La feuille « Tuning » vous permet de configurer un groupe de liaisons afin de
contrôler ensemble plusieurs canaux d’amplificateur. Un groupe de liaisons que vous avez sélectionné
peut être configuré par le bais du « Link Group Editor » (Éditeur du groupe de liaisons). La feuille d’appareil
permet de configurer en détail les réglages et commandes de chaque appareil.

• Les paramètres de l’ensemble du projet peuvent être rappelés à l’aide de la boîte de dialogue « Linked
Presets Manager » (Gestionnaire des présélections liées). Pour plus de détails sur les modalités de
stockage/rappel de chaque appareil, reportez-vous à la page consacrée à l’appareil.

• Les valeurs par défaut (autres que les informations de position) de Properties (Propriétés) peuvent être
stockées sur l’ordinateur en tant que style utilisateur. L’enregistrement d’un style utilisateur vous permet
d’éviter d’avoir à modifier les réglages chaque fois que vous ajoutez un appareil au projet. En outre, vous
pouvez transférer les styles utilisateur vers un autre ordinateur.

• Les appareils peuvent être regroupés dans un groupe d’appareils. Le regroupement de plusieurs appareils
permet une gestion unifiée de leur puissance, etc.

• L’utilisation de la fonction SOLO dans la feuille « Tuning » vous permet de contrôler la sortie audio de
chaque groupe de liaisons séparément.

• Lorsque des haut-parleurs sont placés dans la feuille « Project » et connectés à un appareil de la série PC,
vous pouvez ouvrir « Speaker Editor » (Éditeur de haut-parleur) pour ajuster la réponse des haut-parleurs
individuels, ou « Multiple Speaker Editor » (Éditeur de haut-parleurs multiples) pour ajuster la réponse des
paramètres de plusieurs haut-parleurs connectés au même amplificateur de puissance.

• Lorsque des haut-parleurs sont placés dans la feuille « Project » et connectés à un amplificateur de
puissance, vous pouvez enregistrer des haut-parleurs individuels dans un groupe de liaisons.

1. Introduction
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2. Organisation de l’écran du logiciel
ProVisionaire Design est constitué d’une barre de menus, d’une barre d’outils, d’une feuille « Project » (Projet),

d’une feuille « Tuning » (Accord fin) et d’une feuille de périphérique.
La feuille « Project » est celle où vous placez les périphériques. Les périphériques placés ici sont enregistrés

dans le projet.
La feuille« Tuning » est la feuille dans laquelle vous configurez l’égaliseur ou les niveaux d’un périphérique. La
feuille « Tuning » vous permet de configurer l’égaliseur et les niveaux des unités des séries PC et XMV. Les
canaux d’amplification de puissance peuvent être regroupés entre les péripériques de la même série, ce qui

permet de configurer ensemble les paramètres de même type à l’aide de valeurs relatives ou absolues.
La feuille de péripérique vous permet d’effectuer des réglages détaillés pour chaque périphérique.

Chaque feuille dispose des zones suivantes.

Feuille Zone

Feuille « Project » (Projet) Zone « Devices » (Périphériques)

Zone « Network » (Réseau)

Zone « Properties »
Vue « Bird’s Eye » (Vue aérienne)

Feuille « Tuning » (Accord fin) Zone « Components »

(Composants)

Zone « Properties » (Propriétés)
Zone « Project Devices »

(Périphériques de projet)
Zone « Link Groups » (Groupes de

liaisons)
Vue « Bird’s Eye » (Vue aérienne)

Feuille « Device » : Processeurs
audio

DME7 Zone « Components »

(Composants)

Zone « Parameter Sets »

Zone « Properties »

Zone « Parameters »
Vue « Bird’s Eye » (Vue aérienne)

MRX7-D Zone « Components »

(Composants)

Zone "Parameter Sets"

Zone "Presets"

Zone "Parameter Link Group"

Zone "Gang Edit Group"

Zone "Properties"

Zone "Parameters"
Vue « Bird’s Eye » (Vue aérienne)

MTX5-D Zone « Presets » (Présélections)
Vue « Bird’s Eye » (Vue aérienne)

MTX3 Zone « Presets » (Présélections)
Vue « Bird’s Eye » (Vue aérienne)
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Feuille Zone

Feuille « Device » : Amplificateurs de
puissance

Série PC Zone « Presets » (Présélections)
Vue « Bird’s Eye » (Vue aérienne)

Série XMV Vue « Bird’s Eye » (Vue aérienne)

Feuille « Device » : Haut-parleurs
amplifiés

VXL1-16P Vue « Bird’s Eye » (Vue aérienne)

Feuille « Device » : Microphones RM-CG Vue « Bird’s Eye » (Vue aérienne)

RM-TT Vue « Bird’s Eye » (Vue aérienne)

2. Organisation de l’écran du logiciel
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2.1. Éléments communs à toutes les feuilles

Cette partie présente les éléments communs à toutes les feuilles.

Barre de menus

Les commandes qui peuvent être exécutées dans ProVisionaire Design se trouvent ici, regroupées en catégories.
Cliquez ici pour afficher la liste des commandes. (Barres de menus et barre d’outils)

Barre d’outils

Les fonctions fréquemment utilisées sont fournies ici sous forme de boutons. (Barres de menus et barre
d’outils)

Vue « Bird’s Eye » (Vue aérienne)

Ceci affiche une vue d’ensemble de la feuille. La zone encadrée en vert correspond à ce qui est affiché dans la

feuille. Faites glisser le cadre pour déplacer la zone affichée dans la feuille. Lorsque l’icône ←→ apparaît aux
quatre coins du cadre, vous pouvez la faire glisser pour l’agrandir ou le réduire ; la zone affichée dans la feuille

est alors modifiée en conséquence.
Pour effectuer un zoom avant/arrière dans la vue aérienne elle-même, maintenez la touche < Ctrl > enfoncée et

tournez la molette de la souris.
Lorsque vous placez le curseur sur la limite entre la vue aérienne et la zone au-dessus, le curseur change de
forme ; vous pouvez alors faire un glisser-déposer pour modifier la hauteur de la vue.

2. Organisation de l’écran du logiciel
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Zones spécifiques

Dans le coin supérieur droit de chaque zone d’une feuille se trouve le bouton «   ». Lorsque vous cliquez sur
celui-ci, la zone se transforme en icône placée à gauche ou la droite de l’écran, ce qui permet à la feuille
d’occuper plus d’espace. Lorsque vous placez le curseur sur cette icône, la zone concernée s’agrandit
temporairement. Si vous voulez voir à nouveau dans sa position fixe une zone qui est sous forme d’icône,
déplacez le curseur sur l’icône et cliquez sur le symbole «   ».

Chaque zone contient les boutons et les champs suivants.

Bouton ou champ Récapitulatif

Permet de développer la totalité de l’arborescence.

Permet de réduire la totalité de l’arborescence.

Permet de rechercher et d’afficher les objets qui répondent aux conditions
que vous avez saisies.

Permet d’enregistrer le style de l’objet sélectionné sur l’ordinateur en tant
que style.

Dans la feuille
Utilisez le bouton  d’une feuille pour accéder à la liste des feuilles et choisir la feuille dans laquelle vous

souhaitez vous rendre.
Lorsque le nombre de feuille augmente, le bouton  apparaît. Le bouton  permet de se déplacer d’une

feuille vers la gauche. Le bouton  permet de se déplacer d’une feuille vers la droite.
Vous pouvez également utiliser le menu [Close] (Fermer), auquel vous pouvez accéder en faisant un clic droit sur
la feuille pour la fermer.

Lorsque vous placez le curseur sur la limite entre la feuille et une zone spécifique, le curseur change de forme ;
vous pouvez alors faire un glisser-déposer pour modifier la largeur de la zone.
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2.2. Feuille « Project » (Projet)

① Zone « Devices » (Périphériques)
Cette liste répertorie les péripériques placés dans la feuille « Project » (Projet). Pour enregistrer un périphérique
dans le projet, faites-le glisser et déposez-le dans la feuille « Project ». (Zone « Devices » (Périphériques))

② Zone « Network » (Réseau)
Cette zone répertorie les périphériques détectés par l’ordinateur. Pour enregistrer un périphérique dans le projet,
faites-le glisser et déposez-le dans la feuille « Project ». (Zone « Network » (Réseau))

③ Feuille « Project » (Projet)
Dans cette feuille, vous pouvez placer des périphériques pour les enregistrer dans le projet ou créer un schéma

de connexion. (Feuille « Project » (Projet))
Double-cliquez sur un périphérique pour ouvrir la feuille de périphérique.

④ Zone « Properties » (Propriétés)
Cette zone vous permet d’afficher et de modifier des informations sur l’objet sélectionné. (Zone « Properties »
(Propriétés))

2.3. Linked Presets (Présélections liées)

Cette fonction vous permet de rappeler collectivement tous les périphériques ajoutés au projet.
Utilisez pour cela la boîte de dialogue « Linked Presets Manager » (Gestionnaire des présélections liées) qui

apparaît lorsque vous cliquez sur le bouton . (Boîte de dialogue « Linked Presets Manager » (Gestionnaire

des présélections liées))
Les présélections pour l’ensemble du projet peuvent également être rappelées à partir de la liste déroulante
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2.4. Feuille « Tuning » (pour les séries PC/XMV uniquement)

① Zone « Components » (Composants)
Enregistrez un groupe de liaisons en faisant glisser un composant « Group » et en le déposant dans la feuille
« Tuning ».

② Feuille « Tuning » (Accord fin)

Dans cette feuille, vous pouvez créer et éditer un groupe de liaisons.
Un groupe de liaisons est une fonction qui vous permet de relier des canaux individuels de plusieurs
périphériques. (Feuille « Tuning » (Accord fin))

③ Zone « Properties » (Propriétés)
Cette zone vous permet d’afficher et de modifier des informations sur l’objet sélectionné.(Zone « Properties »
(Propriétés))

④ Zone « Project Devices » (Périphériques de projet)
Les périphériques placés dans la feuille « Project » (Projet) sur lesquels le groupe de liaisons s’applique sont

affichés dans l’arborescence.
Pour enregistrer un périphérique dans un groupe de liaisons, faites-le glisser et déposez-le dans le composant
« Groupe » (Zone « Project Devices » (Périphériques de projet))

⑤ Zone « Link Groups » (Groupes de liaisons)
Cette zone présente l’état des affectations des groupes de liaisons dans une arborescence. (Zone « Link
Groups » (Groupes de liaisons))
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2.5. Feuille de périphérique

Pour ouvrir cette feuille, double-cliquez sur un périphérique placé dans la feuille « Project » (Projet). Les
composants des différents périphériques sont placés ici. Lorsque vous double-cliquez sur un composant,
l’éditeur de composants apparaît, ce qui vous permet de modifier les paramètres du périphérique.

Pour plus de détails, reportez-vous à la section au sujet du périphérique concerné.

2. Organisation de l’écran du logiciel
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3. Principes de base de l’utilisation de ProVisionaire
Design

3.1. Connexion des périphériques

Le connecteur du périphérique qui sera utilisé pour la connexion à ProVisionaire Design varie selon le modèle du
périphérique. Reportez-vous aux connecteurs répertoriés dans le tableau suivant.

DME7 L2 swi t ch

ProVisionai re Design

DME7

Net work Port

Modèle Connecteur

DME7 Connecteur Réseau

MRX7-D/MTX5-D Connecteur [PRIMARY]
(Primaire) Dante

MTX3 Connecteur Réseau

EXi8/EXo8 Connecteur Réseau

Série R/Série Tio Connecteur [PRIMARY]
(Primaire) Dante

Série PC-D/DI Connecteur Réseau

Série XMV-D Connecteur [PRIMARY]
(Primaire) Dante

Série XMV Connecteur Réseau

RM-CG/RM-TT Connecteur Dante/PoE

VXL1-16P Connecteur NETWORK/Dante

3.2. Procédure

Pour utiliser ProVisionaire Design, suivez la procédure décrite ci-dessous, selon la proximité et l’accessibilité de

l’amplificateur de puissance.

Si vous créez un réseau Dante, installez également Dante Controller et faites l’assignation dans Dante Controller.

Pour plus de détails sur Dante Controller, reportez-vous aux liens du site Web Yamaha Pro Audio, à l’adresse :
https://www.yamahaproaudio.com/
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3.2.1. Si vous pouvez connecter le(s) périphérique(s) à l’ordinateur

Si vous êtes à proximité des amplificateurs de puissance, commencez par configurer le réseau avant d’effectuer

les réglages.
Les réglages par défaut d’un amplificateur de série PC sont comme suit et supposent que vous créez un réseau
redondant.

Élément Valeur par défaut

UNIT ID 1

Port secondaire Dante Connexion redondante en étoile*

Réglage IP DHCP (en l’absence d’un serveur DHCP,
l’adresse IP 169.254.x.x est spécifiée)

1. Établissez les connexions.

Branchez les cordons d’alimentation et les câbles réseau des péripériques.
Si vous utilisez une connexion en guirlande, modifiez le réglage « Dante Secondary Port » (Port secondaire
Dante) en [Daisy Chain] (Connexion en guirlande).

2. Mettez tous les périphériques connectés sous tension.

Si besoin, initialisez le microprogramme ou mettez-le à jour.
Si vous souhaitez utiliser ProVisionaire Design pour initialiser le microprogramme ou pour le mettre à jour,

sélectionnez le menu [System] (Système) →[Device Information] (Informations sur le périphérique) et
exécutez ces actions dans la boîte de dialogue « Device Information» (Informations sur le périphérique)
qui apparaît.

3. Lancez ProVisionaire Design.

La boîte de dialogue « Network Setup » (Configuration réseau) apparaît.
Cochez la case correspondant à la carte réseau qui sera utilisée pour communiquer avec les péripériques,

puis cliquez sur le bouton [OK].
Vous pouvez sélectionner jusqu’à deux cartes réseau à la fois. Dans ce cas, définissez un sous-réseau
différent pour chaque carte réseau.

4. Quand la boîte de dialogue de démarrage apparaît, cliquez sur le bouton [New] (Nouveau).
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5. Vérifiez que les périphériques sont affichés dans la zone « Network » (Réseau).
S’ils n’apparaissent pas, vérifiez les connexions avec les périphériques et utilisez la boîte de dialogue
« Network Setup » (Configuration Réseau) pour vérifier que les périphériques sont connectés à la bonne
carte réseau.

6. Dans la zone « Network » (Réseau), cliquez sur le bouton [Unit ID] (ID d’unité).
La boîte de dialogue « Change Unit ID » (Modifier l’ID d’unité) s’ouvre.

7. Cliquez sur le bouton [Auto] (Auto).
L’UNIT ID de chaque périphérique est défini automatiquement de manière à éviter tout conflit.


Cette opération ne s’applique pas aux unités des séries MTX ou XMV. Utilisez les
commutateurs DIP situés sur le panneau arrière pour régler l’ID d’unité.

8. Cliquez sur le bouton [OK].
Les périphériques vont redémarrer ; patientez jusqu’à ce que les amplificateurs des périphériques
réapparaissent dans la zone « Network » (Réseau).

9. Faites glisser un périphérique de la zone « Network » (Réseau), et déposer-le dans la feuille « Project »

(Projet).

Le périphérique est enregistré dans le projet.
Pour faire glisser tous les périphériques et les déposer dans la feuille « Project » (Projet) en une seule
opération, maintenez la touche < Maj > enfoncée, cliquez sur le périphérique en haut de la liste, puis
cliquez sur le périphérique en bas de la liste.

10. Cliquez sur le bouton [Online] (En ligne) de la barre d’outils.
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La boîte de dialogue « Synchronization » (Synchronisation) s’ouvre.
Pour plus de détails sur la synchronisation, reportez-vous à la section « Online and synchronization » (État en
ligne et synchronisation).

11. Cliquez sur le bouton [To Device] (Vers le périphérique), puis cliquez sur le bouton [Online] (En ligne).
Les réglages de ProVisionaire Design sont transmis à chaque périphérique.

12. Double-cliquez sur un périphérique.
La feuille des périphériques s’ouvre.
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13. Double-cliquez sur le composant dont vous souhaitez modifier les paramètres.
L’éditeur de composants s’ouvre.

Il y deux éditeurs de composants dans chaque périphérique. L’un est commun à tous les périphériques, l’autre
est propre au périphérique sélectionné. Pour les éditeurs de composants communs, reportez-vous à la page

https ://manual.yamaha.com/pa/pv/pvd_cg["ProVisionaire Design DME7 Component Guide"] .
Pour les éléments spécifiques aux périphériques, reportez-vous à la description de « Component Editor » (Éditeur
de composants) de chaque périphérique.

14. Modifiez les paramètres.
Si vous souhaitez effectuer les mêmes réglages à plusieurs reprises, faites un clic droit et sélectionnez
[Copy] (Copier) dans la feuille « Project » (Projet) du périphérique que vous avez terminé de modifier. Sur
le périphérique auquel vous souhaitez appliquer les mêmes réglages, sélectionnez [Paste Parameters]
(Coller les paramètres) pour lui appliquer les réglages copiés.

15. Lorsque vous avez terminé les modifications, sauvegardez le fichier de projet.

Pour sauvegarder, cliquez sur ce bouton .
Si vous voulez protéger le fichier, vous pouvez définir un code PIN dans la boîte de dialogue « Protect
File » (Protéger le fichier) accessible depuis le menu [File] (Fichier).



Avec le DME7, si vous travaillez en ligne, vous sauvegardez le fichier de projet sur l’ordinateur

ainsi que sur le périphérique.
Pour plus d’informations, reportez-vous à la boîte de dialogue « File Storage » (Stockage des
fichiers).
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3.2.2. Si vous ne pouvez pas connecter le(s) périphérique(s) à l’ordinateur

Cette méthode vous permet de placer virtuellement des amplificateurs de puissance, puis de les synchroniser
avec les amplificateurs de puissance ultérieurement.

1. Lancez ProVisionaire Design.

La boîte de dialogue « Network Setup » (Configuration réseau) apparaît.
Dans ce cas, et comme vous travaillez hors ligne, cliquez sur le bouton [Cancel] (Annuler).

2. Lorsque la boîte de dialogue de démarrage apparaît, cliquez sur le bouton [New] (Nouveau) pour créer

un nouveau fichier de projet.
Si vous souhaitez modifier un fichier de projet, cliquez sur le bouton […] puis sélectionnez le fichier de
projet et cliquez sur le bouton [OK].

3. Faites glisser un périphérique de la zone « Devices » (Périphériques), et déposez-le dans la feuille

« Project » (Projet).

Le périphérique est enregistré dans le projet.
Enregistrez le nombre de périphériques dont vous avez besoin.
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4. Double-cliquez sur un périphérique.
La feuille des périphériques s’ouvre.

5. Double-cliquez sur le composant dont vous souhaitez modifier les paramètres.

L’éditeur de composants s’ouvre.
Il y deux éditeurs de composants dans chaque périphérique. L’un est commun à tous les périphériques,
l’autre est propre au périphérique sélectionné. Pour les éditeurs de composants communs, reportez-vous

à la page https ://manual.yamaha.com/pa/pv/pvd_cg["ProVisionaire Design DME7 Component Guide"] .
Pour les éléments spécifiques aux périphériques, reportez-vous à la description de « Component Editor »
(Éditeur de composants) de chaque périphérique.
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6. Modifiez les paramètres.

7. Sauvegardez le projet.

Pour sauvegarder, cliquez sur le bouton  dans la barre d’outils.

8. Effectuez les réglages des UNIT ID (ID d’unité) et du port [SECONDARY] (Secondaire) Dante du

périphérique.
Pour plus de détails sur l’établissement de ces réglages, reportez-vous au mode d’emploi de chaque
périphérique.

9. Établissez les connexions.
Branchez les cordons d’alimentation et les câbles réseau des périphériques existants.

10. Mettez tous les périphériques connectés sous tension.

Si besoin, initialisez le microprogramme ou mettez-le à jour.
Pour plus de détails sur l’initialisation ou la mise à jour du microprogramme, reportez-vous au mode
d’emploi de chaque périphérique.

11. Depuis le menu [System] (Système) de la barre de menu, ouvrez « Network Setup » (Configuration

réseau).
La boîte de dialogue « Network Setup » (Configuration réseau) apparaît.

12. Sélectionnez la carte réseau qui sera utilisée pour la communication avec les périphériques, puis
cliquez sur le bouton [OK].
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13. L’UNIT ID spécifié pour les périphériques dans la feuille « Project » s’applique aux périphériques.
Vous pouvez utiliser les méthodes suivantes pour modifier l’UNIT ID d’un périphérique.

◦ Faites glisser un périphérique de la zone « Network » (Réseau), et déposez-le dans la feuille
« Project » (Projet).

◦ Dans la zone « Network » (Réseau), cliquez sur le bouton [Unit ID] (ID d’unité), puis, tout en cliquant
sur le bouton Identify (Identifier) dans la boîte de dialogue « Change Unit ID » (Modifier l’ID d’unité)
pour identifier l’unité spécifique, modifiez manuellement l’ID d’unité.

◦ Modifiez l’ID d’unité à l’aide du périphérique. Reportez-vous au mode d’emploi du périphérique
correspondant.

 Lorsque vous modifiez l’UNIT ID d’un périphérique, il redémarre.

14. Cliquez sur le bouton [Online] (En ligne) de la barre d’outils.
La boîte de dialogue « Synchronization » (Synchronisation) s’ouvre.
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15. Cliquez sur le bouton [To Device] (Vers le périphérique), puis cliquez sur le bouton [Online] (En ligne).
Les réglages de ProVisionaire Design sont transmis à chaque périphérique.

16. Utilisez ProVisionaire Design pour modifier les paramètres.

17. Lorsque vous avez terminé les modifications, sauvegardez le fichier de projet par écrasement.
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4. Barres de menus et barre d’outils
La barre de menus contient les commandes qui peuvent être exécutées par ProVisionaire Design, regroupées

par catégorie.

Cliquez ici pour afficher la liste des commandes.
Les commandes fréquemment utilisées dans ProVisionaire Design, telles que « Print » (Imprimer) et « Align Left
Side » (Aligner à gauche) se présentent sous forme de boutons dans la barre d’outils.

4.1. Menu [File] (Fichier)

Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[New] (Nouveau) Permet de créer un nouveau fichier de projet.
Cette commande n’est pas disponible lorsque
vous êtes en ligne.

---

[Open] (Ouvrir) Permet d’ouvrir un fichier de projet enregistré.
Cette commande n’est pas disponible lorsque

vous êtes en ligne.
La boîte de dialogue « Security » (Sécurité)
s’affiche lorsque vous ouvrez un fichier de projet
pour lequel un code PIN a été spécifié.

---

[Go Online – From
Devices] (Passer
en ligne – Depuis
les périphériques)

--- Permet d’appliquer les données des périphériques
du réseau au fichier de projet.

Boîte de dialogue « Go Online
– From Devices »

[Save] (Enregistrer) Permet d’enregistrer le fichier de projet (en
écrasant la version précédente du fichier).

---

[Save As]
(Enregistrer sous)

--- Permet d’enregistrer le fichier de projet à un
format différent.

Boîte de dialogue « Save
File »

[Save with Style]
(Enregistrer avec le
style)

--- Permet d’enregistrer le fichier de projet en

incluant le style utilisateur.
Même si ce fichier de projet est ouvert sur un
autre ordinateur, le style utilisateur ne sera pas
automatiquement importé. Si vous souhaitez
l’importer, ouvrez le fichier de projet, puis
exécutez la commande [Import Style from Project
File] (Importer le style à partir du fichier de projet).

Boîte de dialogue « Save
File »

[Export Style]
(Exporter le style)

--- Permet d’exporter un style utilisateur enregistré
sur l’ordinateur en tant que fichier (extension de
fichier .pvds).

Boîte de dialogue « Export
Style » (Exporter le style)

[Import Style]
(Importer le style)

--- Permet d’importer dans l’ordinateur un style
utilisateur exporté.

Boîte de dialogue « Import
Style » (Importer le style)

[Import Style from
Project File]
(Importer le style
depuis un fichier
de projet)

--- Permet d’importer un style utilisateur dans
l’ordinateur à partir d’un fichier de projet incluant
un style utilisateur.

---
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Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Reset Style to
Default] (Restaurer
le style sur les
réglages par
défaut)

--- Permet de réinitialiser le style utilisateur sur son
état par défaut, tel qu’il était immédiatement
après l’installation.

---

[Protect File]
(Protéger le fichier)

--- Permet de protéger le fichier de projet en lui

attribuant un code PIN.
Lorsque vous ouvrez un fichier protégé, vous êtes
invité à saisir le code PIN.

Boîte de dialogue « Protect
File »

[Project
Information]
(Informations du
projet)

--- Permet d’inclure un commentaire dans le fichier
de projet afin d’indiquer des informations sur le
contenu du fichier ou des coordonnées de
contact.

Boîte de dialogue « Project
Information »

[Print] (Imprimer) Permet d’imprimer une scène et permet d’accéder
aux réglages d’impression.

Boîte de dialogue « Print »
(Imprimer)

[File Storage]
(Stockage des
fichiers)

--- Permet de préciser le stockage DME7 dans lequel
le fichier de projet sera automatiquement
sauvegardé.

Boîte de dialogue « File
Storage » (Stockage des
fichiers)

[Recentry Open
File] (Fichier ouvert
récemment)

--- Répertorie jusqu’à cinq fichiers de projet
récemment utilisés, ce qui vous permet de les

ouvrir.
Cette commande n’est pas disponible lorsque
vous êtes en ligne.

---

[Exit](Quitter) --- Permet de quitter ProVisionaire Design.
Cette commande n’est pas disponible lorsque
vous êtes en ligne.

---

4.2. Menu [Edit] (Édition)

Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Undo] (Rétablir) Permet d’annuler l’opération précédente. *1 ---

[Redo] (Répéter) Permet de rétablir l’opération qui avait été
précédemment annulée via [Undo] (Rétablir). *1

---

[Cut] (Couper) Permet de déplacer l’élément sélectionné dans le
tampon de copie.

---

[Copy] (Copier) Permet de copier l’élément sélectionné dans le
tampon de copie.

---

[Paste] (Coller) Permet de coller l’élément du tampon de copie à
l’endroit sélectionné.

---
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Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Paste Parameters]
(Coller les
paramètres)

--- Permet d’écraser (par copie) les paramètres du
composant qui sont dans le tampon de copie du
composant sélectionné. Vous pouvez également
copier et coller des paramètres entre les
périphériques.

---

[Paste to Device
Group] (Coller vers
un groupe de
périphériques)

--- Permet de copier le périphérique depuis le
tampon de copie vers un groupe de périphériques.

---

[Delete]
(Supprimer)

--- Permet de supprimer l’objet sélectionné. ---

[Duplicate]
(Dupliquer)

--- Permet de dupliquer l’objet sélectionné. ---
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Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Select All]
(Sélectionner tout)

--- [All] (Tout)
Permet de sélectionner tous les éléments
répertoriés dans la feuille « Project » (Projet). Si
vous voulez sélectionner le contenu d’un groupe
de périphériques, sélectionnez le groupe de
périphériques, puis cliquez sur [Select All]
(Sélectionner tout).

---

--- [All Components] (Tous les composants)
Permet de sélectionner tous les composants
répertoriés dans la feuille de péripérique.

---

--- [All Devices] (Tous les périphériques)
Permet de sélectionner tous les périphériques
répertoriés dans la feuille « Project » (Projet). Si
vous voulez sélectionner des périphériques d’un
groupe de périphériques, sélectionnez le groupe
de périphériques, puis cliquez sur [All Devices]
(Tous les périphériques).

---

--- [All Wires] (Tous les câblages)
Permet de sélectionner tous les câblages
répertoriés dans la feuille « Project » (Projet). Si
vous voulez sélectionner les câblages d’un
groupe de périphériques, sélectionnez le groupe
de périphériques, puis cliquez sur [All Wires]
(Tous les câblages).

---

--- [All Graphics] (Tous les éléments graphiques)
Permet de sélectionner tous les éléments
graphiques répertoriés dans la feuille « Project »
(Projet). Si vous voulez sélectionner des éléments
graphiques d’un groupe de périphériques,
sélectionnez le groupe de périphériques, puis
cliquez sur [All Graphics] (Tous les éléments
graphiques).

---

--- [All Link Groups] (Tous les groupes de liaisons)
Permet de sélectionner tous les groupes de
liaisons dans la feuille « Tuning » (Accord fin).

---

[Create Device
Group] (Créer un
groupe de
périphériques)

--- Permet de regrouper les objets sélectionnés dans
la feuille « Project » (Projet) dans un groupe de
périphériques.

---

[Unpack Device
Group] (Dissocier
le groupe de
périphériques)

--- Permet de dissocier les objets sélectionnés dans
un groupe de périphériques vers la feuille
« Project ».

---

[Unbundle Wires]
(Dégrouper les
câblages)

--- Affiche les câblages connectés au composant
sélectionné ou les composants du bloc défini par
l’utilisateur placés à des intervalles égaux.

Pour plus de détails,
reportez-vous à la section sur
le DME7.
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Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Bundle Wires]
(Grouper les
câblages)

--- Affiche les câblages connectés au composant
sélectionné ou les composants du bloc défini par
l’utilisateur superposés.

Pour plus de détails,
reportez-vous à la section sur
le DME7.

*1. Dans la zone [Properties] (Propriétés), vous pouvez choisir l’opération que la commande [Undo]
(Rétablir)/[Redo] (Répéter) affecte : soit le placement/déplacement ou la suppression d’un objet, soit la
création/suppression d’un câblage entre les périphériques.
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4.3. Menu [View] (Affichage)

Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

Case à cocher des
différentes zones à
afficher

--- Cochez la case correspondant à la zone que vous
souhaitez afficher. Le contenu de la zone affichée
varie en fonction de la feuille et du périphérique.

---

[Zoom In] (Zoom
avant)

Permet d’agrandir l’affichage au sein de la feuille. ---

[Zoom Out] (Zoom
arrière)

Permet de réduire l’affichage au sein de la feuille. ---

[Zoom to 100%]
(Zoom à 100 %)

Permet d’afficher la feuille avec un zoom de
100 %.

---

[Zoom to Fit]
(Zoom
d’ajustement)

Permet d’ajuster l’affichage de sorte que tous les
composants placés sur la feuille soient visibles.

---

[Editor
Magnification]
(Zoom de l’éditeur)

Permet de régler le zoom du Component Editor
(Éditeur de composants).

---

[Print Area] (Zone
d’impression)

--- Permet d’afficher sur la feuille la taille du papier
indiquée dans la boîte de dialogue « Print »
(Imprimer). Les coordonnées (x,y)=(0,0) de la
feuille correspondent au coin supérieur gauche du
papier.

---

4.4. Menu « System » (Système)

Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Network Setup]
(Paramètres
réseau)

--- Permet de sélectionner la carte réseau de
l’ordinateur qui sera utilisée pour communiquer

avec les périphériques.
Vous pouvez également modifier l’adresse IP de
la carte réseau.

Boîte de dialogue « Network
Setup » (Paramètres réseau)

[IP Settings]
(Réglages IP)

--- Répertorie les péripériques du réseau, ce qui vous
permet de modifier leur adresse IP.

Boîte de dialogue « IP
Settings » (Réglages IP)

[Match Device by
IP Address]
(Trouver des
périphériques par
leur adresse IP)

--- Permet d’effectuer les réglages du système de
sorte que ProVisionaire Design recherche les

périphériques par adresse IP.
Effectuer ce réglage si l’ordinateur est sur un
sous-réseau différent des périphériques.

Boîte de dialogue « Match
Devices by IP Address »
(Trouver des périphériques
par leur adresse IP)

[Device
Information]
(Informations sur
le périphérique)

--- Répertorie les périphériques du réseau, ce qui
vous permet de mettre à jour leurs
microprogrammes, de les réinitialiser ou de les
redémarrer.

Boîte de dialogue « Device
Information » (Informations
sur le périphérique)
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Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Word Clock]
(Horloge de mots)

--- Permet de choisir l’horloge de mots du
périphérique.

Boîte de dialogue « Word
Clock » (Horloge de mots)

[Protect Devices]
(Protéger les
périphériques)

--- Permet de définir un code PIN administrateur
pour le périphérique afin d’éviter toute
modification involontaire.

Boîte de dialogue « Protect
Devices » (Protéger les
périphériques)

[Clock] (Horloge) --- Quel que soit l’état en ligne/hors ligne, l’heure et
la date sont mises à jour pour tous les
périphériques connectés au même réseau.

Boîte de dialogue « Clock »
(Horloge)

[Daylight Saving
Time] (Heure d’été)

--- Quel que soit l’état en ligne/hors ligne, l’heure
d’été est mise à jour pour tous les périphériques
connectés au même réseau.

Boîte de dialogue « Daylight
Saving Time » (Heure d’été)

[GPI Calibration]
(Calibrage du GPI)

--- Permet de calibrer la plage de détection de la
tension d’entrée pour le connecteur [GPI] des
périphériques. (Disponible uniquement lorsque
vous êtes en ligne)

Boîte de dialogue « GPI
Calibration » (Calibrage du
GPI)

[Get Log from
Devices] (Obtenir
le journal des
périphériques)

--- Permet de récupérer le fichier journal des unités
des séries MTX ou XMV.

Boîte de dialogue « Get Log
from Devices » (Obtenir le
journal des périphériques)

[Show Alert Popup]
(Afficher la fenêtre
d’alerte)

--- Permet de choisir si une fenêtre d’alerte s’affiche
ou non dans ProVisionaire Design lorsqu’une
alerte apparaît sur le périphérique.

---

[RM Series
Settings]
(Paramètres de la
série RM)

--- [Sign up] (Inscription)
Permet de configurer le mot de passe initial pour

le RM-CG ou RM-TT.

[Login]
Permet de vous identifier aux RM-CG ou RM-TT
pour lesquels le mot de passe a déjà été entré.
Vous devez vous connecter pour configurer ces

périphériques dans ProVisionaire Design.

[Password Settings]
Permet de changer le mot de passe du RM-CG ou

du RM-TT.

[Enable SCP remote control access]
Permet d’activer ou de désactiver le contrôle des
RM-CG ou RM-TT via le contrôleur SCP externe.

Boîte de dialogue « Sign up »

"Log In" dialog box

"Password Settings" dialog

box

"Enable SCP remote control
access" dialog box

4.5. Menu [Tools] (Outils)
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Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Trace Signal Path]
(Tracer le chemin
du signal)

Si vous sélectionnez un port ou un câblage alors
que cette commande est activée, le chemin du
signal sera tracé du point sélectionné vers la
sortie et l’entrée.

---

[Duplicate Port
Label] (Dupliquer le
nom du port)

--- Si vous créez un câblage entre les ports alors que
cette commande est activée, le nom du port
d’origine sera copié sur le port de destination.

---

4.6. Menu [Arrange] (Disposition)

Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Align Left Sides]
(Aligner les bords
gauches)

Permet d’aligner le bord gauche sur le composant
le plus à gauche de la sélection.

---

[Align Right Sides]
(Aligner les bords
droits)

Permet d’aligner le bord droit sur le composant le
plus à droite de la sélection.

---

[Align Tops]
(Aligner les
sommets)

Permet d’aligner le bord supérieur sur le
composant le plus haut de la sélection.

---

[Align Bottoms]
(Aligner les bases)

Permet d’aligner le bord inférieur sur composant
le plus bas de la sélection.

---

[Align Horizontal
Centers] (Aligner
les centres
horizontaux)

Permet d’aligner horizontalement le centre de
l’objet avec celui des multiples composants
sélectionnés.

---

[Align Vertical
Centers] (Aligner
les centres
verticaux)

Permet d’aligner verticalement le centre de l’objet
avec celui des multiples composants
sélectionnés.

---

[Distribute
Horizontally]
(Distribuer
horizontalement)

Permet d’espacer horizontalement les objets
sélectionnés.

---

[Distribute
Vertically]
(Distribuer
verticalement)

Permet d’espacer verticalement les objets
sélectionnés.

---

[Same
Horizontally]
(Même hauteur)

Permet d’aligner la hauteur des objets
sélectionnés.

---
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Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Same Widths]
(Mêmes largeurs)

Permet d’aligner la largeur des objets
sélectionnés.

---

[Bring to Front]
(Mettre au premier
plan)

--- Permet de placer l’objet sélectionné au premier
plan.

---

[Send to Back]
(Mettre en arrière-
plan)

--- Permet de placer l’objet sélectionné à l’arrière-
plan.

---

4.7. Menu [Window] (Fenêtre)

Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Close All Editor
Windows] (Fermer
toutes les fenêtres
Editor)

--- Permet de fermer toutes les fenêtres liées à
l’éditeur de composants et aux réglages de
paramètres.

---

[Show All Editor
Windows] (Afficher
toutes les fenêtres
Editor)

--- Permet d’afficher toutes les fenêtres liées à
l’éditeur de composants et aux réglages de
paramètres en avant-plan.

---

[Hide All Editor
Windows]
(Masquer toutes
les fenêtres Editor)

--- Permet de masquer toutes les fenêtres liées à
l’éditeur de composants et aux réglages de
paramètres.

---
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4.8. Menu [Help] (Aide)

Commande Bouton
de la
barre
d’outils

Récapitulatif Boîte de dialogue affichée

[Shortcut Keys]
(Touches de
raccourci)

--- Affiche une liste de touches de raccourci. Fenêtre « Shortcut Keys »
(Touches de raccourci)

4.9. Boutons uniquement situés sur la barre d’outils

Les boutons suivants n’ont pas de commande de menu correspondante.

Bouton Récapitulatif

Indique le pourcentage d’agrandissement actuel de la feuille. Cliquez sur ▼ pour
modifier l’agrandissement. Vous pouvez cliquer sur l’affichage numérique et entrer
directement la valeur souhaitée. Permet de réduire l’affichage au sein de la feuille.

Permet de passer le curseur de la souris en mode sélection ou édition.

Permet de passer le curseur de la souris en mode dessin de lignes dans la feuille
« Project » (Projet).

Permet de passer le curseur de la souris en mode dessin de polygones dans la feuille

« Project » (Projet).
Lorsque vous dessinez un polygone, cliquez pour déplacer chaque coin
individuellement. Double-cliquez lorsque vous avez terminé.

Les « Linked Presets » (Présélections liées) stockées s’affichent comme illustré à
gauche. (Les présélections des périphériques pour lesquels il n’y a pas « Linked
Presets » déjà existante ne s’affichent pas.) Les présélections liées que vous

sélectionnez ici seront automatiquement rappelées.

Lorsque vous cliquez sur le ▼ à droite, un menu déroulant apparaît, qui vous permet de
rappeler la présélection liée de votre choix.

Permet d’ouvrir la boîte de dialogue « Linked Presets Manager » (Gestionnaire des
présélections liées).

S’allume si les périphériques et l’ordinateur sont en ligne. La couleur du voyant change

en fonction de l’état.

Bleu : tous les périphériques placés sont hors ligne

Jaune : au moins un des périphériques placés est hors ligne
Éteint : tous les périphériques sont hors ligne

Lorsque vous cliquez sur ce bouton, la boîte de dialogue « Synchronisation » apparaît, ce
qui vous permet de synchroniser le périphérique avec ProVisionaire Design.


Si le périphérique placé n’est pas réellement connecté au réseau, le
bouton [Online] (En ligne) ne sera pas disponible.

Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Offline ».


Si le périphérique placé n’est pas réellement connecté au réseau, le
bouton [Offline] (Hors ligne) ne sera pas disponible.
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Bouton Récapitulatif

Permet de basculer l’état de la connexion entre ProVisionaire Design et le réseau. Si ce
statut est « connecté », ProVisionaire Design envoie des données au réseau, par
exemple pour rechercher des périphériques, même dans l’état « Offline » (Hors ligne).
Réglez ce bouton sur « Déconnecté » si vous ne souhaitez pas que des données inutiles
soient transmises, par exemple si vous êtes connecté à un réseau LAN de bureau.

Connecté.

Déconnecté.

Lorsque le périphérique est en ligne, le bouton [SOLO] de l’éditeur du groupe de liaison
est activée.
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5. Touches de raccourci
Cette partie présente les touches de raccourci que vous pouvez utiliser dans ProVisionaire Design.

Conception

Combinaisons de touches Action effectuée

< F5 > Basculer sur [Online] (En ligne).

< Ctrl > + < F5 > Basculer sur [Offline] (hors ligne).

Molette de la souris Changer la position d’un curseur, d’un bouton ou d’une valeur numérique
dans un champ.

< Alt > + Clic sur un paramètre dans
« Component Editor » (Éditeur de
composants)

Régler le paramètre sur sa valeur nominale.

< Alt > + < F4 > Ouvrir l’éditeur du composant au premier plan.

Actions dans une feuille

Combinaisons de touches Action effectuée

< ↑ > / < Ctrl > + < ↑ > Faire défiler la feuille vers le haut.

Si un objet est sélectionné, cela déplace l’objet sélectionné vers le haut.
Les composants d’un périphérique dont la configuration est fixe ne
peuvent pas être déplacés.

< ↓ > / < Ctrl > + < ↓ > Faire défiler la feuille vers le bas.

Si un objet est sélectionné, cela déplace l’objet sélectionné vers le bas.
Les composants d’un périphérique dont la configuration est fixe ne
peuvent pas être déplacés.

< ← > / < Ctrl > + < ← > Faire défiler la feuille vers la gauche.
Si un objet est sélectionné, cela déplace l’objet sélectionné vers la

gauche.
Les composants d’un périphérique dont la configuration est fixe ne
peuvent pas être déplacés.

< → > / < Ctrl > + < → > Faire défiler la feuille vers la droite.

Si un objet est sélectionné, cela déplace l’objet sélectionné vers la droite.
Les composants d’un périphérique dont la configuration est fixe ne
peuvent pas être déplacés.

< Page précédente > Faire défiler la feuille vers le haut.

< Page suivante > Faire défiler la feuille vers le bas.

< Début > (touche Origine) Se déplacer jusqu’à l’objet le plus à gauche.

< Fin > Se déplacer jusqu’à l’objet le plus à droite.

< Ctrl > + < Début > Se déplacer jusqu’à l’objet dans le coin supérieur gauche.

< Ctrl > + < Fin > Se déplacer jusqu’à l’objet dans le coin inférieur droit.

Molette de la souris Faire défiler la feuille vers le bas ou vers le haut.
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Combinaisons de touches Action effectuée

< Maj > + Molette de la souris Faire défiler la feuille vers la gauche ou la droite.

< Ctrl > + Molette de la souris Agrandir ou réduire l’affichage de la feuille.

< Alt > + < F3 > Afficher une liste des feuilles.
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Édition

Combinaisons de touches Action effectuée

Double-clic sur un objet dans
« Components » (Composants).

Passer en mode Stamp (Horodatage).
Le mode Stamp (Horodatage) est une fonction qui place un composant
sur la feuille de conception à clic sur la feuille.

< Échap > Annuler le mode Stamp et les modifications en cours.

< Ctrl > + Glisser-déposer sur un
objet existant dans la feuille de
conception

Dupliquer un objet.

< Ctrl > + Glisser-déposer un
composant depuis la feuille de
conception ou un paramètre depuis
le Component Editor (Éditeur de
composants)

Affecter le(s) éléments(s) aux fenêtres suivantes :

-Parameter Sets (Jeux de paramètres)

-Boîte de dialogue « GPI »
-Boîte de dialogue « Remote Control Setup List » (Liste de configurations

de commandes à distance)
-DCP Components (Composants DCP)

Glisser-déposer un ou plusieurs
composants ou paramètres depuis
« Parameters » (Paramètres)

Affecter le(s) éléments(s) aux fenêtres suivantes :

-Parameter Sets (Jeux de paramètres)

-Boîte de dialogue « GPI »
-Boîte de dialogue « Remote Control Setup List » (Liste de configurations

de commandes à distance)
-DCP Components (Composants DCP)

Touches alphanumériques -Dans la feuille de conception :
Permet de sélectionner les composants dont le nom commence par la
lettre entrée. Si plusieurs composants sont concernés, entrez la lettre

plusieurs fois pour les faire défiler.

-Dans « Components » (Composants), « Parameter Sets » (Jeux de

paramètres) et « Parameters » (Paramètres) :
Permet de sélectionner le composant/paramètre/jeu de paramètres dont
le nom commence par la lettre entrée. Si plusieurs composants sont
concernés, entrez la lettre plusieurs fois pour les faire défiler.

< Ctrl > + Clic Sélectionner ou désélectionner simultanément plusieurs objets.

< Maj > + Clic Sélectionner ou désélectionner simultanément plusieurs objets.

Glisser-déposer Sélectionner les objets qui sont entièrement contenus dans la zone
rectangulaire ainsi créée.

< Ctrl > + Glisser-déposer Sélectionner les objets qui sont entièrement ou partiellement contenus
dans la zone rectangulaire ainsi créée.

< Maj > +Glisser-déposer Sélectionner les ports d’entrée des composants qui sont entièrement
contenus dans la zone rectangulaire ainsi créée.

< Alt > + Glisser-déposer Sélectionner les ports de sortie des composants qui sont entièrement
contenus dans la zone rectangulaire ainsi créée.

< Maj > + < Alt > + Glisser-déposer Sélectionner les ports d’entrée et les ports de sortie des composants qui
sont entièrement contenus dans la zone rectangulaire ainsi créée.
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Combinaisons de touches Action effectuée

Sélectionner et faire un glisser-
déposer du port d’origine d’un
composant vers le port de
destination d’un autre composant.

Créer une connexion de câblage entre les ports de composants.
+ < Espace > : ouvrir la boîte de dialogue « Transmitter or Receiver Form »
(Formulaire émetteur ou récepteur)

Sélectionner des câblages + <
Espace >.

Connecter les câblages aux composants de type émetteur ou récepteur.

Sélectionner et faire un glisser-
déposer plusieurs ports d’origine
d’un composant vers le port de
destination d’un autre composant.

Créer plusieurs connexions de câblage entre les ports de composants.

Sélectionner les ports de sortie d’un
composant audio lorsque le
composant « Probe Monitor »
(Contrôle de vérification) est sur
ON.

Régler le « Monitor Probe» (Capteur de vérification) sur 1.

< Maj > + Sélectionner les ports de
sortie d’un composant audio
lorsque le composant « Probe
Monitor » (Contrôle de vérification)
est sur ON.

Régler le « Monitor Probe» (Capteur de vérification) sur 2.

Sélectionner le port d’entrée d’un
composant audio lorsque le
composant « Probe Monitor »
(Contrôle de vérification) est sur
ON.

Régler le capteur de l’oscillateur.

5. Touches de raccourci
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6. Liste des messages d’alerte
En cas de dysfonctionnement du péripéhrique, un message d’alerte apparaît à l’écran. Si un message d’alerte
s’affiche déjà et qu’un dysfonctionnement de niveau supérieur se produit, l’alerte de dysfonctionnement de

niveau supérieur s’affiche.
Pour plus de détails sur les messages d’alertes, reportez-vous aux liens ci-dessous :

6.1. Amplificateurs de puissance

PC series
XMV series

6.2. Processeurs de signal

DME7

MRX7-D
MTX5-D,MTX3

6. Liste des messages d’alerte
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7. Feuille « Project »
Lorsque vous ouvrez la feuille « Project », la zone « Devices », la zone « Network », la feuille « Project », la zone

« Properties » et la vue « Bird’s Eye » s’affichent.
La vue « Bird’s Eye » montre l’intégralité de la feuille « Project ».

7.1. Feuille « Project »

Vous pouvez placer des appareils dans cette feuille. Les appareils placés ici sont enregistrés dans le projet.
Les réglages de base d’un appareil enregistré se font dans la zone « Properties ».

7.2. Zone « Devices » (Appareils)

Pour placer un appareil dans la feuille « Project » en tant qu’appareil virtuel, faites-le glisser et déposer depuis
cette zone.

 Pour plus de détails sur le format YDIF, reportez-vous à la section « YDIF ».

7. Feuille « Project »
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7.3. Zone « Network » (Réseau)

Les appareils connectés au même réseau que l’ordinateur sont détectés et affichés ici.

Pour enregistrer un appareil affiché ici dans le projet, faites-le glisser dans la feuille « Project ».
Lorsque vous cliquez sur le bouton [Unit ID] (ID d’unité), la boîte de dialogue « Change Unit ID » (Modifier l’ID
d’unité) s’affiche.

RM-CG/RM-TT

Pour contrôler ces appareils, vous devez vous identifier sur ProVisionaire Design.
Si le mot de passe initial n’a pas été défini, l’icône  apparaît. Si le mot de passe initial a été défini mais que

vous ne vous êtes pas encore connecté, l’icône  apparaît.
Vous pouvez contrôler ces appareils via l’option « RM Settings » (Réglages RM), accessible depuis le menu
contextuel ou [System] (Système).

7.3.1. Boîte de dialogue « Change Unit ID » (Modifier l’ID d’unité)

Dans cette boîte de dialogue, vous pouvez modifier l’ID d’unité de l’appareil. Lorsque vous modifiez l’ID d’unité,

l’appareil redémarre, de sorte qu’il disparaît temporairement de la zone « Network ».
Vous ne pouvez pas modifier l’ID d’unité d’un appareil qui est en ligne.

Modèles pris en charge : DME7, série PC, RM-CG, RM-TT, VXL1-16P


Cette opération ne s’applique pas aux unités des séries MTX et XMV. Utilisez les
commutateurs DIP situés sur le panneau arrière pour régler l’ID d’unité.

7. Feuille « Project »
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• Bouton [Auto]
Attribue automatiquement un ID d’unité à chaque appareil, en commençant par le numéro sélectionné
dans la zone de liste [Unit ID Starting From] (ID d’unité à partir de).

• Cases d’option [Unique Unit ID in a model/project] (ID d’unité unique dans un modèle/projet)
Indique si les affectations d’ID d’unité effectuées lorsque vous appuyez sur le bouton [Auto] sont uniques
pour chaque modèle ou pour chaque projet.

• Bouton [Refresh] (Actualiser)
Met à jour la liste des appareils située sous le bouton.

• Bouton [Accessibility] (Accessibilité)
Ouvre une fenêtre « Unit ID » supplémentaire qui vous permet de modifier l’ID d’unité de l’appareil
actuellement sélectionné. La fenêtre « Unit ID » s’ouvre également lorsque vous cliquez avec le bouton
droit sur un endroit autre que le bouton Identify ou la zone de texte [Unit ID] dans la liste des appareils ci-
dessous.

• Liste des appareils
Les appareils connectés au même réseau que l’ordinateur sont détectés et affichés ici.

◦ Bouton Identify (Identifier)
Lorsque vous appuyez sur ce bouton situé à gauche de la colonne Unit ID, les voyants de l’appareil
correspondant clignotent pendant plusieurs secondes.

◦ Zone de texte [Unit ID]
Affiche l’ID d’unité de l’appareil correspondant.

◦ [Model] (Modèle)/[Device Name] (Nom de l’appareil)/[Status] (État)/[IP Address] (Adresse IP)
Affiche des informations sur l’appareil. Vous pouvez cliquer pour trier la liste.

7. Feuille « Project »
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■ Boîte de dialogue « Unit ID »)

Cliquez sur les boutons pour afficher l’ID d’unité en haut.
Vous pouvez modifier l’ID d’unité d’un ou plusieurs appareils.


Si vous sélectionnez « 0 » pour le deuxième chiffre alors que le premier chiffre est réglé sur
« 0 », le deuxième chiffre sera automatiquement défini sur « 1 ».

• Bouton [Apply] (Appliquer)
Applique l’ID d’unité à l’appareil sélectionné.

7. Feuille « Project »
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7.4. Zone « Properties »

Cette zone vous permet d’afficher et de modifier les informations relatives à la feuille ou à l’objet.
Pour plus de détails sur les éléments liés aux réglages d’un appareil ou sur les éléments qui apparaissent dans la
boîte de dialogue lorsque vous cliquez, reportez-vous à la section consacrée à chaque appareil.

• Bouton [Save Style] (Enregistrer le style)
Cliquez sur le bouton [Save Style] pour enregistrer sur l’ordinateur les informations affichées dans la zone
« Properties » en tant que valeurs par défaut. Ces valeurs s’appliquent aux autres projets nouvellement

créés.

Les composants, les ports, les câblages ainsi que la feuille de conception peuvent ainsi être enregistrés.
Les éléments spécifiés dans la zone «Properties» peuvent être enregistrés en tant que style utilisateur, de
sorte que la prochaine fois que vous placez un nouveau composant ou connectez des câbles, ils auront la

même apparence qu’ils avaient lors de leur enregistrement en tant que style.
Si vous souhaitez utiliser le même style utilisateur sur un autre ordinateur, suivez l’une des procédures
suivantes.

◦ Accédez au menu [File] (Fichier) → [Export Style] (Exporter le style) pour enregistrer le style

utilisateur sous forme de fichier, puis utilisez le menu [File] → [Import Style] (Importer le style) sur
l’autre ordinateur pour charger le fichier.

◦ Accédez au menu [File] → [Save with Style] (Enregistrer avec le style) pour créer un fichier de projet

7. Feuille « Project »
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incluant le style utilisateur. Après avoir chargé le fichier sur l’autre ordinateur, accédez au menu

[File] → [Import Style from Project File] (Importer le style depuis le fichier de projet) pour le charger.

7. Feuille « Project »
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• Device

◦ Model
Indique le nom du modèle.

◦ Device Name
Indique le nom défini par l’utilisateur pour l’appareil cible. Double-cliquez sur ce champ pour le
modifier.

◦ Unit ID
Indique l’ID d’unité de l’appareil. Vous ne pouvez pas modifier ce champ lorsque l’appareil est en
ligne.

• Display (Écran)

◦ Output Wiring Step (Étape de câblage de sortie)
Définit la longueur de l’étape de câblage côté sortie. Si vous souhaitez des intervalles égaux,
veuillez définir la commande « Wire Routing » (Acheminement du câblage) sur Automatic
(Automatique) et régler « Auto Block Avoidance » (Évitement automatique du bloc) sur False
(Faux).

◦ Input Wiring Step (Étape de câblage d’entrée)
Définit la longueur de l’étape de câblage côté entrée. Si vous souhaitez des intervalles égaux,
veuillez définir la commande « Wire Routing » sur Automatic et régler « Auto Block Avoidance » sur
False.

• Object (Objet)
Lorsque le port d’un appareil ou d’un composant présent sur la feuille est sélectionné, cliquez sur l’icône

 qui apparaît lorsque vous cliquez sur Label (Étiquette) pour ouvrir la boîte de dialogue Port Label
(Étiquette du port).

7. Feuille « Project »
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7.5. Placement des appareils

Cette section vous explique comment placer des appareils sur la feuille « Project ».


• Si un objet de la zone « Devices » ou « Network » est sélectionné, appuyez sur une

touche alphabétique pour sélectionner le composant commençant par cette lettre.

• Glissez-déposez un appareil depuis la zone « Devices » vers la feuille « Project ».
Vous pouvez sélectionner le nombre d’appareils et l’ID d’unité. L’ID d’unité peut être modifié dans la zone
« Properties ».

• Connectez l’ordinateur au réseau d’appareils, puis glissez-déposez un appareil depuis la zone

« Network » vers la feuille « Project ».
Si un appareil que vous pensez connecté n’apparaît pas dans la zone « Network », vérifiez qu’il est

effectivement connecté au réseau et sous tension.
Les haut-parleurs ne s’affichent pas dans la zone « Network ».



• Double-cliquez sur [Device Group] (Groupe d’appareils) pour sélectionner le mode
Stamp (Horodatage), puis cliquez sur la feuille « Project » pour placer un [Device

Group] chaque fois que vous cliquez sur la feuille.
Pour quitter le mode Stamp, appuyez sur la touche < Échap >.

7. Feuille « Project »

ProVisionaire Design V1.2 Guide d’utilisation | 55



7.6. Sélection de plusieurs objets

Cette section vous explique comment sélectionner plusieurs objets placés dans la feuille « Project » (Projet).

• Utilisez le curseur de la souris pour entourer complètement des objets
En déplaçant le curseur, vous pouvez sélectionner les objets entièrement présents dans la zone
rectangulaire de la feuille.

• Maintenez la touche < Ctrl > enfoncée et utilisez le curseur de la souris pour entourer des objets en tout

ou en partie
En déplaçant le curseur tout en maintenant la touche < Ctrl > enfoncée, vous pouvez sélectionner les
objets qui sont entièrement ou partiellement contenus dans la zone rectangulaire de la feuille.

Pour sélectionner des objets à l’intérieur d’un appareil, commencez votre sélection à l’intérieur de celui-ci. Seuls
les objets contenus dans cet appareil peuvent être sélectionnés.


Si la sélection contient un groupe d’appareils et que le point à partir duquel vous démarrez
l’opération de glisser se trouve sur la feuille, tous les objets situés sur cette feuille sont
sélectionnés. Si le point à partir duquel vous démarrez l’opération de glisser se trouve dans
un groupe d’appareils, tous les objets situés dans ce groupe sont sélectionnés.

• Maintenez la touche < Ctrl > enfoncée et cliquez sur des objets
Pour sélectionner plusieurs objets, maintenez la touche < Ctrl > enfoncée et cliquez sur chaque cible que

vous voulez sélectionner.
Si vous cliquez sur un objet déjà sélectionné alors que la touche < Ctrl > est enfoncée, la sélection est
annulée.

7. Feuille « Project »
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7.7. Connexion de ports

Cette section vous explique comment établir des connexions entre les ports des appareils en créant un câblage
entre ces ports.

• Établissement d’une seule connexion à la fois
Faites glisser un port de sortie vers le port d’entrée de l’appareil de destination.

• Établissement de plusieurs connexions à la fois
Sélectionnez plusieurs ports de sortie et faites glisser un de ces ports vers un port d’entrée de l’appareil
de destination.

7. Feuille « Project »
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7.8. Duplication d’appareils

Cette section vous explique comment dupliquer des appareils ainsi que leurs paramètres.

• Cliquez avec le bouton droit de la souris sur un objet et sélectionnez [Duplicate] (Dupliquer)
Un objet dupliqué chevauchant l’objet original est créé. Si plusieurs objets sont sélectionnés avec leur
câblage lorsque vous choisissez [Duplicate], les câblages sont également dupliqués.

• Glissez-déposez un objet tout en maintenant la touche < Ctrl > enfoncée
Un objet dupliqué est créé à l’endroit où vous déposez l’objet.

• Glissez-déposez plusieurs objets avec leur câblage tout en maintenant la touche < Ctrl > enfoncée
Des doubles des composants et de leur câblage sont créés lorsque vous déposez les composants.

7. Feuille « Project »
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7.9. « Group Editor » (Éditeur de groupes)

Les appareils d’un groupe peuvent être activés/désactivés ou assourdis en une seule étape.
Lorsque vous double-cliquez sur un groupe d’appareils ou cliquez avec le bouton droit, puis sélectionnez [Open

Group Editor] (Ouvrir l’éditeur de groupes) dans le menu contextuel, la fenêtre « Group Editor » s’ouvre.
Cette fonction est uniquement disponible en ligne.

• Zone « Power » (Alimentation)
Permet de basculer l’ensemble des appareils du groupe en mode Veille ou Marche.

• Zone « Device Mute » (Assourdissement de l’appareil)
Permet d’activer/de désactiver le réglage de sourdine pour l’ensemble des appareils du groupe.

7. Feuille « Project »

ProVisionaire Design V1.2 Guide d’utilisation | 59



8. Feuille « Tuning » (Accord fin)


La feuille « Tuning » (Accord fin) prend uniquement en charge les unités des séries PC et
XMV.

Les canaux des amplificateurs de puissance regroupés entre les péripériques de la même série sont appelés un
« groupe de liaisons ». L’utilisation du « Link group » (Éditeur de groupes de liaisons) permet de configurer

ensemble les canaux regroupés, en tant que valeurs relatives ou absolues du même type de paramètre.
Pour créer un groupe de liaisons, vous pouvez faire glisser un [Group] (Groupe) depuis la zone « Components »

(Composants) et le déposer dans la feuille « Tuning » (Accord fin).
Dans la zone « Components » (Composants), double-cliquez sur [Group] (Groupe) pour accéder au mode Stamp
(Horodatage). Un [Group] est placé chaque fois que vous cliquez sur la feuille. Pour quitter le mode Stamp,
appuyez sur la touche < Échap >.

Enregistrer un objet dans un groupe de liaisons peut se faire selon les méthodes suivantes :

Source d’enregistrement Méthode d’enregistrement

Feuille « Project » (Projet) Faites un clic droit sur un périphérique, puis cliquez sur [Add to Link Group] (Ajouter
au groupe de liaisons) pour pouvoir sélectionner le canal et le groupe de liaisons à
enregistrer.

Après avoir sélectionné plusieurs périphériques, faites un clic droit sur l’un d’eux,
puis cliquez sur [Add to Link Group] (Ajouter au groupe de liaisons) pour pouvoir
sélectionner le canal et le groupe de liaisons à enregistrer.

Feuille « Tuning » (Accord
fin)

Dans la zone « Project Devices » (Périphériques de projet), faites glisser un canal
depuis « Amplifiers » (Amplificateurs) ou « Speakers » (Haut-parleurs) dans [Group]
(Grouper).

Dans la zone « Project Devices » (Périphériques de projet), faites un clic droit sur un
canal dans « Amplifiers » (Amplificateurs) ou dans « Speaker » (Haut-parleurs) et
cliquez sur [Add to Link Group] (Ajouter à un groupe de liaisons) pour sélectionner
le groupe de liaisons dans lequel il sera enregistré.

Lorsque vous double-cliquez sur un objet dans la feuille « Tuning », le « Link group component editor » (Éditeur

de composants du groupe de liaisons) s’ouvre.
Pour plus de détails sur l’éditeur de composants du groupe de liaisons, reportez-vous aux sections à propos de
l’éditeur de composants de chaque périphérique.

8. Feuille « Tuning » (Accord fin)
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8.1. Feuille « Tuning » (Accord fin)

Cette feuille permet de visualiser les groupes de liaisons.

Effectuez un clic droit sur un groupe de liaisons et sélectionnez [Open Link Group Editor] (Ouvrir l’éditeur de

groupes de liaisons) pour ouvrir l’éditeur de groupes de liaisons.
Pour en savoir plus sur l’éditeur de groupes de liaisons, reportez-vous à la section au sujet de chaque modèle
d’amplificateur de puissance.

8.2. Zone « Properties » (Propriétés)

Cette zone vous permet d’afficher et de modifier des informations sur la feuille ou l’objet.
Lorsque vous cliquez sur le bouton [Save Style] (Enregistrer le style), les informations autres que [Location]
(Emplacement) sont enregistrées sur l’ordinateur et définies comme les réglages par défaut de cet objet.

8. Feuille « Tuning » (Accord fin)

62 | ProVisionaire Design V1.2 Guide d’utilisation



8.3. Zone « Project Devices » (Périphériques de projet)

Cette zone permet d’afficher les périphériques enregistrés dans le projet sous forme d’arborescence.

8.3.1. [Amplifiers] (Amplificateurs)

Vous pouvez développer un élément pour voir les canaux de l’amplificateur de puissance.

Faites glisser un canal dans [Group] (Groupe) pour enregistrer ce canal dans un groupe de liaisons.
Pour plus de détails sur le menu contextuel qui apparaît lorsque vous faites un clic droit, reportez-vous à la
section Menus contextuels.

8.3.2. [Speakers] (Haut-parleurs)

Vous pouvez développer un élément pour afficher les canaux des amplificateurs de puissance connectés aux

ports du haut-parleur dans la feuille « Project » (Projet).

Faites glisser un canal dans [Group] (Groupe) pour enregistrer ce canal dans un groupe de liaisons.
Pour plus de détails sur le menu contextuel qui apparaît lorsque vous faites un clic droit, reportez-vous à la
section Menus contextuels.

8. Feuille « Tuning » (Accord fin)
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8.4. Zone « Link Groups » (Groupes de liaisons)

Cette zone affiche les groupes de liaisons et les canaux des amplificateurs de puissance qui sont enregistrés
dans ces groupes sous forme d’une arborescence.

Pour plus de détails sur le menu contextuel qui apparaît lorsque vous faites un clic droit, reportez-vous à la
section Menus contextuels.
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9. État en ligne et synchronisation
Vous pouvez connecter des périphériques à l’ordinateur et leur envoyer des réglages créés sur ProVisionaire

Design. Vous pouvez également charger des données depuis les périphériques dans ProVisionaire Design.
L’état dans lequel les périphériques et ProVisionaire Design opèrent de manière synchronisée est appelé l’état

« en ligne ». L’action qui consiste à basculer dans cet état est appelée « Synchronization » (Synchronisation).
La synchronisation met en adéquation les réglages de ProVisionaire Design et des périphériques. Lorsque les
réglages correspondent, ils passent à l’état en ligne, ce qui permet de contrôler les périphériques en temps réel.

9.1. État en ligne

Pour accéder à l’état en ligne dans ProVisionaire Design, cliquez sur le bouton [Online] (En ligne) de la barre

d’outils pour accéder à la boîte de dialogue « Synchronization ».
Vous pouvez également sélectionner « Go Online - From Devices » (Passer en ligne - Depuis les périphériques)
dans le menu [File] (Fichier).

9.1.1. Boîte de dialogue « Synchronization » (Synchronisation)

• Bouton d’option [To Device] (Vers le périphérique)
Choisissez cette option si vous voulez que les réglages de ProVisionaire Design s’appliquent aux
périphériques.

• Bouton d’option [From Device] (Depuis le périphérique)
Choisissez cette option si vous voulez que les réglages des périphériques soient reflétés dans
ProVisionaire Design.


Le système doit avoir été préalablement configuré à l’aide de ProVisionaire Design.
En outre, vous devez utiliser le fichier de projet qui a été créé à ce moment-là.

9. État en ligne et synchronisation
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• Bouton [All On] (Tout activer)
Permet de cocher les cases [Device] pour tous les périphériques de la liste.

• Bouton [All Off] (Tout désactiver)
Permet de décocher les cases [Device] pour tous les périphériques de la liste.

• Liste des périphériques
Affiche les périphériques enregistrés dans le projet.

◦ Case à cocher [Device] (Périphérique)
Permet de cocher la case de chaque périphérique que vous souhaitez synchroniser.

• Status (État)

Indique l’état de synchronisation avec le périphérique.
Les différentes indications ont la signification suivante.

◦ Vert : « Offline » (Hors ligne)

◦ Blanc : « Lost » (Perdu)
L’état « Lost » indique que ProVisionaire Design ne trouve pas le périphérique, par exemple parce
qu’il n’est pas sous tension.

◦ Bleu : « Online » (En ligne)

◦ Jaune : « Not compatible » (Incompatible)

• Progress (Progression)
Indique la progression de la synchronisation.

• Zone « Message »
Des informations s’affichent dans cette zone si vous cliquez sur le bouton [Abort] (Abandonner) pour
arrêter le processus ou si une erreur se produit.

• Bouton [Abort] (Abandonner)
Cliquez sur ce bouton pour arrêter la synchronisation.

• Bouton [Online] (En ligne)
Cliquez sur ce bouton pour démarrer la synchronisation avec les périphériques sélectionnés.

• Bouton [Close] (Fermer)

Permet d’annuler la synchronisation et de fermer la boîte de dialogue.
Vous ne pouvez pas cliquer sur ce bouton pendant la synchronisation.

9.1.2. Procédure

1. Cliquez sur le bouton [Online] (En ligne) de la barre d’outils.
La boîte de dialogue « Synchronization » (Synchronisation) s’ouvre.

2. Choisissez [To Device] (Vers le périphérique) ou [From Device] (Depuis le périphérique) pour spécifier le

sens de la synchronisation.

Si vous choisissez [To Device]
Les réglages de ProVisionaire Design sont transmis aux périphériques. Les réglages actuels de ces

derniers sont écrasés.

Si vous choisissez [From Device]
Les réglages des périphériques sont chargés dans ProVisionaire Design.

3. Cochez les cases de tous les périphériques que vous souhaitez mettre en ligne.

4. Cliquez sur le bouton [Online] (En ligne).

La synchronisation démarre.

La progression de la synchronisation s’affiche.
Si vous cliquez sur le bouton [Abort] (Abandonner), l’opération sera interrompue. Cela peut s’avérer utile
pour gagner du temps, par exemple si vous avez remarqué une erreur pendant la synchronisation et
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souhaitez modifier un paramètre. Les réglages auront été transmis en partie. Par conséquent, une fois les

modifications apportées, assurez-vous de terminer la synchronisation.
Lorsque la synchronisation est terminée, la boîte de dialogue se ferme automatiquement.
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9.1.3. Boîte de dialogue 「Go Online– From Devices」 (Passer en ligne – Depuis les
périphériques)

Les paramètres des périphériques présents sur le réseau peuvent être appliqués au fichier de projet en cours
d’édition ou à un nouveau fichier. Si le système a été précédemment configuré à l’aide de ProVisionaire Design
mais qu’aucun fichier de projet issu de cette configuration n’est disponible, vous pouvez appliquer les

paramètres du périphérique au fichier de projet actuel.
Pour ouvrir cette boîte de dialogue, cliquez sur [Go Online - From Devices] dans le menu [File] (Fichier) de la barre
de menus.

• Bouton [All On] (Tout activer)
Permet de cocher les cases [Device] pour tous les périphériques de la liste.

• Bouton [All Off] (Tout désactiver)
Permet de décocher les cases [Device] pour tous les périphériques de la liste.

• Liste des périphériques
Affiche les périphériques enregistrés dans le projet.

◦ Case à cocher [Device] (Périphérique)
Permet de cocher la case de chaque périphérique que vous souhaitez synchroniser.

• Status (État)

Indique l’état de synchronisation avec le périphérique.
Les différentes indications ont la signification suivante.

◦ Vert : « Offline » (Hors ligne)

◦ Blanc : « Lost » (Perdu)
L’état « Lost » indique que ProVisionaire Design ne trouve pas le périphérique, par exemple parce
qu’il n’est pas sous tension.

◦ Bleu : « Online » (En ligne)

◦ Jaune : « Not compatible » (Incompatible)

• Progress (Progression)
Indique la progression de la synchronisation.

• Zone « Message »
Des informations s’affichent dans cette zone si vous cliquez sur le bouton [Abort] (Abandonner) pour
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arrêter le processus ou si une erreur se produit.

• Bouton [Abort] (Abandonner)
Cliquez sur ce bouton pour arrêter la synchronisation.

• Bouton [Online] (En ligne)
Cliquez sur ce bouton pour démarrer la synchronisation avec les périphériques sélectionnés.

• Bouton [Close] (Fermer)

Permet d’annuler la synchronisation et de fermer la boîte de dialogue.
Vous ne pouvez pas cliquer sur ce bouton pendant la synchronisation.
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9.2. État « Offline » (Hors ligne)

Pour accéder à l’état hors ligne dans ProVisionaire Design, cliquez sur le bouton [Offline] (Hors ligne) de la barre
d’outils pour accéder à la boîte de dialogue correspondante.

9.2.1. Boîte de dialogue « Offline » (Hors ligne)

• Bouton [All On] (Tout activer)
Permet de cocher les cases [Device] pour tous les périphériques de la liste.

• Bouton [All Off] (Tout désactiver)
Permet de décocher les cases [Device] pour tous les périphériques de la liste.

• Liste des périphériques
Affiche les périphériques enregistrés dans le projet.

◦ Case à cocher [Device] (Périphérique)
Cochez les cases de tous les périphériques que vous souhaitez mettre hors ligne.

◦ Status (État)

Indique l’état de synchronisation avec le périphérique.
Les différentes indications ont la signification suivante.

▪ Vert : « Offline » (Hors ligne)

▪ Blanc : « Lost » (Perdu)
L’état « Lost » indique que ProVisionaire Design ne trouve pas le périphérique, par exemple
parce qu’il n’est pas sous tension.

▪ Bleu : « Online » (En ligne)

▪ Jaune : « Not compatible » (Incompatible)

• Bouton [Offline] (Hors ligne)
Lorsque vous cliquez sur ce bouton, les périphériques sélectionnés passent hors ligne dans ProVisionaire
Design.

• Bouton [Close] (Fermer)
Permet de fermer la boîte de dialogue.
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10. Boîtes de dialogue
Ce chapitre décrit les boîtes de dialogue et les fenêtres que vous pouvez ouvrir depuis la barre de menus ou la
barre d’outils.

10.1. Boîte de dialogue de démarrage

Apparaît lorsque ProVisionaire Design démarre.

• Menu déroulant [Path] (Chemin d’accès)
Permet d’afficher et de sélectionner un fichier de projet récemment enregistré.

• Bouton […]
Permet d’afficher la boîte de dialogue « Select File » (Sélectionner un fichier). Sélectionnez le fichier de
projet à charger.

• Bouton [OK]
Charge le fichier de projet affiché dans le menu déroulant [Path].

• Bouton [New] (Nouveau)
Crée un nouveau projet.
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10.2. Boîte de dialogue « Go Online– From Devices »

Pour ouvrir cette boîte de dialogue, cliquez sur [Go Online - From Devices] dans le menu [File] (Fichier) de la barre

de menus.
Pour plus d’informations sur la boîte de dialogue « Go Online – From Devices » (Passer en ligne – Depuis les
appareils), reportez-vous au chapitre « État en ligne et synchronisation ».
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10.3. Boîte de dialogue « Protect File » (Protéger le fichier)

Pour ouvrir cette boîte de dialogue, cliquez sur [Protect File] dans le menu [File] de la barre de menus.
Dans ProVisionaire Design, vous pouvez choisir un code PIN (code secret) afin de protéger un fichier de projet.

• Case à cocher [Protect] (Protéger)
Si cette case est cochée, la boîte de dialogue « Security » (Sécurité) apparaît au démarrage du fichier de

projet.
Lorsque cette case est décochée, tous les utilisateurs peuvent ouvrir le fichier de projet.

• [PIN Code] (Code PIN)
Si la case [Protect] est cochée, entrez le code PIN (code secret). (Le code doit être composé de six
caractères alphanumériques choisis parmi les chiffres 0 à 9 et les lettres a, b, c, d, e et f. Il n’est pas
sensible à la casse.)

 Si vous oubliez le code PIN, vous ne pourrez pas ouvrir le fichier de projet correspondant.

• Bouton [OK]
Met à jour les réglages et ferme la boîte de dialogue.

• Bouton [Cancel] (Annuler)
Ferme la boîte de dialogue sans mettre à jour les réglages.
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10.4. Boîte de dialogue « Project Information » (Informations du projet)

Pour ouvrir cette boîte de dialogue, cliquez sur [Project Information] dans le menu [File] de la barre de menus.
Permet d’inclure un mémo dans le fichier de projet afin de consigner des informations sur la propriété du fichier
ou des coordonnées de contact.
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10.5. Boîte de dialogue « Print » (Imprimer)

Pour ouvrir cette boîte de dialogue, cliquez sur [Print] dans le menu [File] de la barre de menus.
Cette boîte de dialogue vous permet d’effectuer des réglages liés à l’impression, de spécifier le format de la
feuille de papier et d’afficher un aperçu de l’impression.

• Bouton [Print]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Print ».

• Printer (Imprimante)

◦ Liste déroulante [Name] (Nom)
Permet de choisir l’imprimante à utiliser.

• Paper (Papier)

◦ Liste déroulante [Size] (Format)
Permet de choisir la taille du papier. Si l’élément [Print Area] (Zone d’impression) est coché dans le
menu [View] (Affichage), ce réglage correspond au format de papier affiché sur la feuille de
conception.

◦ Cases d’option [Portrait]/[Landscape] (Paysage)
Permet de choisir l’orientation du papier. L’orientation affichée sur la feuille de conception
correspond à ce réglage.

• Margins (Marges)

◦ Cases d’option [mm]/[Inch] (Pouce)
Permettent de choisir l’unité de mesure utilisée pour les marges supérieure, inférieure, gauche et
droite.

◦ Zones de texte [Top] (Haut)/[Bottom] (Bas)/[Left] (Gauche)/[Right] (Droite)
Permettent de définir la taille des marges supérieure, inférieure, gauche et droite.
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• Color (Couleur)

◦ Cases d’option [Color]/[Gray Scale] (Niveaux de gris)
Permettent de choisir si l’impression est effectuée en couleurs ou en niveaux de gris.

• Print Zoom (Zoom d’impression)

◦ Cases d’option [None] (Aucun)/[Fit on one page] (Ajuster sur une page)
Permettent de choisir si le contenu à imprimer doit correspondre à la zone affichée sur la feuille de
conception ou si la taille de la feuille tout entière doit être réduite pour tenir sur une seule page.

• Zone d’aperçu
Affiche un aperçu avant impression.
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10.6. Boîte de dialogue « File Storage » (Stockage des fichiers)

Pour ouvrir cette boîte de dialogue, cliquez sur [File Storage] dans le menu [File] de la barre de menus. Vous

pouvez enregistrer le fichier de projet dans l’unité DME7 depuis ProVisionaire Design.
Vous ne pouvez enregistrer qu’un seul fichier de projet sur chaque unité DME7.

Toutes les unités DME7 détectées par ProVisionaire Design sont répertoriées.

• Case à cocher [Store] (Stocker)
Permet de sélectionner une unité DME7 sur laquelle vous souhaitez enregistrer le fichier de projet. Vous

pouvez choisir plusieurs unités DME7.
Si vous exécutez la commande « Save » (Enregistrer), « Save As » (Enregistrer sous) ou « Save with Style »
(Enregistrer avec le style) alors que ProVisionaire Design et les appareils sont en ligne, le fichier de projet
sera automatiquement transféré et enregistré non seulement dans l’ordinateur, mais aussi dans les unités
DME7 actuellement sélectionnées.

 Veuillez noter que les fichiers actuellement stockés sur ces appareils seront écrasés.

• Unit ID / Model / Device Name

Ces colonnes indiquent l’ID de l’unité, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de la feuille
« Project ».

• Stored File (Fichier stocké)

Si un fichier est stocké sur cet appareil, ce champ indique le nom du fichier.
Si aucun fichier n’est stocké sur l’appareil, ce champ est vide. Si aucun appareil n’est détecté, ce champ
affiche « ----- ».

• Date
Si un fichier est déjà stocké sur l’appareil, ce champ indique la date et l’heure de la dernière mise à jour du

fichier.
Si aucun fichier n’est stocké sur l’appareil, ce champ est vide. Si aucun appareil n’est détecté, ce champ
affiche « ----- ».

• Total Size/Size (Taille totale/Taille)
Dans le cas d’un appareil, ce champ indique la taille de la destination de l’enregistrement. Dans le cas d’un

fichier, ce champ indique la taille du fichier.
Si aucun appareil n’est détecté, ce champ affiche « ----- ».

• Free Space (Espace libre)
Ce champ s’applique uniquement à l’appareil. Il indique l’espace disponible au niveau de la destination de

l’enregistrement.
Si aucun appareil n’est détecté, ce champ affiche « ----- ».

• Bouton [File Manager] (Gestionnaire de fichiers)
Cliquez sur ce bouton pour ouvrir la boîte de dialogue [File Manager].
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10.6.1. Boîte de dialogue [File Manager]

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton [File Manager] dans la boîte de dialogue [File Storage].

Vous pouvez enregistrer n’importe quel fichier de projet sur le DME7.
Vous pouvez choisir n’importe quelle unité DME7 détectée par ProVisionaire Design sur le réseau comme
emplacement de sauvegarde du fichier.

• Case à cocher [Store]
Permet de sélectionner les emplacements de sauvegarde lors de l’exécution de la commande « Store
Now ». Vous pouvez sélectionner plusieurs emplacements.

• Status (État)
Indique l’état d’avancement de la sauvegarde lors de l’exécution de la commande « Store Now ».

• Bouton [Store Now] (Stocker maintenant)
Permet de transférer le fichier de projet vers les appareils cochés.

• Bouton [Download Files] (Télécharger les fichiers)
Permet de télécharger le fichier depuis l’appareil coché.

• Bouton [Clear] (Supprimer)
Permet de supprimer un fichier stocké sur l’appareil coché.
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10.7. Boîte de dialogue « Network Setup » (Configuration réseau)

Pour ouvrir cette boîte de dialogue, cliquez sur [Network Setup] dans le menu [System] de la barre de menus.
Vous pouvez y sélectionner la carte d’interface réseau (ci-après appelée « carte réseau ») de l’ordinateur utilisée

pour communiquer avec les appareils.
Vous pouvez également modifier l’adresse IP de la carte réseau.



Si vous n’utilisez pas de serveur DHCP, corrigez l’adresse IP de la carte réseau de votre

ordinateur. Nous vous recommandons les réglages suivants :

Adresse IP : 192.168.0.253
Masque de sous-réseau : 255.255.255.0

Si l’ordinateur n’est pas connecté au réseau, cliquez sur le bouton [Cancel] pour fermer la boîte de dialogue.

• Network Card Name (Nom de la carte réseau)
Affiche le nom de la carte réseau.

• Status
Affiche l’état de la carte réseau : Up (Active) ou Down (Inactive)

• IP Address (Adresse IP) et Subnet Mask (Masque de sous réseau)

Affiche l’adresse IP et le masque de sous-réseau affectés à la carte réseau.
Sélectionnez une carte réseau du même sous-réseau que les appareils.

• Bouton [Open Network Connections] (Ouvrir les connexions réseau)
Permet d’ouvrir le panneau de commande « Network Connections » (Connexions réseau). Utilisez ce
panneau pour modifier l’adresse IP de la carte réseau.

• Bouton [OK]
Met à jour les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Ferme la boîte de dialogue sans mettre à jour les réglages.
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10.8. Boîte de dialogue « IP Settings » (Réglages IP)

Pour ouvrir cette boîte de dialogue, cliquez sur [IP Settings] dans le menu [System] de la barre de menus.
Cette boîte de dialogue répertorie les appareils présents sur le réseau, ce qui vous permet de modifier leur
adresse IP.

• Network Interface (Interface réseau)
Affiche le nom/l’adresse IP/le masque de sous-réseau de la carte réseau actuellement sélectionnée dans
la boîte de dialogue « Network Setup ».

• Bouton [Refresh]
Effectue une nouvelle recherche des appareils présents sur le réseau.

• Liste des appareils

◦ Bouton Identify
Lorsque vous appuyez sur ce bouton situé à gauche de la colonne Unit ID, les voyants de l’appareil
correspondant clignotent pendant plusieurs secondes.

◦ Unit ID / Model / Device Name
Ces colonnes indiquent l’ID d’unité de l’appareil, le nom du modèle et le nom de l’appareil. S’il y a un

conflit entre les ID d’unité, une icône  s’affiche.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

◦ Control Port (Port de contrôle)
Indique le nom du port s’il y a plusieurs ports de contrôle.

◦ IP Settings
Indique le type de réglage de l’IP.

◦ IP Address/MAC Address (Adresse MAC)/Subnet Mask/Default Gateway (Passerelle par défaut)
Indique l’adresse IP, l’adresse MAC, le masque de sous-réseau et la passerelle par défaut de
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l’appareil.

• Bouton [Set IP Address] (Configurer l’adresse IP)
Permet d’ouvrir la boîte de dialogue « IP Address » (Adresse IP).

• Bouton [Close]
Ferme la boîte de dialogue.
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10.9. Boîte de dialogue « IP Address » (Adresse IP)

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton [Set IP Address] (Configurer l’adresse IP) dans la boîte

de dialogue [IP Settings].
Vous pouvez configurer ici l’adresse IP de l’appareil. Définissez-la de sorte qu’il n’y ait pas de conflit entre les
appareils.

 Ces changements ne sont pas possibles si l’appareil est en ligne.

Pour pouvoir utiliser ProVisionaire Design pour contrôler des appareils de sous-réseau différents, il est
nécessaire d’utiliser ces derniers à l’aide d’adresses IP fixes. Pour plus de détails, reportez-vous à la section
« Réglages pour la commande d’appareils sur plusieurs sous-réseaux ».

■ Pour le DME7
Vous pouvez configurer les paramètres dans les trois onglets suivants : DME Control Port (Port de contrôle
DME), Device Control Port (Port de contrôle des appareils) et Dante Slot (Emplacement Dante).

● Onglets DME Control Port et Device Control Port

• Case d’option [Unit ID] (onglet DME Control Port uniquement)

Attribue automatiquement l’adresse IP en fonction de l’ID d’unité de l’appareil.
Cette option définit l’adresse IP sur 192.168.0 et le masque de sous-réseau sur 255.255.255.0.

• Case d’option [DHCP]
Cliquez sur ce bouton pour configurer automatiquement l’adresse IP, le masque de sous-réseau, la

passerelle par défaut et le serveur DNS à partir du serveur DHCP.
S’il n’y a pas de serveur DHCP, les paramètres du « DME Control Port » (Port de contrôle DME) ne sont pas
définis. Dans le cas du « Device Control Port », l’adresse de lien local est automatiquement définie.
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• Case d’option [Static IP] (Adresse IP statique)
Attribue une adresse IP fixe à l’appareil.

• Zone de texte [Default Gateway]
Attribue l’adresse IP de la passerelle par défaut.

• DNS Server (Serveur DNS)
Saisissez l’adresse du serveur DNS.

◦ Case à cocher [Obtain Default Gateway and DNS Server address automatically] (Obtenir l’adresse

de la passerelle par défaut et du serveur DNS automatiquement)
Si cette case est cochée, l’adresse IP de la passerelle par défaut sera automatiquement affectée.
Le réglage de l’adresse IP pour la passerelle par défaut effectué ci-dessus est ignoré.

◦ Bouton [Apply to all the devices] (Appliquer à tous les appareils)
La configuration de la passerelle par défaut et du serveur DNS est appliquée aux unités DME7.


Lors des réglages, gardez à l’esprit que le réseau du port de contrôle DME et le réseau du port
de contrôle des appareils ne doivent pas se chevaucher (conflit).

● Onglet Dante Slot (Emplacement Dante)


Utilisez Dante Controller pour définir l’adresse IP du port Dante.
Lorsque vous configurez cette adresse IP, si vous sélectionnez « Manually Set IP Address »
(Configurer l’adresse IP manuellement), assurez-vous que l’emplacement Dante est situé sur
le même réseau.
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■ Pour le Rio3224-D2 / Rio1608-D2

■ Pour le Tio1608-D / Tio1608-D2
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■ Pour le RSio64-D

■ Pour la série PC
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■ Pour la série XMV


Si vous ne connaissez pas l’adresse réseau de l’unité, nous vous recommandons d’utiliser le
commutateur DIP pour configurer l’adresse IP sur [UNIT ID].

■ Pour la série MTX/PGM1/EXi8/EXo8


Si vous ne connaissez pas l’adresse réseau de l’unité, nous vous recommandons d’utiliser le
commutateur DIP pour configurer l’adresse IP sur [UNIT ID].
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■ Pour le RM-CG/RM-TT

■ Pour le VXL1-16P
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10.10. Boîte de dialogue « Auto-Assign IP Addresses » (Affecter
automatiquement les adresses IP)

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton [Auto-Assign IP Addresses] (Affecter automatiquement

les adresses IP) dans la boîte de dialogue [IP Address] (Adresse IP).
Les paramètres, tels que l’adresse IP attribuée aux appareils virtuels dans la boîte de dialogue « Match Devices
by IP Address » (Faire correspondre les appareils par adresse IP), sont appliqués à la boîte de dialogue « IP

Settings » en une seule opération.
Pour plus de détails, reportez-vous à la section « Réglages pour la commande d’appareils sur plusieurs sous-
réseaux ».

• Liste des appareils
Affiche les appareils et les réglages IP à affecter.

• DNS Server (PGM1 uniquement)
Par défaut, ce champ est vide. Saisissez l’adresse du serveur DNS.

• Bouton [Assign IP Addresses] (Affecter les adresses IP)
Permet d’appliquer les informations affichées dans la liste des appareils à la boîte de dialogue « IP
Address ». Même si la case d’option [DHCP] est sélectionnée dans la boîte de dialogue « IP Address », la
case d’option [Static IP] (IP statique) est activée.

• Bouton [Close]
Ferme la boîte de dialogue.
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10.11. Boîte de dialogue « Match Devices by IP Address »

Lorsque vous affectez une adresse IP à un appareil virtuel dans cette boîte de dialogue, ProVisionaire Design

recherche des appareils sur le réseau par adresse IP.
Si vous souhaitez contrôler un système qui se trouve sur un sous-réseau différent de ProVisionaire Design,

effectuez vos réglages dans cette boîte de dialogue.

Pour ce faire, reportez-vous à la section « Réglages pour la commande d’appareils sur plusieurs sous-réseaux ».
La communication audio Dante n’est pas possible entre des appareils qui sont sur différents sous-réseaux.

Définissez les adresses IP de manière à ce qu’elles soient uniques pour l’ensemble du chemin de
communication. Si des appareils portant la même adresse IP existent sur le chemin de communication, il est
possible qu’ils ne puissent pas être distingués.
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• IP Address Range Finder (Localisateur de plage d’adresses IP)
Cette section vous permet de calculer la plage des adresses IP pouvant être affectées.

◦ [IP Address]
Entrez l’adresse IP que vous souhaitez utiliser.

◦ [Subnet Mask]
Sélectionnez le masque de sous-réseau.

◦ Bouton [Find Range] (Rechercher la plage)
Lorsque vous cliquez sur ce bouton, la plage qui peut être configurée est calculée à partir de
l’adresse IP et du masque de sous-réseau que vous avez saisis.

◦ [Range]
Affiche la plage d’adresses IP calculée.

◦ [Default Gateway]
Affiche la passerelle par défaut calculée.

• Bouton [Apply IP Address] (Appliquer l’adresse IP)
Lorsque vous cliquez sur ce bouton, l’adresse IP calculée dans « IP Address Range Finder » et la
passerelle par défaut s’appliquent aux appareils répertoriés dans la liste des appareils.

• Bouton [All On] (Tout activer)
Sélectionne tous les appareils de la liste auxquels appliquer l’adresse IP via le bouton [Apply IP Address].

• Bouton [All Off] (Tout désactiver)
Permet de désélectionner tous les appareils de la liste pour qu’ils ne soient pas affectés par le bouton
[Apply IP Address].

• Bouton [All Clear] (Tout supprimer)
Supprime les informations d’adresse IP des appareils.

• Liste des appareils
Cette liste vous permet d’afficher et de modifier les réglages des appareils présents dans la liste.

◦ Case à cocher
Lorsque cette case est cochée, la fonction [Apply IP Address] s’appliquera à cet appareil.
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◦ [IP Address]/[Subnet Mask]/[Default Gateway]
Ces options vous permettent d’afficher et de modifier l’adresse IP, le masque de sous-réseau et la
passerelle par défaut de l’appareil.

• Bouton [OK]
Applique les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Annule les réglages et ferme la boîte de dialogue.
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10.12. Boîte de dialogue « Device Information » (Informations sur
l’appareil)

Pour ouvrir cette boîte de dialogue, cliquez sur [Device Information] dans le menu [System] de la barre de menus.
Cette fenêtre répertorie les informations relatives aux appareils présents sur le réseau, ce qui vous permet de
mettre à jour leurs microprogrammes ou de les redémarrer.

• Network Interface
Affiche le nom/l’adresse IP/le masque de sous-réseau de la carte réseau actuellement sélectionnée dans
la boîte de dialogue « Network Setup ».

• Bouton [Refresh]

Effectue une nouvelle recherche des appareils présents sur le réseau.
Vous ne pouvez pas cliquer sur ce bouton tandis qu’une mise à jour est en cours.

• Bouton [Detail>>] (Détail)
Cliquez sur ce bouton pour afficher à droite les informations détaillées de l’appareil sélectionné dans la
liste des appareils.

• Liste des appareils

◦ Bouton Identify
Lorsque vous appuyez sur ce bouton situé à gauche de la colonne « Unit ID », les voyants de
l’appareil correspondant clignotent pendant plusieurs secondes.

◦ Unit ID / Model / Device Name
Ces colonnes indiquent l’ID d’unité de l’appareil, le nom du modèle et le nom de l’appareil. S’il y a un

conflit entre les ID d’unité, une icône  s’affiche.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».


Si différents types d’appareils sont utilisés, ils peuvent porter le même ID d’unité
Cependant, si l’unité de la série MTX est paramétrée en mode Unit ID, l’adresse

IP sera automatiquement définie sur 192.168.0.< Unit ID >.
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Dans ce cas, vous devez définir des ID d’unité uniques afin qu’il n’y ait pas de
conflit d’adresse entre tous les appareils.

◦ MAC Address
Affiche l’adresse MAC de l’appareil.

◦ Serial No. (N° de série)
Affiche le numéro de série de l’appareil.

◦ Version
Affiche la version du microprogramme.

◦ Status

Affiche l’état en ligne ou hors ligne.
Lors de la mise à jour d’un appareil, l’état d’avancement est affiché.

◦ Battery (Batterie) (unités des séries MTX et XMV uniquement)
Indique la capacité restante de la batterie de l’appareil.

EMPTY (Vide) L’autonomie restante est comprise entre
0 et 0,5 V. Cessez immédiatement d’utiliser
l’appareil et contactez un centre technique
Yamaha.

LOW (Faible) L’autonomie restante est comprise entre
0,5 et 2,5 V. Contactez au plus vite un centre
technique Yamaha.

OK L’autonomie restante est comprise entre
2,5 et 3,5 V. Il n’y a pas de problème.

N/A Il n’y a pas de batterie interne.

• Bouton [Update Firmware] (Mettre à jour le microprogramme)

Met à jour le microprogramme. Veuillez noter que vous ne pouvez le faire que pour les appareils en ligne.
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Update Firmware » (Mettre à jour le
microprogramme).

• Bouton [Initialize] (Initialiser)

Initialise l’appareil.
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Initialize » (Initialiser).

• Bouton [Reboot] (Redémarrer)
Redémarre l’appareil.

• Bouton [Close]

Ferme la boîte de dialogue.
Vous ne pouvez pas cliquer sur ce bouton tandis qu’une mise à jour est en cours.
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10.12.1. Zone « Detail>> »

Cette zone affiche des informations spécifiques à l’appareil cible.

■ Pour le DME7
Cette zone affiche les informations relatives aux appareils pour chaque licence d’appareil activée.

• Title (Titre)
Indique le nom de la licence.

• Purchase Type (Type d’achat)
Indique si la licence est « Buyout » (Achetée) ou « Trial » (À l’essai).

• Activate Type (Type d’activation)
Ces informations apparaissent uniquement si le type d’achat est « Buyout ».

◦ Temporary (Temporaire)
Ce type vous permet d’activer et de désactiver la licence.

◦ Permanent
Ce type vous empêche de désactiver la licence.

◦ Timed (Limité dans le temps)
Ce type indique que la licence dispose d’une date d’expiration.

◦ Activate Date/Time (Date/heure d’activation)
Indique la date et l’heure à laquelle vous avez activé la licence.

• Expiry Date/Time (Date/heure d’expiration
Si le type d’achat est « Trial » ou si le type d’activation est « Timed », ce champ indique la date et l’heure

d’expiration de la licence.
Sinon, il affiche « --- ».

Pour plus d’informations au sujet de la gestion des licences, consultez le document « Device License Activation
Guide » (Guide d’activation des licences des appareils).
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10.13. Boîte de dialogue « Update Firmware » (Mettre à jour le
microprogramme)

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton [Update Firmware] dans la boîte de dialogue [Device

Information].

Cette boîte de dialogue permet de mettre à jour le microprogramme d’une unité prise en charge.
Pour plus de détails sur la mise à jour du microprogramme Dante, reportez-vous au « Guide de mise à jour du
microprogramme Dante ».


Le DME7 met à jour le microprogramme Dante en même temps que le microprogramme de
l’unité.

• Files (Fichiers)
Affiche le fichier de mise à jour (.fupd) actuellement sélectionné.

• Bouton […]
Cliquez sur ce bouton pour sélectionner un fichier de mise à jour. Cliquez sur ce bouton pour ouvrir la
boîte de dialogue « Select Folder » (Sélectionner un dossier), puis sélectionnez un fichier .fupd.


Lors de l’installation de ProVisionaire Design, le fichier .fupd inclus dans le fichier compressé
est également copié dans le dossier Program Files (x86). Ce fichier est automatiquement
sélectionné à l’ouverture de la boîte de dialogue.

• Firmware in this file (Microprogramme contenu dans ce fichier)
Affiche le contenu du fichier de mise à jour.

• Detected Devices (Appareils détectés)
Affiche les appareils détectés.

◦ Cases à cocher
Permettent de sélectionner un appareil à mettre à jour.
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◦ Unit ID
Indique l’ID d’unité de l’appareil.

◦ Type
Indique le nom du modèle de l’appareil.

◦ Version
Affiche la version du microprogramme de l’appareil.


Pour contrôler le PGM1 depuis ProVisionaire Design, vous devez d’abord installer
Bonjour Print Services (Windows).

• Bouton [Update]

Exécute la mise à jour.
Si aucun fichier n’est sélectionné, ce bouton n’est pas disponible et il est impossible de cliquer dessus.

• Bouton [Cancel]
Ferme la boîte de dialogue sans faire de mise à jour.



Un message d’alerte apparaît en cas de détection d’un appareil incompatible avec

ProVisionaire Design.
Pour plus d’informations sur la compatibilité entre ProVisionaire Design et différents
appareils, consultez le site Web de Yamaha Pro Audio.

https://www.yamahaproaudio.com/


Vous devez être connecté pour mettre à jour la série RM.
Reportez-vous au chapitre consacré à RM-CG/RM-TT.
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10.14. Boîte de dialogue « Initialize » (Initialiser)

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton [Initialize] dans la boîte de dialogue [Device

Information]. Cette boîte de dialogue vous permet d’initialiser les réglages de l’appareil.

Les produits concernés sont ceux des séries PC, DME7, RM-CG et RM-TT.
Sélectionnez l’onglet du produit que vous souhaitez initialiser.

■ Pour la série PC

• Cases à cocher
Cochez les éléments que vous souhaitez initialiser.

◦ IP Settings
Si cet élément est coché, les réglages IP de l’appareil seront également initialisés.

◦ Unit ID, Device Name
Si cet élément est coché, l’ID d’unité et le nom de l’appareil seront également initialisés.

◦ Dante Settings
Si cet élément est coché, les paramètres de l’appareil liés à Dante seront également initialisés.

• Bouton [All On]
Permet de cocher tous les appareils.

• Bouton [All Off]
Permet de décocher tous les appareils.

• Case à cocher
Cochez l’appareil que vous souhaitez initialiser.

◦ Unit ID / Model / Device Name

Ces colonnes indiquent l’ID d’unité, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

• Bouton [All Model On] (Tous les modèles activés)
Permet de cocher tous les appareils dans tous les onglets.

• Bouton [All Model Off] (Tous les modèles désactivés)
Permet de décocher tous les appareils dans tous les onglets.
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• Bouton [Initialize]
Permet de lancer l’initialisation.


Les réglages Unit ID et Device Name de l’appareil Dante ne seront pas initialisés si le réglage
« Dante Device Lock » (Verrouillage de l’appareil Dante) est sélectionné.

• Bouton [Cancel]
Ferme la boîte de dialogue sans faire de mise à jour.

■ Pour le DME7

• Cases à cocher
Cochez les éléments que vous souhaitez initialiser.

◦ IP Settings
Si cet élément est coché, les réglages IP de l’appareil seront également initialisés.

◦ Unit ID, Device Name
Si cet élément est coché, l’ID d’unité et le nom de l’appareil seront également initialisés.

◦ Dante Settings
Si cet élément est coché, les paramètres de l’appareil liés à Dante seront également initialisés.

◦ Stored Files
Si cet élément est coché, les fichiers enregistrés sur l’unité à l’aide de la fonction « File Storage »
sont également initialisés.

 L’initialisation de l’appareil n’affecte pas les licences activées.
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■ Pour RM-CG et RM-TT

• Cases à cocher
Cochez les éléments que vous souhaitez initialiser.

◦ Restore all defaults (Restaurer toutes les valeurs par défaut)
Si vous cochez cette case, tous les éléments seront réinitialisés. Les éléments « Network Settings »
(Réglages réseau) sont également initialisés automatiquement.

◦ Network Settings
Si cet élément est coché, les paramètres réseau de l’appareil sont également initialisés.


Vous devez être connecté pour initialiser la série RM.
Reportez-vous au chapitre consacré à RM-CG/RM-TT.
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10.15. Boîte de dialogue « Word Clock » (Horloge de mots)

Pour ouvrir cette boîte de dialogue, cliquez sur [Word Clock] dans le menu [System] de la barre de menus. Cette

boîte de dialogue vous permet de modifier les réglages de l’horloge de mots de l’appareil.
Les modèles concernés sont ceux des séries MTX, XMV (à l’exception des modèles Dante) et DME7 qui ont été
ajoutés au projet.

• Liste des appareils
Cette liste répertorie les appareils dont l’horloge de mots peut être modifiée. Cliquez sur l’appareil dont
vous souhaitez modifier les réglages détaillés de l’horloge de mots ; l’écran de modification apparaît.
L’icône à gauche de UNIT ID indique la source de l’horloge de mots.

Icône Source de l’horloge

Dante

Interne

Carte Mini-YGDAI

Aucune YDIF

• Word Clock Fs (Fréquence d’échantillonnage de l’horloge de mots)
Indique l’horloge de mots de l’appareil. Dans l’état en ligne, indique la valeur de l’horloge de mots de
l’appareil. Lorsque l’appareil est hors ligne, ce champ affiche « ---. »

• Clock Source (Source de l’horloge)
Utilisez ces boutons pour sélectionner la source de l’horloge de mots. Un voyant indiquant l’état s’affiche
à gauche des boutons de sélection. L’état ne peut pas être détecté en étant hors ligne ; tous les voyants
sont donc jaunes.

◦ Pour le MTX3, XMV
Vous pouvez sélectionner une des horloges internes (44,1 kHz, 48 kHz) ou le YDIF.

◦ Pour le MRX7-D/MTX5-D
Vous pouvez sélectionner une carte Dante, YDIF ou Mini-YGDAI.

◦ Pour le DME7
Vous pouvez uniquement sélectionner Dante.
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Voyant État

 Unlock (Déverrouillé) Déverrouillé.

 Lock (Verrouillé) Verrouillé.

 Lock, but not sync’ed
(Verrouillé, mais non
synchronisé)

Verrouillé, mais non synchronisé.

 Unknown (Inconnu) Le statut de l’horloge ne peut pas être détecté
car un appareil externe n’est pas connecté ou
parce qu’il n’y a pas d’entrée d’horloge valide.
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10.16. Boîte de dialogue « Protect Devices » (Protéger les appareils)

Pour ouvrir cette boîte de dialogue, cliquez sur [Protect Devices] dans le menu [System] de la barre de menus.
Vous pouvez spécifier un code PIN administrateur pour l’appareil afin d’empêcher toute personne autre que
l’administrateur de modifier les réglages de l’appareil. Si vous définissez un code PIN administrateur, vous
devrez le saisir lorsque vous souhaiterez établir une connexion en ligne entre l’appareil et ProVisionaire Design
ou configurer divers réglages de l’appareil. Veuillez noter que si vous oubliez le code PIN administrateur, vous ne
pourrez pas modifier les réglages de l’appareil.

• Liste des appareils
Cette zone répertorie les appareils pour lesquels la protection via le code PIN administrateur a été
annulée ou pour lesquels aucun code PIN administrateur n’a encore été défini.

◦ Unit ID / Model / Device Name

Ces colonnes indiquent l’ID d’unité, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

◦ Administrator PIN (Code PIN administrateur)
Ce champ indique le code PIN administrateur pour les appareils déjà déverrouillés par code PIN.

• Zone de texte [Administrator PIN]
Dans ce champ, saisissez le code PIN administrateur de l’appareil. (Le code doit être composé de six
caractères alphanumériques choisis parmi les chiffres 0 à 9 et les lettres a, b, c, d, e et f. Il n’est pas
sensible à la casse. Il est impossible d’entrer un code PIN vide.)

• Case d’option [Protect device with Administrator PIN.] (Protéger l’appareil avec un code PIN

administrateur)
Si vous tentez de modifier les réglages de l’appareil, vous devrez saisir le code PIN.

• Case d’option [No PIN required to change device settings.] (Pas de code PIN requis pour modifier les

réglages de l’appareil)
Permet d’annuler la protection de l’appareil par code PIN administrateur.

• Bouton [OK]
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Permet d’appliquer les réglages de protection de l’appareil.

• Bouton [Cancel]
Annule les réglages et ferme la boîte de dialogue.
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10.17. Boîte de dialogue « Clock » (Horloge)

Pour ouvrir cette boîte de dialogue, cliquez sur [Clock] dans le menu [System] de la barre de menus.
À chaque mise en ligne des appareils, les horloges internes de chaque appareil connecté sont automatiquement

mises à jour en fonction de la date et de l’heure de l’ordinateur.
Si vous transmettez la date et l’heure de l’ordinateur à partir de cette boîte de dialogue, la date et l’heure seront
mises à jour sur toute unité connectée au même réseau, qu’elle soit en ligne ou hors ligne.

10.17.1. Série RM

Cette section concerne les réglages des unités de la série RM.

• Liste des appareils
Affiche les réglages actuels des appareils.

• [Time Zone] (Fuseau horaire)
Indique le fuseau horaire.

• Case à cocher [NTP Support] (Prise en charge du NTP)
Si cette case est cochée, le serveur NTP est utilisé.

• Case à cocher [Enable Daylight Saving Time] (Activer l’heure d’été)
Si cette case est cochée, l’heure d’été sera indiquée.
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10.17.2. Séries autres que RM

Cette section concerne les réglages des unités qui ne font pas partie de la série RM.

• Liste des appareils
Affiche les réglages actuels des appareils.

Les réglages sont envoyés lors de la mise en ligne de ProVisionaire Design et de l’appareil.

• [Time Zone]
Définit le fuseau horaire. Le fuseau horaire de l’ordinateur est défini par défaut.

• [Time] (Heure)
Affiche la date et l’heure en fonction du fuseau horaire.

• Case d’option [Synchronize with an Internet time server] (Synchroniser avec un serveur temporel

Internet)
Obtient les informations relatives à l’heure auprès du serveur temporel spécifié et met à jour l’horloge

interne de l’appareil.
[Time] est envoyé aux appareils qui ne prennent pas en charge de serveur temporel.

◦ [Host name] (Nom d’hôte)
Définit le nom d’hôte du serveur temporel.

◦ [IP Address]
Définit l’adresse IP du serveur temporel.
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• Si vous envisagez de définir un serveur temporel externe, configurez une connexion Internet et
indiquez des valeurs adaptées à l’environnement de connexion dans les champs [DNS server

address] (Adresse du serveur DNS) et [Default gateway] de la boîte de dialogue IP Address.
Si vous entrez un serveur externe, assurez-vous que ce serveur soit fiable. Si le serveur indiqué n’est
pas fiable, votre appareil sera exposé à certains risques, tels qu’une infection par un virus
informatique.

• Lors de l’utilisation de ProVisionaire Edge, nous vous recommandons de désactiver l’option
« Synchronize with an Internet time server ». Si elle est activée, l’heure correcte risque de ne pas
s’afficher.

• Bouton [Update Now]
Cliquez pour mettre à jour les réglages de l’appareil simultanément.

• Bouton [Close]
Ferme la boîte de dialogue.
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10.18. Boîte de dialogue « Daylight Saving Time » (Heure d’été)

Pour ouvrir cette boîte de dialogue, cliquez sur [Daylight Saving Time] dans le menu [System] de la barre de

menus.
Cette boîte de dialogue permet de configurer l’heure d’été pour tous les appareils connectés au même réseau,
quel que soit leur état (en ligne ou hors ligne).

L’appareil cible est la série DME7/MTX.


Pour les unités de la série RM, utilisez la boîte de dialogue « Clock » ) pour effectuer les
réglages.

• Liste des appareils
Affiche l’état actuel des appareils.

• Case à cocher [Enable Daylight Saving Time]
Si cette case est cochée, l’heure d’été sera activée.


Si la case « Automatically adjust daylight saving time » (Régler automatiquement
l’heure d’été) est cochée dans les paramètres « Date and Time » de l’ordinateur, vous
devez également cocher [Enable Daylight Saving Time] dans la boîte de dialogue
« Daylight Saving Time ».

◦ Offset (Décalage)
Indique le décalage horaire entre l’heure d’été et l’heure d’hiver.

◦ Start Time (Heure de début)

Permet d’indiquer l’heure du passage à l’heure d’été.
Par exemple, si vous réglez « Offset » sur « 01:00 » et « Start time » sur « 12:00 », l’horloge indiquera
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13 h 00 à partir de 12 h 00 le jour du passage à l’heure d’été.

◦ End Time (Heure de fin)
Permet d’indiquer l’heure du retour à l’heure d’hiver. Si l’heure de fin est identique à l’heure de

début, cochez l’option [Same as Start Time] (Identique à l’heure de début).
Par exemple, si vous réglez « Offset » sur « 01:00 » et « End time » sur « 12:00 », l’horloge indiquera
11 h 00 à partir de 12 h 00 le jour du retour à l’heure d’hiver. Si la case [Same as Start time] est
cochée, l’heure reviendra automatiquement à l’heure d’hiver le dernier jour de l’heure d’été à l’heure
indiquée dans [Start Time].

• Day of the Week (Jour de la semaine)
Si cette fonction est activée, le jour du passage à l’heure d’été sera indiqué en tant que jour de la semaine.
Utilisez « Start » (Début) et « End » (Fin) pour indiquer quel jour de quelle semaine commence et termine la
période de l’heure d’été. Par exemple, pour indiquer le premier dimanche d’avril, sélectionnez « First »
(Premier), « Sunday » (Dimanche) et « April » (avril) ; pour indiquer le dernier dimanche d’octobre,
sélectionnez « Last » (Dernier), « Sunday » et « October » (Octobre).

• Day (Jour)
Si cette fonction est activée, le jour du passage à l’heure d’été sera indiqué en tant que jour dans le mois.
Utilisez « Start » et « End » pour indiquer la date à laquelle commence et termine la période de l’heure
d’été.

• Bouton [Update Now]
Lorsque vous cliquez sur ce bouton, l’horloge interne de l’appareil est mise à jour en fonction des
réglages.

• Bouton [Close]
Ferme la boîte de dialogue.


Les événements planifiés dans les deux heures précédant ou suivant le début ou la fin de
l’heure d’été via la boîte de dialogue « Scheduler » ne s’exécuteront pas correctement.
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10.19. Boîte de dialogue « GPI Calibration » (Calibrage du GPI)

Pour ouvrir cette boîte de dialogue, cliquez sur [GPI Calibration] dans le menu [System] (Système) de la barre de

menus.
Cette boîte de dialogue permet de calibrer la plage de détection de la tension d’entrée pour le connecteur [GPI]
de l’appareil. Disponible uniquement lorsque vous êtes en ligne. Ces réglages permettent d’ajuster la plage de
détection afin de stabiliser la tension d’entrée du connecteur [GPI].

• [Device:]
Permet de sélectionner un appareil à calibrer.

• Case à cocher [All Ports] (Tous les ports)
Permet de cocher tous les canaux.

• Cases à cocher [Ch]
Le calibrage s’applique aux canaux cochés.

• Calibration data (Données de calibrage)
La tension d’entrée s’affiche en temps réel sous forme de graphique.
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• Bouton [Reset]
Le calibrage est réinitialisé pour les canaux cochés.

• Bouton [Max]

Permet de calibrer la tension d’entrée actuelle des canaux sélectionnés sur la valeur maximale.
La valeur maximale configurée est indiquée par l’icône .

• Bouton [Min]

Permet de calibrer la tension d’entrée actuelle des canaux sélectionnés sur la valeur minimale.
La valeur minimale configurée est indiquée par l’icône .

Procédure de calibrage

1. Connectez votre appareil externe au connecteur [GPI] du DME7/MTX.

2. Cochez les numéros des canaux pour lesquels vous souhaitez effectuer le calibrage.
Si vous voulez sélectionner tous les canaux, cochez [All Ports] (Tous les ports).

3. Pour configurer la plage de détection, augmentez le niveau d’entrée de l’appareil externe au maximum
et cliquez sur le bouton [Max]. Diminuez ensuite le niveau d’entrée au minimum et cliquez sur le bouton

[Min].
Cela vous permet de spécifier la plage de détection optimale en cas de chute de tension due au câblage
ou aux caractéristiques techniques de vos appareils.



• Le seuil pour l’activation et la désactivation est la valeur centrale entre les valeurs de tension
d’entrée maximale et minimale (soit la somme de la valeur maximale et de la valeur minimale,
divisée par 2). Pour éviter tout dysfonctionnement, vous devez laisser une large plage pour la

détection.
• Si la tension chute en raison de la longueur du câble ou du bruit, ajustez les valeurs
maximale et minimale de tension d’entrée. Étant donné que la tension risque de devenir
instable, configurez et installez votre circuit externe de manière à garantir une grande
amplitude entre les valeurs maximale et minimale.
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10.20. Boîte de dialogue « Get Log from Devices » (Obtenir le journal des
appareils)

Pour ouvrir cette boîte de dialogue, cliquez sur [Get Log from Devices] dans le menu [System] (Système) de la

barre de menus.
Un enregistrement des opérations du système de la série MTX/XMV est stocké sous forme de journal dans la
mémoire interne de la série MTX/XMV. Dans cette boîte de dialogue, vous pouvez extraire les journaux de toutes
les unités de la série MTX/XMV existantes sur le sous-réseau auquel votre ordinateur est connecté et les
enregistrer sous la forme d’un fichier. Le fichier journal est au format .csv.

• Zone de texte [Output File Name:] (Nom du fichier de sortie :)
Indique l’emplacement (chemin absolu) dans lequel le fichier journal est enregistré. Vous pouvez
également le saisir directement.

• Bouton […]
Permet d’ouvrir l’explorateur de fichiers et de sélectionner le fichier qui sera utilisé en tant que journal.

• Bouton [Log Clear] (Effacer le journal)
Permet de supprimer le fichier journal de tous les appareils existants sur le sous-réseau.

• Bouton [OK]
Permet de créer le fichier journal et de fermer la boîte de dialogue.

• Bouton [Cancel]
Permet d’annuler la création du fichier journal et de fermer la boîte de dialogue.
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10.21. Boîte de dialogue « RM Series Settings » > « Sign up » (Réglages
de la série RM > Inscription)

Pour ouvrir cette boîte de dialogue, cliquez sur [RM Series Settings] dans le menu [System] de la barre de menus,

puis cliquez sur [Sign up…].

Cette boîte de dialogue vous permet de définir le mot de passe initial d’une unité de série RM.
Pour contrôler l’appareil depuis ProVisionaire Design, vous devez définir un mot de passe initial.

• Liste des appareils
Permet d’afficher les unités de série RM sur le réseau pour lesquelles un mot de passe initial n’a pas été
configuré.

◦ Unit ID / Model / Device Name

Ces colonnes indiquent l’ID de l’unité, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

• Zone de texte [Password] (Mot de passe)
Saisissez ici un mot de passe (4 à 16 caractères alphanumériques).

• Case à cocher [Display a message when you discover a device that is not signed up or logged in.]

(Afficher un message lorsqu’un appareil non inscrit ou non connecté est découvert)
Si cette option est cochée et que ProVisionaire Design détecte des appareils pour lesquels aucun mot de
passe initial n’a été configuré ou des appareils qui n’ont pas été inscrits, la boîte de dialogue « Sign up »
ou « Login » s’affiche automatiquement.
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10.22. Boîte de dialogue « RM Series Settings » > « Login »

Pour ouvrir cette boîte de dialogue, cliquez sur [RM Series Settings] dans le menu [System] de la barre de menus,

puis cliquez sur [Login…].
Vous devez vous identifier pour pouvoir contrôler les appareils via ProVisionaire Design.

• Zone de texte [Password]
Saisissez ici un mot de passe (4 à 16 caractères alphanumériques).

• Liste des appareils

◦ Unit ID / Model / Device Name

Ces colonnes indiquent l’ID de l’unité, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

• Case à cocher [Display a message when you discover a device that is not signed up or logged in.]
Si cette option est cochée et que ProVisionaire Design détecte des appareils pour lesquels aucun mot de
passe initial n’a été configuré ou des appareils qui n’ont pas été inscrits, la boîte de dialogue « Sign up »
ou « Login » est affichée automatiquement.

• Bouton [Login] (Connexion)
Établit la connexion et ferme la boîte de dialogue.

• Bouton [Close]
Annule la connexion et ferme la boîte de dialogue.



Si le réglage « Enable SCP remote control access » (Activer l’accès via la commande à
distance du SCP) d’un appareil a été désactivé, il est automatiquement activé au moment de

la connexion.
Pour désactiver ce réglage, accédez au menu [System] > RM Series Settings > Enable SCP
remote control access.
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10.23. Boîte de dialogue « RM Series Settings » > « Password Settings »
(Réglages du mot de passe)

Pour ouvrir cette boîte de dialogue, cliquez sur [RM Series Settings] dans le menu [System] de la barre de menus,
puis cliquez sur [Password Settings].

Cette boîte de dialogue vous permet de modifier le mot de passe des appareils.

• Liste des appareils
Affiche les appareils connectés dans la liste.

◦ Unit ID / Model / Device Name

Ces colonnes indiquent l’ID de l’unité, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

• Zone de texte [Password]

Saisissez ici un mot de passe (4 à 16 caractères alphanumériques).
Permet de remplacer le mot de passe existant de tous les appareils par un nouveau mot de passe.

• Bouton [OK]
Permet de définir le mot de passe et de fermer la boîte de dialogue.

• Bouton [Cancel]
Permet d’annuler le changement de mot de passe et de fermer la boîte de dialogue.
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10.24. Boîte de dialogue « RM Series Settings » > « Enable SCP remote
control access »

Pour ouvrir cette boîte de dialogue, cliquez sur [RM Series Settings] dans le menu [System] de la barre de menus,

puis cliquez sur [Enable SCP remote control access].
Pour pouvoir modifier les réglages via un contrôleur (tel que ProVisionaire Design), vous devez activer le réglage
« Enable SCP remote control access ».

• Liste des appareils

◦ Unit ID / Model / Device Name

Ces colonnes indiquent l’ID d’unité, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

• Bouton [ALL ON]
Sélectionne tous les appareils.

• Bouton [ALL OFF]
Désélectionne tous les appareils.

• Case à cocher
Lorsque vous cochez cette case et que vous cliquez sur le bouton [OK], le réglage « Enable SCP remote
control access » est activé.

• Bouton [OK]
Permet d’appliquer les réglages et de fermer la boîte de dialogue.

• Bouton [Cancel]
Permet d’annuler les réglages et de fermer la boîte de dialogue.
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10.25. Boîte de dialogue « Linked Presets Manager » (Gestionnaire des
présélections liées)

Pour ouvrir cette fenêtre, cliquez sur l’icône  dans la barre d’outils.

Vous pouvez stocker ou rappeler collectivement des présélections et des instantanés pour chaque appareil.

Un groupe de présélections pour un appareil est appelé une « présélection liée ».
Cette boîte de dialogue vous permet d’affecter les présélections de appareils à une présélection liée.

L’utilisation de base est la suivante.

1. Dans la liste de gauche, sélectionnez la présélection liée de destination du stockage.

2. Dans la liste de droite, cochez les appareils que vous souhaitez stocker.

3. Cliquez sur le bouton [Store].

Pour chaque appareil sélectionné à l’étape 2, la présélection est stockée sous le numéro choisi à l’étape 1.
Pour supprimer un appareil du champ d’action de présélections liées, sélectionnez [----] dans la colonne

[Preset] (Présélection) de la liste de droite.
Pour le DME7, stockez d’abord une présélection liée, puis sélectionnez un instantané enregistré dans la
colonne « Preset ».

Si vous avez préalablement sélectionné des présélections sur chaque appareil, suivez la procédure suivante.

1. Dans la liste de gauche, sélectionnez la présélection liée de destination du stockage.

2. Dans la liste de droite, décochez les appareils pour lesquels une présélection a été spécifiée.

3. Dans la liste de droite, sélectionnez la présélection ([Preset]) de l’appareil dans laquelle il a déjà été
stocké.

4. Cliquez sur le bouton [Store].

• Bouton [Store]
Stocke la présélection liée. Lorsque vous effectuez un enregistrement dans une présélection liée vide, la
boîte de dialogue « Store Linked Preset » (Stocker les présélections liées) apparaît.

• Bouton [Recall]
Rappelle la présélection liée.

• Champ des présélections liées
Sélectionne la présélection liée à stocker ou à rappeler.

• Bouton [Copy]
Copie la présélection liée.
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• Bouton [Paste]
Colle la présélection liée copiée dans la présélection liée sélectionnée.

• Bouton [Clear]
Efface la présélection liée sélectionnée.

• Bouton [All On]
Coche la case [Store] de tous les appareils de la liste.

• Bouton [All Off]
Décoche la case [Store] de tous les appareils de la liste.

• Bouton [Preset]
Affiche la feuille de l’appareil actuellement sélectionné.

• Liste des appareils
Affiche une liste des appareils ayant une fonctionnalité présélectionnée et qui sont enregistrés dans le
projet.

◦ Case à cocher [Store]
Lorsque cette case est cochée, la présélection sélectionnée dans la liste [Preset] est enregistrée

par écrasement sur les appareils de la liste dont la case [Store] est cochée.
Si la liste [Preset] affiche [----], elle sera sauvegardée par-dessus la présélection qui a le même

numéro que la présélection liée.
Si des réglages sont déjà stockés sous ce numéro de présélection de l’appareil et que ce numéro
de présélection est coché dans la liste [Preset], décochez-le.

◦ Device Name / Unit ID / Model

Ces colonnes indiquent le nom de l’appareil, son ID d’unité et le nom de son modèle.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

◦ Liste déroulante [Preset]

Sélectionnez la présélection de l’appareil que vous souhaitez lier à la présélection liée.
Vous pouvez modifier le numéro de la présélection après le stockage. Si vous souhaitez l’exclure
du rappel des présélections liées, sélectionnez [----].

• Bouton [Close]
Ferme la boîte de dialogue.

10. Boîtes de dialogue

ProVisionaire Design V1.2 Guide d’utilisation | 117



10.26. Boîte de dialogue « Store Linked » (Stocker la présélection liée)

Dans la fenêtre « Linked Presets Manager » (Gestionnaire des présélections liées), cliquez sur le bouton [Store]
pour accéder à cette boîte de dialogue.

• Zone de texte [Name]
Saisissez un nom pour la présélection liée. Par défaut, elle s’intitule « Preset + numéro de la
présélection ». Vous ne pouvez pas l’enregistrer si le champ du nom de la présélection liée est vide.

• Case à cocher [Store Device Presets] (Stocker les présélections d’appareils)
Si cette case est décochée, la case à cocher de la liste à droite de la fenêtre « Linked Presets Manager »

l’est aussi et la présélection de l’appareil ne sera pas stockée par écrasement.
Si vous avez précédemment stocké des réglages sous le numéro de présélection de l’appareil, décochez
cette case pour éviter d’écraser les données. Les réglages sont stockés si la case [Store] est décochée.

• Bouton [OK]
Définit la présélection liée et ferme la boîte de dialogue.

• Bouton [Cancel]
Ferme la boîte de dialogue sans définir la présélection liée.
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10.27. Boîte de dialogue Port Label (Étiquette de port)

Après avoir sélectionné le port, cliquez sur la valeur « Label » dans la zone Properties pour l’afficher.
Tous les noms de port des composants, y compris le port sélectionné, peuvent être modifiés simultanément.

• Nom du composant
Le nom du composant contenant le port sélectionné s’affiche en haut de la liste.

• Champ [IN]/[OUT]
Affiche le nom par défaut du port.

• Champ [Port Label]
Affiche/modifie le nom du port. Appuyez sur < Entrée > pour confirmer la saisie et déplacer la mise en
surbrillance sur le port suivant. La mise en surbrillance peut également être déplacée à l’aide des touches
du curseur.

• Bouton [Set Default Name] (Définir le nom par défaut)
Définit le nom par défaut (le nom affiché dans le champ [IN]/[OUT]) dans le champ [Port Label].

• Bouton [All Clear]
Efface tous les noms des ports.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Ferme la boîte de dialogue sans modifier les réglages.
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11. Menus contextuels

Lorsque vous faites un clic droit sur certaines zones, un menu contextuel s’affiche.
Il n’y a pas de menu contextuel dans les zones « Devices » (Périphériques), « Network » (Réseau), ni dans la vue
« Bird’s Eye » (Vue aérienne).

11.1. Sur les onglets des feuilles

Cliquez avec le bouton droit sur l’onglet d’une feuille pour faire apparaître le menu contextuel suivant :

Menu Contenu

[Close] (Fermer) Permet de fermer la feuille.

11.2. Feuille « Project » (Projet)

Cliquez avec le bouton droit sur la feuille « Project » pour faire apparaître le menu contextuel suivant :

Menu Contenu

[Paste] (Coller) Permet de coller l’objet copié dans la feuille.

[Select All] (Sélectionner tout) [All] (Tout)
Permet de sélectionner tous les éléments présents dans la feuille. Si vous
voulez sélectionner les périphériques d’un groupe de périphériques,
sélectionnez le groupe de périphériques, puis cliquez sur [All] (Tout).

[All Devices] (Tous les périphériques)
Permet de sélectionner tous les périphériques présents dans la feuille. Si
vous voulez sélectionner des périphériques d’un groupe de périphériques,
sélectionnez le groupe de périphériques, puis cliquez sur [All Devices]
(Tous les périphériques).

[All Wires] (Tous les câblages)
Permet de sélectionner tous les câblages présents dans la feuille. Si vous
voulez sélectionner les câblages d’un groupe de périphériques,
sélectionnez le groupe de périphériques, puis cliquez sur [All Wires] (Tous
les câblages).

[All Graphics] (Tous les éléments graphiques)
Permet de sélectionner tous les éléments graphiques présents dans la
feuille. Si vous voulez sélectionner des éléments graphiques d’un groupe
de périphériques, sélectionnez le groupe de périphériques, puis cliquez
sur [All Graphics] (Tous les éléments graphiques).

[Close All Editor Windows] (Fermer
toutes les fenêtres Editor)

Permet de fermer tous les éditeurs.

[Snap To Grid] (Aligner sur la grille) Si cette option est cochée, les composants sont alignés avec la grille de
la feuille.

11.2.1. Périphériques dans la feuille « Project » (Projet)

Cliquez avec le bouton droit sur un périphérique dans la feuille « Project » (Feuille de projet) pour faire apparaître
le menu contextuel suivant :
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Menu Contenu

[Open Device] (Ouvrir le
périphérique)

Cocher cet élément permet d’afficher les prises de sortie du périphérique.
Vous pouvez également appuyer sur le bouton [+] dans le coin supérieur
gauche du périphérique. Ce menu existe uniquement pour les
amplificateurs de puissance.

[Open Device Sheet] (Ouvrir la feuille
de périphériques)

Permet d’ouvrir la feuille de périphérique du périphérique. Vous pouvez
également double-cliquer sur le périphérique.

[Identify] (Identifier) Permet de faire clignoter les voyants du périphérique pendant quelques
secondes.

[Alert Information] (Informations
d’alerte)

Permet d’afficher la boîte de dialogue « Alert » (Alertes) sur un
périphérique affiché avec un texte rouge.

[Cut] (Couper) Permet d’envoyer le périphérique vers le tampon de copie.

[Copy] (Copier) Permet de copier l’amplificateur, y compris les réglages de ses
paramètres.

[Paste] (Coller) Permet de coller le périphérique présent dans le tampon de copie, y
compris les réglages de ses paramètres.

[Paste Parameters] (Coller les
paramètres)

Permet d’appliquer les paramètres du périphérique copié sur le
périphérique existant que vous avez sélectionné.

[Duplicate] (Dupliquer) Permet de dupliquer le périphérique, y compris les réglages de ses
paramètres.

[Delete] (Supprimer) Permet de supprimer le périphérique.

[Add to Link Group] (Ajouter à un
groupe de liaisons)

Permet d’enregistrer les canaux du périphérique dans un groupe de
liaisons.

[Create Device Group] (Créer un
groupe de périphériques)

Permet d’enregistrer les objets sélectionnés dans un groupe de
périphériques.

[Bring to Front] (Mettre au premier
plan)

Permet d’afficher le périphérique au premier plan.

[Send to Back] (Mettre en arrière-
plan)

Permet d’afficher le périphérique à l’arrière-plan.

[Device Mute] (Assourdissement du
périphérique)

Permet de couper le son du périphérique.

11.2.2. Haut-parleurs dans la feuille « Project » (Projet)

Cliquez avec le bouton droit sur un haut-parleur dans la feuille « Project» pour faire apparaître le menu contextuel
suivant (certains éléments peuvent être présents ou absents selon le périphérique) :

Menu Contenu

[Open Speaker] (Haut-parleur
ouvert)

Cocher cet élément permet d’afficher les prises d’entrée du haut-parleur.
Vous pouvez également cliquer sur le bouton [+] dans le coin supérieur
gauche du haut-parleur.

[Open Speaker Editor] (Éditeur de
haut-parleur ouvert)

Permet d’ouvrir le « Speaker Editor » (Éditeur de haut-parleur). Vous
pouvez également double-cliquer sur le haut-parleur.
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Menu Contenu

[Open Multiple Speaker Editor]
(Ouvrir l’éditeur pour plusieurs haut-
parleurs)

Si plusieurs haut-parleurs sont sélectionnés, permet d’ouvrir le « Multiple
Speaker Editor » (Éditeur de plusieurs haut-parleurs). Si un seul haut-
parleur est sélectionné, le « Speaker Editor » (Éditeur de haut-parleur) est
ouvert à la place.

[Recall Speaker Preset(s)] (Rappeler
les présélections du haut-parleur)

Ouvre la boîte de dialogue « Recall Speaker Presets » (Rappeler les
présélections du haut-parleur).

[Cut] (Couper) Permet d’envoyer le haut-parleur vers le tampon de copie.

[Copy] (Copier) Permet de copier le haut-parleur vers le tampon de copie.

[Paste] (Coller) Permet de coller le haut-parleur présent dans le tampon de copie, y
compris les réglages de ses paramètres.

[Duplicate] (Dupliquer) Permet de dupliquer le haut-parleur.

[Delete] (Supprimer) Permet de supprimer le haut-parleur.

[Add to Link Group] (Ajouter à un
groupe de liaisons)

Si le haut-parleur est raccordé à un ampli, permet également d’enregistrer
le canal de l’ampli raccordé.

[Create Device Group] (Créer un
groupe de périphériques)

Permet d’enregistrer les objets sélectionnés dans un groupe de
périphériques.

[Bring to Front] (Mettre au premier
plan)

Permet d’afficher le haut-parleur à l’avant-plan.

[Send to Back] (Mettre en arrière-
plan)

Permet d’afficher le haut-parleur à l’arrière-plan.

11.2.3. Groupe de périphériques dans la feuille « Project » (Projet)

Cliquez avec le bouton droit sur un groupe de périphériques dans la feuille « Project » (Feuille de projet) pour
faire apparaître le menu contextuel suivant.

Menu Contenu

[Open Group Editor] (Ouvrir l’éditeur
de groupe)

Permet d’ouvrir le « Group Editor » (Éditeur de groupe).

[Cut] (Couper) Permet d’envoyer le groupe de périphériques vers le tampon de copie.

[Copy] (Copier) Permet de copier le groupe de périphériques vers le tampon de copie.

[Paste] (Coller) Permet de coller le groupe de périphériques présent dans le tampon de
copie.

[Paste to Device Group] (Coller vers
un groupe de périphériques)

Permet de coller le groupe de périphériques présent dans le tampon de
copie à l’intérieur du groupe de périphériques sélectionné.

[Delete] (Supprimer) Permet de supprimer le groupe de périphériques.
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Menu Contenu

[Select All] (Sélectionner tout) [All] (Tout)
Permet de sélectionner tous les éléments présents dans le groupe de
périphériques.

[All Devices] (Tous les périphériques)
Permet de sélectionner tous les périphériques présents dans le groupe de
périphériques.

[All Wires] (Tous les câblages)
Permet de sélectionner tous les câblages présents dans le groupe de
périphériques.

[All Graphics] (Tous les éléments graphiques)
Permet de sélectionner tous les éléments présents dans le groupe de
périphériques.

[Linked Presets Manager for Group]
(Gestionnaire de présélections liées
pour un groupe)

Ouvre la fenêtre « Linked Presets Manager for Group » (Gestionnaire de
présélections liées pour un groupe), en ayant comme cible les
périphériques du groupe de périphériques. Pour plus de détails sur cette
boîte de dialogue, reportez-vous à la boîte de dialogue « Linked Presets
Manager » (Gestionnaire des présélections liées).

[Unpack Device Group] (Dissocier le
groupe de périphériques)

Permet de dissocier les périphériques du groupe.

[Bring to Front] (Mettre au premier
plan)

Permet d’afficher le groupe de périphériques au premier plan.

[Send to Back] (Mettre en arrière-
plan)

Permet d’afficher le groupe de périphériques à l’arrière-plan.

11.2.4. Texte, ligne ou polygone dans la feuille « Project »

Cliquez avec le bouton droit sur un élément graphique (texte, ligne ou polygone) dans la feuille « Project » (Feuille
de projet) pour faire apparaître le menu contextuel suivant.

Menu Contenu

[Cut] (Couper) Permet d’envoyer l’élément graphique vers le tampon de copie.

[Copy] (Copier) Permet de copier l’élément graphique vers le tampon de copie.

[Paste] (Coller) Permet de coller l’élément graphique présent dans le tampon de copie.

[Duplicate] (Dupliquer) Permet de dupliquer l’élément graphique.

[Delete] (Supprimer) Permet de supprimer l’élément graphique.

[Create Device Group] (Créer un
groupe de périphériques)

Permet d’enregistrer les éléments graphiques sélectionnés dans un
groupe de périphériques.

[Bring to Front] (Mettre au premier
plan)

Permet de déplacer l’élément graphique au premier plan.

[Send to Back] (Mettre en arrière-
plan)

Permet de déplacer l’élément graphique à l’arrière-plan.
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11.2.5. Câblages dans la feuille « Project » (Projet)

Cliquez avec le bouton droit sur un câblage dans la feuille « Project » ou dans une feuille de périphérique pour
faire apparaître le menu contextuel suivant (certains éléments peuvent être présents ou absents) :

Menu Contenu

[Delete] (Supprimer) Permet de supprimer le câblage.

[Bring to Front] (Mettre au premier
plan)

Permet d’afficher le câblage sélectionné au premier plan.

[Send to Back] (Mettre en arrière-
plan)

Permet d’afficher le câblage sélectionné à l’arrière-plan.

[Insert Node] (Insérer un nœud) Permet d’ajouter un nœud sur le câblage.

[Remove Segment] (Supprimer le
segment)

Permet de supprimer le segment de câblage entre les nœuds.

11.2.6. Zone « Network » (Réseau)

Cliquez avec le bouton droit sur un périphérique pour faire apparaître le menu contextuel suivant.

Menu Contenu

[Alert Information] (Informations
d’alerte)

Permet d’afficher la boîte de dialogue « Alert » (Alertes) sur un
périphérique affiché avec un texte rouge.

[Identify] (Identifier) Permet de faire clignoter les voyants du périphérique pendant quelques
secondes.

[Sign Up] (Inscription) (Uniquement
sur la série RM)

Permet d’ouvrir la boîte de dialogue « RM Series Settings > Sign up »
(Réglages de la série RM > Inscription)

[Login] (Identification) (Uniquement
sur la série RM)

Permet d’ouvrir la boîte de dialogue « RM Series Settings > Log In »
(Réglages de la série RM > Identification)

11.3. Feuille de périphérique

11.3.1. Composants et éditeurs de composants présents dans la feuille de
périphérique

Cliquez avec le bouton droit ailleurs que sur un contrôleur de composant ou sur un composant pour faire
apparaître le menu contextuel suivant (les éléments ne sont pas tous présentés pour l’ensemble des
composants).

Menu Contenu

[Open Component Editor] (Ouvrir
l’éditeur de composants)

Permet d’ouvrir l’éditeur de composants.

[Copy] (Copier) Permet de copier les réglages de paramètres de l’éditeur de composants.

[Paste Parameters] (Coller les
paramètres)

Permet d’appliquer les réglages de paramètres copiés depuis l’éditeur de
composants.

11. Menus contextuels

124 | ProVisionaire Design V1.2 Guide d’utilisation



12. Opérations communes aux feuilles d’appareil
Les opérations suivantes sont communes aux différentes feuilles d’appareil.

12.1. Opérations de l’éditeur de composants

Pour ouvrir l’éditeur de composants, double-cliquez ou cliquez avec le bouton droit sur un composant dans la

feuille d’appareil, puis sélectionnez [Open Component Editor] (Ouvrir l’éditeur de composants).

Pour plus de détails sur le menu contextuel, reportez-vous à la section « Menus contextuels ».
Si vous souhaitez passer d’un éditeur de composants à un autre dans une même fenêtre, cliquez sur le symbole

de recyclage ( ) en bas à droite de l’éditeur de composants pour qu’il devienne vert ( ). Si vous ouvrez un
autre éditeur de composants, l’affichage de l’éditeur de composants à l’avant-plan change.

Il est possible de régler le pourcentage d’agrandissement de l’éditeur de composants.
Vous avez le choix entre 50 %, 75 %, 100 %, 150 % et 200 %.

Si le symbole de recyclage est gris Si le symbole de recyclage est vert
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12.2. Édition des paramètres

Cette section vous explique comment modifier les paramètres dans l’éditeur de composants.

• Boutons rotatifs
Il existe plusieurs façons de modifier un paramètre se présentant sous la forme d’un bouton rotatif.

◦ Sélectionnez le bouton rotatif, maintenez le bouton gauche de la souris enfoncé et déplacez le
curseur de la souris vers le haut ou le bas.

◦ Sélectionnez le bouton rotatif et tournez la molette de la souris.

◦ Sélectionnez la zone d’affichage numérique, maintenez le bouton gauche de la souris enfoncé et
déplacez le curseur de la souris vers le haut ou vers le bas.

◦ Sélectionnez la zone d’affichage numérique et tournez la molette de la souris.

◦ Double-cliquez sur la zone d’affichage numérique et saisissez directement une valeur numérique.

◦ Appuyez sur < Alt >+clic pour régler la valeur nominale.

• Curseurs
Il existe plusieurs façons de modifier les paramètres sous forme de curseurs, tels que les faders.

◦ Faites glisser le contrôleur du curseur.

◦ Sélectionnez le contrôleur du curseur et tournez la molette de la souris à l’intérieur du cadre.

◦ Sélectionnez la zone d’affichage numérique, maintenez le bouton gauche de la souris enfoncé et
déplacez le curseur de la souris vers le haut ou vers le bas.

◦ Sélectionnez la zone d’affichage numérique et tournez la molette de la souris.

◦ Double-cliquez sur la zone d’affichage numérique et saisissez directement une valeur numérique.

◦ Appuyez sur < Alt >+clic pour régler la valeur nominale.

• Boutons

Cliquez sur un bouton pour changer le paramètre du bouton.
Il existe plusieurs types de boutons. La couleur du bouton lorsqu’il est allumé varie selon la fonction qu’il
régit.

Fonction activée / désactivée
Le bouton s’allume lorsque la fonction est activée.

Fonctions mutuellement exclusives
Dans un ensemble de boutons, l’activation d’un bouton désactive tous les autres.
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Ouverture d’une fenêtre de réglage des paramètres ou d’un autre éditeur de composants
Cliquer sur un bouton permet d’ouvrir une fenêtre de réglage des paramètres ou un autre éditeur de
composants.

Affichage d’un menu
Cliquer sur le bouton permet d’accéder à un menu.
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12.3. Enregistrement des paramètres dans ProVisionaire Control

Vous pouvez enregistrer dans ProVisionaire Control les paramètres, les instantanés et les présélections de
l’appareil qui sont stockés dans ProVisionaire Design.

Source d’enregistrement Méthode d’enregistrement

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser un
paramètre et déposez-le sur une page dans ProVisionaire Control.

Zone « Parameters » Faites glisser un paramètre et déposez-le sur une page de ProVisionaire
Control.

Zone « Preset »/Zone « Parameter
Sets »

Faites glisser la présélection/l’instantané/le groupe d’instantanés* et

déposez-le sur la page de ProVisionaire Control.
*Le groupe d’instantanés est une fonction uniquement disponible sur le
MRX7-D.

Éditeur de commandes de liaison Tout en maintenant la touche < Ctrl > enfoncée, faites glisser Link Control

et déposez-le sur la page de ProVisionaire Control.
*Il s’agit d’une fonction du MRX7-D uniquement.
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13. Processeurs audio : DME7

13.1. Présentation

Le DME7 est un processeur librement configurable, qui vous laisse le loisir de concevoir un système en toute

liberté en disposant les composants selon les besoins.
Le DME7 peut être utilisé à l’aide d’un contrôleur externe, par exemple un DCP/MCP1.

Dans la feuille d’appareil du DME7, le déroulement des opérations consiste à placer librement les composants

dans la feuille de conception, puis à compiler le résultat.
Puis, vous pouvez utiliser l'éditeur de composants en lien avec l’unité DME7 afin de modifier les paramètres.

La fonction Trace Signal Path (Tracer le chemin du signal) permet d’afficher le chemin du signal (affichage du

chemin du signal).
La fonction Duplicate Port Label (Dupliquer l’étiquette de port) vous permet de dupliquer successivement le nom
du port de départ le long du chemin du signal (duplication du nom du port d’entrée).

Les paramètres sont stockés et rappelés sous forme d'instantanés.
Si vous souhaitez stocker/rappeler plusieurs paramètres, il est possible de les regrouper (Parameter Sets) : il est
possible de stocker 100 valeurs de paramètres dans chaque jeu de paramètres enregistré sous forme

d’instantané.
Les instantanés peuvent également être rappelés grâce à un contrôleur à distance.

Les valeurs initiales d’un composant, ainsi que les données qui configurent les câblages entre les composants,
peuvent être sauvegardés sur un ordinateur en tant que style utilisateur. Enregistrer un style utilisateur vous évite
d’avoir à modifier les réglages chaque fois que vous placez un composant. En outre, les styles utilisateur

peuvent aussi être transférés vers un autre ordinateur.
Les composants et leurs câblages peuvent être regroupés dans un bloc défini par l’utilisateur. Regrouper
plusieurs composants en un seul bloc vous permet de rendre la feuille moins encombrée ou de copier des blocs
afin de créer facilement la même fonctionnalité pour d’autres canaux. Si vous activez le mode « View Only »
(Affichage uniquement) ou « Protect » (Protection) dans des blocs individuels, vous pouvez protéger ces blocs
lorsque vous exécutez le mode « Protect User Defined Block » (Protéger le bloc défini par l’utilisateur).

13.2. Feuille « Project »

Vous pouvez placer des appareils dans cette feuille. La boîte de dialogue « Settings » apparaît lorsque vous
cherchez à placer un appareil.

• Capacity (Capacité)
Permet d’indiquer la capacité de traitement du signal du DME7. Vous avez le choix entre 64, 128, 192 et
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256.
Cette capacité doit correspondre à celle de l’unité DME7.

• Sampling Frequency (Fréquence d’échantillonnage)
Permet d’indiquer la fréquence d’échantillonnage de l’appareil. Vous avez le choix entre 44,1 kHz, 48 kHz,
88,2 kHz et 96 kHz.

• Number of Devices (Nombre d’appareils)
Permet de choisir le nombre d’unités DME7 placées sur la feuille d’appareil.

• Unit ID Starting From (ID d’unité à partir de)
Permet d’indiquer l’ID d’unité à partir duquel commencer.

• Device Name
Permet d’afficher et de modifier le nom de l’appareil.

13.2.1. Barre d’outils

• Editor Magnification (Zoom de l’éditeur)
Permet de zoomer et dézoomer l’affichage de l’éditeur de composants.

• Trace Signal Path
Si vous sélectionnez un port ou un câblage alors que cette commande activée, le chemin du signal sera
tracé sous forme de lignes clignotantes entre le point sélectionné, l’entrée et la sortie.
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13.2.2. Zone « Properties »

Cette zone vous permet d’afficher et de modifier les informations à propos du DME7.

• Device

◦ Capacity
Permet d’indiquer la capacité de traitement du signal du DME7. Vous avez le choix entre 64, 128,

192 et 256.

Cette capacité doit correspondre à celle de l’unité DME7.
La capacité d’usine par défaut de l’unité DME7 est de 64. Dans ce cas, le nombre maximum
d’entrées et de sorties disponibles pour Dante, pour les composants Matrix Mixer et pour les

composants Routeur est de 64 entrées/64 sorties.
Chaque fois que vous ajoutez une licence (DEK-DME7-DX64), le nombre d’entrées et de sorties

pour Dante, ainsi que pour les composants Matrix Mixer et Routeur, est augmenté de 64 canaux.
Vous pouvez ajouter jusqu’à trois licences. Pour plus de détails sur l’ajout d’une licence d’appareil,
reportez-vous au document « Device License Activation Guide ».

◦ Sampling Frequency
Permet d’indiquer la fréquence d’échantillonnage de l’appareil. Vous avez le choix entre 44,1 kHz,

48 kHz, 88,2 kHz et 96 kHz.
Ce taux doit correspondre à la fréquence d’échantillonnage de Dante.

◦ Unit ID
Cette valeur doit correspondre à l’ID d’unité de l’unité DME7. Le réglage d’usine par défaut est 1.
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◦ DCP
Choisissez un DCP (Digital Control Panel) (Panneau de commande numérique) à connecter sur le

port DCP du DME7.
Si vous sélectionnez un DCP, le composant DCP est ajouté à la feuille d’appareil.

Pour plus de détails, reportez-vous à la section DCP.
Pour les autres éléments, reportez-vous à la description présente dans la zone « Properties » lorsque les
éléments en question sont sélectionnés.
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13.3. Configuration de l’écran de la feuille d’appareil

La feuille d’appareil se compose d’une barre de menus, de boutons d’outils, d’une zone « Components », d’une
zone « Parameter Sets », d’une feuille de conception, d’une zone « Properties », d’une zone « Parameters » et
d’une vue « Bird’s Eye View ».

① Boutons d’outils
Les fonctions fréquemment utilisées apparaissent sous forme de boutons (boutons d’outils).

② Zone « Components »
Cette zone répertorie respectivement les composants de la couche Audio et de la couche Control (zone
« Components »).

③ Zone « Parameter Sets »
Cette zone permet de configurer des jeux de paramètres ou des instantanés (zone « Parameter Sets »).

④ Feuille de conception
Dans cette feuille, vous pouvez placer et connecter les composants (feuille de conception).

⑤ Zone « Properties »
Cette zone permet de modifier les réglages du composant, du port ou du câblage actuellement sélectionné (zone
« Properties »).

⑥ Zone « Parameters »
Cette zone répertorie les composants qui ont été placés dans la feuille de conception (couche Audio ou couche
Control) et leurs paramètres (zone « Parameters »).

⑦ Vue « Bird’s Eye »
Ceci affiche une vue d’ensemble de la feuille.

⑧ Composant
Différents modules de traitement des signaux, tels qu’un égaliseur ou un compresseur, sont appelés des
« composants ».

⑨ Éditeur de composants
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Utilisez l’éditeur de composants pour configurer les paramètres.
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13.4. Utilisation des fonctions de base de ProVisionaire Designer

1. Depuis la zone « Components » à gauche, faites glisser le composant que vous souhaitez utiliser et
déposez-le dans la feuille de conception.

Si vous déposez un composant qui dispose de plusieurs options tels que des canaux, les options seront toutes
affichées ; si nécessaire, sélectionnez celle que vous souhaitez utiliser.


Double-cliquez sur un composant dans la zone « Components » pour sélectionner le mode
Stamp. Dans ce mode, les composants sont positionnés les uns après les autres chaque fois
que vous cliquez sur la feuille de conception. Pour sortir du mode Stamp, appuyez sur <
Échap > ou cliquez sur un composant dans la liste.

2. Pour établir une connexion, faites glisser l’icône  d’un composant et déposez-la sur l’icône  d’un

autre composant.
Pour plus de détails, reportez-vous à la section Connexion de ports.

3. Double-cliquez ou faites un clic droit sur un composant, puis sélectionnez « Open Component Editor »
(Ouvrir l’éditeur de composants). L’éditeur de composants s’ouvre, ce qui vous permet de configurer les
paramètres.
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4. Lorsque vous avez effectué les réglages nécessaires, cliquez sur le bouton « Compile » (Compiler) pour
vérifier s’il y a des problèmes au niveau du placement et des connexions du composant.
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13.5. Boutons d’outils

Les commandes fréquemment utilisées sur le DME7 sont disponibles sous la forme de boutons.

Bouton Commande Description

[Layer] (Couche) Bascule entre les couches Audio et Control (Commande).
Vous pouvez utiliser le raccourci <Ctrl + page haut>.

[Control Function]
(Fonction de commande)

Activez ce bouton pour imiter la configuration de la couche
Control. Tant que ce bouton est activé, vous ne pouvez pas
modifier la configuration.

[Compile] Détermine s’il y a un problème de placement et de câblage
des composants.

[Device Mute]
(Assourdissement de
l’appareil)

Coupe le son du DME7.
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Bouton Commande Description

[Tools] (Outils) [Remote Control Setup List] (Liste de configurations de

commandes à distance)
Permet d’enregistrer les paramètres que vous souhaitez

contrôler par le biais du contrôleur à distance.

[SD Card File Manager] (Gestionnaire de fichiers de la carte

SD)
Permet d’enregistrer les fichiers que vous souhaitez lire sur la

carte SD.

[GPI]
Utiliser les entrées/sorties GPI vous permet de contrôler le
DME7 à distance à partir d’un contrôleur personnalisé ou d’un

appareil externe.

[MIDI]

Vous pouvez contrôler le DME7 à distance via MIDI.

[MCP1]

Ouvre l’éditeur MCP1 qui a été placé sur la feuille Project.

[Peak Hold] (Maintien de crête)
Sélectionnez « On » pour maintenir la valeur de crête sur

l’indicateur de niveau du composant placé sur la feuille.
Sélectionnez « Reset » (Réinitialisation) pour réinitialiser le

maintien de la crête.

[Protect User Defined Block]

Ouvre la boîte de dialogue « Protect User Defined Block ».
Pour plus de détails, reportez-vous à la section « Bloc défini

par l’utilisateur ».

[Layer Link] (Liaison de couches)
Activez cette commande pour synchroniser (lier) la position
du composant audio entre la couche Audio et la couche
Control.
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13.6. Zone « Components »

Cette zone répertorie les composants, respectivement de la couche Audio et de la couche Control.

Pour plus de détails sur les composants, reportez-vous au « ProVisionaire Design DME7 Component Guide ».
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13.7. Feuille de conception

Dans cette feuille, vous pouvez placer les composants et les connecter entre eux.
Les réglages de paramètres sont les principales opérations que vous pouvez effectuer lorsque vous êtes en
ligne. Par contre, les opérations telles que le placement et la connexion de composants s’effectuent uniquement
hors ligne.

13.7.1. Placement des composants

Cette section vous explique comment placer les composants sur la feuille de conception.


Si un composant de la zone « Components » est sélectionné, appuyez sur une touche
alphabétique pour sélectionner le composant commençant par cette lettre.

• Placement d’un seul composant
Faites glisser le composant souhaité depuis la liste dans la zone « Components » et déposez-le dans la
feuille de conception.

• Placement de plusieurs instances du même composant
Double-cliquez sur un composant dans la zone « Components » pour sélectionner le mode Stamp ; dans
ce mode, une instance du composant est positionnée à chaque fois que vous cliquez sur la feuille de
conception. Pour sortir du mode Stamp, appuyez sur < Échap > ou cliquez sur un composant dans la liste.

• Modification du nombre de canaux d’un composant placé
Dans la zone « Properties », cliquez d’abord sur le champ Form (Formulaire), puis sur l’icône […] qui
apparaît et sélectionnez le nombre désiré de canaux. Ce réglage ne peut pas être modifié sur un
composant n’affichant pas l’icône […].
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13.7.2. Sélection de plusieurs composants, ports ou câblages

Voici comment procéder pour sélectionner plusieurs composants placés dans la feuille de conception ou
différents câblages qui relient les ports des composants.

• Utilisez le curseur de la souris pour entourer complètement des objets
Dans la feuille de conception, faites glisser le curseur de la souris pour créer une zone rectangulaire : les
composants, les ports de composants ainsi que les câblages et les éléments de texte qui sont
complètement encadrés sont sélectionnés.



Si la sélection renferme un bloc défini par l’utilisateur, que ce bloc est développé et que le
point à partir duquel vous commencez à faire glisser le curseur se trouve sur la feuille de

style, tous les objets situés sur la feuille de style sont sélectionnés. Si
le point de départ se trouve dans un bloc défini par l’utilisateur, tous les objets situés dans ce
bloc seront alors sélectionnés.

• Maintenez la touche < Ctrl > enfoncée et utilisez le curseur de la souris pour entourer des objets en tout

ou en partie
Maintenez la touche < Ctrl > enfoncée et faites glisser le curseur de la souris pour créer une zone
rectangulaire et sélectionner les composants, les ports de composants, les câblages et les éléments de
texte qui sont complètement ou partiellement encadrés.



Si la sélection renferme un bloc défini par l’utilisateur, que ce bloc est développé, et que le
point à partir duquel vous commencez à faire glisser le curseur se trouve sur la feuille de
style, tous les objets situés sur la feuille de style et le bloc défini par l’utilisateur sont
sélectionnés. Si le point de départ se trouve dans un bloc défini par l’utilisateur, tous les
objets situés dans ce bloc sont sélectionnés.

• Maintenez la touche < Ctrl > enfoncée et cliquez sur des objets

Maintenez la touche < Ctrl > enfoncée et cliquez sur la cible que vous souhaitez sélectionner.
Si vous cliquez sur un objet déjà sélectionné alors que la touche < Ctrl > est enfoncée, la sélection est
annulée. Ceci est pratique lorsque vous avez sélectionné plusieurs objets en les encadrant et que vous
décidez ensuite désélectionner un des objets sélectionnés.


Si des objets situés dans un bloc défini par l’utilisateur et sur la feuille de style sont
sélectionnés simultanément, certaines opérations seront limitées. Par exemple, vous ne
pourrez pas déplacer des composants.
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13.7.3. Connexion de ports

Cette section vous explique comment établir des connexions entre des ports de composants par le biais d’un
câblage.

• Établissement d’une seule connexion à la fois
Faites glisser un port de sortie vers le port d’entrée du composant de destination.

• Établissement de plusieurs connexions à la fois
Sélectionnez plusieurs ports de sortie et faites glisser l’un de ces ports vers un port d’entrée du
composant de destination.

13. Processeurs audio : DME7

144 | ProVisionaire Design V1.2 Guide d’utilisation



13.7.4. Traçage du chemin du signal

Voici comment visualiser le chemin du signal.

Pour visualiser le chemin du signal, cliquez sur le bouton  [Trace Signal Path] de la barre d’outils ou cochez

une case dans le menu [Tools] → [Trace Signal Path].

• Cliquez sur un câble
Le chemin du signal qui circule par ce câble s’affiche.

• Cliquez sur un port
Le chemin du signal qui circule par ce port est affiché.

Si le chemin du signal est connecté mais qu’aucun signal audio ne circule car il est sur OFF ou réglé au
minimum, le chemin du signal s’affiche sous la forme d’une ligne pointillée.
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13.7.5. Duplication du nom de port d’entrée

Si vous souhaitez utiliser le nom du signal comme nom du port, il est commode de dupliquer le nom du port.

Voici comment dupliquer automatiquement le nom du port d’entrée.
En général, le nom du port d’entrée est automatiquement dupliqué vers le port d’entrée du composant situé à la
sortie de la connexion, mais les exceptions suivantes s’appliquent.

• S’il s’agit d’un composant de type mixeur ou d’un composant qui ne dispose que d’une sortie, le nom du
port de sortie est dupliqué vers le port d’entrée de la sortie de la connexion.

• Si le nom du port source de la duplication est vide, il ne sera pas automatiquement dupliqué.

 Si le nom du port a déjà été spécifié, il sera écrasé par la duplication automatique.

• Duplication automatique du nom de port lors de la connexion de composants

Si la case du menu [Tools] → [Duplicate Port Label] (Dupliquer le nom du port) est cochée, le nom de port
sera automatiquement dupliqué lors de la connexion des composants.

• Duplication du nom de port des composants le long du chemin du signal
Dans le menu contextuel qui apparaît lorsque vous faites un clic droit sur un port ou un composant,
sélectionnez [Duplicate Port Label – to the right] (Dupliquer le nom du port vers la droite) ou [Duplicate
Port Label – to the left] (Dupliquer le nom du port vers la gauche) ; le nom du port d’entrée est alors

dupliqué vers le port d’entrée des composants suivants ou précédents.
Cependant, si un composant de type mixeur est présent sur ce chemin, la duplication s’arrête au niveau du
composant de type mixeur.
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13.7.6. À propos de la commande [Unbundle Wires] (Dégrouper les câblages)

Après avoir placé tous les composants nécessaires et terminé de relier les câblages entre eux, vous pouvez
sélectionner tous les composants et exécuter la commande [Unbundle Wires] afin de prévenir le chevauchement

des câblages à l’écran.
Lorsque vous exécutez [Unbundle Wires], les éléments de la zone « Properties » correspondants aux
composants et aux câblages connectés aux composants sont réglés sur les valeurs suivantes.

Élément Valeur

Composant Output Wiring Step Une valeur appropriée s’affiche
automatiquement.

Input Wiring Step Une valeur appropriée s’affiche
automatiquement.

Câble Wire Routing (Acheminement du câblage) Automatic (Automatique)

Auto Block Avoidance (Évitement
automatique du bloc)

False (Faux)

Si vous souhaitez modifier de façon sélective l’espacement entre les câblages, effectuez l’opération ci-dessus,
puis modifiez les valeurs des éléments [Output Wiring Step] (Étape de câblage de sortie) ou [Input Wiring Step]
(Étape de câblage d’entrée).

Pour éviter le chevauchement des câblages en effectuant les connexions, exécutez la procédure suivante.

1. Placez tous les composants.

2. Sélectionnez tous les composants et exécutez la commande [Unbundle Wires].

3. Procédez à une connexion entre les composants et sélectionnez le câblage.

4. Définissez la commande [Wire Routing] du câblage sur [Automatic], puis réglez [Auto Block Avoidance]
sur [False].

5. Cliquez sur le bouton [Save Style] (Sauvegarder le style) pour enregistrer le style utilisateur du câblage
sur l’ordinateur.

Par la suite, lorsque vous connectez des câblages, ils s’affichent sans se chevaucher.
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13.7.7. Duplication des composants

Cette section vous explique comment dupliquer les composants ainsi que leurs paramètres.

• Cliquez avec le bouton droit sur un composant et sélectionnez [Duplicate]
Un composant dupliqué est créé, qui se chevauche avec le composant original. Si plusieurs composants
sont sélectionnés avec leur câblage lorsque vous choisissez [Duplicate], ces composants seront
dupliqués en même temps que leur câblage.

• Faites glisser un composant tout en maintenant la touche < Ctrl > enfoncée et déposez-le
Le composant est dupliqué à l’endroit où vous l’avez déposé.

• Faites glisser plusieurs composants et leur câblage tout en maintenant la touche < Ctrl > enfoncée et

déposez-les
Des doubles des composants et de leur câblage sont créés lorsque vous déposez les composants.
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13.8. Feuille de conception : couche Audio

Cette couche vous permet de placer des composants audio pour créer une configuration.
Vous pouvez y contrôler les signaux audio en effectuant le câblage entre les composants audio.

13.8.1. Composant Audio

Pour plus de détails sur l’utilisation de l’éditeur de composants, reportez-vous au Chapitre 12.
Pour plus de détails sur les composants, reportez-vous au « ProVisionaire Design DME7 Component Guide ».

13.9. Feuille de conception : couche Control

Cette couche permet de gérer les signaux de commande.
Vous pouvez manipuler les signaux de commande en effectuant un câblage entre les composants de
commande ou les composants audio.

Les composants de commande peuvent être manipulés à l’aide des modifications des paramètres ou des
niveaux des composants audio. Les composants audio peuvent être manipulés à l’aide des modifications des

paramètres des composants de commande.
Vous pouvez également placer des instantanés dans la couche Control, qui peuvent être traités comme faisant
partie de la configuration.

Composant Control

Pour plus de détails sur l’utilisation de l’éditeur de composants, reportez-vous au Chapitre 12.
Pour plus de détails sur les composants, reportez-vous au « ProVisionaire Design DME7 Component Guide ».

13.9.1. Utilisation des paramètres du composant audio dans la couche Control

1. Sélectionnez la couche Audio.

2. Sélectionnez la zone « Parameters », puis sélectionnez le composant audio dans la feuille.

Dans la colonne « Control PINs » (Repères de commande), cochez les paramètres souhaités. Le
composant audio est alors également placé dans la couche Control.
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Si vous désactivez la commande « Layer Link » (Liaison de couches) (un des boutons d’outils), la
disposition du composant audio sera désynchronisée (non liée) entre la couche Audio et la couche
Control.

3. Placez le composant de commande dans la couche Control et faites le câblage nécessaire.

4. Activez le bouton [Control Function]  et modifiez les paramètres des composants de commande pour
simuler l’opération.

 Vous ne pouvez pas modifier la configuration si le bouton [Control Function] est activé.
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13.9.2. Contrôle d’un instantané et d’un jeu de paramètres dans un composant
Control

Vous pouvez contrôler un instantané et un jeu de paramètres dans un composant de commande.
Pour plus de détails sur le jeu de paramètres et les instantanés, reportez-vous à la section « Zone Parameter
Sets ».

■ Exemple de commande qui utilise un composant Snapshot

1. Faites glisser un instantané depuis le menu « Snapshot » vers la zone « Parameter Set » et déposez-le
dans la couche Control. Le composant Snapshot apparaît dans la couche Control.

2. L’instantané est rappelé lorsqu’un signal entre par son port d’entrée.

3. Lorsque l’instantané est rappelé, un « 1 » apparaît au niveau de son port de sortie.

■ Exemple de commande qui utilise un composant ParamSet

Vous pouvez également contrôler un instantané à l’aide du composant ParamSet. Dans cette section, deux
exemples de commande sont présentés : l’une utilise des repères Snaspshot, l’autre des repères Sel.

[1] Exemple de commande qui utilise des repères Snapshots

1. Faites glisser le composant Parameter Set depuis la zone « Parameter Sets » et déposez-le dans la
couche Control. Le composant ParamSet, qui inclut plusieurs composants Snapshot, apparaît dans la
couche Control.

2. Sélectionnez le jeu de paramètres dans la zone « Parameters », puis cliquez sur le signe « + » à côté de
« Snapshot » pour dérouler la liste d’instantanés.
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3. Dans la colonne Control PINs, cochez la case du numéro de l’instantané souhaité. Des ports
d’entrée/sortie sont ajoutés aux composants qui figurent sur la feuille. La méthode pour les rappeler est

identique à la méthode « ■ Exemple de commande à l’aide d’un composant Snapshot ».

[2] Exemple de commande qui utilise un repère Sel

1. Sélectionnez Parameter.Set dans la zone « Parameters », puis cochez la case « Sel » dans la colonne
Control PINs (Repères de commande) pour l’ajouter au port d’entrée du composant sur la feuille.

2. Saisissez le numéro souhaité (1 à 100) comme identifiant de l’entrée Sel. Le composant Snapshot
correspondant à ce numéro est rappelé. (La sortie de ce composant affiche alors un « 1 ».)
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13.10. Composants autres que les composants audio ou de commande

13.10.1. Transmetteur/Récepteur

Cette fonction permet de connecter des composants situés à une certaine distance les uns des autres dans la

feuille de conception via une connexion sans fil.

Le composant émetteur et le composant récepteur portant le même nom sont connectés.
S’il existe plusieurs ports, les ports portant le même numéro sont reliés. Il est possible de connecter un seul

émetteur à plusieurs récepteurs.
Lorsque vous placez ce composant dans la feuille de conception, sélectionnez le nom du composant et le
nombre de canaux. Vous pouvez entrer un nouveau nom pour ce composant ou sélectionner le nom du
composant auquel vous l’associez. Sélectionnez ensuite le nombre de canaux que vous souhaitez utiliser.

Lorsque vous sélectionnez un câblage et appuyez sur < Espace >, un émetteur et un récepteur sont ajoutés.
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Si vous maintenez le bouton de la souris enfoncé au milieu d’une connexion, puis appuyez sur la touche <
Espace >, un composant émetteur ou un composant récepteur sera créé.
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13.10.2. Bloc défini par l’utilisateur

Les composants et leurs câblages peuvent être intégrés dans un bloc défini par l’utilisateur. Regrouper plusieurs
composants en un seul bloc vous permet améliorer l’apparence de la feuille de style et effectuer des copies

entre les blocs afin de faciliter la création de la même fonctionnalité sur d’autres canaux.
Une fonction de protection est fournie pour les blocs définis par l’utilisateur. Protéger ce bloc vous permet
d’empêcher une autre personne d’en modifier la configuration ou les paramètres ou de regarder à l’intérieur.

Voici comment placer un bloc défini par l’utilisateur.

• Effectuez un glisser-déposer depuis la zone « Component ». (Un bloc vide est alors placé.)

• Sélectionnez les composants, cliquez avec le bouton droit et sélectionnez [Create User Defined Block]
(Créer un bloc défini par l’utilisateur). (Cela permet de placer un bloc contenant les composants
sélectionnés.)

• Une fois les composants sélectionnés, sélectionnez le menu [Edit] → [Create User Defined Block]. (Cela
permet de placer un bloc contenant les composants sélectionnés.)

Lorsque vous placez un bloc défini par l’utilisateur, indiquez le nombre d’entrées et de sorties du bloc. Le nombre
d’entrées et de sorties peut être modifié ultérieurement via la commande « Form » de la zone « Properties ». Les
entrées et sorties relient directement entre eux les composants situés respectivement à l’extérieur et à l’intérieur
du bloc.

Pour afficher ou masquer le contenu d’un bloc, cliquez sur les boutons [+]/[–] dans le coin supérieur gauche du
bloc ou double-cliquez sur le bloc.

Les composants d’un bloc peuvent être placés, connectés et modifiés de la même manière que dans une feuille

de conception.
Lorsqu’un bloc est sélectionné, vous avez la possibilité de l’étendre ou de le rétrécir en faisant glisser un de ses
coins vers le haut, le bas, la gauche ou la droite. Lorsqu’un bloc développé est sélectionné, vous pouvez le
déplacer à l’intérieur de la feuille de conception en faisant glisser un de ses quatre bords (haut, bas, gauche ou
droite).

Voici comment défaire un bloc défini par l’utilisateur.

• Cliquez avec le bouton droit sur le bloc et sélectionnez [Unpack User Defined Block] (Défaire le bloc défini
par l’utilisateur).

• Après avoir sélectionné le bloc, sélectionnez le menu [Edit] → [Unpack User Defined Block].
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Il existe trois modes de protection des bloc défini par l’utilisateur.

• Mode Off (Désactivé)
Le bloc n’est pas protégé.

• Mode View Only (Affichage uniquement)
Un bloc défini par l’utilisateur protégé ou un éditeur de composants à l’intérieur du bloc peut être ouvert,
mais la configuration et les paramètres ne peuvent pas être modifiés. Les composants du bloc défini par

l’utilisateur ne sont pas visibles dans la zone « Parameters ».
Dans un bloc protégé, une icône de verrou ( ) apparaît en bas à gauche de l’éditeur de composant.

• Mode Protect (Protection)
Il est impossible d’ouvrir un bloc protégé défini par l’utilisateur. Les composants du bloc défini par
l’utilisateur ne sont pas visibles dans la zone « Parameters ». Utilisez cette option pour en masquer

totalement le contenu.
Une icône de verrou ( ) apparaît en haut à gauche du bloc protégé.

Pour protéger un bloc, procédez comme suit.

1. Sélectionnez le bloc défini par l’utilisateur et que vous souhaitez protéger.
Si vous sélectionnez plusieurs blocs définis par l’utilisateur, ils seront protégés avec le même mode.

2. Dans la zone « Properties », utilisez [Lock Mode] (Mode de verrouillage) pour choisir le mode de
verrouillage que vous souhaitez appliquer.

3. Si nécessaire, répétez les étapes 1 et 2 pour choisir le mode de verrouillage d’autres blocs définis par
l’utilisateur.

4. Sélectionnez le menu [Edit] → [Protect User Defined Block] depuis le bouton [Tools] de la feuille

« Device ».
La boîte de dialogue « Protect User Defined Block » s’affiche.
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Entrez le code PIN et cliquez sur OK pour attribuer le même code PIN à tous les blocs définis par l’utilisateur
dont le mode de verrouillage est « Protect ».
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Pour annuler la protection d’un bloc, procédez comme suit.

1. Sélectionnez le menu [Edit] → [Protect User Defined Block] depuis le bouton [Tools] de la feuille

« Device ».
La boîte de dialogue « Unprotect User Defined Block » (Annuler la protection du bloc défini par l’utilisateur)
s’affiche.

2. Entrez le code PIN qui a été indiqué lors du verrouillage, puis cliquez sur [OK].
La boîte de dialogue « Protect User Defined Block » s’affiche.

3. Décochez la case « Protect contents of locked User Defined Blocks » (Protéger le contenu des blocs
définis par l’utilisateur verrouillés).

4. Cliquez sur le bouton [OK].
La protection est désactivée. Le réglage [Lock Mode] est conservé.
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13.10.3. Texte

Cette zone est utilisée pour placer du texte dans la feuille de conception.
Vous pouvez également double-cliquer sur la zone affichée sous [Text] (Texte) et saisir du texte.
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13.11. Zone « Parameter Sets »

Un ensemble de paramètres stockés ou rappelés en tant qu’instantané est appelé un jeu de paramètres. Le
stockage d’un instantané enregistre les valeurs actuelles des éléments du jeu de paramètres. Un jeu de
paramètres peut stocker jusqu’à 100 instantanés. Un paramètre peut être enregistré dans plusieurs jeux de
paramètres.

L’enregistrement des paramètres dans un jeu de paramètres s’effectue de plusieurs manières, décrites ci-
dessous.

Source d’enregistrement Méthode d’enregistrement

Feuille de conception Tout en maintenant la touche < Ctrl > enfoncée, faites glisser un
composant et déposez-le sur le nom d’un jeu de paramètres.

Cliquez avec le bouton droit sur un composant et utilisez [Add to
Parameter Set] (Ajouter au jeu de paramètres) pour sélectionner le jeu de
paramètres dans lequel le composant doit être enregistré.

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser un
paramètre et déposez-le sur le nom d’un jeu de paramètres.

Zone « Parameters »*1 Faites glisser le composant ou le paramètre et déposez-le sur le nom d’un
jeu de paramètres.

Cliquez avec le bouton droit sur un composant ou un paramètre et utilisez
[Add to Parameter Set] pour sélectionner le jeu de paramètres dans lequel
le composant ou le paramètre sera enregistré.

Zone « Parameter Sets » Après avoir sélectionné le jeu de paramètres à enregistrer, cliquez sur le
bouton [Add Device] (Ajouter l’appareil) pour enregistrer tous les
composants placés sur ce point.

*1. Vous pouvez également utiliser les touches < Maj > ou < Ctrl > pour enregistrer simultanément plusieurs
composants ou paramètres au sein d’un jeu de paramètres.
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13.11.1. Parameter Sets

• Bouton [New]
Crée un nouveau jeu de paramètres.

• Bouton [Add Device]
Enregistre un appareil individuel dans un jeu de paramètres.

• Bouton [Delete]
Supprime le jeu de paramètres, l’unité DME7, le composant ou le paramètre sélectionné.


Si vous changez les éléments qui ont été enregistrés dans un jeu de paramètres, vous devez
écraser et enregistrer à nouveau les instantanés.

• Bouton [Duplicate]
Permet de dupliquer le jeu de paramètres sélectionné. Si vous souhaitez également dupliquer les
instantanés, cochez la commande [Duplicate Snapshots Also] (Dupliquer aussi les instantanés) dans la
boîte de dialogue « Duplicate » qui apparaît.

• Bouton [Recall Settings] (Rappeler les réglages)
Pour démarrer ou arrêter la lecture du fichier via la sortie GPI ou la carte SD en même temps que les
instantanés, utilisez la boîte de dialogue « Recall Settings » (Rappeler les réglages).
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• Parameter Set Name (Nom du jeu de paramètres)
Affiche le nom du jeu de paramètres. Vous pouvez double-cliquer sur le nom du jeu de paramètres pour le
modifier.



Le numéro affiché à côté du nom du jeu de paramètres est l’ID du jeu de paramètres. Vous
pouvez choisir cet identifiant lorsque vous rappelez un instantané via la commande du

protocole distant.
Pour modifier l’identifiant, faites un clic droit sur le nom du jeu de paramètres pour afficher le
menu contextuel, puis sélectionnez [Change ID] (Changer l’identifiant).


Si un jeu de paramètres de la zone « Parameter Sets » est sélectionné, appuyez sur une
touche alphabétique pour sélectionner le jeu de paramètres commençant par cette lettre.

• Protect
Si la fonction Protect est activée, vous ne pouvez pas modifier le jeu de paramètres ou enregistrer des

instantanés.

Cliquez ici pour activer la protection ( ) ou pour la désactiver(  ).
Faites un clic droit sur le nom du jeu de paramètres pour ouvrir le menu contextuel.

13.11.2. Snapshot

• Bouton [Store]
Permet de stocker (enregistrer) un instantané.

• Bouton [Recall]
Permet de rappeler un instantané.

• Bouton [Clear]
Permet de supprimer un instantané.

• Champ [Fade Time] (Temps de fondu)
Ce champ affiche le temps de fondu nécessaire pour modifier le niveau des composants de fader ou le
niveau d’envoi des composants de matrice qui sont enregistrés dans le jeu de paramètres. Double-cliquez
sur cette option pour ouvrir la boîte de dialogue « Fade Time ». Dans la boîte de dialogue qui apparaît,
choisissez la durée requise pour faire appliquer le changement. Vous pouvez aller jusqu’à trois heures.

13.11.3. Recall

• Power On Default
Vous pouvez choisir si un instantané est rappelé lors de la mise sous tension de l’unité. Si vous souhaitez
rappeler l’instantané actuellement sélectionné, appuyez sur le bouton [Set] (Définir) dans la boîte de

dialogue « Power On Default » (Mise sous tension par défaut).
Si l’instantané n’est pas affecté pour être rappelé, l’unité démarrera en utilisant le dernier réglage obtenu
juste avant la mise hors alimentation. Pour annuler l’affectation, cliquez sur [Clear] dans la boîte de
dialogue [Power on Default].
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• Emergency Recall (Rappel d’urgence)
Vous pouvez choisir si un instantané doit être rappelé lorsque le DME7 reçoit un signal EMG (Emergency)
(Urgence) provenant d’un appareil externe ou si la tension d’entrée sur le connecteur [GPI IN] (IN 16) (qui

prend en charge +24 V) tombe en dessous de 2,5 V.
Pour plus de détails sur la manière de régler ou d’effacer l’affectation, reportez-vous à la section relative à
la boîte de dialogue « Power On Default ».

13.11.4. Fonctions connexes

• Control Panel Recall (Rappel du panneau de commande)

Permet d’enregistrer l’instantané rappelé sur le panneau de commande de l’appareil.

Cliquez sur le bouton  pour l’enregistrer.

Cliquez sur le bouton  pour supprimer un instantané de la liste d’enregistrement.
Cliquez sur le bouton  pour supprimer tous les instantanés de la liste d’enregistrement.

Utilisez les boutons flèche du haut / flèche du bas pour modifier l’ordre des instantanés affichés sur le panneau
de l’appareil.
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13.11.5. Boîte de dialogue « Recall Settings » (Rappeler les réglages)

• GPI Out (Sortie GPI)

Vous définissez ici les réglages GPI OUT qui seront envoyés lorsque l’instantané est rappelé.
Vous pouvez utiliser la sortie GPI OUT pour contrôler un appareil relié au connecteur [GPI OUT] de cette

unité.

Boutons [Active]/[Inactive]/[Ignore]
Ces boutons permettent de choisir si la sortie du connecteur GPI OUT est activée (Active), activée avec un

OUTPUT TYPE inversé (Inactive) ou ignorée (Ignore).
Si le réglage [OUTPUT TYPE] de la boîte de dialogue GPI Output est sur [Pulse] (Impulsion) ou [Pulse Inv.]
(Impulsion inversée), les seuls choix disponibles sont [Active] et [Ignore].

◦ Si [Active] est défini
Lorsque [OUTPUT TYPE] est défini sur [Closed] (Fermé), la broche [GPI OUT] est fermée (reliée à la

terre).

Lorsque le réglage [OUTPUT TYPE] est sur [Open] (Ouvert), la broche [GPI OUT] est ouverte.
Lorsque le réglage [OUTPUT TYPE] est sur [Pulse] (Pulsation), la broche [GPI OUT] est fermée

(reliée à la terre) pendant environ 250 ms.
Lorsque [OUTPUT TYPE] est défini sur [Pulse Inv.], la broche [GPI OUT] est ouverte pendant environ
250 ms.

◦ Si [Inactive] est défini

Lorsque le réglage [OUTPUT TYPE] est sur [Closed], la broche [GPI OUT] est ouverte.
Lorsque le réglage [OUTPUT TYPE] est sur [Open], la broche [GPI OUT] est fermée (reliée à la terre).

◦ Si [Ignore] est défini
Il n’y a pas de changement dans la sortie. Utilisez ce réglage si une autre fonction est affectée à
GPI OUT et que vous ne souhaitez pas que cette fonction soit affectée par le rappel d’instantané.

• SD Song Play (Lecture du morceau SD)

◦ Pause
Permet d’arrêter de jouer le fichier immédiatement lorsqu’un instantané est rappelé.

◦ Play (Lecture)

Permet de jouer le fichier spécifié immédiatement lorsqu’un instantané est rappelé.
Vous pouvez lire les fichiers stockés sur la carte SD indiquée dans la boîte de dialogue « SD Card
File Manager ».
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13.12. Zone « Properties »

Dans cette zone, vous pouvez modifier les réglages du composant ou câblage actuellement sélectionné.

• Component
Cliquez sur le champ « Value » (Valeur) dans « Component » / « Form » afin de faire apparaître l’icône .
Cela permet d’ouvrir une boîte de dialogue pour changer le nombre de canaux du composant et d’autres

éléments.
Ces réglages ne peuvent pas être modifiés sur un composant n’affichant pas l’icône .

• Port
Si vous cliquez sur l’icône  qui apparaît lorsque vous cliquez sur la valeur « Label », la boîte de dialogue
Port Label s’affiche pour vous permettre de modifier les étiquettes de tous les ports du composant en
même temps.
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13.13. Zone « Parameters »

Cette zone affiche des informations sur le composant actuellement sélectionné dans la feuille de conception

(couche audio ou commande).
La partie supérieure de cette zone indique la capacité de traitement des signaux de chaque composant sous

forme de pourcentage.
La partie inférieure de cette zone répertorie les paramètres de l’élément actuellement sélectionné dans la partie

supérieure.
Si vous cochez la case dans la colonne « Control PINs » (Repères de commande), vous pourrez contrôler le
paramètre correspondant dans la couche Control.

Cette zone vous permet d’affecter des composants et des paramètres à un jeu de paramètres, à une liste de
configurations de commandes à distance, à une boîte de dialogue GPI, à une boîte de dialogue MIDI et à un
composant DCP. Pour plus de détails sur la manière de les affecter, reportez-vous à la section relative à la boîte
de dialogue ou à l’écran correspondant.

• Composants
Répertorie les composants actuellement sélectionnés dans la feuille.

◦ Processing (Traitement)
Indique les ressources qui vont être traitées sous la forme d’un pourcentage.

• Parameters
Répertorie les paramètres du composant actuellement sélectionné dans la partie supérieure.

◦ Control PINs
Si vous cochez la case dans cette colonne, vous pourrez contrôler le paramètre correspondant

dans la couche Control.
Immédiatement après avoir coché la case, le composant audio correspondant est placé dans la
couche de commande.
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13.14. Menu contextuel

13.14.1. Feuille de conception

Le menu contextuel suivant apparaît lorsque vous faites un clic droit sur une feuille de conception ne contenant
pas de composant.

Menu Description

[Paste] Colle le composant copié dans la feuille de conception.

[Select All] (Sélectionner tout) Sélectionne tous les composants et câblages de la feuille de conception.

[Close All Editor Windows] (Fermer
toutes les fenêtres de l’éditeur)

Ferme toutes les fenêtres de l’éditeur de composants et de réglage des
paramètres.

[Snap To Grid] (Aligner sur la grille) Lorsque cette option est cochée, les composants sont alignés sur la grille
de la feuille de conception.

[Layer Link] (Liaison de couches) Activez cette commande pour synchroniser (lier) la position du
composant audio entre la couche Audio et la couche Control.

13.14.2. Components

Lorsque vous faites un clic droit sur un composant, le menu contextuel suivant apparaît (les éléments ne sont
pas tous présents pour l’ensemble des composants).

Menu Description

[Open Component Editor] (Ouvrir
l’éditeur de composants)

Ouvre l’éditeur de composants.

[Cut] (Couper) Déplace l’élément sélectionné vers le tampon de copie.

[Copy] Copie le composant, y compris les réglages des paramètres de l’éditeur
de composants.

[Paste] Colle le composant copié dans la feuille de conception.

[Paste Parameters] (Coller les
paramètres)

Duplique le composant copié, y compris les réglages des paramètres de
l’éditeur de composants.

[Duplicate] Duplique le composant copié, y compris les réglages des paramètres de
l’éditeur de composants.

[Delete] Supprime le composant.

[Add to Parameter Set] Enregistre le composant dans le jeu de paramètres.

[Add to Remote Control List]
(Ajouter à la liste des commandes à
distance)

Enregistre tous les paramètres ou les indicateurs de niveau du

composant dans la liste des configurations de commandes à distance.
Si plusieurs composants sont enregistrés simultanément, ils le seront en
tant qu’indicateurs de niveau.

[Bring to Front] (Mettre au premier
plan)

Affiche le composant au premier plan.

[Send to Back] (Mettre en arrière-
plan)

Affiche le composant à l’arrière-plan.

[Unbundle Wires] Affiche les câblages connectés au composant sélectionné ou au bloc
défini par l’utilisateur séparés par des intervalles égaux.
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Menu Description

[Bundle Wires] Affiche les câblages connectés au composant sélectionné ou au bloc
défini par l’utilisateur superposés.

[Duplicate Port Label - to the right] Duplique le nom du port d’entrée du composant sélectionné sur les ports
d’entrée des composants en aval le long du chemin du signal.

[Duplicate Port Label - to the left] Duplique le nom du port d’entrée du composant sélectionné sur les ports
d’entrée des composants en amont le long du chemin du signal.

[Create User Defined Block] Intègre les composants sélectionnés en tant que bloc défini par
l’utilisateur.

13.14.3. Ports des composants

Menu Description

[Duplicate Port Label - to the right] Duplique le nom du port d’entrée correspondant au port d’entrée ou de
sortie sélectionné sur les ports d’entrée des composants en aval le long
du chemin du signal.

[Duplicate Port Label - to the left] Duplique le nom du port d’entrée correspondant au port d’entrée ou de
sortie sélectionné sur les ports d’entrée des composants en amont le long
du chemin du signal.

13.14.4. Fenêtres liées à l’éditeur de composants et aux réglages des paramètres.

Si vous cliquez sur un éditeur de composants ou sur une fenêtre de réglage des paramètres avec le bouton droit
de la souris, vous ouvrirez le menu contextuel décrit ci-après.

Menu Description

[Register as default values]
(Enregistrer comme valeurs par
défaut)

Enregistre les valeurs actuelles des paramètres du composant sous
forme de style en tant que valeurs par défaut. De nouveaux composants

seront placés avec les valeurs par défaut enregistrées.
En outre, ces dernières peuvent également être exportées/importées
comme fichier de style.

[Reset default values to Factory
Default] (Rétablir les valeurs par
défaut d’usine)

Rétablit les valeurs par défaut du composant aux valeurs telles qu’elles
étaient immédiatement après l’installation de ProVisionaire Design.

[Copy] Copie le composant, y compris les réglages des paramètres de l’éditeur
de composants.

[Paste Parameters] Si vous sélectionnez un composant existant du même type et activez
cette commande, les paramètres copiés du composant sont appliqués.

[Add to Parameter Set] Si vous exécutez cette commande sur un paramètre, celui-ci est

enregistré dans le jeu de paramètres.
Par contre, si vous exécutez cette commande ailleurs que sur un
paramètre, c’est le composant qui sera enregistré dans le jeu de
paramètres.
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Menu Description

[Add to Remote Control List] Si vous exécutez cette commande sur un paramètre, celui-ci est

enregistré dans la liste des configurations de commandes à distance.
Si vous exécutez cette commande ailleurs que sur un paramètre, tous les
paramètres ou les indicateurs de niveau du composant seront enregistrés
dans la liste de commande à distance.

13.14.5. Câblage

Faites un clic droit sur un élément pour ouvrir le menu contextuel suivant.

Menu Description

[Delete] Supprime le câblage.

[Bring to Front] Affiche le câblage sélectionné au premier plan.

[Send to Back] Affiche le câblage sélectionné à l’arrière-plan.

[Add to Transmitter & Receiver
Space] (Ajouter à l’espace émetteur
et récepteur)

Connecte les câblages aux composants de type émetteur et récepteur.

[Insert Node] (Insérer un nœud) Insère des nœuds sur le câblage. * Un nœud est le point de division d’un
fil.

[Remove Segment] (Supprimer le
segment)

Supprimer les câblages entre des nœuds.

13. Processeurs audio : DME7

170 | ProVisionaire Design V1.2 Guide d’utilisation



13.14.6. Zone « Parameter Sets »

Faites un clic droit sur un élément pour ouvrir le menu contextuel suivant.

Menu Description

[Find] (Rechercher) Recherche un composant ou son paramètre dans la feuille d’appareil.

[Delete] Supprime le jeu de paramètres. Les réglages de niveau inférieur sont
également supprimés.

[Change ID] (Changer d’ID) Modifie l’ID du jeu de paramètres. Le numéro affiché à côté du nom du jeu

de paramètres est l’ID du jeu de paramètres.
Vous devez utiliser cet ID lorsque vous rappelez un instantané via la
commande du protocole SCP.

13.14.7. Zone « Parameters »

Le menu contextuel suivant apparaît lorsque vous cliquez avec le bouton droit de la souris sur un paramètre.

Menu Description

[Find] Si vous exécutez cette opération sur un composant, le composant

correspondant dans la feuille de conception est sélectionné.
Si vous l’appliquez à un paramètre, l’éditeur de composants incluant le
paramètre correspondant s’ouvrira en ayant ce paramètre sélectionné.

[Add to Parameter Set] Si vous exécutez cette commande sur un paramètre, celui-ci est

enregistré dans le jeu de paramètres.
Si vous exécutez cette commande sur un paramètre, il en résulte que
celui-ci sera enregistré dans le jeu de paramètres.

[Add to Remote Control List] Si vous exécutez cette commande sur un paramètre, celui-ci est

enregistré dans la liste des configurations de commandes à distance.
Si vous exécutez cette commande ailleurs que sur un paramètre, tous les
paramètres ou les indicateurs de niveau du composant seront enregistrés

dans la liste de commande à distance.
Si vous essayez d’enregistrer un composant, une boîte de dialogue
s’affiche pour vous permettre de sélectionner la méthode
d’enregistrement.

Si vous essayez d’ajouter un composant à la liste de configurations de commandes à distance, la boîte de
dialogue suivante s’affiche.

• Bouton [All Parameters] (Tous les paramètres)
Permet d’enregistrer tous les paramètres du composant.

• Bouton [Parameter Type (define range)] (Type de paramètre - définir la plage)
Permet d’enregistrer tous les paramètres du composant par type.
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• Bouton [Metering only] (Mesure uniquement)
Permet d’enregistrer tous les indicateurs de niveau du composant par type.
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13.15. Boîte de dialogue

13.15.1. Boîte de dialogue « Compile »

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton d’outil [Compile] dans la feuille d’appareil.
Cette boîte analyse le placement et le câblage des composants du système DME7 afin de détecter les éventuels
problèmes. Vous pouvez également afficher ici des statistiques telles que le taux d’utilisation des ressources.

•  /Message
Indique si la compilation a réussi ou non. En cas de réussite, le message « Compile Successful »
(Compilation réussie) est affiché. En cas d’échec, le message « Fail to Compile » (Échec de la
compilation) est affiché.

• Bouton 
Cliquez ici pour afficher la méthode de dépannage.

• [Device Information] (Informations sur l’appareil)
Cette zone affiche des informations sur l’appareil.

• Liste des appareils

◦ Unit ID / Model / Device Name

Ces lignes indiquent l’ID d’unité de l’appareil, le nom du modèle et le nom de l’appareil.
Pour modifier le nom de l’appareil, utilisez le champ [Device Name] dans la zone « Properties » de
la feuille « Project ».

• [Capacity Information] (Informations sur la capacité)

◦ Virtual Device (Appareil virtuel)
Ce champ indique la capacité de traitement des signaux spécifiée dans le champ « Capacity » de la
zone « Properties » de l’appareil.

◦ Actual Device (Appareil réel)
Ce champ indique la capacité réelle de traitement des signaux d’un appareil telle que détectée par
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ProVisionaire Design.
Si ce champ indique une valeur, la compilation sera exécutée sur la base de cette capacité de
traitement des signaux.

• [Result] (Résultat)
Cette zone affiche les résultats de la compilation. Le DME7 ne peut être mis en ligne que si la compilation
réussit.

◦ Total Signal Processing (Traitement total du signal)

Indique le taux d’utilisation de toutes les unités de traitement des signaux de l’appareil.
(Informations supplémentaires) L’appareil traite les signaux à l’aide de ses multiples unités de

traitement de signaux.
La ligne « Total Signal Processing » indique le pourcentage de la capacité réelle utilisée (taux
d’utilisation) par rapport à la somme de la capacité maximale de traitement du signal de toutes les
unités, qui représente 100 %.

◦ Processing

Indique le taux d’utilisation maximum de chaque unité de traitement des signaux de l’appareil.
Plus le chemin du signal est long ou plus le nombre d’entrées et de sorties des composants est
élevé, plus la vitesse d’utilisation risque d’augmenter.

◦ Memory Usage (Utilisation de la mémoire)
Si la mémoire utilisée de l’appareil dépasse la quantité de mémoire autorisée, ce champ indique
« NG ».

◦ Latency (Latence)

Indique la latence des signaux audio entre l’entrée Dante et la sortie Dante dans l’unité DME7.
(Informations complémentaires) Indique la latence maximale sur le chemin du signal. La latence
qui se produit à l’intérieur du composant n’est pas prise en compte.

◦ License (Licence)

La latence qui se produit à l’intérieur du composant n’est pas prise en compte.

Indique qu’il y a trop ou trop peu de licences d’appareil.
Si ce champ indique « NG », vous pourrez résoudre le problème en achetant des licences

supplémentaires.
Pour plus de détails à ce sujet, reportez-vous à la section« Licence requise ».

• [Information]
Cette zone affiche des détails sur la compilation.

• [Component unavailable due to missing license] (Composant indisponible pour cause de licence

manquante)
Cette zone affiche les noms des composants qui ne fonctionnent pas, ainsi que la licence requise pour
ceux-ci.

• [Required License] (Licence requise)
Cette zone affiche le nom des licences requises et leur nombre.

• Bouton [Close]
Ferme la boîte de dialogue.

13. Processeurs audio : DME7

174 | ProVisionaire Design V1.2 Guide d’utilisation



La capture d’écran suivante montre ce qui s’affiche si la compilation échoue.
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13.15.2. Boîte de dialogue « Remote Control Setup List » (Liste de configurations de
commandes à distance)

Pour ouvrir cette boîte de dialogue, cliquez sur [Remote Control Setup List] à partir du bouton [Tools] dans la

feuille d’appareil.
Pour commander ou contrôler le DME7 à l’aide du protocole de communication SCP ou YOSC, vous devez
enregistrer les paramètres ou les niveaux dans la Remote Control Setup List.


Pour plus de détails sur les protocoles de communication, reportez-vous à la section
« Caractéristiques techniques du protocole de commande à distance DME7 » ou
« Caractéristiques techniques du DME7 OSC » disponibles sur le site web de Yamaha Pro
Audio.

■ Enregistrement des paramètres ou des niveaux dans la liste

Vous pouvez enregistrer des paramètres ou des niveaux dans les listes à l’aide de l’une des méthodes
suivantes :

Source d’enregistrement Méthode d’enregistrement

Feuille de conception Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
composant et déposez-le dans la liste.

Cliquez avec le bouton droit sur un composant, puis sélectionnez
[Add to Remote Control List].

Éditeur de composants/
Fenêtre de réglage des
paramètres

【Parameter】
Tout en maintenant la touche < Ctrl > enfoncée, faites glisser un

paramètre et déposez-le dans la liste.
Faites un clic droit sur un paramètre, puis sélectionnez [Add to
Remote Control List].

【Component】
Faites un clic droit ailleurs que sur un paramètre, puis
sélectionnez [Add to Remote Control List].

Zone « Parameters »*1 Faites glisser un composant ou un paramètre et déposez-le dans

la liste.
Faites un clic droit sur un composant ou un paramètre, puis
sélectionnez [Add to Remote Control List].

*1. Vous pouvez également utiliser les touches< Maj > ou < Ctrl > pour enregistrer simultanément plusieurs
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paramètres dans une liste.
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• Si vous essayez d’ajouter un composant à la liste, la boîte de dialogue suivante s’affiche.

◦ Bouton [All Parameters]
Permet d’enregistrer tous les paramètres du composant.

◦ Bouton [Parameter Type (define range)]

Permet d’enregistrer tous les paramètres du composant par type.

Indique la valeur X et la valeur Y (tels que les canaux) du paramètre enregistré.

Utilisez le contrôleur externe pour régler les canaux sur « any ».
Pour plus de détails à ce sujet, reportez-vous à la section « Caractéristiques du protocole de
commande à distance DME7 ».

◦ Bouton [Metering only]
Permet d’enregistrer tous les indicateurs de niveau du composant par type.

• [Function]
Affiche le type d’élément qui est enregistré dans la liste.

• [< Ctrl >drag-and-drop component/parameter/meter.] (< Ctrl >  glisser-déposer le

composant/paramètre/indicateur de niveau)
Affiche l’élément qui est enregistré dans la liste.

• [X]/[Y]

Indique la valeur X et la valeur Y (tels que les canaux) du paramètre enregistré.

Vous pouvez modifier les canaux après que le paramètre ait été enregistré.
S’il s’agit d’un paramètre réglable, cliquer sur cette colonne permet d’ouvrir une boîte de dialogue afin d’en
modifier la plage.

Si vous sélectionnez « any », vous serez en mesure de choisir la valeur par le biais du contrôleur.
Paramétrer les canaux via le contrôleur vous permet de réduire le nombre de paramètres qui doivent être
enregistrés dans la liste. Pour plus de détails à ce sujet, reportez-vous à la section « Caractéristiques du
protocole de commande à distance DME7 ».

• [Min]/[Max]
Permet de paramétrer la plage de valeurs d’un paramètre pouvant être manipulé à partir du contrôleur.
Dans le cas d’un paramètre de type niveau pour lequel une valeur min/max peut être spécifiée, cliquez
pour ouvrir une boîte de dialogue dans laquelle vous pouvez spécifier la plage de valeurs.

• [Type]
Affiche le type de composant dont le paramètre est enregistré dans la liste.

• [Cmp ID] (ID du composant)
Indique l’ID du composant. Cet ID apparaît à la fin du nom du composant dans la zone « Parameters ».
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• Bouton 
Permet de naviguer entre les pages.

• Options de menu qui apparaissent lorsque vous cliquez sur le menu [ ] ou que vous cliquez avec le
bouton droit sur la boîte de dialogue

◦ Find
Permet d’ouvrir l’éditeur de composants pour le paramètre ou l’indicateur de niveau de la ligne
actuellement sélectionnée.

◦ Cut
Permet de couper la ligne actuellement sélectionnée.

◦ Copy
Permet de copier la ligne actuellement sélectionnée.

◦ Paste
Permet de coller la ligne copiée.

◦ Insert
Permet d’insérer la ligne copiée.

◦ Delete
Permet de supprimer la ligne actuellement sélectionnée.

◦ Swap
Permet de permuter la position de la ligne actuellement sélectionnée.

• Bouton [Clear]
Permet d’effacer la ligne actuellement sélectionnée. Vous pouvez utiliser les touches < Ctrl > ou < Maj >
pour sélectionner plusieurs éléments en même temps.

• Bouton [Clear All]
Permet d’effacer tous les paramètres ou les niveaux enregistrés.

• Bouton [Export] (Exporter)
Permet d’exporter la liste dans un fichier au format .csv.

• Bouton [Search] (Rechercher)
Permet d’ouvrir la boîte de dialogue « Search » pour effectuer une recherche dans la liste dans la boîte de
dialogue « Remote Control Setup List ».

• Bouton [String Display] (Affichage de chaînes)/[Numeric] (Numérique)

Permet de changer le mode d’affichage dans les colonnes [MIN] et [MAX].

String Display : Affiche le format utilisé dans l’éditeur de composants.
Numeric : Affiche la valeur interne.

• Bouton [OK]
Applique les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Ferme la boîte de dialogue sans mettre à jour les réglages.

• Bouton [Apply]
Permet de mettre à jour les nouveaux réglages.
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■Boîte de dialogue « Search » permettant d’effectuer des recherches dans la liste

Utilisez cette boîte de dialogue pour lancer une recherche dans la boîte de dialogue « Remote Control Setup
List ».

• Zone de liste [Look In:] (Rechercher dans)
Permet de sélectionner l’emplacement à rechercher.

• Zone de texte/liste [Search for:] (Rechercher)
Une liste apparaît si vous sélectionnez [FUNCTION] dans la liste [Look In:] ; sinon, une zone de texte est

affichée.
Sélectionnez l’élément à rechercher ou entrez du texte.

• Bouton [Search All] (Rechercher tout)
Permet de lancer une recherche dans la liste selon les critères spécifiés et affiche les résultats ci-

dessous.
Lorsque vous cliquez sur un des éléments répertoriés dans la liste affichée des résultats de la recherche,
le curseur se déplace vers l’élément correspondant dans la boîte de dialogue « Remote Control Setup
List ».

• Bouton [Search Next] (Rechercher suivant)
Permet de lancer une recherche en fonction des critères choisis et déplace le curseur vers l’élément
trouvé dans la boîte de dialogue « Remote Control Setup List ». Si vous appuyez de nouveau sur ce
bouton, le curseur passe au résultat de recherche suivant.

• Bouton [Close]
Ferme la boîte de dialogue.
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13.15.3. Boîte de dialogue « SD Card File Manager »

Dans les boutons [Tools] de la feuille d’appareil, cliquez sur [SD Card File Manager] pour ouvrir cette boîte de

dialogue.

Cette boîte de dialogue permet d’enregistrer les fichiers que vous souhaitez lire sur la carte SD.
La liste de cette boîte de dialogue permet également de lire des fichiers via le DCP ou GPI.

• Bouton [Edit]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « SD Card File Settings ».

• Bouton Menu 
Cliquez sur ce bouton pour ouvrir le menu contextuel suivant.

◦ Copy
Permet de copier les réglages de la ligne actuellement sélectionnée.

◦ Paste
Permet de coller le contenu copié dans la ligne actuellement sélectionnée ou dans la boîte de
dialogue « SD Card File Manager » d’autres appareils.

◦ Clear
Permet de supprimer les réglages de la ligne actuellement sélectionnée.

◦ Copy All (Copier tout)
Permet de copier tous les réglages.

◦ Clear All (Effacer tout)
Permet de supprimer tous les réglages.

• Liste
Si aucun fichier ou dossier n’est spécifié, l’indication « No Assign » (Aucune affectation) apparaît.

◦ No. (N°)
Vous pouvez affecter les lignes 001 à 100.

◦ Type
Si vous avez sélectionné « Play 1 Song » (Lire 1 morceau) pour « File/Folder » (Fichier/Dossier)
dans la boîte de dialogue « SD Card File Settings », « 1 Song » (1 morceau) apparaît dans cette
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colonne. Si vous sélectionnez « Play all songs in a folder » (Lire tous les morceaux d’un dossier),
« Folder » (Dossier) apparaîtra dans cette colonne.

◦ File/Folder (Fichier/Dossier)
Indique le nom du fichier ou du dossier.

◦ Play Mode (Mode de lecture)
Indique le mode de lecture choisi.

◦ Go to the top (Retourner en haut)
Indique le réglage coché dans [Go to the top when playback stops] (Retourner au début lorsque la
lecture s’arrête).

◦ Interval (Intervalle)
Affiche la durée de l’intervalle.

•
Flèches haut et bas 
Permettent de changer la position de la ligne actuellement sélectionnée.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Permet de fermer la boîte de dialogue sans enregistrer les modifications.

Boîte de dialogue « SD Card File Settings » (Réglages des fichiers de la carte SD)

【Folder/File】
Permet de choisir le fichier à lire.

• Case d’option [Play 1 song] / [Play all songs in a folder]

Si vous choisissez [Play 1 song], seul le fichier actuellement sélectionné dans [SD CARD:/] sera lu.
Si vous sélectionnez [Play all songs in a folder], tous les fichiers enregistrés dans le dossier sélectionné
de [SD CARD:/] seront lus.

• [SD CARD:/]

Ceci affiche le nom du fichier ou dossier de lecture. Vous pouvez modifier le nom ou le saisir directement.

Si [Play 1 song] est sélectionné
Les formats de fichier et de dossier suivants peuvent s’afficher.

◦ (nom du dossier)\(nom du fichier).mp3

◦ (nom du dossier)\(nom du fichier).wav

◦ (nom du fichier).mp3

◦ (nom du fichier).wav
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• Si [Play all songs in a folder] est sélectionné
Les formats de dossier suivants peuvent s’afficher.

◦ (nom du dossier)

◦ vide


- Seuls les dossiers de premier niveau sont valides.
- Si le nom du dossier est vide, tous les fichiers situés à la racine de la carte mémoire SD
seront lus (les dossiers en-dessous de la racine ne seront pas inclus).

• Bouton [Browse] (Parcourir)
Lorsque vous cliquez sur ce bouton, un écran s’affiche pour vous permettre de sélectionner le fichier ou le

dossier à lire.

Si vous avez choisi [Play 1 song] (Lire 1 morceau), sélectionnez un fichier.
Si vous avez choisi [Play all songs in a folder] (Lire tous les morceaux d’un dossier), sélectionnez un
dossier.

【Play Mode】(Mode de lecture)

• [Normal]/[Repeat] (Répétition)/[Shuffle Repeat] (Répétition aléatoire)

Indique le mode de lecture du fichier ou des fichiers.

Si vous choisissez [Normal], le ou les fichiers dans le dossier seront lus une seule fois.

Si vous choisissez [Repeat], le ou les fichiers dans le dossier seront lus en boucle.
Si vous choisissez [Shuffle Repeat], les fichiers dans le dossier seront lus en boucle dans un ordre
aléatoire. Si vous choisissez [Play 1 song] dans [Folder/File], le réglage [Shuffle Repeat] ne sera pas
disponible.

• Case à cocher [Go to the top when playback stops.] (Retourner au début lorsque la lecture s’arrête.)
Lorsque vous arrêtez la lecture du fichier, ce bouton vous permet d’indiquer si le morceau est mis en

pause à l’endroit où vous vous êtes arrêté ou si vous retournerez au début du fichier.
Si cette fonction est sur « On », la lecture reprend au début du fichier (s’il n’y en a qu’un) ou au début du

premier fichier du dossier.
Si cette fonction est sur « Off », la lecture reprend à partir de l’endroit où vous avez arrêté.

【Interval】 (Intervalle)
Indique l’intervalle entre deux fichiers joués consécutivement.

• Time (sec) (Temps en secondes)
Permet de définir la durée de l’intervalle entre 0,0 s et10,0 s avec un pas de 0,1 s.


Si la lecture d’un autre fichier est lancée alors que le fichier actuel est toujours en cours de
lecture, la lecture en cours s’arrête et la lecture de l’autre fichier démarre.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Permet de fermer la boîte de dialogue sans enregistrer les modifications.
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13.15.4. Boîte de dialogue « GPI »

Pour ouvrir cette boîte de dialogue, cliquez sur [GPI] dans les boutons [Tools] de la feuille d’appareil.
GPI signifie « General Purpose Interface » (Interface à usage général). L’utilisation des entrées/sorties GPI vous
permet de contrôler le DME7 à distance à partir de contrôleurs personnalisés ou de appareils externes. Un
contrôleur relié au connecteur d’entrée GPI peut être utilisé pour changer les instantanés sur le DME7 ou
contrôler les paramètres des composants.

Des appareils d’affichage tels que des DEL et des lampes, ou des équipements de commande externes produits
par d’autres fabricants, peuvent être reliés au connecteur de sortie GPI, ce qui vous permet de contrôler l’appareil

externe en tenant compte des présélections ou des paramètres.
Pour plus de détails sur le matériel, par exemple sur la manière de connecter le connecteur [GPI], reportez-vous
au mode d’emploi de l’unité concernée.

Il existe deux méthodes pour configurer l’entrée GPI.

・ Utilisation de la boîte de dialogue « GPI Input », accessible à partir des boutons [Tools] dans la feuille

d’appareil.
Utilisez cette méthode pour envoyer une fonction unique via un port unique.

・Ajout du composant « GPI Input » à la couche Control dans la feuille d’appareil et utilisation de l’éditeur pour

le configurer.
Utilisez cette méthode si vous souhaitez envoyer plusieurs paramètres ou fonctions simultanément via un port

unique, ou si vous voulez effectuer une opération complexe en combinant plusieurs composants de contrôle.
* Pour l’entrée GPI, les réglages de la boîte de dialogue et ceux du composant GPI Input de la couche Control
sont envoyés simultanément.

Il existe deux méthodes pour configurer la sortie GPI.

・ Utilisation de la boîte de dialogue « GPI Output », accessible à partir des boutons [Tools] dans la feuille

d’appareil.
Utilisez cette méthode pour envoyer un signal basé sur une seule opération via un port de sortie unique.

・Ajout du composant « GPI Output » à la couche Control dans la feuille d’appareil et utilisation de l’éditeur

pour le configurer.
Utilisez cette méthode si vous souhaitez créer un signal basé sur plusieurs opérations via un port de sortie

unique, ou si vous voulez effectuer une opération complexe en combinant plusieurs composants de contrôle.
* Le réglage Output Port Type est commun entre cette boîte de dialogue et le composant GPI Output de la
couche Control.

■ Opérations appliquées à la fois à la boîte de dialogue « GPI Input » et « GPI Output »

• Bouton [Clear All]
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Permet de réinitialiser les réglages de tous les ports.

• Boutons de sélection [Port]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Settings ».

• Bouton [OK]
Permet d’appliquer le réglage et de fermer la boîte de dialogue.

• Bouton [Cancel]
Permet d’annuler les réglages et de fermer la boîte de dialogue.

• Function
Indique les fonctions affectées au port correspondant.

• Parameter
Indique les paramètres affectés au port correspondant.

■ Enregistrement d’un paramètre ou d’un instantané

Faites glisser un instantané ou un paramètre et déposez-le dans zone verte. La colonne « Function » indique
automatiquement le nom de la fonction correspondante.

Source d’enregistrement Méthode d’enregistrement

Zone « Parameter Sets » Faites glisser un instantané et déposez-le dans la zone verte.

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser un
paramètre et déposez-le dans la zone verte.

Zone « Parameters » Faites glisser un paramètre et déposez-le dans la zone verte.

■ Boîte de dialogue [GPI Input]

Cette boîte de dialogue indique comment les connecteurs [GPI IN] de l’appareil sont configurés.
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• [Voltage] (Tension)

Indique la valeur actuelle de la tension d’entrée lorsque l’appareil est en ligne.
Seul le connecteur [GPI IN] n° 16 prend en charge l’entrée d’urgence (entrée de +24 V).

Boîte de dialogue « Settings »

Function

• [SD Play] (Lecture SD)

◦ SD Song Select & Play (Sélection et lecture d’un morceau SD)
Permet de lire le fichier indiqué dans la boîte de dialogue « SD Card File Manager ».

◦ SD Song Pause (Mise en pause du morceau SD)
Permet de mettre en pause la lecture du fichier.

• [Snapshot Recall] (Rappel d’instantané)
Permet de rappeler l’instantané.

• [Parameter]
Permet de modifier le paramètre affecté.

Lorsque Control Type (Type de contrôle) est défini sur Parameter Value Edit (Modifier la valeur du
paramètre)

Vous pouvez modifier le paramètre affecté dans la limite de la plage indiquée.
Cliquez sur le champ Lower Limit (Limite inférieure) ou Upper Limit (Limite supérieure) pour afficher
l’opérateur.

Lorsque Control Type est défini sur Direct Parameter Value (Valeur directe du paramètre)

Vous pouvez régler le paramètre affecté sur une valeur spécifique.
Cliquez sur le champ « Value » (Valeur) pour afficher l’opérateur.
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• [Device Mute]
Coupe le son de l’appareil.

• [GPI Lock] (Verrouillage GPI)
Permet de désactiver toutes les entrées provenant des ports [GPI IN], autres que celles verrouillées par
« GPI Lock ».

• [Emergency In] (Entrée d’urgence)
Permet de mettre l’appareil en mode Emergency. Seul le port n° 16 prend en charge le mode Emergency.

◦ Mode Emergency (Urgence)
Le DME7 passe en mode Emergency s’il reçoit la commande d’urgence « devmode » du SCP ou

lorsque le connecteur [GPI IN] (IN 16) (qui prend en charge +24 V) reçoit moins de 2,5 V en entrée.
Dans ce mode, l’unité fonctionne comme suit.

▪ L’unité rappelle l’instantané configuré dans [Emergency Recall], auquel vous pouvez accéder
à partir de [Parameter Sets]. Lorsque le mode Emergency s’arrête, l’appareil revient à l’état
qui précède le rappel de l’instantané.

▪ Les opérations provenant d’un contrôleur externe telles qu’un DCP ne seront plus reçues.

▪ L’unité est mise hors ligne à partir de ProVisionaire Design.

■ Input Type (Type d’entrée)

Exemples de connexions qui utilisent le connecteur [GPI IN]

• Exemple de connexion 1 :
Contrôle du DME7 à l’aide d’un commutateur

• Exemple de connexion 2 :
Contrôle du DME7 à l’aide d’une résistance variable à courbe B de 10 kΩ

• [INPUT TYPE] (Type d’entrée) permet de configurer les éléments suivants.
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◦  Analog (Analogique)

◦  Analog Inv. (Analogique inversé)

◦  High Active (Hautement actif)

◦  Low Active (Faiblement actif)

◦  Rising Edge (Front montant)

◦  Falling Edge (Front descendant)
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

• La valeur seuil pour l’activation et la désactivation est la valeur centrale entre les valeurs de
tension d’entrée maximale et minimale (soit la somme de la valeur maximale et de la valeur
minimale, divisée par deux). Pour éviter les dysfonctionnements, laissez une marge de

détection suffisante (voir la boîte de dialogue « GPI Calibration »).
• Si la tension chute en raison de la longueur du câble ou du bruit, utilisez la boîte de dialogue
« GPI Calibration » pour ajuster les valeurs maximale et minimale de tension d’entrée. Étant
donné que la tension risque de devenir instable, configurez et installez votre circuit externe de
manière à garantir une grande amplitude entre les valeurs maximale et minimale.

【  Analog】 (Analogique)
Vous pouvez sélectionner cette option si vous avez affecté un paramètre qui change de manière continue à la
catégorie [Parameter Value Edit] (Édition de la valeur du paramètre).

• Le niveau est à sa valeur maximale lorsque la tension d’entrée sur le GPI IN est au maximum (5 V) et à sa
valeur minimale lorsque la tension d’entrée est au minimum (0 V).

【  Analog Inv.】 (Analogique inversé)
Vous pouvez sélectionner cette option si vous avez affecté un paramètre qui change de manière continue à la
catégorie [Parameter Value Edit].

• Le niveau est à sa valeur minimale lorsque la tension d’entrée sur le GPI IN est au maximum (5 V) et à sa
valeur maximale lorsque la tension d’entrée est au minimum (0 V).

【  High Active】 (Hautement actif)
Vous pouvez sélectionner cette option si l’une des fonctions suivantes a été affectée.

• Device Mute

• GPI Lock
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• La fonction s’active lorsque la tension d’entrée du GPI IN dépasse la tension centrale et se désactive
lorsqu’elle tombe en deçà de la tension centrale.

【  Low Active】(Faiblement actif)
Vous pouvez sélectionner cette option si l’une des fonctions suivantes a été affectée.

• Device Mute

• GPI Lock

• La fonction se désactive lorsque la tension d’entrée du GPI IN dépasse la tension centrale et s’active
lorsqu’elle tombe en deçà de la tension centrale.

【  Rising Edge】 (Front montant)
Vous pouvez sélectionner cette option si l’une des fonctions suivantes a été affectée.

• On/Off

• SD Song Select & Play/ SD Song Pause

• Snapshot

• Parameter > Direct Parameter Value

• Device Mute

• GPI Lock

• La fonction affectée est exécutée si la tension d’entrée sur le connecteur [GPI IN] passe de en-dessous à
au-dessus de la tension moyenne.

【  Falling Edge】 (Front descendant)
Vous pouvez sélectionner cette option si l’une des fonctions suivantes a été affectée.

• On/Off

• SD Song Select & Play/ SD Song Pause

• Snapshot

• Parameter > Direct Parameter Value

• Device Mute

• GPI Lock
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• La fonction affectée est exécutée si la tension d’entrée sur le connecteur [GPI IN] passe de au-dessus à
en-dessous de la valeur moyenne de tension.

■ Boîte de dialogue GPI Output

• Bouton [Active] / bouton [Inactive]
Appuyez sur ce bouton tandis que l’appareil est en ligne pour envoyer un signal de test au niveau de la

sortie GPI en fonction du réglage Output Type (Type de sortie).
Pour plus de détails à ce sujet, reportez-vous aux explications fournies dans la section « Output Type » .

Boîte de dialogue « Settings »

Function

• [SD Song Play]
La commande est envoyée via le connecteur [GPI OUT] lorsque vous lancez la lecture d’un fichier de la
carte SD.

• [Parameter]
La commande est envoyée via le connecteur [GPI OUT] lorsque la valeur du paramètre atteint l’état
indiqué.
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• [GPI Lock]
Le statut « GPI Lock » (Verrouillage GPI) est envoyé via le connecteur [GPI OUT].

• [Alert]
La commande est envoyée via connecteur [GPI OUT] en cas d’alerte spécifique.

■ Output Type (Type de sortie)

Exemples de connexion via le connecteur [GPI OUT]

• [OUTPUT TYPE] permet les réglages suivants.

◦  Closed

◦  Open

◦  Pulse

◦  Pulse Inv.

•  Closed

Lorsque la fonction choisie [Function] passe dans l’état sélectionné, le contact se ferme.

Si [Parameter Value Edit] est sélectionné, le contact se ferme lorsque le seuil indiqué est dépassé.
Si [Direct Parameter Value] est sélectionné, le contact se ferme lorsque la valeur indiquée est atteinte.

◦ Appuyez sur le bouton [Active] pour fermer le contact.

◦ Appuyez sur le bouton [Inactive] pour ouvrir le contact.

•  Open

Lorsque la fonction choisie dans [Function] passe dans l’état sélectionné, le contact s’ouvre.

Si [Parameter Value Edit] est sélectionné, le contact s’ouvre lorsque le seuil indiqué est dépassé.
Si [Direct Parameter Value] est sélectionné, le contact s’ouvre lorsque la valeur indiquée est atteinte.

◦ Appuyez sur le bouton [Active] pour ouvrir le contact.

◦ Appuyez sur le bouton [Inactive] pour fermer le contact.

•  Pulse
Si la colonne [Direction] indique [Upward] (Vers le haut), le contact s’ouvre pendant environ 250 ms

lorsque la fonction choisie dans [Function] passe dans l’état sélectionné.
Si [Parameter Value Edit] est sélectionné, le contact se ferme pendant environ 250 ms lorsque la valeur

dépasse le seuil.
Si la colonne [Direction] indique [Downward] (Vers le bas), le contact s’ouvre pendant environ 250 ms

lorsque la fonction choisie dans [Function] n’est plus dans l’état sélectionné.
Si [Parameter Value Edit] est sélectionné, le contact se ferme pendant environ 250 ms lorsque la valeur
passe en-deçà du seuil.

◦ Appuyez sur le bouton [Active] pour ouvrir le contact pendant 250 ms.

◦ Le bouton [Inactive] est désactivé.
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•  Pulse Inv.
Si la colonne [Direction] indique [Upward] (Vers le haut), le contact s’ouvre pendant environ 250 ms

lorsque la fonction choisie dans [Function] passe dans l’état sélectionné.
Si [Parameter Value Edit] est sélectionné, le contact s’ouvre pendant environ 250 ms lorsque la valeur

dépasse le seuil.
Si la colonne [Direction] indique [Downward] (Vers le bas), le contact s’ouvre pendant environ 250 ms

lorsque la fonction choisie dans [Function] n’est plus dans l’état sélectionné.
Si [Parameter Value Edit] est sélectionné, le contact s’ouvre pendant environ 250 ms lorsque la valeur
passe en-deçà du seuil.

◦ Appuyez sur le bouton [Active] pour ouvrir le contact pendant 250 ms.

◦ Le bouton [Inactive] est désactivé.
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13.15.5. Boîte de dialogue « MIDI »

Pour ouvrir cette boîte de dialogue, cliquez sur [MIDI] dans les boutons [Tools] de la feuille d’appareil.

Vous pouvez contrôler le DME7 via le MIDI. Vous pouvez également contrôler le réglage à partir du DME7.
En outre, vous pouvez modifier les réglages lorsque l’appareil est en ligne.

■　Affectation des éléments à la liste

Vous pouvez affecter des éléments à la liste à l’aide de l’une des méthodes suivantes.

Source d’enregistrement Méthode d’enregistrement

Zone « Parameter Sets » Faites glisser un instantané et déposez-le dans la zone verte de
l’écran « Program Change » (Changement de programme).

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
paramètre et déposez-le dans la zone verte de l’écran « Control
Change » (Changement de contrôle).

Zone « Parameter Sets » Faites glisser un paramètre et déposez-le dans la zone verte de
l’écran « Control Change ».

■  Réglages MIDI usuels

• Channel (Canal)

◦ Tx (Transmission)
Permet de choisir parmi les canaux de transmission MIDI (1-16).

◦ Rx (Réception)
Permet de choisir parmi les canaux de réception MIDI (1-16).

◦ Program Change
Permet d’activer ou de désactiver Program Change Tx (canal de transmission) et Rx (canal de

réception).
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Si le paramètre OMNI est sur [ON], tous les messages Program Change sont reçus, quel que soit le
réglage du canal de réception. (Ceci s’applique uniquement aux canaux de réception. Un canal

unique est utilisé pour la transmission.)
Si le paramètre ECHO est sur [ON], tous les messages Program Change reçus depuis un appareil
externe ressortiront sans modification.

◦ Control Change
Permet d’activer ou de désactiver le Tx (Canal de transmission) et le Rx (Canal de réception) du

Control Change.
Si le paramètre OMNI est sur [ON], tous les messages Control Change sont reçus, quel que soit le
réglage du canal de réception. (Ceci s’applique uniquement aux canaux de réception. Un canal

unique est utilisé pour la transmission.)
Si le paramètre ECHO est sur [ON], tous les messages Control Change reçus depuis un appareil
externe ressortiront sans modification.

• Onglets de commutation Program Change/Control Change
Ces onglets permettent de basculer entre les écrans de réglage Program Change et Control Change.

• Bouton [Clear]
Permet d’effacer les réglages de la ligne actuellement sélectionnée.

• Bouton [Clear All]
Permet d’effacer les réglages de toutes les lignes.

■  Onglet [Program Change]

Permet d’affecter des instantanés à des numéros 1 à 128 pour changer de programme. Change de scène
lorsque les changements de programme sont reçus. Il est possible d’effectuer jusqu’à 999 affectations. Les
instantanés au-delà du numéro 128 sont affectés en choisissant une autre banque.

• Bouton [Bank Select LSB] (Sélection de banque LSB)
Les banques 0-7 sont disponibles. Choisissez un numéro de 001 à 128 dans chaque banque.

• Liste de changements de programmes
La liste au centre indique les numéros de changement de programme et le réglage actuel.

◦ No.
Indique le numéro de changement de programme.
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◦ Drag-and-drop Snapshot into this area. (Glisser-déposer les instantanés dans cette zone)
Indique le nom des instantanés enregistrés.
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■  Onglet [Control Change]

Permet d’affecter des composants au changement de commande pour chaque DME. Vous pouvez changer les
paramètres de DME en envoyant des messages de changement de commande à partir d’un équipement

extérieur.
Vous pouvez affecter au changement de commande les numéros 1-31, 33-95 et 102-119.


Les numéros de changement de commande 0 et 32 sont utilisés pour la sélection de banque
MSB, les numéros 96 à 101 sont liés au RPN/NRPN et les numéros 120 à 127 sont utilisés
pour les messages de mode. Ils ne peuvent donc pas être utilisés pour l’affectation de
composants.

• Liste de changements de commande
Les numéros des changement de commande et les réglages actuels s’affichent dans la liste au centre.

◦ No.
Affiche les numéros des changement de commande.

◦ < Ctrl >+drag-and-drop DME parameter into this area. (< Ctrl > + glisser-déposer le paramètre

DME dans cette zone)
Indique le nom des paramètres enregistrés.

◦ Min/Max
Permet de spécifier la plage de modification des paramètres. Cliquez sur le champ pour afficher

l’opérateur.
Vous pouvez modifier le paramètre en faisant glisser le curseur.
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13.16. Liste des messages

Les messages affichés par l’écran DME7 et leurs contre-mesures sont :

ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30002 EXT TEMP Limit
(Limite de

température
extérieure)

- La température
environnante est
supérieure à la
limite supportée
par l’appareil.
Vérifiez le flux
d’air.

- -

30009 FAN

Rotation
Error (Erreur de

rotation du
ventilateur)

- La vitesse de
rotation du
ventilateur est hors
contrôle. Veuillez
vérifier que la
rotation du
ventilateur n’est
pas entravée par
un élément
extérieur.

- Ventilateur à
l’arrêt. Contactez
un technicien
Yamaha.

30010 Fan

Lifespan
Warning

(Avertissement de
fin de vie du
ventilateur)

- Le ventilateur est
proche de sa fin de
vie. Contactez un
technicien
Yamaha.

- -

30011 Low Battery
(Batterie faible)

- L’autonomie
restante de la
batterie est faible.
Veuillez la
remplacer.

La batterie sera
bientôt déchargée.
Veuillez la
remplacer.

La batterie est
déchargée.
Certaines données
ne peuvent pas
être conservées
correctement.

30022 Leader W/C Unlock
(Déverrouiller

l’horloge de mots
principale)

- - Horloge de mots
incorrecte détectée
sur la source de
l’horloge de mots
principale.

-

30024 Storage Lifespan
Warning

(Avertissement de
fin de vie du
stockage)

- Le périphérique de
stockage est
proche de sa fin de
vie. Contactez un
technicien
Yamaha.

- -
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ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30025 Storage

Access
Error (Erreur
d’accès au
stockage)

- Une erreur s’est
produite lors de
l’écriture des
données dans
l’espace de
stockage.

- Une erreur s’est
produite lors de
l’écriture des
données dans
l’espace de
stockage.
Contactez un
technicien
Yamaha.

30026 IP Address
Duplicate

(Adresse IP en
double)

- - Un conflit
d’adresse IP a été
détecté.

-

30033 Dante Module
Error (Erreur du
module Dante)

- - - Le module Dante
ne répond pas.
Essayez de
récupérer le
microprogramme
Dante ou
contactez un
technicien
Yamaha.

30034 No Dante
Connection
(Absence de
connexion de

Dante)

- Aucun réseau n’est
connecté au port
Dante. Veuillez
vérifier la
connexion Dante.

- -

30037 Wrong Dante Clock
(Horloge de Dante

incorrecte)

- Les réglages de
l’horloge de mots
de Dante sont
incorrects. Vérifiez
les réglages.

- -

30038 Muted - Dante
Clock Err.

(Assourdi - Erreur
de l’horloge de

Dante)

- - Le son est coupé
car les réglages de
l’horloge de mots
de Dante sont
incorrects. Veuillez
vérifier les
réglages de
l’horloge de mots
Dante.

-

30039 Dante Clock Offset
Err. (Erreur de
décalage de

l’horloge de Dante)

- Le décalage de
fréquence de
l’horloge de Dante
est instable.
Vérifiez la
configuration du
réseau,
notamment les
réglages des
commutateurs
Ethernet.

- -
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ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30040 Dante Redundancy
Triggered

(Redondance de
Dante déclenchée)

- La transmission
audio de Dante a
basculé sur le
réseau secondaire.

- -

30041 Dante Secondary
Error (Erreur de
port secondaire

Dante)

- Le port secondaire
Dante ne
fonctionne pas.

- -

30047 Power ON (Mise
sous tension-

Mise sous tension - - -

30049 Device Initialized
(Appareil initialisé)

La mémoire a été
initialisée.

- - -

30050 Time Synchronized
(Heure

synchronisée)

La date et l’heure
ont été
synchronisées.

- - -

30051 Firmware Updated
(Microprogramme

mis à jour)

Le
microprogramme a
été mis à jour.

- - -

30052 Scene/Snapshot
Store (Stocker la

scène/l’instantané)

Le stockage des
scènes/instantané
s a été effectué.

- - -

30053 Scene/Snapshot
Recall (Rappel de

la
scène/l’instantané)

Les
scènes/instantané
s ont été rappelés.

- - -

30056 PSU Switched Over
(Basculement du

bloc
d’alimentation)

- L’alimentation
redondante « A »
ou « B » ne
fonctionne pas.
Vérifiez la source
et les câbles
d’alimentation.

- -

30057 Dante Link
100Mbps (Liaison
Dante 100 Mo/s)

- La vitesse de
connexion Dante
est inférieure à un
Gigabit. Essayez
d’utiliser un autre
commutateur
réseau ou un autre
port. Sinon,
essayez d’utiliser
un autre câble
réseau.

- -

30058 Sub Module Error
(Erreur du sous-

module)

- - - Le sous-module
interne ne répond
pas. Contactez un
technicien
Yamaha.
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ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30059 Sub Module
Rebooted (Sous-

module redémarré)

- - Le sous-module
interne a
accidentellement
redémarré.

-

30060 Illegal MAC
address (Adresse

MAC illégale)

- - - Une adresse MAC
illégale a été
détectée sur
l’interface Ethernet
de commande.
Contactez un
technicien
Yamaha.

30061 Dante MAC
Address Err.

(Erreur d’adresse
MAC de Dante

- - - Une adresse MAC
illégale a été
détectée sur
l’interface Ethernet
Dante. Contactez
un technicien
Yamaha.

30062 IP Address
Assigned

(Adresse IP
assignée)

L’adresse IP est
assignée à
l’interface réseau.

- - -

30063 IP Address
Assigned (Auto IP)

(Adresse IP
assignée (IP auto))

L’adresse IP
(AutoIP) est
affectée à
l’interface réseau.

- - -

30064 IP Address
Released

(Adresse IP
libérée)

L’adresse IP
attribuée par le
serveur DHCP a
été libérée.

- - -

30065 Internal Network
Error (Erreur du
réseau interne)

- - Impossible
d’établir une
connexion avec le
sous-module
interne en raison
d’une adresse
réseau incorrecte.

-

30066 Dante (TX)
Overflow

(Débordement
(transmission) de

Dante)

- - La limite du flux
audio de
transmission de
Dante a été
dépassée. Veuillez
revoir les
assignations Dante
pour correspondre
aux limites de flux
Dante.

-
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ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30067 Dante (RX)
Overflow

- - La limite du flux
audio de réception
de Dante a été
dépassée. Veuillez
revoir les
assignations Dante
pour correspondre
aux limites de flux
Dante.

-

30068 Dante Settings
Locked (Réglages
Dante verrouillés)

- Impossible
d’appliquer les
nouveaux réglages
au module Dante
en raison de la
fonction Dante
Device Lock ou des
réglages
d’autorisation du
DDM.

- -

30069 DCP Comms Error
(Erreur de

communication
des DCP)

- - Erreur de
communication
détectée lors de la
séquence de
communication
entre l’appareil
hôte et les DCP.
Veuillez vous
assurer que les
éléments suivants
soient conformes

aux spécifications :
1) longueur du

câble,

2) qualité du câble,
3) le dernier DCP
de la chaîne est
équipé d’une
terminaison.

-

30070 DCP Configuration
Error (Erreur de

configuration des
DCP)

- - Impossible de
communiquer
correctement avec
les DCP
connectés.

Veuillez vérifier si
1) Les Panel ID (ID
de panneau) sont
correctement

réglés
2) Les DCP de type
préconfigurés et
de type réel
connectés par fil
sont identiques

-
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ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30071 DSP Resource
Overflow

(Débordement des
ressources DSP)

- - La limite de
capacité de
traitement du
signal audio a été
dépassée de
manière
inattendue, ce qui
peut engendrer des
bruits parasites.

-

30072 Incompatible
Data/File

(Données/fichier
incompatibles)

- - Impossible de
charger ou
d’importer des
données ou un
fichier en raison
d’une
incompatibilité de
format.

-

30073 Incompatible RC
Protocol

(Protocole RC non
compatible)

- - Impossible de
communiquer avec
un appareil ou un
logiciel externe de
commande à
distance ou de lui
répondre, en raison
d’une version de
protocole
incompatible.

-

30074 DHCP Server No
Response

(Absence de
réponse du serveur

DHCP)

- - Le serveur DHCP
ne répond pas à
l’appareil.

-

30075 NTP Server No
Response

(Absence de
réponse du serveur

NTP)

- - Le serveur NTP ne
répond pas à
l’appareil.

-

30076 Missing License
(Licence

manquante)

- - Une partie ou
l’intégralité des
fonctions de
l’appareil ont cessé
de fonctionner en
raison de licences
manquantes ou
insuffisantes.
Activez des
licences
supplémentaires
ou supprimez les
fonctions
correspondantes.

-
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ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30077 Setting Data
Corrupted/Lost

(Données de
réglage

corrompues/perdu
es)

- - Détection de
données ou d’un
fichier corrompus.

-

30078 Storage Full
(Stockage plein)

- - L’espace de
stockage est plein.

-

30079 Unsupported
File System
(Système de

fichiers non pris en
charge)

- - Le lecteur de
stockage est
formaté avec un
type de système
de fichiers non pris
en charge. Veuillez
reformater le
lecteur de
stockage dans un
format pris en
charge.

-

30080 Removable Drive
Mounted (Lecteur
amovible monté)

Un lecteur de
stockage amovible
a été monté sur
l’appareil.

- - -

30081 Removable Drive
Unmounted

(Lecteur amovible
démonté)

Un lecteur de
stockage amovible
a été démonté de
l’appareil.

- - -

30082 File Not Found
(Fichier

introuvable)

Le fichier est
introuvable.

- - -

30083 Authentication
Failed (Échec de
l’authentification)

- Le code PIN/mot
de passe saisi est
incorrect.

- -

30084 Panel Locked
(Panneau
verrouillé)

Le panneau de
commande est
verrouillé.

- - -

30085 Panel Unlocked
(Panneau

déverrouillé)

Le panneau de
commande est
déverrouillé.

- - -

30086 Scene/Snapshot
Recall Failed

(Échec du rappel
de la

scène/l’instantané)

- - Échec du rappel
des données de
scène/d’instantané
.

-
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ID des
données

Nom des données Message
[Normal]

Message
[Warning]

Message
[Error]

Message
[Fault]

30087 Data Sync Failed
(Échec de la

synchronisation
des données)

- - La synchronisation
des données a été
interrompue de
manière
inattendue.

-
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14. Processeur audio MRX7-D

14.1. Présentation

Le MRX7-D est un processeur à configuration libre qui vous permet de concevoir facilement et librement votre

système en organisant les composants de votre choix.

Le MRX7-D peut être commandé à l’aide d’un contrôleur externe, tel que le DCP ou le MCP1.
Le PGM1 peut être utilisé pour créer un système de radiomessagerie.

La feuille de l’appareil MRX7-D vous permet de placer librement des composants, de les câbler et de compiler.
Communiquez ensuite avec l’unité principale du MRX7-D pour définir les paramètres à l’aide de l'éditeur de
composants ou d’un autre logiciel.

Les paramètres sont stockés et rappelés sous forme d’instantanés.
Les paramètres que vous souhaitez stocker et rappeler peuvent être regroupés dans un (jeu de paramètres). Il
est possible de stocker 10 valeurs de paramètres dans chaque jeu de paramètres enregistré sous forme

d’instantanés.
Les instantanés peuvent être enregistrés dans des présélections et rappelés depuis le panneau avant de l’unité

principale ainsi que le DCP et d’autres équipements.
Plusieurs instantanés peuvent être regroupés (groupe d’instantanés) et enregistrés dans une présélection
unique. Les instantanés et les groupes d’instantanés peuvent être rappelés à partir du contrôleur à distance.

Il est possible de lier plusieurs paramètres (groupes de liaisons de paramètres).
Ils peuvent être liés pour chaque composant (groupe d’édition groupée).

Des informations telles que les valeurs initiales des composants, les composants et les câbles entre les
composants peuvent être stockées dans l’ordinateur sous la forme de styles utilisateur. Le fait d’enregistrer des
styles utilisateur vous évite de devoir modifier les réglages chaque fois que vous placez un composant. En outre,
les styles utilisateur peuvent être exportés vers d’autres ordinateurs.

Les câblages entre les composants peuvent être convertis en blocs sous forme de bloc défini par l’utilisateur. En
combinant plusieurs composants dans un seul bloc, vous pouvez épurer l’apparence de la feuille de style et créer
facilement la même fonctionnalité pour différents canaux en copiant des blocs. En définissant le mode « View
Only » ou « Protect » pour chaque bloc, vous pouvez protéger celui-ci lorsque vous exécutez la fonction « Protect
User Defined Block ».
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14.2. Feuille Project

Il s’agit de la feuille sur laquelle les appareils sont placés. Lorsque vous placez des appareils, l’écran « Settings »
s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités MRX7-D à placer sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.

14.2.1. Barre d’outils

• Editor Magnification
Modifie l’agrandissement de l’éditeur de composants.

• Trace Signal Path
Lorsque cette fonction est activée et que vous sélectionnez un port ou un câblage, le chemin du signal est
recherché dans la direction de la sortie et de l’entrée à partir du point sélectionné.
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14.2.2. Zone Devices

Si « YDIF » est ajouté au projet, un exemple de raccordement de plusieurs appareils par des bornes YDIF

s’affiche.
Le réglage de l’horloge de mots est également effectué automatiquement.
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14.2.3. Zone Properties

Permet d’afficher et de modifier les informations du MRX7-D.

Device

• Unit ID
Faites correspondre cet ID d’unité avec celui de l’unité principale du MRX7-D. Le réglage d’usine par défaut
est 1.

• Remote control
Cette option vous permet de confirmer le numéro de port en cas de connexion d’un contrôleur externe et

de configurer les réglages lors de la connexion d’un contrôleur externe au RS-232C.
Pour ouvrir la boîte de dialogue Remote Control, cliquez sur l’icône , qui s’affiche lorsque vous cliquez
sur le champ Value de l’onglet Properties.

◦ [Network IP PORT No.] (Numéro de port IP du réseau)

Affiche le numéro de port de la borne NETWORK du MRX7-D.
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Il est possible de connecter jusqu’à 8 contrôleurs externes aux bornes.
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• Zone de liste [Remote (RS-232C) BIT RATE] (Débit binaire (RS-232C) distant)
Permet de sélectionner la vitesse de communication via le RS-232C. Vous avez le choix entre 38 400 et

115 200 bps.
Vous pouvez connecter un contrôleur externe au connecteur RS-232C.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Ferme la boîte de dialogue sans modifier les réglages.

◦ DCP

Sélectionne le DCP à connecter au port DCP du MRX7-D.
Lorsqu’un DCP est sélectionné, ce DCP est connecté au MRX7-D et le composant DCP est ajouté à
la feuille d’appareil.

L’affectation des paramètres s’effectue dans l'éditeur de composants du DCP.

• PGM1

Définit l’ID d’unité du PGM1 qui contrôle le MRX7-D.
Pour ouvrir la boîte de dialogue PGM1, cliquez sur l’icône , qui s’affiche lorsque vous cliquez sur le

champ Value de l’onglet Properties.
Pour en savoir plus, reportez-vous à la section Déroulement des réglages de radiomessagerie du MTX5-D.



Le MRX7-D conserve les données des réglages du PGM1. Il n’y a donc aucun problème de

configuration même si le PGM1 n’est pas découvert dans ProVisionaire Design.
Lors de la mise à jour du microprogramme du PGM1 ou de la modification de l’adresse IP,
veuillez installer Bonjour Print Service et autoriser ProVisionaire Design à découvrir l’appareil.
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Pour les autres éléments, veuillez vérifier l’explication affichée lorsque l’élément Properties est sélectionné.
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14.3. Configuration de l’écran de la feuille d’appareil

① Boutons d’outils
Des boutons ont été créés pour les commandes fréquemment utilisées sur le MRX7-D (boutons outils).

② Zone Components
Une liste des composants s’affiche (zone Components).

③ Zone Parameter Sets
Configure les jeux de paramètres et les instantanés (zone Parameter Sets).

④ Zone Presets

Configure les présélections (zone Presets).
Vous pouvez rappeler les présélections depuis le panneau avant de l’unité principale.

⑤ Zone Parameter Link Group (Groupe de liaisons de paramètres)
Crée un groupe de liaisons de paramètres pour lier plusieurs paramètres du type Level ou du type ON/OFF (zone
Parameter Link Group).

⑥ Zone Gang Edit Group (Groupe d’édition groupée)
Crée un groupe d’édition groupée qui relie plusieurs composants (zone Gang Edit Group).

⑦ Feuille de conception
Cette feuille permet de placer et de connecter les composants (feuille de conception).

⑧ Zone Properties
Modifie les réglages du composant, du port ou du câblage sélectionné (zone Properties).

⑨ Zone Parameters
Affiche une liste des composants et des paramètres déjà placés sur la feuille de conception (zone Parameters).

⑩ Vue Bird’s Eye
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Affiche une vue complète de la feuille.

⑪ Composants
Les divers modules de traitement des signaux, tels que les égaliseurs et les compresseurs, sont appelés des
« composants ».

⑫ Éditeur de composants
Les paramètres sont définis ou configurés dans l’éditeur de composants.

14.4. Utilisation de base

Reportez-vous à la section Utilisation de base du DME7.
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14.5. Boutons d’outils

Il s’agit de boutons de raccourci pour les commandes fréquemment utilisées sur le MRX7-D.

Bouton Commande Description

[Compile] Détermine s’il y a des problèmes de placement et de
câblage des composants.

[Gang Edit] (Édition
groupée)

Active ou désactive le bouton Active de la zone Gang

Edit Group.
Lorsqu’il est activé, le nom du groupe d’édition groupée
actuellement sélectionné s’affiche à droite du bouton.
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Bouton Commande Description

[Tools] [Remote Control Setup List]
Enregistre les paramètres qui seront commandés

depuis le contrôleur à distance.

[SD Card File Manager]
Permet d’enregistrer les fichiers à lire à l’aide de la

carte SD.

[Scheduler] (Programmateur)
Les présélections peuvent être changées à des dates
et heures prédéterminées, ce qui permet de reproduire
des morceaux et des effets sonores stockés sur une

carte mémoire SD.

[GPI]
Les E/S GPI permettent de contrôler la série MRX7-D à
distance à partir d’un contrôleur personnalisé ou d’un

appareil externe.

[External Events] (Événements externes)
Définit les commandes émises en sortie par le MRX7-

D.

[MCP1]
Ouvre l’éditeur MCP1 qui a été placé sur la feuille

Project.

[Install Speech Privacy File] (Installer le fichier Speech

Privacy)

Installe les fichiers liés au composant Speech Privacy.

[Peak Hold]
Si ON est coché, la valeur maximale est maintenue
dans le compteur dans l’indicateur de niveau du

composant placé.
Lorsque Reset est sélectionné, la valeur maximale

conservée est réinitialisée.

[Protect User Defined Block]
Ouvre la boîte de dialogue « Protect User Defined

Block ».
Reportez-vous à la section « Bloc défini par
l’utilisateur » du DME7.
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14.6. Zone Components

Une description détaillée des composants peut être trouvée dans le document « ProVisionaire Design DME7

Component Guide ».
Pour les composants spécifiques au MRX7-D, reportez-vous à l’éditeur de composants.

14.7. Feuille de conception

Reportez-vous à la feuille de conception du DME7.

14.8. Composants autres qu’audio

Reportez-vous à la section Composants autres qu’audio/de commande du DME7.
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14.9. Zone Parameter Sets

Un ensemble de paramètres stockés/rappelés dans un instantané est appelée un jeu de paramètres. Lorsque
vous stockez un instantané, les valeurs actuelles des éléments du jeu de paramètres sont enregistrées. Un jeu
de paramètres peut stocker jusqu’à 10 modèles d’instantanés. Un même paramètre peut être enregistré dans

plusieurs jeux de paramètres.
Les instantanés peuvent être contrôlés à l’aide d’un contrôleur externe en les attribuant à la liste de
configurations de commandes à distance.

Notez que les instantanés ne peuvent pas être rappelés depuis le panneau avant de l’unité principale (seules des

présélections peuvent être rappelées).
Dans la zone Presets, cliquez sur [Recall Settings] pour enregistrer l’instantané dans une présélection.

Les méthodes suivantes sont disponibles pour l’enregistrement d’un jeu de paramètres.

Source d’enregistrement Méthode d’enregistrement

Feuille de conception Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
composant et déposez-le sur le nom du jeu de paramètres.

Cliquez avec le bouton droit sur un composant et sélectionnez le jeu de
paramètres à enregistrer à l’aide de la fonction [Add to Parameter Set].

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le paramètre
et déposez-le sur le nom du jeu de paramètres.

Éditeur de commandes de liaison Tout en maintenant la touche < Ctrl > enfoncée, faites glisser la
commande de liaison et déposez-la sur le nom du jeu de paramètres.

Zone Parameters*1 Faites glisser un composant ou un paramètre et déposez-le sur le nom du
jeu de paramètres.

Cliquez avec le bouton droit sur un composant ou un paramètre et
sélectionnez le jeu de paramètres à enregistrer à l’aide de la fonction [Add
to Parameter Set].

Zone Parameter Sets Après avoir sélectionné le jeu de paramètres à enregistrer, cliquez sur le
bouton [Add Device] pour enregistrer tous les composants placés sur ce
point dans le temps.

*1. Il est possible d’enregistrer plusieurs composants et paramètres simultanément dans un jeu de paramètres
en appuyant simultanément sur < Maj > et < Ctrl >.
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Pour obtenir des explications sur les jeux de paramètres et les instantanés, reportez-vous à la zone Parameter
Sets du DME7.

14.9.1. Groupe d’instantanés

Il est possible d’enregistrer plusieurs instantanés dans un seul groupe et de les rappeler en même temps.
Les groupes d’instantanés peuvent être contrôlés à l’aide d’un contrôleur externe en les attribuant à la liste de
configurations de commandes à distance.

Notez que les groupes d’instantanés ne peuvent pas être rappelés depuis le panneau avant de l’unité principale

(seules des présélections peuvent être rappelées).
Dans la zone Presets, cliquez sur [Recall Settings] pour enregistrer le groupe d’instantanés dans une
présélection.
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14.9.2. Procédure de création d’un groupe d’instantanés

1. Cliquez sur le bouton [New] pour créer un groupe.

2. Attribuez des instantanés à un groupe par glisser-déposer.

Vous pouvez également attribuer des instantanés non stockés.

3. Réorganisez l’ordre des instantanés selon vos besoins.

Les instantanés enregistrés dans un groupe sont rappelés par ordre ascendant.
Si vous cliquez avec le bouton droit sur un instantané, un menu contextuel s’affiche pour vous permettre
de réorganiser l’ordre des instantanés.

Menu Description

Delete Supprime l’instantané sélectionné.

Up (Haut) Déplace l’instantané sélectionné d’un niveau vers
le haut.

Down (Bas) Déplace l’instantané sélectionné d’un niveau vers
le bas.

Pour supprimer un groupe ou un instantané, sélectionnez-le et cliquez sur le bouton [Delete]. Vous pouvez
également utiliser la touche Suppr de l’ordinateur ou l’option [Delete] dans le menu contextuel.
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14.10. Zone Presets

Les instantanés et les groupes d’instantanés ne peuvent pas être rappelés directement depuis le panneau avant

de l’unité principale.

Vous pouvez rappeler les présélections depuis le panneau avant de l’unité principale.
Enregistrez les instantanés et les groupes d’instantanés dans des présélections.

• Snapshot
Les instantanés associés à la présélection s’affichent dans la boîte de dialogue [Recall Settings].

• Enable Scheduler (Activer le programmateur)

Lorsque cette option est activée et que la présélection est rappelé, la fonction Scheduler est activée.
Cliquez sur l’icône pour l’activer/la désactiver.


Lorsque la fonction Scheduler est désactivée, l’indicateur [SCHEDULER] sur l’unité principale
clignote rapidement lorsqu’un événement se produit.

• Filter
Dans la boîte de dialogue Recall Filter (Filtre de rappel), si une seule partie a été définie pour ne pas être

rappelée, une icône  s’affiche.

14.10.1. Procédure

1. Sélectionnez une présélection.

2. Cliquez sur le bouton [Recall Settings].

14. Processeur audio MRX7-D

ProVisionaire Design V1.2 Guide d’utilisation | 221



14. Processeur audio MRX7-D

222 | ProVisionaire Design V1.2 Guide d’utilisation



3. Dans la boîte de dialogue Recall Settings, sélectionnez le rappel d’instantané ou de groupe d’instantanés
à attribuer à la présélection dans Snapshot/Snapshot Group.

• Bouton [OK & Recall] (OK et rappeler)
Confirme les réglages actuels, effectue un rappel et ferme la boîte de dialogue.

• Bouton [OK]
Confirme réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Annule les modifications et ferme la boîte de dialogue.

Pour GPI Out et SD Song Select et Play, reportez-vous à la boîte de dialogue Recall Settings du DME7.

Pour une explication du rappel, reportez-vous à la zone Parameter Sets du DME7.
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14.11. Zone Parameter Link Group

Crée un groupe de liaisons de paramètres pour lier plusieurs paramètres pour le type Level ou pour le type

ON/OFF.
Un même paramètre peut être enregistré dans plusieurs groupes de liaisons de paramètres. Le groupe de
liaisons de paramètres créé peut être utilisé dans un instantané, un programmateur, un GPI, un DCP, un MCP1 ou
la liste de configurations de commandes à distance. Les paramètres de type Level et ON/OFF ne peuvent pas
être mêlés au sein d’un même groupe de liaisons de paramètres. Il est possible de créer jusqu’à 64 groupes de
liaisons de paramètres.

Les méthodes suivantes sont disponibles pour l’enregistrement d’un groupe de liaisons de paramètres.

[Parameter]

Source d’enregistrement Méthode d’enregistrement

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
paramètre et déposez-le dans la zone verte de la boîte de dialogue
Settings.

Cliquez avec le bouton droit sur le paramètre et sélectionnez le
groupe de liaisons de paramètres à enregistrer dans [Add to
Parameter Link Group].

Zone Parameters*1 Faites glisser le paramètre et déposez-le dans la zone verte de la
boîte de dialogue Settings.

Cliquez avec le bouton droit sur le paramètre et sélectionnez le
groupe de liaisons de paramètres à enregistrer dans [Add to
Parameter Link Group].

*1. Il est possible d’enregistrer plusieurs paramètres simultanément dans un groupe de liaisons de paramètres
en appuyant simultanément sur < Maj > et < Ctrl >.


Si vous appuyez sur une touche alphabétique lors de la sélection d’un groupe de liaison de
paramètres ou d’un autre élément dans la zone Parameter Link Group, le groupe de liaisons
de paramètres ou l’élément commençant par cette lettre sera sélectionné.
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• Bouton [New]
Crée un groupe de liaisons de paramètres.

• Bouton [Delete]
Supprime le groupe de liaisons de paramètres ou le paramètre sélectionné.

• Bouton [Open]
Affiche l’éditeur de commandes de liaisons pour le groupe de liaisons de paramètres sélectionné.

14.11.1. Éditeur de commandes de liaison

Chaque groupe de liaisons de paramètres dispose d’une commande de liaison. Lorsque celle-ci est modifiée, les

paramètres enregistrés dans le groupe de liaisons de paramètres changent en même temps.
Les paramètres de la commande de liaison ne change pas, même si les paramètres enregistrés dans le groupe

de liaisons de paramètres changent.
La commande de liaison peut être attribuée au GPI, au DCP, à la liste de configurations de commandes à
distance, au groupe de liaison de paramètres ou au MCP1.

Le nom du groupe de liaisons de paramètres est affiché dans la barre de titre.

Type Level Type ON/OFF

• Fader (type Level uniquement)
Définit les valeurs des paramètres de type Level.

• Bouton [ON] (type ON/OFF uniquement)
Définit les valeurs des paramètres de type On/Off.

• Bouton [Match Values] (Mettre en correspondance les valeurs)
Si [Absolute] (Absolu) ou [Equal] (Égal) est sélectionné dans le menu déroulant, la valeur du paramètre
enregistré sera identique à celle de la commande de liaison.

• Bouton [Active]
Lorsque ce bouton est activé, le groupe de liaisons de paramètres est également activé. Désactivez le
bouton si vous voulez désactiver temporairement la liaison.

• Menu déroulant
Détermine la manière dont les réglages de type Level et ON/OFF sont appliqués.

[Absolute]/[Equal] Définit la valeur du paramètre enregistré sur la même valeur que la
commande de liaison.

[Relative]/[Opposite]
(Relatif/Opposé)

Lorsque vous utilisez la commande de liaison, les paramètres
enregistrés changent tout en conservant leurs positions relatives.
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14.12. Zone Gang Edit Group

Crée un groupe d’édition groupée qui relie plusieurs composants.
Les paramètres des composants du même type au sein d’un groupe peuvent être modifiés en même temps.
Étant donné que cela peut être aussi fait en ligne, vous pouvez l’utiliser pour effectuer les derniers réglages du

processeur de haut-parleur (ou autre) tout en écoutant le son à l’emplacement réel.
Lorsque vous ouvrez l’éditeur de composants pour un des composants que vous souhaitez modifier, il se

transforme en commande de liaison et vous pouvez configurer d’autres composants liés.
Il est possible de créer jusqu’à 64 groupes d’édition groupée.

Les méthodes suivantes sont disponibles pour enregistrer un élément dans un groupe d’édition groupée.

Source d’enregistrement Méthode d’enregistrement

Feuille de conception Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
composant et déposez-le sur le nom du groupe d’édition groupée.

Cliquez avec le bouton droit sur le composant et sélectionnez le
groupe d’édition groupée à enregistrer à l’aide de la fonction [Add
to Gang Edit Group] (Ajouter au groupe d’édition groupée).

Zone Parameters*1 Faites glisser le composant et déposez-le sur le nom du groupe

d’édition groupée.
Cliquez avec le bouton droit sur le composant et sélectionnez le
groupe d’édition groupée à enregistrer à l’aide de la fonction [Add
to Gang Edit Group].

*1. Il est possible d’enregistrer plusieurs composants simultanément dans un groupe d’édition groupée en
appuyant simultanément sur < Maj > et < Ctrl >.

• Bouton [Active]
Active/désactive la fonction Gang Edit Group. S’applique au groupe actuellement sélectionné.
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• Bouton [New]
Crée un groupe d’édition groupée.

• Bouton [Delete]
Supprime le groupe d’édition groupée ou le composant sélectionné.

• [Parameters]
Cochez la case du paramètre que vous souhaitez lier.

14.12.1. Procédure

1. Cliquez sur le bouton [New] pour créer un groupe.

2. Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le composant et déposez-le sur la feuille

sur le nom du groupe.

Ou faites glisser le composant et déposez-le depuis la zone Parameters.
La liaison fonctionne uniquement avec les composants du même type, mais il est possible d’enregistrer
plusieurs types de composants.

3. Décochez les paramètres que vous ne souhaitez pas lier.

4. Activez le bouton [Active] ou le bouton [Gang Edit] dans la barre d’outils.

5. Double-cliquez sur un composant sur n’importe quelle feuille enregistrée dans le groupe d’édition

groupée.
L’éditeur de composants s’affiche.

6. Modifiez les paramètres dans l’éditeur de composants.
Les paramètres des composants du même type appartenant au groupe d’édition groupée sont modifiés
ensemble.

7. Si le bouton [Active] ou le bouton [Gang Edit] de la barre d’outils est désactivé, la liaison est désactivée.
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14.13. Zone Properties

Modifie les réglages du composant, du port ou du câblage actuellement sélectionné.

• Component
Cliquez sur l’icône  qui s’affiche lorsque vous cliquez sur la valeur « Form » (Forme). Une boîte de
dialogue s’affiche pour vous permettre de modifier le nombre de canaux du composant.

• Port
Cliquez sur l’icône  qui s’affiche lorsque vous cliquez sur la valeur « Label ». Une boîte de dialogue
s’affiche pour vous permettre de modifier les étiquettes de tous les ports du composant à la fois.

Pour plus de détails, reportez-vous à la boîte de dialogue Port Label.
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14.14. Zone Parameters

Affiche des informations sur le composant actuellement sélectionné sur la feuille de conception.
Les paramètres du composant actuellement sélectionné dans la zone supérieure sont affichés dans la zone

inférieure.
Cette zone vous permet d’affecter des composants et des paramètres à des jeux de paramètres, à des listes de
configurations de commandes à distance, à des boîtes de dialogue GPI, à des composants DCP et à l’éditeur
MCP1. Pour les méthodes d’affectation, reportez-vous à l’explication de chaque écran.

14.15. Menu contextuel

Reportez-vous au menu contextuel du DME7.
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14.16. Boîte de dialogue

14.16.1. Boîte de dialogue Compile

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton d’outil [Compile] (Compiler) dans la feuille d’appareil.
Cette boîte de dialogue détermine s’il y a des problèmes de placement et de câblage des composants du MRX7-
D. Elle permet également de vérifier la consommation des ressources, etc.

• /Message
Indique si l’action de compilation a réussi ou non. Si l’opération a réussi, le message « Completed
normally. » (Terminé normalement) s’affiche. En cas d’échec, le message « Compile failed » (Échec de la
compilation) s’affiche.

• Bouton 
Cliquez pour afficher la méthode de résolution du problème.

• [Result]

Affiche les résultats compilés. Le MRX-7D ne peut passer en ligne que si la compilation a réussi.
Pour chaque élément, vérifiez les informations qui s’affichent lorsque vous cliquez sur ?.
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14.16.2. Boîte de dialogue Remote Control Setup List

Pour ouvrir cette boîte de dialogue, cliquez sur [Remote Control Setup List] à partir du bouton [Tools] de la feuille
d’appareil.

Le MRX7-D peut être contrôlé à partir d’un appareil externe à l’aide de la borne [PRIMARY]/[SECONDARY] de

Dante ou de la borne [RS-232C].
Pour exécuter des commandes ou un contrôle à partir d’un appareil externe, les paramètres, les indicateurs de
niveau, les instantanés et les groupes d’instantanés doivent être enregistrés dans la liste de configurations de
commandes à distance.


Configurez l’appareil externe conformément aux « Caractéristiques techniques du protocole
de commande à distance EXi8 EXo8 de la série MTX3 MTX5-D MRX7-D XMV ».

● Onglet Remote Setup (Configuration à distance)

Deux méthodes sont disponibles enregistrer des éléments dans la liste.

Source d’enregistrement Méthode d’enregistrement

Feuille de conception Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
composant et déposez-le sur la liste.

Cliquez avec le bouton droit sur le composant et sélectionnez
[Add to Remote Control List] (Ajouter à la liste des commandes à
distance).

Éditeur de composants/
Fenêtre de réglage des
paramètres

[Parameters]
Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le

paramètre et déposez-le sur la liste.
Cliquez avec le bouton droit sur le paramètre et sélectionnez [Add
to Remote Control List].

[Components]
Cliquez avec le bouton droit en dehors du paramètre et
sélectionnez [Add to Remote Control List].
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Source d’enregistrement Méthode d’enregistrement

Zone Parameters*1 Faites glisser des composants ou des paramètres et déposez-les

sur la liste.
Cliquez avec le bouton droit sur un composant ou un paramètre et
sélectionnez [Add to Remote Control List].

Zone Parameter Sets Faites glisser des instantanés et déposez-les sur la liste.
Faites glisser des groupes d’instantanés et déposez-les sur la
liste.

Éditeur de groupes de liaisons
de paramètres

Tout en maintenant la touche < Ctrl > enfoncée, faites glisser la
commande de liaison et déposez-la dans la zone verte.

*1. Il est possible d’enregistrer plusieurs composants et paramètres simultanément dans la liste en appuyant
simultanément sur < Maj > et < Ctrl >.

• [Function]
Affiche les types d’éléments enregistrés dans la liste.

• [< Ctrl >+drag-and-drop component/parameter/meter.]
Affiche les éléments enregistrés dans la liste.

• [Type]
Affiche le type de composant pour lequel des paramètres sont enregistrés dans la liste.

• [Cmp ID]
Affiche l’ID d’un composant pour lequel des paramètres sont enregistrés dans la liste.

• [MIN]/[MAX]
Affiche les limites supérieure et inférieure et la plage de sélection des paramètres enregistrés dans la

liste. Dans le cas de paramètres de type Level pour lesquels une valeur Min/
Max peut être configurée, cliquez dessus pour ouvrir une boîte de dialogue vous permettant de spécifier la
plage.

• Bouton Transfer (Transférer)
Démarre l'application File Transfer, qui permet d’envoyer des fichiers à ProVisionaire Touch.

Pour d’autres fonctions, reportez-vous à la boîte de dialogue Remote Control Setup List du DME7.

● Onglet External Event
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Les événements externes sont enregistrés sous l’état initial de la liste.

Pour plus de détails sur les événements externes, reportez-vous à la boîte de dialogue External Events du MTX5-
D/MTX3.
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14.16.3. Application File Transfer

Pour ouvrir cette application, cliquez sur le bouton Transfer dans la boîte de dialogue Remote Control Setup List.

Le fichier .rcsl, le fichier PDF, le fichier image, etc. exportés sont alors transférés vers un iPad sur le même

réseau que celui où ProVisionaire Touch (version 1.2 ou ultérieure) est installé.

Avant le transfert, démarrez ProVisionaire Touch et vérifiez qu’il s’affiche à l’écran.
Si aucune carte réseau n’a été sélectionnée, la boîte de dialogue [Network Setup] (Configuration réseau) s’affiche
pour vous permettre d’en sélectionner une.

ProVisionaire Touch peut recevoir des fichiers portant les extensions suivantes :

.rcsl, .pdf, .jpg, .jpeg, .bmp, .png, .pvt, .ypvt, .ypvk

.Les fichiers pvt, .ypvt et .ypvk sont enregistrés dans le dossier de fichiers Provisionaire Touch.

.Les fichiers rcsl peuvent être utilisés en enregistrant le MRX7-D en tant qu’appareil dans Provisionaire Touch.

• Menu System
Ouvrez la boîte de dialogue Network Setup à l’aide de la commande Network Setup.

• Sélectionnez un fichier à transférer
Sélectionne le fichier à envoyer. Cliquez sur le bouton  sur le côté droit pour afficher la boîte de
dialogue Open File (Ouvrir un fichier), qui vous permet de sélectionner un fichier.

• Destinations
Sélectionnez l’iPad de destination du transfert. Si vous ne voyez pas l’iPad de destination du transfert,
appuyez sur le bouton [Search] pour lancer une recherche sur votre réseau. Le bouton [Search] est activé
lorsqu’un fichier à transférer est sélectionné.

• Bouton [Send] (Envoyer)
Envoie les fichiers sélectionnés à l’iPad sélectionné.

• Bouton [Close]
Ferme l’application File Transfer.
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14.16.4. Boîte de dialogue SD Card File Manager

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis sur [SD Card File Manager] pour ouvrir cette boîte de

dialogue.
Reportez-vous à la boîte de dialogue SD Card File Manager du DME7.

14.16.5. Boîte de dialogue Scheduler

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis cliquez sur [Scheduler] pour ouvrir cette boîte de

dialogue.
Reportez-vous à la boîte de dialogue Scheduler du MTX5-D/MTX3.

14.16.6. Boîte de dialogue GPI

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis cliquez sur [GPI] pour ouvrir cette boîte de dialogue.
Reportez-vous à la boîte de dialogue GPI du DME7.


Le MRX7-D ne possède pas paramètres GPI au niveau la couche Control.
Le MRX7-D ne dispose pas de réglage Control Type: Direct Parameter Value.

Les méthodes suivantes sont disponibles pour enregistrer les paramètres, les instantanés, les groupes
d’instantanés et les présélections :

Source d’enregistrement Méthode d’enregistrement

Zone Parameter Sets Faites glisser des instantanés et des groupes d’instantanés et déposez-
les dans la zone verte.

Zone Presets Faites glisser des présélections et déposez-les dans la zone verte.

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le paramètre
et déposez-le dans la zone verte.

Zone Parameters Faites glisser le paramètre et déposez-le dans la zone verte.

Éditeur de groupes de liaisons de
paramètres

Tout en maintenant la touche < Ctrl > enfoncée, faites glisser la
commande de liaison et déposez-la dans la zone verte.

14.16.7. Boîte de dialogue External Events

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis cliquez sur [External Events] pour ouvrir cette boîte de
dialogue.

Reportez-vous à la boîte de dialogue External Events du MTX5-D/MTX3.
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14.16.8. Boîte de dialogue Install Speech Privacy File

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton [Tools] dans la feuille d’appareil, puis sur [Install Speech

Privacy File].
Cette boîte de dialogue installe les fichiers liés au composant Speech Privacy sur le MRX7-D.

Une fois l’installation terminée, le MRX7-D redémarre.

• Bouton [Install]
Démarre l’installation des fichiers sur le MRX7-D.

• Bouton [Cancel]
Ferme la boîte de dialogue sans installer de fichiers.
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14.17. Éditeur de composants

Faites glisser des paramètres et déposez-les dans l’éditeur de composants tout en maintenant le bouton< Ctrl >
du clavier enfoncé pour les affecter à la page ProVisioniare Control.

Une description détaillée des composants non répertorié ci-dessous peut être trouvée dans le document
« ProVisionaire Design DME7 Component Guide ».

14.17.1. Éditeur de composants Acoustic Echo Canceller

La fonction Acoustic Echo Canceller (AEC) élimine les échos provoqués par les réflexions des haut-parleurs et
des murs (échos acoustiques), ainsi que le bruit constant des climatiseurs, etc., qui posent problème lors de
téléconférences. La fourniture d’un son clair qui élimine les échos et le bruit permet d’avoir des conversations

fluides pendant la téléconférence.
Veuillez noter que pour éliminer l’écho acoustique généré du côté de l’autre interlocuteur, un système avec

fonction de compensateur d’écho acoustique doit également être installé de son côté.
Chaque MRX7-D peut être équipé d’AEC pour un maximum de 8 canaux.

Le retard suivant est ajouté au chemin du signal sur lequel le composant AEC est placé.

Lorsque l’horloge de mots est de 44,1 kHz : 26,17 ms
Lorsque l’horloge de mots est de 48 kHz : 24,02 ms

Les entrées AEC sont les suivantes, de haut en bas.

• MicIn 1 : entrée du microphone

• MicIn 2 : entrée du microphone

• Reference (Référence) : Entrée d’un signal que vous ne souhaitez pas envoyer à un emplacement distant
(signal devant être considéré comme un écho et supprimé) (par exemple, Codec In)


MicIn 1 et MicIn 2 doivent être des entrées provenant de microphones situés dans la même
salle de conférence.

■ Éditeur d’AEC

Cet éditeur configure les paramètres liés à l’AEC. Le côté gauche de l’écran est réservé aux paramètres liés au
microphone connecté à MicIn 1, et le côté droit aux paramètres du microphone connecté à MicIn 2.
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① Bouton AEC [ON]
Active ou désactive la fonction AEC.

② Bouton [NR]
Active/désactive la fonction de réduction du bruit, pour éliminer le bruit constant des projecteurs, des
climatiseurs, etc. situés à proximité. En général, il est recommandé d’activer cette fonction.

③ Bouton [Threshold] (Seuil)
Lorsque vous utilisez la réduction de bruit, le bruit qui dépasse le niveau de seuil est atténué jusqu’au niveau
spécifié par Threshold.

④ Indicateur de niveau
Affiche les informations relatives aux entrées/sorties et à l’écho acoustique.

• Indicateur de niveau [IN]
Affiche le niveau d’entrée du microphone.

• Indicateur de niveau [REF]
Affiche le niveau d’entrée en provenance de Reference.

• Indicateur de niveau [OUT]
Affiche le niveau de sortie de l’AEC.

• Indicateur de niveau [ERL]
Affiche le rapport entre l’entrée de référence et la quantité d’écho incluse dans l’entrée du microphone

telle qu’estimée par l’AEC.
Un environnement d’installation adéquat est un environnement dans lequel l’affaiblissement de l’écho ou
ERL (Echo Return Loss) est compris entre 0 dB et –16 dB. S’il est supérieur à 0 dB, il est possible que le
niveau d’entrée du microphone soit trop élevé ou que le microphone et le haut-parleur soient trop proches.
S’il est inférieur à –16 dB, le niveau d’entrée du microphone est peut-être trop faible.

• Indicateur de niveau [ERLE]
Affiche la quantité (en dB) d’écho acoustique que l’AEC a supprimé de l’entrée du microphone à la suite de
l’apprentissage. Si l’écho est supprimé correctement, une valeur négative est affichée.

• Indicateur de niveau [TER]
Affiche la quantité (en dB) d’écho acoustique finalement supprimée.

⑤ Bouton [RESET]
Lorsque vous cliquez sur ce bouton, les informations apprises par l’AEC sont renvoyées.

⑥ Zone de texte du port
Affiche le nom du port. Le nom peut être modifié en double-cliquant sur cette zone.
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14.17.2. Éditeur de composants [Effect]

① Bouton Effect [ON]
Active ou désactive la fonction d’effet.

② Zone de liste des types d’effet
Sélectionne le type d’effet. Vous avez le choix entre quatre types d’effet :

• Reverb Hall
Cette réverbération simule un grand espace, tel qu’une salle de concert.

• Reverb Stage
Cette réverbération simule une grande scène.

• Karaoke Echo
Il s’agit d’un écho de microphone destiné à être utilisé en karaoké.

• Vocal Echo
Il s’agit d’un écho spécialement conçu pour le chant et destiné à être utilisé sur scène.

③ Bouton des paramètres d’effet
Règle un paramètre d’effet. Si le type d’effet est Reverb, il s’agira de [REVERB TIME] (Temps de réverbération).
Dans le cas d’Echo, il s’agira de [DELAY TIME] (Temps de retard).
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14.17.3. Éditeur de composants Analog In (Entrée analogique)

Affiche les réglages liés au préampli micro pour la borne [INPUT] et le niveau du signal audio en entrée.

① Index des canaux
Affiche les numéros des bornes d’entrée analogique.

② Indicateur de niveau
Affiche le niveau de l’entrée analogique.

③ Bouton [GAIN]
Règle le gain analogique du préampli micro.

④ Bouton [+48V]
Permet d’activer ou de désactiver l’alimentation fantôme du HA (+48 V).

 NOTE

Si l’alimentation fantôme n’est pas requise, désactivez ce bouton.
Si l’alimentation fantôme est activée, veuillez garder à l’esprit les points suivants afin d’éviter tout bruit ou

endommagement de l’appareil principal ou des appareils externes.
• En cas de connexion d’un appareil non compatible avec l’alimentation fantôme à une borne [INPUT],

désactivez le bouton.

• Ne déconnectez pas les câbles de la borne [INPUT] tant que le bouton d’alimentation est activé.
• Réglez le niveau de sortie sur son niveau le plus bas lors de l’activation ou de la désactivation de

l’alimentation fantôme.
Il n’y a pas de commutateur +48 V Active. Utilisez des réglages qui correspondent à l’équipement connecté
pour éviter d’endommager l’appareil.
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14.17.4. Éditeur de composants Slot In (Entrée de logement)

Permet d’afficher le niveau du signal audio transmis en entrée depuis la carte Mini-YGDAI.
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14.17.5. Éditeur de composants Analog Out (Sortie analogique)

Permet d’afficher les réglages liés à la sortie de la borne [OUTPUT] et au niveau du signal audio transmis en
sortie.

① Index des canaux
Affiche les numéros des bornes de sortie analogique.

② Indicateur de niveau
Affiche le niveau de la sortie analogique.

③ Bouton [GAIN]
Permet d’ajuster le gain de sortie.

④ Bouton [INV]
Permet d’alterner la polarité du signal de sortie.
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14.17.6. Éditeur de composants Slot Out (Sortie de logement)

Permet d’afficher les réglages liés à la sortie de la carte Mini-YGDAI et au niveau du signal audio transmis en
sortie.

① Index des canaux
Affiche les numéros des bornes de sortie.

② Indicateur de niveau
Affiche le niveau de sortie.

③ Bouton [GAIN]
Permet d’ajuster le gain de sortie.

④ Bouton [INV]
Permet d’alterner la polarité du signal de sortie.
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14.17.7. Éditeur de composants Speech Privacy

Cette fonction mélange les sons ambiants et les sons perturbateurs pour empêcher les personnes situées à

proximité d’entendre les conversations dans un endroit déterminé.

Vous ne pouvez installer qu’un seul de ces éditeurs sur chaque MRX7-D.
Deux signaux mixés sont émis pour chaque système, un sans décalage et un avec décalage qui décale le point
de reproduction. En alternant les haut-parleurs qui émettent chacun de ces signaux, l’inconfort causé par le

déphasage dans les endroits où le son se chevauche est réduit.
Avant de mettre le MRX7-D en ligne, utilisez la boîte de dialogue Install Speech Privacy File qui s’affiche lorsque
vous sélectionnez [Install Speech Privacy File] depuis le bouton [Tools] pour installer les fichiers sur le MRX7-D.

Configurez les réglages liés aux sons ambiants et aux sons perturbateurs dans l’éditeur de composants Speech
Privacy.

① Index des systèmes
Affiche les numéros du système à configurer.

② Zone de liste [Environmental Sound] (Sons ambiants)
Définit le son ambiant à utiliser. Sélectionnez un son qui correspond à l’environnement de sortie.

• Forest (Forêt) : sons de la forêt

• Seashore (Bord de mer) : bruit des vagues

• Street (Rue) : sons de la rue

• Building (Bâtiment) : bruit d’air conditionné

③ Bouton [Speech Sound Masker] (Masquage des paroles)
Définit le pourcentage de bruit parasite à inclure dans le son en sortie. L’unité est le %.

④ Bouton [LEVEL]
Définit le niveau du signal pour le mixage de sons ambiants et de sons perturbateurs.
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⑤ Bouton [ON]
Assourdit ou désassourdit les signaux mixés de chaque système.

14.18. Liste des alertes

Reportez-vous à la section Liste des alertes du MTX5-D/MTX3.

14.19. Flux de configuration de la radiomessagerie

Pour le MRX7-D, pour utiliser PGM1, placez d’abord le composant Paging (Radiomessagerie) de la zone

Components sur la feuille d’appareil.
Pour la méthode de configuration, reportez-vous au flux de configuration de la radiomessagerie du MTX5-D.
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15. Processeurs audio : MTX5-D/MTX3

15.1. Présentation

Le MTX3/MTX5-D est un processeur optimisé pour les installations de petite à moyenne taille dans les magasins

ou les salles de réception.
Pour en savoir plus, reportez-vous au mode d’emploi de l’équipement.

15.2. Feuille « Project »

Il s’agit de la feuille sur laquelle les appareils sont placés. Lorsque vous placez des appareils, l’écran « Settings »
s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités MTX placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.

15.2.1. Zone « Devices »

Si « YDIF » est ajouté au projet, un exemple de raccordement de plusieurs appareils par des bornes YDIF est

fourni ci-dessous.
Le réglage de l’horloge de mots s’effectue automatiquement.
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15.2.2. Zone « Properties »

Permet d’afficher et de modifier les informations du MTX.

• Remote Control
Vous pouvez vérifier ici les numéros de port pour raccorder un contrôleur externe, ou effectuer des

réglages pour raccorder un contrôleur externe au RS-232C.
Pour ouvrir la boîte de dialogue « Remote Control », cliquez sur l’icône , qui s’affiche quand le champ de
propriété « Value » est sélectionné.

◦ [Network IP PORT No.]
Indique le numéro de port du connecteur NETWORK du MTX3 ou des connecteurs Dante
[PRIMARY/SECONDARY] (Principal/Secondaire) du MTX5-D. Vous pouvez relier à ce port jusqu’à
huit contrôleurs externes ou unités Wireless DCP.

◦ Case [Remote(RS-232C) BIT RATE] (Débit binaire (RS-232C) distant)
Permet de sélectionner la vitesse de communication via le RS-232C. Vous avez le choix entre
« 38 400 » et « 115 200 » bps. Vous pouvez connecter un contrôleur externe au port RS-232C.
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◦ Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

◦ Bouton [Cancel]
Permet de fermer la boîte de dialogue sans enregistrer les modifications.

• DCP

Sélectionnez le DCP connecté au port DCP.
Pour ouvrir la boîte de dialogue [DCP], cliquez sur l’icône , qui s’affiche lorsque vous cliquez sur le

champ de propriété Value.
Pour en savoir plus, reportez-vous au chapitre « DCP ».

• PGM1 (MTX5-D uniquement)

Spécifiez l’ID d’unité du PGM1 qui contrôle le MTX5-D.
Pour ouvrir la boîte de dialogue [PGM1], cliquez sur l’icône , qui s’affiche lorsque vous cliquez sur le

champ de propriété Value.
Pour en savoir plus, reportez-vous à la section « Déroulement des réglages de la radiomessagerie ».



Les réglages du PGM1 étant stockés par le MTX5-D, ProVisionaire Design n’a pas besoin de

découvrir le PGM1.
Lors de l’utilisation de ProVisionaire Design pour mettre à jour le microprogramme du PGM1
ou pour modifier l’adresse IP, installez Bonjour Print Service afin de permettre à ProVisionaire
Design de découvrir l’appareil.
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15.3. Configuration de l’écran de la feuille d’appareil

À l’ouverture de la feuille d’appareil du MTX, les zones « Presets » et « Bird’s Eye view » s’affichent.

① Boutons d’outils
Vous trouverez ici les commandes fréquemment utilisées, présentées sous forme de boutons.

② Zone « Presets »
Vous pouvez stocker plusieurs réglages de paramètres sous forme de présélections.

③ Vue Bird’s Eye
Affiche une vue d’ensemble de la feuille.
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15.4. Boutons d’outils

Vous trouverez ici les commandes fréquemment utilisées, présentées sous forme de boutons.

Bouton Commande Description

MTX Configuration Les réglages d’E/S du MTX, tels que le port d’entrée et
le canal de sortie, le bus Matrix, etc., sont spécifiés
pour chaque appareil. Cette commande ne peut pas
être sélectionnée dans l’écran « Project ».

Tools [SD Card File Manager]
Permet d’enregistrer les fichiers à lire à l’aide de la

carte SD.

[Scheduler]
Les présélections peuvent être changées à des dates
et heures prédéterminées, ce qui permet de reproduire
des morceaux et des effets sonores stockés sur une

carte mémoire SD.

[GPI]
Les E/S GPI permettent de contrôler l’appareil de la
série MTX à distance à partir d’un contrôleur

personnalisé ou d’un appareil externe.

[External Events]
Permet de définir les commandes émises en sortie par
le MTX.
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15.5. Zone « Presets »

Cette zone permet de stocker (sauvegarder) des valeurs des paramètres en tant que présélections. Le rappel
d’une présélection permet de déployer les paramètres en tant que valeur actuelle (paramètre actuel). Vous
pouvez rappeler les présélections à l’aide du panneau avant de l’appareil.

• Bouton [Store]
Permet de stocker la présélection à l’emplacement sélectionné.

• Bouton [Recall]
Permet de rappeler la présélection sélectionnée.

• Bouton [Clear]
Permet d’effacer la présélection sélectionnée.

• Bouton [Recall settings]
Permet d’ouvrir la boîte de dialogue « Recall Settings » (Rappeler les réglages).

• Bouton [Recall Filter]
Permet d’ouvrir la boîte de dialogue « Recall Filter » (Rappeler le filtre).

• Liste des présélections
Affiche une liste des présélections. 50 présélections au maximum peuvent être stockées.

◦ Preset

Permet d’afficher le numéro et le nom de la présélection.

Vous pouvez modifier le nom d’une présélection stockée en double-cliquant dessus.
La mention [No Data] (Aucune donnée) figurera en regard des présélections vides.

◦ Protect
Lorsque vous cliquez sur l’icône de cadenas  et qu’elle se transforme en , la protection est

activée et il est impossible d’apporter des modifications.
Si vous cliquez sur l’icône lorsque la protection a été appliquée, celle-ci sera désactivée.


Pour rappeler les présélections de plusieurs appareils simultanément, cliquez sur le bouton

 et ouvrez la boîte de dialogue « Linked Presets Manager ».
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• Enable Scheduler

Lorsque cette option est activée et que la présélection est rappelé, la fonction Scheduler est activée.
Cliquez sur l’icône pour l’activer/la désactiver.


Lorsque la fonction Scheduler est désactivée, l’indicateur [SCHEDULER] sur l’unité principale
clignote rapidement lorsqu’un événement se produit.

• Filter
Dans la boîte de dialogue Recall Filter, si une seule partie a été définie pour ne pas être rappelée, une

icône  s’affiche.

15.5.1. Recall

• Power on Default
Définit la présélection à rappeler lorsque l’alimentation de l’unité principale est activée. Appuyez sur le
bouton « Set » dans la boîte de dialogue [Power on Default] pour définir la présélection actuellement

sélectionnée.
Lorsqu’aucune présélection n’a été définie, l’appareil démarre dans l’état où il était au moment où il a été
éteint. Pour annuler, cliquez sur Clear dans la boîte de dialogue [Power on Default].

• Emergency Recall
Permet de définir la présélection à rappeler lorsque le MTX reçoit un signal EMG (Urgence) provenant d’un

appareil externe ou que la tension à l’entrée de la borne [GPI IN] compatible 24 V est inférieure à 2,5 V.
Les méthodes de réglage et d’annulation sont les mêmes que pour « Power on Default ».
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15.6. Menus contextuels

15.6.1. Feuilles MTX5-D/MTX3

Lorsque vous cliquez avec le bouton droit sur un emplacement sans objet dans le MTX, le menu contextuel
suivant s’affiche.

Menu Description

[Close All Editor Windows] Ferme tous les éditeurs.

15.6.2. Composants de l’éditeur de composants du MTX

Lorsque vous faites un clic droit sur un emplacement autre que l’opérateur du composant ou le composant lui-
même, le menu contextuel suivant s’affiche (certains éléments peuvent être omis).

Menu Description

[Open Component Editor] Ouvre l’éditeur de composants.

[Copy] Copie les réglages de paramètres de l’éditeur de composants.

[Paste Parameters] Colle les réglages des paramètres de l’éditeur de composants qui ont été
copiés.

[Select Mini-YGDAI Card]
(Sélectionner la carte Mini-YGDAI)

Seuls les éditeurs de composants « Slot In » et « Slot Out » s’affichent. La
boîte de dialogue « Slot » (Logement) permettant de sélectionner une
carte Mini-YDGAI s’ouvre.

[Sampling Rate Converter]
(Convertisseur du taux
d’échantillonnage)

Ce menu s’affiche lorsque vous sélectionnez MY4-AEC ou MY8-AE96S
dans la boîte de dialogue Slot. La boîte de dialogue permettant de régler
la fonction SRC (Sampling Rate Converter, Convertisseur du taux
d’échantillonnage) de la carte MY4-AEC ou MY8-AE96S s’ouvre.
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15.7. Boîte de dialogue

15.7.1. Boîte de dialogue « MTX Configuration » (Configuration du MTX)

Pour ouvrir cette boîte de dialogue, cliquez sur le bouton d’outil [MTX Configuration] dans la feuille d’appareil.
Vous pouvez spécifier ici les réglages d’entrée/sortie, tels que les ports d’entrée du MTX, les canaux de sortie et
les bus Matrix.


Comme ces réglages ne sont pas inclus dans une présélection, ils ne peuvent pas être
modifiés via la fonction Preset Recall.

• Onglet [INPUT]
Cet onglet vous permet d’effectuer divers réglages liés aux entrées.

◦ INPUT PORT SETUP (Configuration du port d’entrée)

Vous pouvez définir ici les entrées des ports d’entrée stéréo.

STEREO…………. Le signal stéréo entre sans être modifié.
SUM……………….. Les entrées L et R sont regroupées sur un même canal. Il n’y aura qu’une seule
entrée sur l’assignation d’entrée.

◦ INPUT CHANNEL SETUP (Configuration du canal d’entrée)

Vous pouvez effectuer ici les réglages des canaux d’entrée.

MONO x2………. Les canaux d’entrée seront traités comme deux canaux mono.
STEREO…………. Les canaux d’entrée seront traités comme une seule paire stéréo.

• Onglet [OUTPUT]
Cet onglet vous permet d’effectuer divers réglages liés aux sorties.

◦ MATRIX BUS SETUP (Configuration du bus Matrix)

Vous pouvez effectuer ici les réglages des bus Matrix.

MONO x2………. Les canaux d’entrée seront traités comme deux canaux mono.

STEREO…………. Les canaux d’entrée seront traités comme une seule paire stéréo.
Si le mode YDIF du système MTX est le mode Cascade, les paramètres seront communs à toutes
les unités MTX du système MTX.

◦ OUTPUT CHANNEL SETUP (Configuration du canal de sortie)
Vous pouvez spécifier ici le type de processeur de haut-parleur du canal de sortie (1WAYx2 ou
2WAY). Les réglages effectués ici affectent l’égaliseur de pièce et le processeur de haut-parleur
dans l’éditeur de composants « Output CH » (Canal de sortie).
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• Bouton [Advanced Settings] (Réglages avancés)
La boîte de dialogue « Advanced Settings » s’ouvre.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Annule les réglages et ferme la boîte de dialogue.

Boîte de dialogue « Advanced Settings »

Vous pouvez spécifier ici le mode panoramique (PAN ou Blend) du mixeur matriciel. Le réglage [MATRIX BUS

SETUP] (Configuration du bus Matrix) ne peut être spécifié que pour deux canaux STÉRÉO.
Si vous choisissez [Blend] (Mélange), les canaux audio stéréo de droite et de gauche seront mélangés mais la
sensation de stéréo sera préservée. Par exemple, sur certains enregistrements stéréo anciens où les données
audio stockées sur les canaux de droite et de gauche sont complètement différenciées, l’enregistrement
reproduit sur un système sonore stéréo d’ambiance donne l’impression qu’il s agit de contenus musicaux
distincts diffusés à partir d’emplacements différents. Le réglage « Blend » réduit efficacement cette différence.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Annule les réglages et ferme la boîte de dialogue.
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15.7.2. Boîte de dialogue « SD Card File Manager »

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis sur [SD Card File Manager] pour ouvrir cette boîte de

dialogue.

Permet d’enregistrer les fichiers à lire à l’aide de la carte SD.

Cette liste est utilisée pour la reproduction de fichiers via DCP, GPI, etc.
Pour en savoir plus, reportez-vous au chapitre DME7.
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15.7.3. Boîte de dialogue « Scheduler » (Programmateur)

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis cliquez sur [Scheduler] pour ouvrir cette boîte de

dialogue.
Vous pouvez changer de présélection ou reproduire un morceau ou un effet sonore à partir d’une carte
mémoire SD à une date et une heure précédemment spécifiées. Chacun de ces réglages est appelé un
« événement ».

< Exemple d’utilisation 1 >

Changer de musique de fond selon la période
Voici comment changer le type de musique de fond selon la période, dans un établissement commercial par
exemple.

< Exemple d’utilisation 2 >

Changer de musique de fond selon les jours de la semaine
Voici comment changer de musique de fond selon le jour de la semaine ou les heures de travail, dans un
établissement commercial par exemple.

Vous pouvez également définir des exceptions. Par exemple, vous pouvez choisir de diffuser une musique de
fond spécifique en période de fêtes de fin d’années, ou d’arrêter la lecture les jours de fermeture de
l’établissement.



• Si un événement a été affecté, le voyant [SCHEDULER] du panneau avant du MTX s’allume

en jaune. Le voyant se mettra à clignoter une minute avant que l’événement ne commence.
• Si plusieurs événements sont affectés en même temps, tous les événements s’exécuteront
successivement avec une seconde d’intervalle. Pendant ce temps, le paramètre [SCHEDULER]

du panneau avant du MTX continue de clignoter.
• Si la case [Enable Daylight Saving Time] est cochée dans la boîte de dialogue « Daylight
Saving Time », les événements qui ont été programmés dans les deux heures avant ou après
le début ou la fin de l’heure d’été ne s’exécuteront pas correctement.
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Vous pouvez affecter jusqu’à 50 événements et 50 exceptions.

• Bouton [Month] (Mois)/Bouton [Day] (Jour)
Permet de basculer le calendrier en vue mensuelle ou journalière.

Vue mensuelle Vue journalière

◦ Sur le calendrier, double-cliquez sur la date de votre choix. La boîte de dialogue « Add Event »
(Ajouter un événement) s’affiche pour vous permettre d’ajouter un événement.

◦ Les événements non répétitifs peuvent être déplacés par glisser-déposer (dans la vue mensuelle,
vous pouvez les déplacer d’un jour à l’autre, et dans la vue journalière, d’une heure à l’autre).

◦ Dans la vue mensuelle, vous pouvez cliquer sur l’icône du calendrier pour accéder à un écran de
sélection de l’année ou du mois.

• Bouton [Today] (Aujourd’hui)

Affichage mensuel : permet d’afficher le calendrier du mois en cours.
Affichage journalier : permet d’afficher le planning du jour.

• Boutons [ ＜ ]/[ ＞ ]

Affichage mensuel : permet d’afficher le calendrier du mois précédent ou du mois suivant.
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Affichage journalier : permet d’afficher le planning de la veille ou du lendemain.

• Event Control (Gestion des événements)

◦ Bouton [Add]

La boîte de dialogue « Add Event » (Ajouter un événement) apparaît.
Elle vous permet d’ajouter un événement.

◦ Bouton [Edit]

La boîte de dialogue « Edit Event » (Modifier un événement) apparaît.
Elle vous permet de modifier le contenu de l’événement sélectionné. Si aucun événement n’est
sélectionné, le bouton est grisé.

◦ Bouton [Clear]
Permet de supprimer l’événement actuellement sélectionné. Si aucun événement n’est sélectionné,
le bouton est grisé.

◦ Bouton [All Clear]
Permet de supprimer tous les événements enregistrés.

• Case à cocher [Show Event Time] (Afficher l’heure de l’événement)
Si cette case est cochée, l’heure de l’événement apparaît sur l’affichage mensuel.

• Event Info (Infos de l’événement)
Dans cette zone sont affichées les informations spécifiées dans les boîtes de dialogue « Add Event » ou
« Edit Event » (Modifier un événement) correspondant à l’événement sélectionné.

◦ Operation Type (Type d’opération)
Permet d’indiquer l’opération qui sera exécutée au moment du déclenchement de l’événement.

◦ Repeat Type (Type de répétition)
Permet d’indiquer la fréquence à laquelle l’événement se déclenchera.

◦ Set Exception (Définir une exception)
Permet d’indiquer la date et l’heure auxquelles, exceptionnellement, l’événement ne se produira
pas.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Permet de fermer la boîte de dialogue sans enregistrer les modifications.
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Boîtes de dialogue [Add Event] / [Edit Event]

● Event Name (Nom de l’événement)

Renseignez le nom de l’événement.

● [Event Operation] (Opération associée à l’événement)

Liste déroulante [Type]
Indiquez l’opération qui sera exécutée au moment du déclenchement de l’événement.


Dans la boîte de dialogue « Recall Settings », des opérations comme GPI Out ou SD Song
Select & Play peuvent être incluses dans la présélection. Sélectionnez GPI Out si vous voulez
contrôler un appareil externe via [GPI OUT] sans rappeler de présélection, ou sélectionnez SD
Song Select & Play si vous souhaitez changer le fichier audio à reproduire.

• Preset Recall
Une présélection est rappelée.

• GPI Out
Le connecteur [GPI OUT] est contrôlé.

• SD Song Select & Play

La lecture d’un fichier audio enregistré sur la carte mémoire SD démarre ou s’arrête.
Définissez à l’avance le fichier de lecture dans la boîte de dialogue « SD Card File Manager ».
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• Paging
Un message audio sauvegardé sur la carte mémoire SD est diffusé pour la destination spécifiée (ZONE).

● Settings
Le contenu varie selon l’événement choisi dans la liste déroulante [Type].

• Si vous avez choisi Preset Recall
Sélectionnez la présélection que vous souhaitez rappeler.

• Si vous avez choisi GPI Out

Permet de définir l’état du connecteur GPI OUT lorsqu’un événement est déclenché.
La méthode de réglage est la même que pour [GPI Out] dans la boîte de dialogue « Recall Settings ».

• Si vous avez choisi SD Song Select et Play
Spécifiez comment les fichiers audio enregistrés sur la carte mémoire SD seront lus ou arrêtés au
moment de l’événement.

◦ Pause
Permet d’arrêter le fichier de la carte SD en cours de lecture au démarrage d’un événement.

◦ Play

Permet de lancer la lecture du fichier de la carte SD au démarrage de l’événement.
Sélectionnez le numéro d’index de la liste dans la boîte de dialogue « SD Card File Manager ».

• Si vous avez choisi Paging
Spécifiez la zone/le groupe de zones vers laquelle/lequel les fichiers de message sauvegardés sur la
carte mémoire SD seront diffusés au moment de l’événement.
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• SD CARD:/
Indique le fichier de message sélectionné.

• Bouton [Browse]
Lorsque vous cliquez sur ce bouton, un écran apparaît qui vous permet de sélectionner un fichier de
message.

• [Zone]/[Zone Group] (Groupe de zones)
Ces paramètres permettent de spécifier la zone et le groupe de zones vers lesquels la diffusion est
effectuée. Plusieurs sélections sont possibles pour chacun d’eux.

• Boutons [All On]/[All Off]
Cliquez sur ces boutons pour activer ou désactiver toutes les zones ou tous les groupes de zones.

Définissez ZONE GROUP dans le composant ZONE > éditeur de composants PAGING, puis réglez la lecture de
carillon et l’affectation de fonctions sur les boutons PGM1 dans l’éditeur de composants PAGING > Settings.

● Event Schedule (Planifier événement)

Définissez la date et l’heure auxquelles l’événement sera déclenché.

• Commutateurs de sélection [Color]
Choisissez la couleur de l’événement affiché dans le calendrier. Vous pouvez vous servir des couleurs
pour distinguer différents types d’événements.

• [Date]

Permet de spécifier la date à laquelle l’événement sera déclenché (année/mois/jour).
Vous pouvez modifier la date en saisissant directement la valeur souhaitée ou en cliquant sur le

calendrier qui apparaît lorsque vous cliquez sur l’icône V sur la droite.
Selon le réglage REPEAT EVENT (Répéter l’événement) expliqué ci-dessous, cette option peut ne pas
s’afficher.

• [Time]
Permet de spécifier l’heure à laquelle l’événement sera déclenché. (heure:minute:seconde, au format

24 heures)
Cliquez sur l’heure, la minute ou la seconde que vous souhaitez spécifier ; utilisez les flèches de

défilement ou saisissez directement une valeur.
Si vous sélectionnez REPEAT EVENT et que vous spécifiez comme fréquence de l’événement « Hourly »
(Toutes les heures), vous ne pourrez régler que les minutes et les secondes.

● Repeat Event
Cette case à cocher permet de spécifier un événement qui se répète.

• Cases [Yearly]/[Monthly]/[Weekly]/[Daily]/[Hourly] (Tous les ans/Tous les mois/Toutes les

semaines/Tous les jours/Toutes les heures)
Permettent de définir la fréquence à laquelle l’événement se produira.

• Event start date and time (Date et heure de début de l’événement)
Permet de définir la date et l’heure auxquelles l’événement sera répété. Les éléments que vous pouvez
définir dépendent de la fréquence de l’événement.

◦ Si la fréquence de l’événement est [Yearly]
Si la case [Day of the Month] (Jour du mois) est cochée, l’événement se produira chaque année à la
date et à l’heure spécifiées par les paramètres « month » (mois), « 1st/2nd/3rd/4th »
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(1er/2ème/3ème/4ème), « day of the week » (jour de la semaine) et [Time].
Si la case [Day of the Month] n’est pas cochée, l’événement se produira chaque année au jour
sélectionné dans le calendrier (indiqué dans [Date]) et à l’heure sélectionnée dans [Time].

◦ Si la fréquence de l’événement est [Monthly]
Si la case [Day of the Week] (Jour de la semaine) est cochée, l’événement se produira chaque mois
à la date et à l’heure spécifiées par les paramètres « 1st/2nd/3rd/4th » (1er/2ème/3ème/4ème),

« day of the week » et [Time].
Si la case [Day of the Week] n’est pas cochée, l’événement se produira chaque mois au jour
sélectionné dans le calendrier (indiqué dans [Date]) et à l’heure sélectionnée dans [Time].

◦ Si la fréquence de l’événement est [Weekly]
L’événement se produira chaque semaine au jour de la semaine sélectionné et à l’heure indiquée
par [Time].

◦ Si la fréquence de l’événement est [Daily]
L’événement se produira chaque jour à l’heure (heure:minute:seconde) indiquée par [Time].

◦ Si la fréquence de l’événement est [Hourly]
L’événement se produira chaque heure au moment (heure:minute:seconde) indiqué par [Time].

◦ Bouton [Exception]

La boîte de dialogue « Event Exceptions » (Exceptions aux événements) apparaît.
Vous pouvez spécifier ici la date et l’heure auxquelles, à titre exceptionnel, l’événement répétitif
n’aura pas lieu.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Permet de fermer la boîte de dialogue sans enregistrer les modifications.
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■ Boîte de dialogue « Event Exceptions »

Vous pouvez spécifier ici la date et l’heure auxquelles, à titre exceptionnel, l’événement répétitif n’aura pas lieu.

Les éléments que vous pouvez définir dépendent de la fréquence de l’événement.

Exemple : - Ne pas diffuser de musique de fond le mercredi, lorsque l’établissement est fermé.
- Diffuser une musique de fond spécifique uniquement lors de l’événement qui se produit le troisième dimanche
de chaque mois.

• Exception Item (Détails de l’exception)

◦ Si la fréquence de l’événement est [Yearly]

Permet de définir l’année pendant laquelle l’événement n’aura pas lieu.
Seul le paramètre [Year] peut être renseigné.

◦ Si la fréquence de l’événement est [Monthly]

Permet de définir le mois ou le jour où l’événement n’aura pas lieu.
Seuls les paramètres [Month] (Mois) et [Day] peuvent être renseignés.

◦ Si la fréquence de l’événement est [Weekly]

Permet de définir le mois, la semaine ou le jour où l’événement n’aura pas lieu.
Seuls les paramètres [Month], [Week] et [Day] peuvent être renseignés.

◦ Si la fréquence de l’événement est [Daily]

Permet de définir le mois, la semaine ou le jour de la semaine où l’événement n’aura pas lieu.
Seuls les paramètres [Month], [Week], [Day] et [Day of the week] peuvent être renseignés.

◦ Si la fréquence de l’événement est [Hourly]
Permet de définir le mois, la semaine, le jour de la semaine ou l’heure où l’événement n’aura pas

lieu.
Les paramètres [Month], [Week], [Day], [Day of the week] et [Hour] peuvent être renseignés.

◦ Bouton [ ＞ ]
Permet d’ajouter une date et une heure que vous souhaitez définir comme exception dans la liste
sur la droite.

◦ Bouton [ ＜ ]
Permet de supprimer une date et une heure que vous avez définies comme étant des exceptions de
la liste sur la droite.

◦ Bouton [<<]
Permet de supprimer de la liste sur la droite toutes les dates et les heures que vous avez définies
comme étant des exceptions.

◦ Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

◦ Bouton [Cancel]
Permet de fermer la boîte de dialogue sans enregistrer les modifications.
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15.7.4. Boîte de dialogue « GPI »

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis cliquez sur [GPI Input] ou [GPI Output] pour ouvrir

cette boîte de dialogue.
L’utilisation des fonctions GPI est identique à celle du DME7, mais les paramètres qui peuvent être affectés avec
FUNCTION sont différents.

■ [GPI Input]

Boîte de dialogue « Settings »

 Pour en savoir plus sur le type d’entrée, reportez-vous à la section GPI du DME7.

Function

• [No Assign] (Aucune affectation)
Ce réglage est utilisé pour ne pas modifier les réglages des commutateurs, boutons et curseurs du

contrôleur.
[DEVICE] et [PARAMETER1/2] ne sont pas disponibles.

• [MTX ON]

La tension d’entrée sur le connecteur [GPI IN] active/désactive le paramètre.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Input Ch ON

◦ Fx RTN ON

◦ ZONE Out ON (Sortie de zone activée)

◦ Output Ch ON (Canal de sortie activé)

◦ Input Ch Mute Group (Groupe de mutes du canal d’entrée)

◦ ZONE Out Mute Group (Groupe de mutes de la sortie de zone)


Pour Input Ch Mute Group et ZONE Out Mute Group, le voyant de l’unité
principale s’éteint lorsque l’assourdissement est activé.
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◦ [Parameter1]
Permet de définir le canal du paramètre.

◦ [Input Type]

Permet de spécifier la manière dont la tension d’entrée de GPI IN s’applique au paramètre.
Vous pouvez choisir [High Active], [Low Active], [Rising Edge] (Front montant) ou [Falling Edge]
(Front descendant).

• [MTX Send ON] (Envoi du MTX activé)

La tension d’entrée sur le connecteur [GPI IN] contrôle l’activation/désactivation de l’envoi du canal.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Input Ch Send ON (Envoi du canal d’entrée activé)

◦ Fx RTN Send ON (Envoi du Fx RTN activé)

• [MTX Priority Ducker ON] (Ducking prioritaire du MTX activé)

La tension d’entrée sur le connecteur [GPI IN] active/désactive le ducking de la zone.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ 1st Priority (1ère priorité)

◦ 2nd Priority (2e priorité)

• [MTX Dugan Automixer] (Dugan Automixer MTX)

La tension d’entrée sur le connecteur [GPI IN] active/désactive le paramètre.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Override(main) (Remplacer (principal))

◦ Mute(main) (Assourdir (principal))

◦ override(Ch) (Remplacer (Canal))

• [SD Play]

La tension d’entrée sur le connecteur [GPI IN] lance la lecture du fichier audio spécifié.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ SD Song Select & Play

◦ SD Song Pause

◦ [Input Type]

Permet de spécifier la manière dont la tension d’entrée de GPI IN s’applique au paramètre.
Vous pouvez choisir [Rising Edge] ou [Falling Edge].

• [Preset Recall]
La tension d’entrée sur le connecteur [GPI INPUT] rappelle la présélection spécifiée.

◦ [Parameter1]
Sélectionnez le numéro de la présélection que vous souhaitez rappeler.

◦ [Input Type]

Permet de spécifier la manière dont la tension d’entrée du GPI IN s’applique au paramètre.
Vous pouvez choisir [Rising Edge] ou [Falling Edge].
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• [External Event]
La tension d’entrée du connecteur [GPI IN] déclenche l’émission des commandes spécifiées dans la boîte
de dialogue « External Events ».

◦ [Parameter1]
Sélectionnez le nom de l’événement à exécuter.

◦ [Input Type]

Permet de spécifier la manière dont la tension d’entrée de GPI IN s’applique au paramètre.

Vous pouvez choisir [High Active], [Low Active], [Rising Edge] ou [Falling Edge].
Si vous avez sélectionné [On/Off] (Activer/Désactiver) pour [Command Type] (Type de commande),
l’action suivante se produit :

[High Active]
(Hautement actif)

Si la tension d’entrée est élevée, la commande affectée
à [Command - On] (Commande - Activer) est
transmise. Si la tension d’entrée est faible, la
commande affectée à [Command - Off] (Commande -
Désactiver) est transmise.

[Low Active]
(Faiblement actif)

Si la tension d’entrée est faible, la commande affectée
à [Command - On] est transmise. Si la tension d’entrée
est élevée, la commande affectée à [Command - Off]
est transmise.

[Rising Edge] Chaque fois que la tension d’entrée devient élevée, la
commande affectée à [Command - On] et celle
affectée à [Command - Off] sont transmises en
alternance.

[Falling Edge] Chaque fois que la tension d’entrée devient faible, la
commande affectée à [Command - On] et celle
affectée à [Command - Off] sont transmises en
alternance.

• [MTX Level]

La tension d’entrée sur le connecteur [GPI IN] contrôle le niveau du canal.
Si le niveau maximal ne peut pas être atteint en raison de la longueur du câble, ajustez les valeurs de

tension d’entrée maximale et minimale dans la boîte de dialogue « GPI Calibration » (Calibrage GPI).
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Input Ch Level

◦ Fx RTN Level

◦ Matrix Out Level

◦ ZONE Out Level

◦ Output Ch Level

◦ 1st Priority Mix Level

◦ 2nd Priority Mix Level

◦ Input Ch DCA Group (Groupe DCA du canal d’entrée)

◦ ZONE Out DCA Group (Groupe DCA de la sortie de zone)

◦ [Parameter1]
Permet de spécifier le canal dont vous souhaitez contrôler le niveau.

◦ [Input Type]

Permet de spécifier la manière dont le niveau de GPI IN s’applique au paramètre.
Vous pouvez sélectionner [Analog] (Analogique) ou [Analog Inv.] (Analogique inversée).
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◦ [Upper Limit]/[Lower Limit] (Limite supérieure/inférieure)
Servez-vous des réglages [Upper Limit] et [Lower Limit] pour définir la plage au sein de laquelle le
niveau peut varier. En utilisant [Parameter Range] (Plage de paramètres), vous pouvez limiter la

plage au sein de laquelle l’utilisateur peut contrôler le
volume. Par exemple, vous pouvez spécifier le volume maximal de la musique de fond ou utiliser
un contrôleur pour effectuer des réglages affinés de volume dans une plage étroite de – 6 dB à
+ 6 dB.

• [MTX Send Level] (Niveau d’envoi du MTX)

La tension d’entrée sur le connecteur [GPI IN] contrôle le niveau d’envoi du canal.

Si le niveau maximal ne peut pas être atteint en raison de la longueur du câble, ajustez

les valeurs de tension d’entrée maximale et minimale dans la boîte de dialogue « GPI Calibration ».
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Input Ch Send Level (Niveau d’envoi du canal d’entrée)

◦ Fx RTN Send Level (Niveau d’envoi du Fx RTN)

■ Boîte de dialogue [GPI Output]

Boîte de dialogue « Settings »

 Pour en savoir plus sur le type de sortie, reportez-vous à la section GPI du DME7.

Function

• [No Assign]
[OUTPUT TYPE] permet de spécifier la polarité du signal de sortie en cas d’alerte. Aucune autre fonction
n’est spécifiée ; il s’agit de la valeur par défaut.

◦ [Output Type]
Permet de contrôler la sortie GPI lors du rappel d’une présélection ou de l’exécution d’un
événement planifié.

• [MTX ON]

Les opérations d’activation/désactivation du paramètre contrôlent la sortie GPI.
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Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Input Ch ON

◦ Fx RTN ON

◦ ZONE Out ON

◦ Output Ch ON

◦ Input Ch Mute Group

◦ ZONE Out Mute Group

◦ [Parameter1]
Spécifiez le canal qui contrôlera le réglage d’activation/désactivation du paramètre.

◦ [Output Type]

Permet de spécifier le mode de sortie du connecteur [GPI OUT].
Vous pouvez choisir [Closed], [Open], [Pulse], [Pulse Inv.] ou [Falling Edge].

• [MTX Send On]

Les opérations d’activation/désactivation de l’envoi contrôlent la sortie GPI.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Input Ch Send ON

◦ Fx RTN Send ON

• [MTX Priority Ducker ON]

Les opérations d’activation/désactivation du ducker de la zone contrôlent la sortie GPI.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ 1st Priority

◦ 2nd Priority

• [MTX Dugan Automixer]

Les opérations d’activation/désactivation du paramètre contrôlent la sortie GPI.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Override(master)

◦ Mute(master)

◦ override(Ch)

◦ [Parameter1]
Pour Override (master) (Remplacer (principal)) et Mute (master) (Assourdir (principal)),
sélectionnez le groupe qui contrôle l’activation/désactivation. Pour Override (Ch) (Remplacer
(Canal)) sélectionnez le canal qui contrôle l’activation/désactivation.

◦ [Output Type]
Permet de spécifier le mode de sortie du connecteur [GPI OUT].

• [SD Song Play]
L’état de lecture des fichiers audio est transmis au connecteur [GPI OUT].

◦ [Output Type]
Permet de spécifier le mode de sortie du connecteur [GPI OUT].

• [MTX Level]
Permet de contrôler la sortie GPI en fonction du niveau (changements de volume) de chaque canal. Vous
pouvez utiliser cette fonction pour démarrer un lecteur de CD à l’aide d’un curseur ou pour faire en sorte

qu’un voyant s’allume en cas de volume élevé.
Sélectionnez l’un des types de paramètre suivants, puis effectuez les réglages appropriés.

◦ Input Ch Level
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◦ Fx RTN Level

◦ Matrix Out Level

◦ ZONE Out Level

◦ Output Ch Level

◦ 1st Priority Mix Level

◦ 2nd Priority Mix Level

◦ Input Ch DCA Group

◦ ZONE Out DCA Group

◦ [Parameter1]
Spécifiez le canal qui sera utilisé pour commander le connecteur [GPI OUT].

◦ [Output Type]
Permet de spécifier le mode de sortie du connecteur [GPI OUT].

• [MTX Send Level]
Vous pouvez utiliser cette fonction pour démarrer un lecteur de CD à l’aide d’un curseur ou pour faire en
sorte qu’un voyant s’allume en cas de volume élevé. Sélectionnez l’un des types de paramètre suivants,
puis effectuez les réglages appropriés.

◦ Input Ch Send Level

◦ Fx RTN Send Level

• [Alert]
Un signal sera envoyé au connecteur [GPI OUT] en cas d’alerte.

◦ [Parameter1]
Sélectionnez le type d’alerte parmi la liste ci-dessous. Pour en savoir plus sur le type d’alerte émise,
reportez-vous à la section « Liste des alertes ».

▪ Fault, Error, Warning

▪ Fault, Error

▪ Fault

◦ [Output Type]
Seul le paramètre Closed peut être sélectionné. En cas d’alerte, le connecteur [GPI OUT] sera fermé.
Il restera fermé jusqu’à ce que l’alerte soit levée.
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15.7.5. Boîte de dialogue « External Events »

Cliquez sur le bouton [Tools] dans la feuille d’appareil, puis cliquez sur [External Events…] pour ouvrir cette boîte

de dialogue.
Vous pouvez effectuer ici les réglages d’une commande qui sera transmise au réseau auquel le connecteur
Dante ou le connecteur NETWORK est connecté. Cette commande peut être déclenchée par le rappel d’une
présélection sur le MTX, via l’entrée GPI, ou via l’opération d’un appareil externe tel qu’une unité DCP.

 Seules les commandes sont transmises, les réponses aux commandes sont ignorées.

Vous pouvez configurer jusqu’à 20 événements. Vous pouvez configurer jusqu’à 5 commandes par événement.

• Bouton Menu ( )
Cliquez sur ce bouton pour exécuter les fonctions suivantes.

◦ [Copy Event] (Copier l’événement)
Permet de copier le contenu de l’événement sélectionné dans le tampon de copie.

◦ [Copy All Event] (Copier tous les événements)
Permet de copier le contenu de tous les événements dans le tampon de copie.

◦ [Paste Event] (Coller l’événement)
Permet d’enregistrer les réglages d’événement dans le tampon de copie par écrasement.

◦ [Clear Event] (Effacer l’événement)
Permet de réinitialiser le contenu de l’événement sélectionné.

◦ [Clear All Event] (Effacer tous les événements)
Permet de réinitialiser le contenu de tous les événements.

• Zone de liste [Event No.] (Numéro de l’événement)
Permet de spécifier le numéro d’événement.

• Zone de liste [Event Mode] (Mode de l’événement)

Permet de spécifier si la commande déclenchée est de type [On/Off] (Activer/Désactiver) ou [1shot].
Lorsqu’un événement est affecté au bouton d’un appareil externe, tel qu’une unité DCP, chaque type de
commande déclenche l’opération suivante :

◦ [On/Off]
Lorsque vous appuyez plusieurs fois sur le bouton affecté, le MTX transmet les commandes On
(Activer) et Off (Désactiver) en alternance.

◦ [1shot]
Lorsque vous appuyez sur le bouton affecté, le MTX transmet la commande programmée.

• Zone de texte [Event Name] (Nom de l’événement)
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Permet de spécifier le nom de l’événement.

• Boutons [Test - On] (Test - Activer) /[Test - Off] (Test - Désactiver)
ProVisionaire Design transmet directement les commandes spécifiées dans le tableau « Controlled
Device » (Appareil contrôlé) dans l’ordre numérique. Si [1shot] a été sélectionné dans la zone de liste
[Command Type] (Type de commande), le bouton [Test - Off] est désactivé.

 Vous pouvez exécuter la transmission de commande en ligne ou hors ligne.

• Tableau « Controlled Device » (Appareil contrôlé)
Spécifiez les informations relatives à l’appareil qui recevra les commandes. Lorsque l’appareil reçoit un

signal déclencheur, il transmet les commandes par ordre numérique, comme indiqué dans le tableau.
Pour en savoir plus sur les réglages de l’appareil récepteur, reportez-vous aux explications de la
documentation de l’appareil en question relatives aux commandes.

◦ Zone de liste [Protocol]
Sélectionnez le protocole pris en charge par l’appareil qui reçoit les commandes.

◦ Zone de texte [IP Address]
Spécifiez l’adresse IP de l’appareil qui reçoit les commandes.

◦ Zone de texte [Port No.] (Numéro de port)
Spécifiez le numéro de port de l’appareil qui reçoit les commandes.

◦ Zone de texte [Comments] (Commentaires)
Vous pouvez entrer jusqu’à 32 caractères alphabétiques. Ce texte peut être un nom permettant
d’identifier l’appareil.

• Bouton [Copy]
Permet de copier dans le tampon de copie les informations sur la commande sélectionnée, spécifiées
dans le tableau « Controlled Device » et la zone de texte Command.

• Bouton [Paste]
Permet de coller (et de remplacer) les informations que contient le tampon de copie dans le tableau
« Controlled Device » et la zone de texte Command.

• Bouton [Test]
ProVisionaire Design transmet directement les commandes entrées dans la zone de texte Command.

• Bouton [Overwrite] / [Insert]
Cliquez sur ce bouton plusieurs fois pour basculer entre les modes de remplacement et d’insertion.
Lorsque le bouton [Insert] s’affiche, vous pouvez insérer un numéro hexadécimal au début ou au milieu du
texte dans la zone de texte Command.

• Zones de texte Command
Si [On/Off] a été sélectionné dans la zone de liste [Event Mode], appuyez plusieurs fois sur le bouton d’un
appareil externe, tel qu’une unité DCP, pour que le MTX transmette les commandes On et Off en
alternance. Si [1shot] a été sélectionné dans la zone de liste [Event Mode], appuyez plusieurs fois sur le
bouton d’un appareil externe, tel qu’une unité DCP, pour que le MTX/MRX transmette les commandes

programmées.

Les commandes doivent être des nombres hexadécimaux et être entrées au format XX.
Si une commande pour contrôler un appareil externe est exprimée par une chaîne de texte dans le
document de spécification correspondant, servez-vous de la zone Converter (Convertisseur) pour
convertir la chaîne de texte en un nombre hexadécimal.

 La longueur maximale d’une commande est de 128 octets.

• Bouton [Converter>>]
Affiche une zone qui vous permet de convertir une chaîne de texte en nombre hexadécimal.

• Bouton d’option [ASCII to Hex] (ASCII vers Hex)/[Hex to ASCII] (Hex vers ASCII)
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Ces options vous permettent de convertir une chaîne de texte en numéro hexadécimal, ou vice versa.

15. Processeurs audio : MTX5-D/MTX3

ProVisionaire Design V1.2 Guide d’utilisation | 273



• Zone de texte [ASCII]/[Hex]
La zone de texte supérieure peut être nommée ASCII ou Hex, selon la sélection effectuée dans les cases

d’option [ASCII to Hex]/[Hex to ASCII].
Cliquez sur le bouton [Convert] (Convertir) pour afficher le résultat de la conversion dans la zone de texte
inférieure.

• Bouton [Reset]
Permet d’effacer le contenu des zones de texte [ASCII]/[Hex].

• Bouton [To Command] (Vers la commande)
Permet d’afficher la commande hexadécimale (qui a été convertie à partir de la chaîne de texte) dans la

zone de texte Command.
Si vous avez sélectionné [On/Off] dans la zone de liste [Command Type], les boutons [Command - On] et
[Command - Off] s’affichent pour que vous puissiez sélectionner le bouton auquel la commande doit
s’appliquer.

• Bouton [OK]
Met à jour les réglages et ferme la boîte de dialogue. Si l’adresse IP ou le format de commande n’est pas
valide, un message d’erreur s’affiche et la boîte de dialogue ne se ferme pas.

• Bouton [Cancel]
Ferme la boîte de dialogue sans mettre à jour les réglages.
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15.7.6. Boîte de dialogue « Recall Settings » (Rappeler les réglages)

Cliquez sur [Recall Settings] dans la zone « Presets » de la feuille des appareils pour ouvrir cette boîte de

dialogue.
Cette boîte de dialogue permet de configurer les réglages liés à la bibliothèque DCP et à l’événement externe qui
sont rappelés en même temps qu’une présélection.

• DCP Library (Bibliothèque DCP)
Permet de sélectionner la bibliothèque DCP à rappeler en même temps qu’une présélection.

• External Event

Permet de sélectionner l’événement à émettre lors du rappel d’une présélection.
Sélectionnez le numéro d’événement défini dans la boîte de dialogue « External Events ».

• GPI Out

Permet de configurer le réglage GPI OUT qui est émis lors du rappel d’une présélection.
Un appareil externe relié à la borne [GPI OUT] de l’unité principale est contrôlé à l’aide de la sortie de GPI
OUT.

Boutons [Active] (Actif)/[Inactive] (Inactif)/[Ignore] (Ignorer)
Ces boutons permettent de choisir si la sortie du connecteur GPI OUT est activée (Active), activée avec un

OUTPUT TYPE inversé (Inactive) ou ignorée (Ignore).
Si [OUTPUT TYPE] dans la boîte de dialogue GPI Output est défini sur [Pulse] ou [Pulse Inv.], les seuls

choix disponibles sont [Active] et [Ignore].
Si [OUTPUT TYPE] dans la boîte de dialogue « Settings » est défini sur [Pulse] ou [Pulse Inv.], les seuls
choix disponibles sont [Active] et [Ignore].

◦ Si [Active] est défini

Lorsque [OUTPUT TYPE] est défini sur [Closed], la broche [GPI OUT] est fermée (reliée à la terre).

Lorsque le réglage [OUTPUT TYPE] est sur [Open], la broche [GPI OUT] est ouverte.
Lorsque le réglage [OUTPUT TYPE] est sur [Pulse], la broche [GPI OUT] est fermée (reliée à la terre)

pendant environ 250 ms.
Lorsque [OUTPUT TYPE] est défini sur [Pulse Inv.], la broche [GPI OUT] est ouverte pendant environ
250 ms.

◦ Si [Inactive] est défini

Lorsque le réglage [OUTPUT TYPE] est sur [Closed], la broche [GPI OUT] est ouverte.
Lorsque le réglage [OUTPUT TYPE] est sur [Open], la broche [GPI OUT] est fermée (reliée à la terre).
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• Si [Ignore] est défini
Il n’y a pas de changement dans la sortie. Utilisez ce réglage si une autre fonction est affectée à GPI OUT
et que vous ne souhaitez pas que cette fonction soit affectée par le rappel d’une présélection.

◦ SD Song Select & Play

• Pause
Permet d’arrêter la lecture du fichier en même temps que le rappel de la présélection.

• Play

Permet de lancer la lecture du fichier spécifié en même temps que le rappel de la présélection.
Permet de spécifier le numéro d’index de la liste dans la boîte de dialogue « SD Card File Manager ».
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15.7.7. Boîte de dialogue « Recall Filter » (Rappeler le filtre)

Cliquez sur [Recall Filter] dans la zone « Presets » de la feuille d’appareil pour ouvrir cette boîte de dialogue.
Vous pouvez spécifier ici quels paramètres sont rappelés lorsque vous rappelez une présélection. Par exemple,
si les niveaux d’entrée/sortie ne changent pour aucune des présélections, vous pouvez exclure les paramètres
INPUT LEVEL (Niveau d’entrée) et OUTPUT LEVEL (Niveau de sortie) du rappel, de manière à ce que les réglages
de niveau restent identiques sans qu’il soit nécessaire de les renseigner pour chaque présélection.

● Bouton [All On] (Tout activer)
Permet de sélectionner tous les boutons (affichés alors en bleu). Toutes les présélections seront rappelées.

● Bouton [All Off] (Tout désactiver)
Permet de désactiver tous les boutons (affichés alors en blanc). Aucun des paramètres ne sera rappelé.

● Boutons de sélection des paramètres

• Bouton [HA] (Préampli micro)
Si cette fonction est activée, les réglages de gain HA et d’alimentation fantôme (+48 V) des ports d’entrée
sont rappelés.

• Bouton [IN PATCH] (Assignation d’entrée)
Si ce paramètre est activé, les réglages d’assignation d’entrée et les noms des canaux d’entrée sont

récupérés.
Ces boutons commandent notamment l’assignation sur les canaux d’entrée de la carte MY4-AEC des
composants From Far-end (Depuis l’extrémité distante), Farend Voice (Voix distante), Near-end Mic.
(Microphone local), Near-end Voice (Voix locale) et To Far-end (Vers l’extrémité distante).

• Boutons [INPUT]/[LEVEL]

Si le bouton [INPUT] est sélectionné, les réglages de canaux d’entrée suivants seront rappelés.

Canaux d’entrée : Phase, HPF, Digital Gain, PEQ, COMP, GATE, AGC, FBS, Insert on/off
Le réglage Insert on/off (Activation/désactivation de l’insertion) est uniquement destiné au système

MTX5-D.

Canaux d’entrée stéréo : Digital Gain, PEQ, AGC, COMP
Si le bouton [LEVEL] est activé, les réglages de niveau du canal d’entrée et d’activation/désactivation

(assourdissement) sont rappelés.
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Ils peuvent être spécifiés individuellement pour chaque canal.


Dans la boîte de dialogue « MTX Configuration », si [INPUT PORT SETUP] passe de « MONO
x2 » à « STEREO », les réglages des boutons [INPUT]/[LEVEL] suivront le côté « L » (gauche).
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• Boutons [Fx1]/[Fx2]
Si ces boutons sont sélectionnés, le type d’effet et les réglages suivants sont rappelés.

◦ Niveau d’envoi du canal d’entrée vers le bus d’effet, activation/désactivation de l’envoi

◦ Niveau de retour de l’effet, activation/désactivation (assourdissement)

◦ Nom du retour d’effet

• Bouton [DCA] (côté INPUT)
Si ce bouton est sélectionné, les réglages suivants sont rappelés.

◦ Affectation du canal d’entrée au groupe DCA ou de mutes

◦ Niveau principal du groupe DCA

◦ Mute principal du groupe de mutes

• Bouton [Automixer]
Si ce bouton est activé, les réglages du Dugan Automixer sont rappelés.

• Bouton [MATRIX SEND] (Envoi vers Matrix)
Si le bouton de gauche est activé, les réglages suivants sont rappelés. Si le bouton de droite est activé, le
niveau de sortie de matrice est rappelé.

◦ Niveau d’envoi du canal d’entrée vers le bus Matrix, activation/désactivation de l’envoi et
panoramique du canal stéréo

◦ Niveau d’envoi du retour d’effet vers le bus Matrix, activation/désactivation de l’envoi et
panoramique du canal stéréo

• Boutons [ANC1 SEND]/[ANC2 SEND] (Envoi ANC1/ANC2)
Si ces boutons sont activés, le niveau d’envoi du canal d’entrée vers le bus ANC et l’état d’envoi
(activé/désactivé) sont rappelés.

• Bouton [ZONE]
Si ce bouton est sélectionné, les réglages suivants sont rappelés.

◦ Priority Source de 1st Priority, Mix Level, Ducker

◦ Priority Source de 2nd Priority, Mix Level, Ducker

◦ ANC

◦ Nom de la zone


Dans la boîte de dialogue « MTX Configuration », si [INPUT PORT SETUP] passe de « MONO
x2 » à « STEREO », le réglage du bouton [ZONE] suivra la zone impaire.

• Bouton [PAGING]
Si ce bouton est activé, le réglage du bouton PAGING [ON] (Radiomessagerie - Activé) est rappelé.

• Bouton [ZONE OUT]
Si ce bouton est activé, le niveau de zone de sortie et l’activation/désactivation (assourdissement) seront
rappelés.

• Bouton [DCA] (côté ZONE)
Si ce bouton est sélectionné, les réglages suivants sont rappelés.

◦ Affectation du canal de la sortie de la zone au groupe DCA ou de mutes

◦ Niveau principal du groupe DCA

◦ Mute principal du groupe de mutes

• Bouton [ROUTER] (Routeur)
Si ce bouton est activé, les réglages du routeur sont rappelés.

• Bouton [LEVEL]/[OUTPUT]
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Si le bouton [LEVEL] est sélectionné, les réglages de niveau du canal de sortie et

d’activation/désactivation (assourdissement) sont rappelés.
Si le bouton [OUTPUT] est activé, les réglages de l’égaliseur de pièce, du retard et du processeur de haut-

parleur sont rappelés.
Ils peuvent être spécifiés individuellement pour chaque canal.

• Bouton [OUT PATCH] (Assignation de sortie)
Si ce bouton est activé, les réglages d’assignation de sortie et les noms des canaux de sortie sont
rappelés.

• Bouton [OUT PORT]
Si ce bouton est activé, les réglages de gain de sortie et de polarité sont rappelés.

• Bouton [EXT. I/O YDIF] (YDIF d’entrée et de sortie externe)
Si ce bouton est activé, les réglages du signal audio émis depuis le MTX vers YDIF en mode Distribution
sont rappelés.

• Bouton [DCP]
Si ce bouton est sélectionné, les affectations de paramètres de l’unité DCP (panneau de commande
numérique) connectée au MTX/MRX sont rappelées. Ce bouton affiche l’ID du DCP.

• Bouton [MY4-AEC] (MTX5-D uniquement)

Si ce bouton est activé, les réglages de la carte MY4-AEC installée sur le MTX5-D sont rappelés.
Les réglages suivants ne sont pas compris dans les réglages de rappel du bouton [MY4-AEC].

◦ From Far-end, Far-end Voice, Near-end Mic., Near-end Voice et To Far-end (inclus dans la plage du
bouton [IN PATCH])

◦ SRC
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15.7.8. Boîte de dialogue « Sampling Rate Converter » (Convertisseur du taux
d’échantillonnage)

Cliquez sur « Sample Rate Converter » dans le menu contextuel de l’éditeur de composants « Slot In » ou « Slot

Out ».
Vous pouvez activer/désactiver ici la fonction SRC (Sampling Rate Converter, Convertisseur du taux
d’échantillonnage) de la carte MY4-AEC ou MY8-AE96S installée dans le logement de l’appareil et spécifier le
réglage de l’horloge de mots de la sortie.

• Bouton [ON]
Permet d’activer ou de désactiver la fonction SRC. Ce bouton indique également l’état
d’activation/désactivation.

• Case [Fs Type] MY4-AEC uniquement)
Permet de sélectionner l’horloge de mots émise en sortie depuis la carte MY4-AEC lorsque la fonction

SRC est activée.
Si vous sélectionnez AES/EBU_IN_CH1/2, l’horloge de mots reçue sur les entrées 1/2 de la carte MY4-AEC
sera émise en sortie. Si vous sélectionnez AES/EBU_IN_CH3/4, l’horloge de mots reçue sur les entrées
3/4 de la carte MY4-AEC sera émise en sortie.

• Bouton [OK]
Applique les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Permet de fermer la boîte de dialogue sans appliquer de réglages.
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15.8. Liste des alertes

Les alertes générées par les unités MRX7-D/MTX5-D/MTX3 ainsi que leur signification et les mesures à prendre

sont répertoriées ci-dessous.
Si cela ne vous permet pas de résoudre le problème, contactez votre distributeur Yamaha.

Alerte
d’alerte

Signification Mesure à prendre

01–09 L’appareil n’a pas démarré correctement. Mettez l’appareil hors tension, patientez au moins
6 secondes, puis remettez-le sous tension. Si cette
action ne résout pas le problème, veuillez réinitialiser la
mémoire. Si cette mesure échoue également,
contactez votre distributeur Yamaha.

10 La batterie de secours interne est
complètement déchargée ou n’a pas été
installée.

Lorsque vous mettez l’appareil hors tension, les
réglages actuels sont perdus et réinitialisés sur leurs
valeurs par défaut. Veuillez arrêter immédiatement
l’appareil et contacter votre distributeur Yamaha.

11 La batterie de secours interne est très faible
et il est possible que la mémoire interne ait
été effacée.

Lorsque vous mettez l’appareil hors tension, les
réglages actuels sont perdus et réinitialisés sur leurs
valeurs par défaut. Veuillez arrêter immédiatement
l’appareil et contacter votre distributeur Yamaha.

12 La batterie de secours interne est presque
complètement déchargée.

Cela n’affecte pas le fonctionnement de l’appareil.
Cependant, si vous poursuivez votre utilisation de
l’appareil, les réglages pourront être perdus et
réinitialisés sur leur valeur par défaut. Contactez votre
distributeur Yamaha dès que possible.

13 Un problème est survenu au niveau de
l’horloge interne et celle-ci a été réinitialisée
(1er janvier 2000, 0 h 00).

Si ce phénomène se produit à chaque mise sous
tension, il est possible que la batterie de secours
interne soit déchargée ou que l’appareil présente un
dysfonctionnement. Contactez votre distributeur

Yamaha.
Si cela n’arrive qu’une seule fois, l’horloge a sans doute
été réinitialisée suite à la détection d’une erreur de
paramétrage. Utilisez ProVisionaire Design pour régler
l’heure.

14 La présélection actuelle enregistrée dans la
mémoire interne a été perdue.

Rappelez la présélection. Si cette action ne résout pas
le problème, contactez votre distributeur Yamaha.

15 Les réglages enregistrés dans la mémoire
interne sont perdus.

La batterie de secours interne est faible ou l’appareil
présente un dysfonctionnement. Contactez votre
distributeur Yamaha.

20 Une carte Mini-YGDAI incompatible a été
insérée dans le logement, ou la carte Mini-
YGDAI insérée a connu un
dysfonctionnement.

Remplacez la carte par une carte Mini-YGDAI
compatible ou vérifiez si la carte Mini-YGDAI insérée
fonctionne correctement dans un autre hôte.

21 L’horloge de mots leader est déverrouillée. Assurez-vous que le signal de l’horloge de mots est
reçu correctement.
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Alerte
d’alerte

Signification Mesure à prendre

22 Le signal numérique envoyé au connecteur
[YDIF IN] n’est pas synchronisé avec
l’horloge de mots de l’appareil.

Vérifiez que les câbles YDIF sont correctement

branchés.
Utilisez des câbles conformes aux caractéristiques
techniques requises.

23 Le signal numérique envoyé au connecteur
[YDIF IN] n’est pas synchronisé en continu
avec l’horloge de mots de l’appareil.

24 Le signal numérique envoyé au logement
n’est pas synchronisé avec l’horloge de
mots de l’appareil.

Vous pouvez soit émettre en entrée un signal
synchronisé, soit spécifier le logement en tant
qu’horloge de mots leader.

25 Le signal numérique envoyé au logement
n’est pas synchronisé en continu avec
l’horloge de mots de l’appareil.

26 Le signal numérique envoyé au connecteur
Dante n’est pas synchronisé avec l’horloge
de mots de l’appareil.

Vous pouvez soit émettre en entrée un signal
synchronisé, soit spécifier le connecteur Dante en tant
qu’horloge de mots leader.

27 Le signal numérique transmis au
connecteur Dante n’est pas synchronisé en
continu avec l’horloge de mots de l’appareil.

28 La fréquence d’échantillonnage Dante a été
modifiée pour correspondre à l’horloge de
mots leader de cette unité.

Vérifiez le réglage de l’horloge de mots de l’unité.
Définissez ensuite la fréquence d’échantillonnage du
réseau Dante.

30 La connexion du connecteur [YDIF IN]
présente un problème.

Vérifiez que les câbles YDIF sont correctement

branchés.
Utilisez des câbles conformes aux caractéristiques
techniques requises.

40 Des adresses IP sont en double. Modifiez les adresses IP de sorte à éliminer toute
duplication d’adresse.

41 L’adresse IP n’a pas été définie dans les
60 secondes suivant le démarrage.

Vérifiez le réglage du commutateur DIP 6 (Réglage IP)
situé sur le panneau arrière. Si le commutateur DIP 6
est réglé sur « PC », vous devez utiliser ProVisionaire
Design ou le serveur DHCP pour spécifier l’adresse IP
de l’appareil.

42 Un appareil du système MTX n’a pas été
détecté sur le réseau.

Mettez tous les appareils du système sous tension et
vérifiez qu’ils sont correctement connectés au réseau.

43 Le nombre d’appareils connectés au réseau
est trop élevé.

Réduisez le nombre d’appareils connectés au réseau.

46 Le nombre de flux de transmission Dante a
dépassé la limite.

Le taux de transmission Dante maximal a été dépassé.
Essayez de passer une partie du flux de transmission
en multidiffusion à l’aide du contrôleur Dante.

50 Le paramètre UNIT ID est réglé sur « 00 ». Réglez le paramètre UNIT ID sur une valeur autre que
« 00 ».

51 Des appareils possédant le même ID d’unité
sont connectés au même réseau.

Modifiez l’ID d’unité de manière à éviter toute
duplication.
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Alerte
d’alerte

Signification Mesure à prendre

52 Une erreur de communication est survenue
au niveau de la connexion [DCP].

• Si une erreur s’est affichée sur le panneau DCP,
reportez-vous au mode d’emploi de l’unité DCP
concernée pour prendre les mesures correctives

nécessaires.
• Vérifiez que les ID de panneau respectifs des
différentes unités DCP ne sont pas en conflit les uns

avec les autres.
• Vérifiez que les câbles sont correctement branchés et
que leur longueur est conforme aux spécifications.

53 L’unité DCP reliée au connecteur [DCP] a
été configurée différemment de ce qui est
indiqué dans les réglages du projet.

• Vérifiez que l’unité DCP requise est branchée.
• Vérifiez si une unité DCP d’un modèle différent a été
connectée.

56 La carte mémoire SD n’a pas été reconnue. Utilisez une carte mémoire SD conforme aux
caractéristiques techniques exigées.

58 Impossible de lire le fichier ou le dossier
spécifié depuis le lecteur SD.

Vérifiez que le fichier audio ou le dossier désigné
existe sur la carte mémoire SD. Le dossier spécifié doit
comprendre au moins un fichier audio reproductible.

60 Une tentative de rappel d’une présélection a
échoué.

Réinitialisez la mémoire de l’appareil. Si cette action ne
résout pas le problème, contactez votre distributeur
Yamaha.

61 Le rappel n’a pas pu être exécuté car la
présélection devant être rappelée n’a pas
été trouvée au démarrage du MTX.

Spécifiez une présélection qui existe. Aucun son ne
sera émis tant qu’une présélection appropriée n’aura
pas été rappelée.

64 La présélection n’a pas pu être rappelée. • La présélection sélectionnée pour le rappel ne peut
pas être rappelée car aucune donnée n’y a été

enregistrée.
• Un autre appareil a peut-être été ajouté après le
stockage des présélections. Synchronisez et contrôlez
toutes les présélections à l’aide de ProVisionaire
Design ; procédez aux modifications nécessaires et
stockez-les à nouveau.

70 La synchronisation n’a pas pu être
terminée. La synchronisation a peut-être été
arrêtée avant son terme.

Effectuez à nouveau la synchronisation à l’aide de
ProVisionaire Design. Si cette action ne résout pas le
problème, réinitialisez la mémoire de l’appareil et
recommencez la synchronisation. Si cette mesure
échoue également, contactez votre distributeur
Yamaha.

71 Les réglages UNIT ID appliqués lors de
l’exécution de la synchronisation ne
correspondent pas aux réglages UNIT ID
actuellement sélectionnés.

Ne modifiez aucun ID d’unité après avoir effectué la
synchronisation. Si vous avez modifié un UNIT ID,
recommencez la synchronisation.

72
(MRX7-
D/MTX5-
D)

Comme la fonction Dante Device Lock est
activée sur cet appareil, les réglages des
commutateurs DIP de l’appareil et de
ProVisionaire Design ne correspondent pas
aux réglages actuels de Dante.

Si la fonction Dante Device Lock est activée,
désactivez-la à l’aide de Dante Controller, examinez les
réglages des commutateurs DIP de l’appareil et les
réglages Dante de ProVisionaire Design et mettez-les à
jour.
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Alerte
d’alerte

Signification Mesure à prendre

80
(MRX7-D
uniqueme
nt)

Le fichier audio du composant Speech
Privacy n’existe pas.

Installez-le à l’aide de la boîte de dialogue Install
Speech Privacy File.
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15.9. Éditeurs de composants

Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.
Vous trouverez ci-après des explications relatives à l’éditeur de composants spécifique au MTX. Pour plus de
détails sur les autres composants, reportez-vous au « ProVisionaire Design DME7 Component Guide ».

Numér
o

Nom du composant Description Lien

①

Analog In Affiche les réglages liés à l’entrée
de la borne [INPUT] et au niveau
du signal audio transmis en
entrée.

Éditeur de composants « Analog In »

②
Stereo In Affiche le niveau du signal audio

transmis en entrée depuis la
borne [ST IN].

---

③
SD In Envoie le signal audio en cours

de lecture depuis la carte
mémoire SD.

---

④
YDIF In Affiche le niveau du signal audio

transmis en entrée depuis la
borne [YDIF].

---

⑤
Dante In (MTX5-D
uniquement)

Envoie l’entrée du signal audio
depuis la borne [Dante].

---
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Numér
o

Nom du composant Description Lien

⑥

Slot In (MTX5-D
uniquement)

Affiche le niveau du signal audio
transmis en entrée depuis la

carte Mini-YGDAI.

Faites un clic droit sur le
composant [Slot in] ou [Slot Out],
sélectionnez la carte « Mini-
YGDAI » dans le menu contextuel,
puis sélectionnez la carte « MY4-
AEC » ; le composant « MY4-
AEC » s’affiche.

Éditeur de composants « MY4-AEC »

⑦
DCP Règle le panneau de commandes

DCP.
« DCP »

⑧
Input Patch Affecte la source d’entrée à un

canal d’entrée.

---

⑨
Input Ch (Canal d’entrée) Effectue le traitement du signal

des canaux d’entrée.
Éditeur de composants « Input CH »

⑩
Input Fader (Fader
d’entrée)

Ajuste le niveau du canal
d’entrée.

---

⑪ Fx Fader (Fader Fx) Ajuste le niveau du retour d’effet.
---

⑫

Dugan Automixer Dans les applications vocales, le
MTX3 règle automatiquement le
gain de mixage automatique des
canaux d’entrée 1 à 4, et le
MTX5-D règle automatiquement
le gain de mixage automatique
des canaux d’entrée 1 à 8.

« ProVisionaire Design DME7 Component
Guide »

⑬
Insert (MTX5-D
uniquement)

Active ou désactive l’insertion de
la carte Mini-YGDAI.

Éditeur de composants « Insert »

⑭
Matrix Mixer (Console
de mixage matricielle)

Mixe les signaux des canaux
d’entrée et les envoie vers
chaque ZONE.

« ProVisionaire Design DME7 Component
Guide »

⑮
Matrix Out Fader (Fader
de sortie de la matrice)

Règle le niveau depuis la console
de mixage matricielle vers la
ZONE.

---

⑯ Effect Ajuste les effets.
---

⑰

Zone Cet écran est utilisé pour
spécifier les réglages liés au
PGM1 (MTX5-D uniquement) et
aux signaux de sortie selon la
priorité du signal d’entrée.

Éditeur de composants « Zone »

⑱
From YDIF In Signal d’entrée en provenance de

la borne ④ [YDIF IN].

---

⑲
Oscillator (Oscillateur) Transmet en sortie le signal de

l’oscillateur.

---
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Numér
o

Nom du composant Description Lien

⑳
Zone Out Fader (Fader
de sortie de zone)

Règle le niveau de sortie de la
zone.

---

㉑
Router Affecte des signaux aux canaux

de sortie.
« ProVisionaire Design DME7 Component
Guide »

㉒
Output Ch effectue le traitement du signal

du canal de sortie.
Éditeur de composants « Output CH »

㉓
Output Fader (Fader de
sortie)

Ajuste le niveau du canal de
sortie.

---

㉔
Post on Input Fader
(Fader d’entrée après
activation)

Signal de sortie en provenance

de ⑩ [Input Fader] ou de ⑫
[Dugan Automixer].

---

㉕
Post-on Zone Out (Sortie
de zone après
activation)

Signal de sortie en provenance

de ⑳ [Zone Out Fader].

---

㉖
Output Patch Affecte les signaux de sortie aux

différents types de bornes de
sortie.

---

㉗
YDIF Out Patch
(Assignation de sortie
YDIF)

Affecte les signaux de sortie à la
borne [YDIF].

---

㉘
Pilot Tone (Fréquence
pilote)

Définit la fréquence pilote. Éditeur de composants « Pilot Tone »

㉙

Analog Out Affiche les réglages liés à la
sortie de la borne [OUTPUT] et au
niveau du signal audio transmis
en sortie.

Éditeur de composants « Analog Out »

㉚
Dante Out (MTX5-D
uniquement)

Spécifie les réglages liés à la
sortie Dante.

« ProVisionaire Design DME7 Component
Guide »

㉛

Slot Out (MTX5-D
uniquement)

Affiche les réglages liés à la
sortie de la carte Mini-YGDAI et
au niveau du signal audio
transmis en sortie.

Éditeur de composants « Slot Out »

㉜
YDIF Out Émet en sortie vers la borne

[YDIF].

---

㉝
Input DCA Groups
(Groupes DCA d’entrée)

Définit le groupe DCA pour le
canal d’entrée.

Éditeur de composants « DCA
Groups/Mute Groups »

㉞
Input Mute Groups
(Groupe de mutes
d’entrée)

Définit le groupe de mutes pour
le canal d’entrée.

Éditeur de composants « DCA
Groups/Mute Groups »

㉟
Zone DCA Groups
(Groupes DCA de la
zone)

Définit le groupe DCA pour la
sortie de la zone.

Éditeur de composants « DCA
Groups/Mute Groups »
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Numér
o

Nom du composant Description Lien

㊱
Zone Mute Groups
(Groupes de mutes de la
zone)

Définir le groupe de mutes pour
la sortie de la zone.

Éditeur de composants « DCA
Groups/Mute Groups »
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15.9.1. Éditeur de composants « Analog In »

Vous pouvez effectuer ici les réglages du HA (préampli micro) de la prise [INPUT] et visualiser les niveaux des
signaux audio transmis en entrée.

① Index de canal
Permet d’indiquer le numéro de la prise d’entrée analogique.

② Indicateur de niveau
Permet d’indiquer le niveau de l’entrée analogique.

③ Bouton [GAIN] (Gain)
Permet d’ajuster le gain analogique du HA.

④ *Bouton [48V]* Permet d'activer et de désactiver l'alimentation fantôme du HA ( 48 V).

 Avis

Assurez-vous de désactiver ce bouton si l’alimentation fantôme n’est pas requise.
Veillez à suivre les précautions ci-dessous afin d’éviter le bruit ainsi que d’éventuels dommages aux

appareils externes et à l’unité elle-même lorsque vous activez l’alimentation fantôme.
• Assurez-vous de désactiver ce bouton lorsque vous branchez au connecteur [INPUT] un appareil ne

prenant pas en charge l’alimentation fantôme.
• Évitez tout branchement/débranchement de câble en liaison avec le connecteur [INPUT] lorsque ce

bouton est activé.
• Abaissez le niveau de sortie jusqu’au volume minimal avant d’activer ou de désactiver l’alimentation

fantôme.
Il n’y a pas de commutateur actif +48 V. Afin d’éviter tout dysfonctionnement, assurez-vous que cette
option est réglée de manière appropriée pour l’équipement connecté.
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15.9.2. Éditeur de composants « MY4-AEC »

Faites un clic droit sur le composant [Slot in] ou [Slot Out] (MTX5-D uniquement), sélectionnez la carte « Mini-
YGDAI » dans le menu contextuel, puis sélectionnez la carte « MY4-AEC ». Le composant « MY4-AEC » s’affiche.

Cet écran vous permet de procéder aux réglages des signaux de la carte MY4-AEC.
Dans un système de téléconférence, les emplacements local et distant sont respectivement désignés par les

termes « Near-end » et « Far-end ».
Le compensateur d’écho acoustique (AEC) de la carte MY4-AEC détermine le composant d’écho compris dans le
signal d’entrée de micro en utilisant le signal reçu en provenance de l’extrémité distante comme signal de

référence et soustrait
du signal de l’entrée de microphone le composant d’écho associé à l’extrémité distante uniquement. Ceci permet

une transmission claire du son émis à partir de l’extrémité locale vers l’autre partie.
Les signaux de la carte MY4-AEC peuvent être spécifiés à l’aide des sélections et des écrans décrits ci-après.
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From Far-end Signaux d’entrée provenant de l’emplacement distant
(l’autre partie)

Far-end Voice Signaux provenant de l’emplacement distant reproduit par
les haut-parleurs de l’emplacement local (de votre côté)

Near-end Mic. Signaux d’entrée reçus depuis les microphones locaux

Near-end Voice Signaux reçus depuis les microphones locaux reproduits
par les haut-parleurs locaux

To Far-end Signaux soumis à la compensation d’écho émis depuis les
microphones locaux vers l’emplacement distant

■ Écran « To Far-end »

Cet écran vous permet de procéder aux réglages de compensation d’écho sur les micros.
Le signal de micro soumis à la compensation d’écho est transmis en sortie vers l’emplacement distant.

① Boutons de sélection [Near-end Mic]
Vous pouvez sélectionner ici les ports pour les microphones locaux (Near-end Mic). Lorsque vous cliquez sur un
bouton de sélection de port, la boîte de dialogue « Input Patch » apparaît. Ce bouton indique le port actuellement
sélectionné.

② Bouton AEC [ON]
Permet d’activer ou de désactiver la fonction de compensation d’écho.
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③ Boutons REFERENCE [A][B][C][D]
Ces boutons vous permettent de spécifier si le signal défini par la sélection de From Far-end est utilisé ou non

comme signal de référence AEC (REFERENCE).
Si plusieurs signaux sont sélectionnés, ils seront mixés.

④ Indicateurs de niveau

• Indicateur de niveau Mic In. (Entrée micro)
Indique le niveau du signal transmis en entrée par votre propre micro (Microphone local).

• Indicateur de niveau Ref In. (Entrée de référence)
Indique le niveau du signal de référence. La compensation d’écho la plus efficace est obtenue au niveau
signalé par l’illumination occasionnelle des voyants jaunes.

• Indicateur de niveau Echo Attn. (Compensation d’écho)
Indique le degré de compensation d’écho pour chaque canal. Des niveaux supérieurs indiquent que le
compensateur d’écho est en cours de fonctionnement.

• Indicateur de niveau ERL
Indique la valeur de l’indicateur ERL (Echo Return Loss (Affaiblissement d’écho) = niveau du signal audio
émis depuis le haut-parleur et redirigé vers le microphone). La compensation d’écho sera d’autant plus
efficace si vous réglez les positions respectives du haut-parleur et du micro de sorte à minimiser le niveau
ainsi obtenu.

⑤ Zone de liste [Effect]
Permet de spécifier le degré de compensation d’écho. Des valeurs numériques supérieures permettent la
compensation d’un plus grand nombre d’échos. Cependant, la qualité audio diminue en conséquence, de sorte
que vous devez considérer l’équilibre entre ces facteurs lorsque vous effectuez le réglage.

⑥ Bouton [NR]
Il s’agit de commutateurs d’activation/désactivation de la fonction de réduction de bruit, qui élimine le bruit
permanent produit par exemple par un projecteur ou un climatiseur situé à l’emplacement local. Nous vous
recommandons de garder ces sélecteurs en état d’activation.

⑦ Bouton [Distance]
Permet de spécifier la distance en mètres entre le microphone installé et le haut-parleur utilisé. En cas de
connexion de plusieurs microphones et haut-parleurs, c’est la distance entre le microphone et le haut-parleur les
plus proches qui doit être indiquée. Si la distance est égale ou inférieure à 2 m, réglez la valeur sur 2.

⑧ Bouton de sélection du canal [To Far-end]
Ce bouton permet de sélectionner les destinations de sortie des signaux audio transmis en sortie à
l’emplacement distant (Far-end). Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Output Patch ».

⑨ Boutons de sélection du signal [From Far-end]
Ces boutons permettent d’afficher la boîte de dialogue « Input Patch », où vous pouvez sélectionner les signaux
audio émis depuis l’emplacement distant (From Far-end). Ce bouton indique le port ou le canal actuellement
sélectionné.

⑩ Bouton [NR]
Il s’agit de commutateurs d’activation/désactivation de la fonction de réduction de bruit, qui éliminent le bruit
permanent produit par exemple par un projecteur ou un climatiseur situé à l’emplacement distant. Nous vous
recommandons de garder ces sélecteurs en état d’activation. Le signal audio après réduction de bruit est
considéré comme le signal de référence (REFERENCE).

⑪ Boutons de sélection de [Far-end Voice]
Ces boutons permettent de sélectionner les destinations de sortie des signaux audio transmis en sortie vers les
haut-parleurs de l’emplacement local. Cliquez sur un de ces boutons pour ouvrir la boîte de dialogue « Output
Patch ». Ce bouton permet d’afficher le canal actuellement sélectionné.
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
Il est supposé que la voix distante sera mixée avec le microphone local et émise depuis les
haut-parleurs. Par conséquent, vue depuis la carte MY4-AEC, la voix distante est émise vers
un canal d’entrée du système MTX.
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■ Écran « Near-end Voice »

Cet écran vous permet de procéder aux réglages de la fonction FBS (Suppresseur de feed-back) intégrée à la
carte MY4-AEC.

① Bouton FBS [ON]

Permet d’activer/désactiver la fonction de suppresseur de feed-back.
La fonction FBS de la carte MY4-AEC utilise une méthode dynamique qui recherche en permanence les points de

feedback au fur et à mesure de leur évolution et met à jour les réglages de filtre en conséquence.
La réinitialisation s’effectue à la mise hors tension du MTX5-D sur l’état d’absence d’insertion de filtre coupe-
bande.

② Zone de liste [Width] (Largeur)
Vous pouvez spécifier ici la largeur de rejet du filtre passe-bande inséré à la fréquence de feedback détectée.
Choisissez une largeur de rejet plus étroite si le suppresseur de feed-back entraîne des changements
indésirables dans le caractère du son. Un réglage de « 1/93 » correspond à la largeur de bande de filtre passe-
bande la plus étroite. Cependant, dans ce cas, le suppresseur de feedback peut perdre en efficacité.

③ Zone de liste [Depth] (Profondeur)
Vous pouvez spécifier ici le degré de rejet appliqué par le filtre passe-bande inséré à la fréquence de feedback
détectée. Un réglage de « –18 » produit la plus forte suppression de feedback. Néanmoins, vous pouvez
constater dans ce cas une modification du caractère du son.

④ Bouton de sélection de canal [Near-end Voice]
Ce bouton permet de sélectionner la destination de sortie du signal audio émis localement (Near-end Voice).
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Output Patch ».
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■ Écran « Mic »

Si le microphone utilisé est doté d’un sélecteur d’émission (PTT - Presser pour parler), une faible quantité de
bruit pourra retentir lorsque l’interrupteur est désactivé. Si ce bruit est envoyé vers le système AEC, celui-ci risque
d’identifier ce bruit par erreur, ce qui peut produire un écho indésirable lors de l’activation du sélecteur
d’émission PTT en cas de reprise de la parole. Cet écran vous permet de procéder aux réglages et de spécifier le
type de micro requis pour empêcher ces interférences.

① Bouton PTT [ON]
Lorsque ce bouton est activé et que le niveau d’entrée du microphone local (Near-end Mic) tombe en deçà de la
valeur spécifiée pour le seuil du paramètre PTT, le système détermine que le sélecteur d’émission PTT du micro
local a été désactivé et interrompt la phase d’identification des caractéristiques sonores par l’AEC. Nous vous

recommandons
de garder ce bouton en état d’activation.

② Indicateur de niveau Mic In.
Indique le niveau du signal transmis par le micro local (Near-end Mic). Cet indicateur de niveau affiche
également le niveau de bruit qui se produit lorsque le bouton PTT du micro est désactivé.

③ Bouton [PTT Threshold] (Seuil PTT)
Ce bouton permet de définir le niveau de référence pour l’identification par l’AEC. Si le bouton PTT [ON] est
activé, l’identification par l’AEC s’arrêtera dès que le signal d’entrée sur le micro local (Near-end Mic) tombe en

deçà de ce niveau ; l’identification reprend aussitôt que le signal d’entrée dépasse ce niveau.
L’indicateur de niveau du microphone d’entrée affiche le niveau du signal d’entrée.

④ Zone de liste [Mic. Type] (Type de microphone)

Spécifiez le type de microphone connecté.
Choisissez « Fixed » (Fixe) pour un environnement dans lequel la distance entre le micro et le haut-parleur est
fixe ou « Moving » (Mobile) pour un environnement dans lequel cette distance varie, comme en cas d’utilisation
d’un micro à la main. Même dans le cas d’un environnement où la distance entre le micro et le haut-parleur est
fixe, optez pour « Moving » dès que l’écho devient gênant.
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15.9.3. Éditeur de composants « Input CH » (Canal d’entrée)

Cet écran permet d’effectuer le traitement du signal du canal d’entrée.

Les traitements de signaux « Polarity » (Polarité), « HPF », « EQ », « Gate », « Comp », « FBS » et « AGC » sont
effectués.

●Sélection d’un écran

Lorsque vous cliquez sur un bouton, vous basculez sur l’écran de réglage.

Pour plus de détails sur le réglage de chaque paramètre dans le composant/l’éditeur, reportez-vous au
« ProVisionaire Design DME7 Component Guide ».

● Opérations communes aux écrans « INPUT »


Vous pouvez copier les réglages d’un canal dans d’autres canaux. Lorsque vous faites un clic
droit dans une zone, un menu contextuel s’affiche.
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15.9.4. Éditeur de composants « Insert » (Insérer)

Ce bouton permet d’afficher un écran sur lequel vous pouvez modifier le réglage d’activation/désactivation de

huit canaux en même temps.
Lorsqu’il est activé, le signal audio est émis à partir de POST ON (Après activation) vers la carte Mini-YGDAI
installée dans [SLOT] (Logement).


Si aucune carte Mini-YGDAI n’est installée ou si la carte Mini-YGDAI installée ne prend pas en
charge l’insertion, il n’y a pas de sortie audio lorsque ce bouton est activé.
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15.9.5. Éditeur de composants « Zone »

Cet écran vous permet de spécifier les réglages du PGM1 et la manière dont la priorité du signal d’entrée
contrôle les signaux de sortie.

Lorsque vous cliquez sur un bouton, vous basculez sur l’écran de réglage.

• [Paging]
Permet d’afficher l’éditeur de composants « Paging » pour la configuration du microphone de la station de
radiomessagerie PGM1.

• [2nd Priority Ducker] (Ducker secondaire)

[1st Priority Ducker] (Ducker prioritaire)
Permet d’afficher l’éditeur de composants « Priority Ducker » (Ducker prioritaire).

• [ANC]
Permet d’afficher l’éditeur de composants « Ambient Noise Compensator ».

Pour plus d’informations sur Ducker et ANC, reportez-vous au « ProVisionaire Design DME7 Component Guide ».
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■ Éditeur de composants « Paging » (MTX5-D uniquement)

Cet écran vous permet de procéder aux réglages du microphone de la station de radiomessagerie PGM1.

Le terme « radiomessagerie » fait référence à la fonction de diffusion d’une annonce.
Pour plus de détails sur le déroulement des réglages, reportez-vous à la section « Déroulement des réglages de

la radiomessagerie ».
Les messages SD mentionnés ici sont des annonces au format standard sauvegardées sur la carte SD du MTX.

① Bouton Paging [ON]
Permet d’activer et de désactiver la fonction de radiomessagerie.

② Bouton [ZONE GROUP]
L’éditeur « ZONE GROUP » s’ouvre lorsque vous cliquez sur ce bouton.

③ Bouton [Settings]
L’éditeur « PGM1/PGX1 » s’ouvre lorsque vous cliquez sur ce bouton.

④ Zone de réglages de la source de radiomessagerie

• Voyant
Ce voyant s’allume pour signaler la radiodiffusion actuellement en cours sur l’unité PGM1 ou SD.

• Zone de liste des canaux
Permet de sélectionner la source de radiomessagerie. Sélectionnez le canal d’entrée auquel une unité
PGM1 ou SD est connectée. Spécifiez le premier microphone pour le canal d’entrée de l’unité PGM1
indiquée comme prioritaire.

⑤ Zone ZONE

• Voyant
Ce voyant s’allume pour signaler une zone dans laquelle une radiodiffusion est en cours à l’aide d’un
message PGM1 ou SD.

⑥ Zone de réglage GAIN
Chaque bouton est réinitialisé sur sa valeur par défaut si vous cliquez dessus tout en maintenant la touche < Alt
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> enfoncée.
Dans cette zone, vous pouvez effectuer des réglages liés à la ligne affichée en vert dans le flux de production
représenté ci-dessous.

• Bouton [RANGE]
Permet de spécifier la valeur du programme pendant que le carillon retentit ou lorsque l’unité PGM1 est en
cours de radiodiffusion.

• Bouton [ATTACK] (Attaque)
Permet de spécifier le délai qui s’écoule entre le moment où la fonction PTT est activée sur l’unité PGM1
et celui où le programme atteint la valeur RANGE.

• Bouton [RELEASE] (Relâchement)
Permet de spécifier le délai qui s’écoule entre le moment où la diffusion ou la lecture du carillon de
fermeture prend fin et celui où le programme revient à son niveau d’origine.

■ Éditeur « ZONE GROUP »
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① Nom de zone
Indique le nom de la zone.

② Nom de groupe
Indique le nom du groupe.

③ Matrice du groupe de zones
Spécifiez un groupe de zones si vous souhaitez qu’un seul bouton de sélection de zone/message d’une unité
PGM1/PGX1 soit diffusé dans plusieurs zones. Cliquez sur la matrice pour sélectionner les zones à ajouter au
groupe de zones. Vous pouvez spécifier jusqu’à 24 groupes de zones.

④ Bouton [Clear] (Effacer)
Permet d’effacer le groupe de zones qui avait été réglé.

■ Éditeur « PGM1/PGX1 »

Cette zone vous permet de procéder à des affectations pour les boutons de sélection de zone/message des
unités PGM1 et PGX1, ainsi que d’effectuer les réglages du bouton PTT.

• Zone de liste de sélection PGM1
Sélectionnez l’unité PGM1 que vous souhaitez régler.


Les réglages de PGM1/PGX1 peuvent être effectués même si le PGM1 n’est pas connectée
au MTX lui-même. Veuillez connecter l’unité PGM1/PGX1 correctement durant l’utilisation.

• Onglet [Function Assign] (Assignation de fonction)
Cette zone vous permet d’affecter des fonctions aux boutons de sélection de zone/message de l’unité

PGM1 ou PGX1.
Les choix suivants sont disponibles dans la zone « FUNCTION » :

◦ [No Assign]
Aucune fonction n’est affectée au bouton.
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◦ [Zone]

Permet de sélectionner/désélectionner la zone destinée à la diffusion.
Lorsque la sélection a été effectuée, le voyant de zone/message s’allume.

◦ [Zone Group]
Permet de sélectionner et de désélectionner plusieurs zones destinées à la diffusion en une seule

opération.

Définissez le groupe de zones à l’aide de l'éditeur « ZONE GROUP ».
Le voyant de zone/message est allumé lorsque la diffusion est possible vers toutes les zones
enregistrées dans le groupe.

◦ [SD Message] (Message SD)
Permet de sélectionner le fichier de la carte SD à diffuser.

◦ [All Zone Off] (Désactiver toutes les zones)

Permet de désélectionner l’ensemble des zones ou des groupes de zones.
Cela n’affecte pas l’état de sélection des zones ou des groupes de zones sur d’autres unités
PGM1/PGX1.

◦ [All Zone On/Off] (Activer/désactiver toutes les zones)

Permet de sélectionner et de désélectionner l’ensemble des zones ou des groupes de zones.
Cela n’affecte pas l’état de sélection des zones ou des groupes de zones sur d’autres unités

PGM1/PGX1.
L’indicateur de zone/message est allumé lorsque la diffusion est possible vers toutes les zones ou
les groupes de zones.

• Bouton Menu( )
Cliquez sur le bouton menu pour exécuter les fonctions suivantes.

◦ [Copy]
Permet de copier les réglages de FUNCTION et PARAMETER de l’appareil correspondant dans le
tampon de copie.

◦ [Paste]
Permet de coller les réglages de FUNCTION et PARAMETER du tampon de copie, et de les
remplacer dans l’appareil correspondant.

◦ [Clear]
Permet de réinitialiser les réglages de FUNCTION et PARAMETER de l’appareil correspondant.

• Onglet [Properties]
Vous pouvez effectuer ici les réglages pour le fonctionnement de l’unité PCM1.
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• MTX

◦ Case d’option [Block all paging.] (Bloquer toute radiomessagerie)
Si cette option est sélectionnée, la diffusion de radiomessagerie, y compris via le programmeur, est
arrêtée lorsque le MTX est en mode d’urgence.
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◦ Case d’option [Block paging except for 1st Priority PGM1] (Bloquer la radiomessagerie sauf pour

l’unité PGM1 prioritaire)
Si cette option sélectionnée, la diffusion de radiomessagerie n’est possible que pour l’unité PGM1
prioritaire lorsque le MTX est en mode d’urgence.

• Paging Device Group (Groupe d’appareils de radiomessagerie)

◦ Cases à cocher [Opening Chime] (Carillon d’ouverture)/[Closing Chime] (Carillon de fermeture)
Si ces cases sont cochées, vous pouvez effectuer les réglages du carillon d’ouverture et/ou du
carillon de fermeture. Cliquez sur le bouton de droite pour spécifier le fichier de carillon qui sera lu.
Ce réglage est commun aux unités PGM1 (Paging Device Group) connectées au même système
MTX.

◦ Zone de liste [Maximum paging duration] (Durée maximale de la radiomessagerie)
Permet de sélectionner le délai d’activation de la fonction PTT depuis le moment où elle est lancée
jusqu’à sa désactivation automatique. Si un message est en cours de lecture, la fonction ne sera
pas désactivée même si le délai d’activation spécifié est dépassé. Ce réglage est commun aux
unités PGM1 connectées au même système MTX.

◦ Case à cocher [The scheduler’s paging events are broadcast with higher priority than PGM1.
Paging events have a lower priority than 1st Priority PGM1.] (Les événements de
radiomessagerie du programmateur sont diffusés avec une priorité supérieure à celle de l’unité

PGM1. Les événements de radiomessagerie ont une priorité inférieure à l’unité PGM1 prioritaire.)
Si cette case est cochée, l’ordre de priorité sera « PGM1 prioritaire > événements > PGM1
standard ». Si cette case n’est pas cochée, l’ordre de priorité sera « PGM1 prioritaire > PGM1
standard > événements ».

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Annule les réglages et ferme la boîte de dialogue.

■ Éditeur de composants « PRIORITY DUCKER » (Ducker prioritaire)

Permet d’effectuer des réglages du ducker.
La fonction Ducker réduit temporairement le niveau d’entrée d’un canal lorsqu’un signal audio parvient sur un
autre canal d’entrée spécifié, ce qui permet de s’assurer que le signal audio de cet autre canal est clairement
audible. L’ordre de priorité est comme suit : « PRIORITY SOURCE » (Source prioritaire) sous « 1st PRIORITY »
(1ère priorité) > « PRIORITY SOURCE » sous « 2nd PRIORITY » (2ème priorité) > signal MATRIX Out (Sortie de
matrice).
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• Liste [PRIORITY SOURCE]

Permet de sélectionner le signal d’entrée du ducker.
Sélectionnez [ANC Bus] (Bus ANC) si vous souhaitez que le signal mixé soit le signal audio de priorité
élevée. Le mixage des signaux audio sur le bus ANC peut être effectué dans l’éditeur de composants
« Matrix Mixer ».

Pour plus de détails sur les autres paramètres, reportez-vous au « ProVisionaire Design DME7 Component
Guide ».

■ Éditeur de composants « Ambient Noise Compensator »

Dans cet éditeur, vous pouvez régler le composant « Ambient Noise Compensator » (ci-après appelé « ANC »).
ANC est une fonction qui renforce ou atténue le signal de sortie du MTX en fonction du niveau entrant d’un micro
de détection de bruit ambiant. La fonction ANC fournie par le MTX est un ANC de type « gap » (écart) qui détecte
les intervalles de silence, par exemple entre les morceaux, ainsi que le niveau de bruit pendant ces intervalles,
puis règle le niveau du signal en conséquence.

Pour plus de détails sur les paramètres, reportez-vous au « ProVisionaire Design DME7 Component Guide ».
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15.9.6. Éditeur de composants « Output CH »

Cet écran permet d’effectuer le traitement des signaux du canal de sortie.

Les signaux « Delay » (Retard), « Room EQ » (Égaliseur de pièce) et « Speaker Processor » (Processeur de haut-
parleur) sont traités.

●Sélection d’un écran

Lorsque vous cliquez sur un bouton, vous basculez sur l’écran de réglage.

Pour plus de détails sur le réglage de chaque paramètre dans l’éditeur de composants, reportez-vous au
« ProVisionaire Design DME7 Component Guide ».

● Opérations communes aux écrans « OUTPUT »


Vous pouvez copier les réglages d’un canal dans d’autres canaux.
Lorsque vous faites un clic droit dans la zone, un menu contextuel apparaît.
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15.9.7. Éditeur de composants « Pilot Tone »

Vous pouvez effectuer des réglages pour indiquer si une fréquence pilote est émise depuis la sortie numérique.
Lorsque le bouton PILOT TONE [ON] (Fréquence pilote activée) est activé, la fréquence pilote est réglée sur le
canal de sortie YDIF ou Dante affecté à la sortie de fréquence pilote.

① Bouton PILOT TONE [ON]
Permet d’activer/désactiver la fonction de fréquence pilote. Si ce bouton est désactivé, aucune fréquence pilote
ne sera envoyée même si les boutons « YDIF » ou « Dante » sont activés.

② Freq. (Fréquence)
Permet d’indiquer la fréquence centrale de la fréquence pilote. Celle-ci est fixée à 20 kHz.

③ Bouton [LEVEL]
Permet de spécifier le niveau de la fréquence pilote.

④ Bouton YDIF
Lorsque vous cliquez sur ce bouton, l’écran qui permet de régler la sortie de la fréquence pilote vers YDIF
s’ouvre.

⑤ Bouton DANTE (MTX5-D uniquement)
Lorsque vous cliquez sur ce bouton, l’écran qui permet de régler la sortie de la fréquence pilote vers DANTE
s’ouvre.
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15.9.8. Éditeur de composants « Analog Out »

Dans cet écran, vous effectuez les réglages des sorties sur les prises [OUTPUT] et vous affichez les niveaux des
signaux audio émis en sortie.

① Index de canal
Permet d’indiquer le numéro de la prise de sortie analogique.

② Indicateur de niveau
Permet d’indiquer le niveau de la sortie analogique.

③ Bouton [GAIN]
Permet d’ajuster le gain de sortie.

④ Bouton [INV] (Inverser)
Inverse la polarité du signal de sortie.
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15.9.9. Éditeur de composants « Slot Out »

Dans cet écran, vous effectuez les réglages liés aux sorties des cartes Mini-YGDAI et vous affichez les niveaux
des signaux audio émis en sortie.

① Index de canal
Permet d’indiquer le numéro de la prise de sortie.

② Indicateur de niveau
Permet d’indiquer le niveau de sortie.

③ Bouton [GAIN]
Permet d’ajuster le gain de sortie.

④ Bouton [INV]
Inverse la polarité du signal de sortie.
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15.9.10. Éditeur de composants « DCA Groups »/« Mute Groups » (Groupes DCA /
Groupes de mutes)

Cet éditeur de composants permet de contrôler le niveau et l’assourdissement de plusieurs canaux en même
temps.

Ces éditeurs de composants peuvent enregistrer 8 groupes pour le groupe DCA et le groupe de mutes pour les

canaux d’entrée et 8 groupes pour le groupe DCA et le groupe de mutes pour la sortie ZONE.
Dans les groupes DCA, il est possible de contrôler simultanément le niveau d’entrée ou de sortie de plusieurs

canaux à l’aide d’un même bouton.
Le groupe de mutes permet d’activer ou de désactiver plusieurs canaux simultanément.

• Composant « Input DCA Groups »
Affiche l’éditeur qui permet de définir le groupe DCA pour le canal d’entrée.

• Composant « Input Mute Groups »
Afficher l’éditeur qui permet de définir le groupe de mutes pour le canal d’entrée.

• Composant « Zone DCA Groups »
Affiche l’éditeur qui permet de définir le groupe DCA pour la sortie de ZONE.

• Composant « Zone Mute Groups »
Afficher l’éditeur qui permet de définir le groupe de mutes pour la sortie de ZONE.

■ Composant « Input DCA Groups » (Groupes DCA d’entrée)/ Composant « Zone DCA Groups » (Groupes DCA

de zone)
L’écran illustré ci-après est celui du composant « Input DCA Groups », mais l’écran des composants de « Zone
DCA Groups » est similaire.
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① Bouton [Clear]
Ce bouton permet d’effacer tous les canaux affectés aux groupes correspondant.

② Matrice d’affectation des canaux

Cette matrice vous permet d’affecter des canaux à des groupes DCA.
Les noms des groupes sont indiqués sur l’axe vertical et les noms des canaux qui peuvent être affectés sont
indiqués sur l’axe horizontal. Cliquez sur une intersection pour affecter un canal à un groupe.

③ Bouton [Level]
Ajustez le niveau de chaque groupe DCA.

■ Composant « Input Mute Groups » (Groupes de mutes d’entrée) / Composant « Zone Mute Groups » (Groupes

de mutes de zone)
L’écran illustré ci-après est celui du composant « Input Mute Groups », mais l’écran du composant « Zone Mute
Groups » est similaire.

① Boutons d’activation des groupes de mutes
Ces boutons permettent d’activer/désactiver chaque groupe de mutes.

15. Processeurs audio : MTX5-D/MTX3

314 | ProVisionaire Design V1.2 Guide d’utilisation



15.10. Déroulement des réglages de la radiomessagerie

Il est possible de connecter quatre unités PGM1 à un seul système MTX5-D. Une unité PGM1 devient le micro
prioritaire et peut être diffusée en priorité, avant d’autres unités PGM1.

Voici un exemple de connexion de quatre unités PGM1 au MTX5-D.
Le micro qui a une priorité de diffusion supérieure à celle des autres micros est appelé le micro prioritaire (ID

d’unité = 60). Assignez sa sortie au canal d’entrée Dante du MTX5-D.
De la même manière, assignez Mic2-4 (Micro 2-4) (ID d’unité = 61-63) aux canaux d’entrée Dante 2-4 du MTX5-D.

Configurez les réglages Dante avec Dante Controller.

1. Dans la feuille « Project », placez le MTX5-D.

2. Sélectionnez le MTX5-D placé sur la feuille « Project ».

Pour afficher la boîte de dialogue « PGM1 », cliquez sur la colonne Value de « PGM1 » dans la zone
« Property », puis cliquez sur .

3. Spécifiez l’ID d’unité (60 à 63) de PGM1.
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4. Ouvrez l’éditeur de composants « Input Patch » du MTX5-D.

Affectez D1 au canal d’entrée 1.
Affectez D2-D4 aux canaux d’entrée 2-4 de la même façon.

5. Ouvrez le composant « ZONE » du MTX5-D -→ Éditeur de composants « Paging ».

Sélectionnez « CH1:CH1 » (Canal 1:Canal1) pour le 1er micro de PAGING SOURCE (Source de

radiomessagerie).
Effectuez des sélections pour les autres sources également.

6. Affectez des fonctions aux boutons dans l’éditeur « PGM1/PGX1 » qui apparaît lorsque vous cliquez sur

le bouton [Settings].
Si nécessaire, définissez ZONE GROUP dans l’éditeur « ZONE GROUP » qui apparaît lorsque vous cliquez
sur le bouton [ZONE GROUP].

Pour les éditeurs « PGM1/PGX1 » et « ZONE GROUP », reportez-vous aux explications respectives.
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

Le réglage initial de PGM1 Properties -→ Utilities -→ Unlatch Enable (Autoriser le

déverrouillage) est « OFF » (Désactivé).
La procédure suivante est requise pour modifier le réglage Unlatch Enable (Autoriser le

déverrouillage) et le répercuter dans PGM1.
1. Installez Bonjour Print Service sur votre ordinateur afin que ProVisionaire Design puisse

trouver l’unité PGM1.
2. Dans la feuille « Project », placez l’unité PGM1. Spécifiez l’ID d’unité réglé sur « 3 » lors du
placement.

Les réglages sont reflétés lors de la synchronisation.
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16. Expandeurs d’E/S MTX : Exi8 / Exo8

16.1. Présentation

Il s’agit du convertisseur AD de l’expandeur d’entrée (EXi8) et du convertisseur DA de l’expandeur de sortie
(EXo8) de la série MTX. L’EXi8 convertit les signaux de micro/ligne à 8 canaux en YDIF et les envoie

numériquement vers les appareils de la série MTX.
L’EXo8 reçoit les données audio des appareils de la série MTX au format YDIF et produit un signal analogique à
8 canaux.

16.2. Feuille « Project »

Il s’agit de la feuille sur laquelle les appareils sont placés. Lorsque vous placez des péripériques, l’écran
« Settings » s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités EXi8 et EXo8 placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité de l’appareil.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.

 Pour afficher la méthode de connexion YDIF, sélectionnez YDIF dans la zone Devices.
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16.3. Éditeur

Double-cliquez sur l’EXi8 dans la feuille Project pour ouvrir l’éditeur [EXi8].

• Bouton [+48V]
Permet d’activer ou de désactiver l’alimentation fantôme du HA (+48 V).

 NOTE

Si l’alimentation fantôme n’est pas requise, désactivez ce bouton.
Si l’alimentation fantôme est activée, veuillez noter les points suivants afin d’éviter tout bruit ou

endommagement de l’unité principale ou des appareils externes.
• En cas de connexion d’un appareil non compatible avec l’alimentation fantôme à une borne [INPUT],

désactivez le bouton.

• Ne déconnectez pas les câbles de la borne [INPUT] tant que le bouton d’alimentation est activé.
• Réglez le niveau de sortie sur son niveau le plus bas lors de l’activation ou de la désactivation de

l’alimentation fantôme.
Il n’y a pas de commutateur ACTIVE. Utilisez des réglages qui correspondent à l’équipement connecté pour
éviter d’endommager l’appareil.

• Gain analogique HA
Permet de régler le gain analogique du préampli micro.

• Fréquence de coupure/bouton [HPF] (Filtre passe-haut)

Permet d’activer ou de désactiver le HPF (filtre passe-haut).
Permet de régler la fréquence de coupure du HPF.

• Bouton [φ]
Permet d’alterner la phase du signal d’entrée.

• Bouton [ON]
Permet d’activer ou de désactiver le canal d’entrée.

• YDIF Out
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Sélectionnez le canal à affecter à YDIF.
Si vous sélectionnez Thru, le signal envoyé depuis YDIF In sera envoyé inchangé.

Double-cliquez sur l’EXo8 dans la feuille Project pour ouvrir l’éditeur [EXo8].

• YDIF In
Permet d’affecter le signal envoyé depuis YDIF In à un canal.

• Gain
Permet d’ajuster le gain de sortie.

• Bouton [ON]
Permet d’activer ou de désactiver le canal de sortie.

• Bouton INV
Permet d’alterner la polarité du signal de sortie.
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17. Amplificateurs de puissance : série PC

17.1. Présentation

En combinant les puissantes fonctions de matrice d’entrée 20×8 des amplificateurs de la série PC-D/DI à des

E/S Dante, il est possible d’augmenter considérablement la polyvalence de n’importe quel système.
La fonction de matrice d’entrée de la série PC-D/DI permet non seulement d’étendre l’ensemble du système,
mais en permettant l’entrée directe des signaux audio depuis d’autres appareils analogiques ou appareils
équipés d’E/S Dante, même dans des systèmes sans consoles de mixage ou DSP supplémentaires,
l’acheminement devient encore plus flexible.

17.2. Feuille « Project »

Il s’agit de la feuille sur laquelle les appareils sont placés. Lorsque vous placez des péripériques, l’écran
« Settings » s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités de la série PC placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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17.2.1. Connexions des unités de la série PC-D et des haut-parleurs

Vous pouvez ajouter des haut-parleurs à la feuille Project en les glissant-déposant depuis la zone Devices.

Lorsque vous connectez un amplificateur et un haut-parleur et double-cliquez sur le haut-parleur, l’éditeur de
haut-parleurs s’affiche.

L’éditeur de haut-parleurs vous permet de contrôler les paramètres de l’amplificateur de puissance à partir

duquel vous vous connectez.
Pour plus de détails, reportez-vous à la section « Éditeur de haut-parleurs / Éditeur de haut-parleurs multiples ».

17.2.2. Zone « Properties »

Pour plus d’informations sur les réglages des appareils, reportez-vous au mode d’emploi de la série PC.
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17.2.3. Éditeur de haut-parleurs / Éditeur de haut-parleurs multiples

Lorsqu’un haut-parleur est raccordé à un appareil de la série PC via un câblage, les paramètres du processeur de

haut-parleur de l’appareil de la série PC s’affichent pour chaque haut-parleur.
Lorsque vous double-cliquez ou faites un clic droit sur un haut-parleur, puis sélectionnez [Open Speaker Editor]

(Ouvrir l’éditeur de haut-parleurs) dans le menu contextuel, l’éditeur de haut-parleurs s’ouvre.
Lorsque plusieurs haut-parleurs sont sélectionnés, vous pouvez cliquer avec le bouton droit et sélectionner
[Open Multiple Speaker Editor] (Ouvrir l’éditeur de haut-parleurs multiples) dans le menu contextuel afin d’ouvrir

l’éditeur de haut-parleurs multiples.
Cela peut s’avérer utile dans les situations suivantes :

• Lorsque des haut-parleurs sont raccordés à plusieurs appareils de la série PC et que vous souhaitez
visualiser chacun de ces processeurs de haut-parleurs en une seule étape.

• Si vous souhaitez afficher les courbes de réponse superposées du haut-parleur principal et des haut-
parleurs secondaires (éditeur de haut-parleurs multiples).

Pour plus de détails sur les paramètres, reportez-vous à l’éditeur de composants « Speaker Processor » du
« ProVisionaire Design DME7 Component Guide ».
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17.3. Feuille « Tuning »

Pour plus de détails sur la feuille, reportez-vous à la section Feuille « Tuning ».

17.3.1. Éditeur de groupes de liaisons

Cet éditeur apparaît lorsque vous double-cliquez sur un groupe de liaisons de feuille « Tuning » dans lequel un
canal d’une unité de la série PC est enregistré, ou lorsque vous faites un clic droit et sélectionnez [Open Link
Group Editor] (Ouvrir l’éditeur de groupes de liaisons).

• Bouton [SOLO]

Dans l’état en ligne, ce bouton est activé si le bouton [Solo Mode] de la barre d’outils l’est également.
Si ce bouton est activé, le son est émis uniquement à partir des canaux enregistrés dans ce groupe de
liaisons, ce qui est pratique lors des ajustements finaux de l’égaliseur, du volume et du retard.

17. Amplificateurs de puissance : série PC

324 | ProVisionaire Design V1.2 Guide d’utilisation



17.3.2. Onglet [User EQ/Volume] (Égaliseur utilisateur/Volume)

Vous pouvez effectuer ici des ajustements collectifs pour l’égaliseur utilisateur et le volume des canaux

enregistrés dans le groupe.

Utilisez le fader principal pour contrôler le volume.
Le fader principal « Volume » applique un réajustement en conséquence sur le volume des canaux enregistrés

dans le groupe.
Pour plus de détails, reportez-vous à la section Éditeur de composants « User EQ/User Delay ».

• Boutons [Band Sharing] (Partage de bande)
Si un canal est enregistré dans plusieurs groupes, cliquez pour sélectionner les bandes appartenant à
chaque groupe. Une bande qui appartient à un groupe s’affiche en bleu. Les bandes qui ne sont pas
représentées sous forme de chiffres blancs sur fond noir appartiennent à d’autres groupes et ne peuvent

pas être sélectionnées ni utilisées.

Les bandes sur lesquelles vous cliquez et qui s’affichent en bleu appartiennent actuellement à un groupe.
La propriété peut uniquement être cédée par l’éditeur de groupes de liaisons auquel appartient cette
bande.

• Bouton [MATCHVAL]
Copie les réglages d’égaliseur des bandes appartenant à l’éditeur de groupes de liaisons dans les canaux
enregistrés.

• LINK MAIN (Liaison principale)
Applique un ajustement relatif aux volumes au sein du groupe de liaisons.
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• Voyant [AMP PROTECT]
S’allume si la fonction de protection de l’unité de la série PC est activée.
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• Voyant [AMP LIMIT]
S’allume si le limiteur de l’unité de la série PC est activé.

◦ Master Fader (Fader principal)
Applique un ajustement relatif aux volumes au sein du groupe de liaisons. La plage réglable

s’affiche au-dessus et en dessous en grisé.
Lorsque vous cliquez avec le bouton droit sur le curseur et sélectionnez [Match Values], les
membres du groupe de liaisons sont réglés sur la même valeur de volume.

◦ Bouton 
Augmente le fader principal de 3 dB.

◦ Bouton 
Augmente le fader principal de 1 dB.

◦ Bouton [RESET]
Déplace le fader principal sur la position 0.

◦ Bouton 
Baisse le curseur principal de 1 dB.

◦ Bouton 
Baisse le fader principal de 3 dB.
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17.3.3. Onglet [User Delay] (Retard utilisateur)

Vous pouvez modifier collectivement ici le retard utilisateur de l’éditeur de composants « User EQ/User Delay »

(Égaliseur utilisateur/Retard utilisateur) pour les prises liées.
Pour plus de détails, reportez-vous à la section « "User EQ/User Delay" component editor » (Éditeur de
composants « Égaliseur utilisateur/retard utilisateur »).

• LINK MAIN
Vous pouvez apporter ici un ajustement relatif au temps de retard des canaux des appareils enregistrés
dans ce groupe de liaisons.

◦ Master fader
Applique un ajustement relatif aux temps de retard au sein du groupe de liaisons. La plage réglable

s’affiche au-dessus et en dessous en grisé.
Lorsque vous cliquez avec le bouton droit sur le curseur et sélectionnez [Match Values], les
membres du groupe de liaisons sont réglés sur la même valeur de temps de retard.

◦ Bouton 
Augmente le fader principal de 3 ms.

◦ Bouton 
Augmente le curseur principal de 0,3 ms.

◦ Bouton [RESET]
Déplace le fader principal sur la position 0.
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◦ Bouton 
Baisse le fader principal de 0,3 ms.

◦ Bouton 
Baisse le fader principal de 3 ms.

◦ [ms]
Indique la valeur du fader principal en ms.

◦ Liste déroulante [meter] (mètres)/[feet] (pieds)

Permet d’afficher les unités de mesure en mètres ou en pieds dans l’écran de gauche.
Modifie également l’affichage pour les différentes prises.
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17.4. Configuration de l’écran de la feuille d’appareil

À l’ouverture de la feuille de l’appareil de la série PC, les zones « Presets » et « Bird’s Eye view » s’affichent.
Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.

① Zone Presets
Vous pouvez stocker plusieurs réglages de paramètres sous forme de présélections.

② Vue Bird’s Eye
Affiche une vue d’ensemble de la feuille.
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17.5. Zone « Presets »

Dans cette zone, vous pouvez stocker les réglages de plusieurs paramètres sous forme de présélections, ou
rappeler une présélection stockée afin d’appliquer ses paramètres aux réglages actuels. Les paramètres de la

présélection appliquée sont appelés « paramètres actuels ».

Si vous souhaitez rappeler les présélections de plusieurs unités simultanément, cliquez sur le bouton , puis
effectuez les réglages dans la boîte de dialogue « Linked Presets Manager ».

• Bouton [STORE]
Ce bouton permet de stocker une présélection. Si vous sélectionnez une présélection dans laquelle des
réglages n’ont pas été stockés, la boîte de dialogue « Store Preset » (Stocker la présélection) s’affiche.

• Bouton [RECALL]
Ce bouton permet de rappeler une présélection.

• Bouton [CLEAR]
Ce bouton permet d’effacer une présélection.

• Liste des présélections
Affiche une liste des présélections. Vous pouvez stocker jusqu’à 32 présélections.

◦ « Preset »
Affiche le numéro et le nom de la présélection. Vous pouvez développer ce paramètre et

sélectionner les paramètres à rappeler.
Si vous sélectionnez une présélection stockée et double-cliquez sur cette zone, vous pourrez

modifier le nom.
Les présélections vides affichent le message [No Data] (Aucune donnée).

◦ « Protect »
Si vous cliquez sur l’icône du cadenas ( ), celle-ci se transforme en , protégeant ainsi la

présélection de façon à ce qu’elle ne puisse être ni modifiée ni effacée.
Si vous cliquez sur cette icône à l’état protégé, la protection est supprimée.
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17.5.1. Boîte de dialogue « Store Preset »

• [Name]
Entrez le nom de la présélection. Par défaut, elle s’intitule « Preset + numéro de la présélection ». Le nom
de la présélection ne peut pas être vide.

• Bouton [OK]
Stocke la présélection et ferme la boîte de dialogue.

• Bouton [Cancel]
Annule le stockage de la présélection et ferme la boîte de dialogue.
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17.6. Menu contextuel

17.6.1. Feuille « Tuning »

Le menu contextuel suivant apparaît lorsque vous faites un clic droit sur la feuille « Tuning ».

Menu Description

[Select All] [All Link Groups]
Sélectionne tous les groupes de liaisons dans la feuille.

[Close All Editor Windows] Ferme tous les éditeurs.

[Snap to Grid] Si cette option est cochée, les composants sont alignés sur la grille de la
feuille.

17.6.2. Groupe de liaisons dans la feuille « Tuning »

Le menu contextuel suivant apparaît lorsque vous cliquez avec le bouton droit sur un groupe de liaisons, même
si certains éléments de menu peuvent être présents ou absents.

Menu Description

[Open Link Group Editor] Ouvre l’éditeur de groupes de liaisons Pour en savoir plus sur l’éditeur de
groupes de liaisons, reportez-vous à chaque appareil.

[Open Amplifier Sheet] (Ouvrir la
feuille de l’amplificateur)

Ouvre la feuille de l’amplificateur sélectionné.

[Identify] Provoque le clignotement des voyants de l’amplificateur pendant

plusieurs secondes.
Si un canal est sélectionné sur l’amplificateur de la série PC, le voyant du
canal clignote pendant plusieurs secondes.

[Delete] Si un canal est sélectionné, cette option le supprime du groupe de

liaisons.
Si un appareil est sélectionné, cette option le supprime du groupe de

liaisons.
Si un groupe de liaisons est sélectionné, cette option le supprime.

[Bring to Front] Déplace le groupe de liaisons à l’avant-plan.

[Bring to Back] Déplace le groupe de liaisons à l’arrière-plan.

17.6.3. Zone « Project Devices » (Appareils du projet)

Le menu contextuel décrit ci-après apparaît lorsque vous faites un clic droit sur un appareil ou un canal dans la
zone « Project Devices ».

Menu Description

[Find] Met en surbrillance le groupe de liaisons dans lequel l’appareil ou le canal
est enregistré.

[Add to Link Group] (Ajouter au
groupe de liaisons)

Enregistre les canaux de l’amplificateur dans un groupe de liaisons. Si le
haut-parleur est raccordé à un amplificateur, cette option enregistre
également le canal de l’ampli raccordé.
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17.6.4. Zone « Link Groups » (Groupes de liaisons)

Le menu contextuel suivant apparaît lorsque vous faites un clic droit sur un objet dans la zone « Link Groups ».

Menu Description

[Find] Si vous cliquez avec le bouton droit sur un appareil, celui-ci est mis en
surbrillance dans le groupe de liaisons et l’éditeur de composants du

groupe de liaison s’ouvre.
Si vous cliquez avec le bouton droit sur un canal ou un groupe de liaisons,
le canal est mis en surbrillance au sein de ou sur le groupe de liaisons, et
l’éditeur de groupes de liaisons s’ouvre.

[Delete] Si vous cliquez avec le bouton droit sur un canal, celui-ci est supprimé du

groupe de liaisons.
Si vous avez fait un clic droit sur un appareil, cette option permet de le

supprimer du groupe de liaisons.
Si vous avez fait un clic droit sur un groupe de liaisons, cette option
permet de le supprimer.

17.6.5. Feuille d’appareil

Lorsque vous faites un clic droit sur une feuille d’appareil dans un emplacement sans objet, le menu contextuel
suivant s’affiche.

Menu Description

[Close All Editor Windows] Ferme tous les éditeurs.

[Debug Mode] (Mode débogage) -

17.6.6. Composants répertoriés dans la feuille d’appareil/l’éditeur de composants

Lorsque vous faites un clic droit sur un emplacement autre que l’opérateur du composant ou le composant lui-
même, le menu contextuel suivant s’affiche (certains éléments peuvent être omis).

Menu Description

[Open Component Editor] Ouvre l’éditeur de composants.

[Copy] Copie les réglages de paramètres de l’éditeur de composants.

[Paste Parameters] Colle les réglages des paramètres de l’éditeur de composants qui ont été
copiés.

17.6.7. Zone « Presets »

Lorsque vous faites un clic droit sur une présélection, le menu contextuel suivant s’affiche.

Menu Description

[All On] Coche toutes les cases pouvant faire l’objet d’un rappel.

[All Off] Désélectionne toutes les cases pouvant faire l’objet d’un rappel.
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17.7. Liste des alertes

Les alertes générées par les unités de la série PC ainsi que leur signification et les mesures à prendre sont

répertoriées ci-dessous.
Une alerte unique s’affiche lorsque l’événement se produit. Une alerte persistante s’affiche quand l’événement se

produit et quand il prend fin.
Si le problème n’est pas résolu, contactez l’un des services techniques Yamaha dont la liste figure à la fin du
mode d’emploi du modèle concerné.

Nu
mér
o

Message Gravité Description Mesure Unique/P
ersistant
e

05 Amplifier Output Muting
(Assourdissement de la
sortie de l’amplificateur)

Erreur La fonction de protection a
été activée pour couper la
sortie de l’amplificateur.

Annulez la fonction de
protection à l’origine du

problème.
La cause est indiquée par
une autre alerte qui
s’affiche en même temps.

Persistan
te

12 Mains Voltage Over 276[V]
(Tension secteur
supérieure à 276 [V])

Erreur (au démarrage)
L’amplificateur ne peut
pas démarrer car la
tension de l’alimentation
dépasse la tension de
fonctionnement autorisée.

Branchez une alimentation
stable conforme aux
exigences en matière
d’alimentation.

Unique

L’amplificateur s’est arrêté
car la tension de
l’alimentation dépasse la
tension de
fonctionnement autorisée.

Persistan
te

13 Power Supply Output
Voltage (Tension de sortie
de l’alimentation)

Défaut (au démarrage)
L’amplificateur ne peut
pas démarrer en raison
d’une anomalie de la
tension de sortie du circuit
d’alimentation.

Il est possible que l’unité
présente un

dysfonctionnement.
Contactez un centre
technique Yamaha.

Unique

L’amplificateur a été arrêté
car une anomalie est
survenue au niveau de la
tension de sortie du circuit
d’alimentation.

Persistan
te

14 Power Supply Over-
temperature (Température
excessive de
l’alimentation)

Erreur (au démarrage)
L’amplificateur ne peut
pas démarrer car le circuit
d’alimentation est trop
chaud.

- Abaissez la température

avant toute utilisation.

- Nettoyez l’entrée d’air.
- Abaissez la température
ambiante.

Unique

L’amplificateur a été arrêté
car le circuit
d’alimentation est devenu
anormalement chaud.

Persistan
te
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Nu
mér
o

Message Gravité Description Mesure Unique/P
ersistant
e

21 Amplifier Ch.* DC Output
(Sortie CC du canal* de
l’amplificateur)

Défaut (au démarrage)
L’amplificateur ne peut
pas démarrer en raison
d’une anomalie de la sortie
de l’amplificateur.

Il est possible que l’unité
présente un

dysfonctionnement.
Contactez un centre
technique Yamaha.

Unique

L’amplificateur a été arrêté
car une anomalie est
survenue au niveau de la
sortie de l’amplificateur du
canal correspondant.

Persistan
te

22 Amplifier Ch.* Overcurrent
(Surtension du canal* de
l’amplificateur)

Erreur La sortie a été assourdie
en raison d’un courant
excessif qui circule dans
l’amplificateur du canal
correspondant.

- Réduisez le volume de
sortie de façon à ce que la
valeur actuelle ne devienne

pas excessive.
- Il est possible que la
prise de sortie du haut-
parleur doive être court-
circuitée.

Persistan
te

23 Amplifier Ch.* Overtemp
Level 1 (Température
excessive de niveau 1 du
canal* de l’amplificateur)

Erreur Étant donné que la
température de
l’amplificateur du canal
correspondant a dépassé
le niveau 1, la vitesse de
rotation du ventilateur a
été augmentée et le
limiteur a été appliqué à la
sortie.

- Diminuez le volume de
sortie de façon à ce que la
température ne devienne

pas excessive.
- Nettoyez le filtre.
Maintenez également la
température ambiante
constante.

Persistan
te

24 Amplifier Ch.* Overtemp
Level 2

Erreur Étant donné que la
température de
l’amplificateur du canal
correspondant a dépassé
le niveau 2, la vitesse de
rotation du ventilateur a
été augmentée et le
limiteur a été appliqué à la
sortie.

Persistan
te

25 Amplifier Ch.* Overtemp
Level 3

Erreur Étant donné que la
température de
l’amplificateur du canal
correspondant a dépassé
le niveau 3, la vitesse de
rotation du ventilateur a
été augmentée au
maximum et la sortie a été
assourdie.

Persistan
te
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Nu
mér
o

Message Gravité Description Mesure Unique/P
ersistant
e

26 Ch.* High Load (Charge
élevée du canal*)

Avertisse
ment

La valeur d’impédance du
canal correspondant
contrôlé par la fonction
Load Monitoring est
supérieure à la valeur
spécifiée.

- Vérifiez qu’il n’y a pas
d’anomalie au niveau du

haut-parleur ou du câble.
Vérifiez que le seuil est
réglé sur une valeur
approprié.

Persistan
te

27 Ch.* Low Load (Charge
faible du canal*)

Avertisse
ment

La valeur d’impédance du
canal correspondant
contrôlé par la fonction
Load Monitoring est
inférieure à la valeur
spécifiée.

Persistan
te

31 Fan * Error (Erreur du
ventilateur *)

Défaut Le ventilateur portant le
numéro correspondant a
cessé de tourner.

Il est possible que l’unité
présente un

dysfonctionnement.
Contactez un centre
technique Yamaha.

Persistan
te

42 Input D* Change To 2nd
(Basculement du Dante*
d’entrée vers le second)

Avertisse
ment

La fonction Input
Redundancy Backup
(Sauvegarde de la
redondance d’entrée) a fait
basculer le signal audio
sur le deuxième circuit
prioritaire.

Vérifiez si le circuit audio
principal (Dante) présente

un dysfonctionnement.
(Notez que si la fonction
Auto Return est réglée sur
ON, le circuit risque de
rebasculer brusquement
en cas de restauration de
la connexion.)

Unique

43 Input D* Change To 3rd
(Basculement du Dante*
d’entrée vers le troisième)

Avertisse
ment

La fonction Input
Redundancy Backup a fait
basculer le signal audio
sur le troisième circuit
prioritaire.

Vérifiez si le circuit audio
principal ou le deuxième
circuit audio prioritaire
(Dante) présente un

dysfonctionnement.
(Notez que si la fonction
Auto Return est réglée sur
ON, le circuit risque de
rebasculer brusquement
en cas de restauration de
la connexion.)

Unique

61 Dante Module Failed
(Défaillance du module
Dante)

Défaut Le module Dante interne
ne fonctionne pas
correctement.

Il est possible que l’unité
présente un

dysfonctionnement.
Contactez un centre
technique Yamaha.

Persistan
te

63 Firmware Versions
Mismatch (Discordance
des versions du
micrologiciel)

Erreur La version du
microprogramme de l’unité
n’est pas compatible avec
celle du microprogramme
de Dante.

Le programme de mise à
jour disponible sur le site
Web contient à la fois le
microprogramme de cette
unité et le
microprogramme de
Dante. Mettez à jour les
deux.

Unique
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Nu
mér
o

Message Gravité Description Mesure Unique/P
ersistant
e

64 Dante Is Not Working By
Giga Bit (Dante ne
fonctionne pas en gigabit)

Erreur Un appareil qui ne prend
pas en charge la
technologie Gigabit

Ethernet est connecté.
En mode de connexion en
guirlande, cette alerte se
produit également en cas
de connexion au port de

contrôle.
Lorsque l’unité est
déconnectée du réseau,
l’alerte 69 se produit et
cette alerte est
temporairement
désactivée.

Si vous souhaitez
transmettre les données
audio via Dante, utilisez
des appareils prenant en
charge la technologie
Gigabit Ethernet.

Persistan
te

65 Dante Is Working At
Secondary (Dante
fonctionne sur le circuit
secondaire)

Avertisse
ment

En mode Redundant, la
communication audio
Dante se déroule sur le

circuit secondaire.
Lorsque l’unité est
déconnectée du réseau,
l’alerte 69 se produit et
cette alerte est
temporairement
désactivée.

Vérifiez si le circuit
principal est défectueux.

Persistan
te

66 Error Occurred At
Secondary Port (Erreur au
niveau du port secondaire)

Avertisse
ment

En mode Redundant, le
circuit principal de Dante
fonctionne correctement,
mais le circuit secondaire

n’est pas connecté.
* Uniquement si la
connexion a été confirmée
à un moment donné, puis
débranchée

Si la connexion du circuit
secondaire est nécessaire,
vérifiez s’il présente un
dysfonctionnement.

Persistan
te

67 Wrong Word Clock
(Horloge de mots
incorrecte)

Avertisse
ment

Un problème a été détecté
dans l’horloge de mots.

- Dans Dante Controller,
réglez correctement
l’horloge de mots de

l’ensemble du système.
- Vérifiez que le réglage FS
(fréquence
d’échantillonnage) est le
même pour les appareils
dont le son est assigné.

Persistan
te
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Nu
mér
o

Message Gravité Description Mesure Unique/P
ersistant
e

69 Dante Port Is Not
Connected (Port Dante
non connecté)

Avertisse
ment

En mode Redundant, le
circuit principal de Dante
fonctionne correctement,
mais le circuit secondaire

n’est pas connecté.
* Ce message s’affiche
uniquement si la
connexion a été confirmée
à un moment donné, puis
débranchée.

Vérifiez que le circuit de
Dante est correctement
connecté.

Persistan
te
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17.8. Éditeurs de composants

Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.
Cette section décrit l’éditeur de composants spécifique à la série PC, ainsi que les boîtes de dialogue et les
fenêtres étroitement associées aux composants. Pour plus de détails sur les autres composants, reportez-vous
au « ProVisionaire Design DME7 Component Guide ».

Numér
o

Nom du composant Description Lien

①

Power Cette fonction active
l’alimentation de l’appareil et
affiche la valeur du courant
électrique de l’unité principale.

Éditeur de composants « Power »

②

DANTE IN Affiche les réglages liés à l’entrée
de la borne [Dante] et au niveau
du signal audio transmis en
entrée.

Éditeur de composants « Input
Alignment »

③

ANALOG IN Affiche les réglages liés à l’entrée
de la borne [INPUT] et au niveau
du signal audio transmis en
entrée.

Éditeur de composants « Input
Alignment »

④

Redundancy Définit la source d’entrée et
l’opération de
remplacement/sauvegarde au
niveau de chaque canal.

---

⑤
Input Ajuste le niveau du canal

d’entrée.

---

⑥
Matrix Mixer Règle la balance de groupe pour

chaque bus de sortie.
« ProVisionaire Design DME7 Component
Guide »

⑦

Matrix Out Règle le niveau depuis la console
de mixage matricielle vers la
sortie du routeur et la sortie
Dante.

---
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Numér
o

Nom du composant Description Lien

⑧
Router Affecte la sortie de la console de

mixage matricielle aux canaux de
sortie.

« ProVisionaire Design DME7 Component
Guide »

⑨
Volume Ajuste le niveau du canal de

sortie.

---

⑩
User EQ/Delay
(Égaliseur/retard
utilisateur)

Définit l’égalisation/le retard du
canal de sortie.

Éditeur de composants « User EQ/Delay »

⑪
Speaker Processor Définit le processeur de haut-

parleur du canal de sortie.
Éditeur de composants « Speaker
Processor »

⑫
Amplifier (Amplificateur) Définit le mode de sortie de

l’amplificateur et le détecteur
d’impédance.

Éditeur de composants « Amplifier »

⑬
DANTE OUT Indique le niveau de sortie de

Dante.

---

⑭
SPEAKER OUT Affiche la tension et le courant

de sortie de la borne de sortie du
haut-parleur.

Éditeur de composants « Speaker Out »
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17.8.1. Éditeur de composants « Power » (Alimentation)

Fait basculer l’alimentation de l’appareil et indique la valeur du courant électrique de l’unité.
Cette fonction est uniquement disponible en ligne.

• Power

◦ Bouton [STANDBY]/[ON] (Veille/Marche)
Fait basculer l’alimentation entre l’état de veille et de marche.

◦ [VOLTAGE] (Tension)
Indique la valeur de la tension de l’entrée d’alimentation.

◦ [CURRENT] (Courant)
Indique la valeur du courant électrique de l’appareil.

• Boutons Device Mute [OFF]/[ON] (Assourdissement de l’appareil)

Permet d’activer ou de désactiver la fonction Device Mute.
Lorsque cette fonction est activée, la sortie du haut-parleur est assourdie pour tous les canaux de
l’amplificateur.
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17.8.2. Éditeur de composants « Input Alignment » (Alignement des entrées)

Pour afficher cet éditeur de composants, double-cliquez sur le composant « DANTE IN » ou sur le composant

« ANALOG IN ».
Sur cet écran, vous pouvez effectuer les réglages des prises d’entrée et consulter les niveaux des signaux audio
transmis en entrée.

• Niveau d’entrée
Indique le niveau après compensation par TRIM (Écrêtage) et DELAY (Retard).

• Bouton [TRIM]
Compense les différences de niveau entre les prises d’entrée.

• Bouton [DELAY]
Compense les différences de latence entre les prises d’entrée.

• Nom du canal
Affiche ou modifie le nom de la prise d’entrée.
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17.8.3. Éditeur de composants « User EQ/Delay »

• Graphique EQ

Affiche un graphique de l’effet d’égalisation.
Vous pouvez faire glisser un point de contrôle pour modifier les paramètres.

• Boutons [Band Select] (Sélection de bande)
Si un bouton est sélectionné, la valeur actuelle de la bande correspondante s’affiche sous « EQ »
(Égaliseur) ci-dessous. Pour les bandes dont le bouton [BYPASS] (Contourner) de la zone «EQ »
(Égaliseur) est activé, le voyant qui se trouve sous le bouton [Band Select] (Bande sélectionnée) est
allumé.

Pour plus de détails sur les autres paramètres, reportez-vous au « ProVisionaire Design DME7 Component
Guide ».

17. Amplificateurs de puissance : série PC

344 | ProVisionaire Design V1.2 Guide d’utilisation

https://manual.yamaha.com/pa/pv/pvd_cg
https://manual.yamaha.com/pa/pv/pvd_cg


17.8.4. Éditeur de composants « Speaker Processor »

「PEAK LIMITER」 (Limiteur de crête)/「RMS LIMITER」 (Limiteur RMS)

Ne s’affichent pas si la prise correspondante est définie comme étant une connexion à haute impédance telle
que 70 V ou 100 V.

• Bouton [ON]
Permet d’activer ou de désactiver le limiteur. Lorsque le bouton est désactivé, le limiteur est contourné.

• Voyant de réduction du gain
Ce voyant s’allume lorsque la valeur seuil est dépassée.

• Bouton [Threshold]
Spécifie la valeur seuil au-delà de laquelle le limiteur s’applique, en termes de puissance de sortie (W).

• Bouton [Attack]
Détermine la vitesse à laquelle le limiteur est appliqué.

• Bouton [Release]
Spécifie la vitesse de relâchement du limiteur.

• Indicateur de niveau « GR »
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Indique le niveau de réduction du gain.

• Bouton [Impedance / Unit] (Impédance/unité)

Spécifie l’impédance nominale du haut-parleur.
Même en cas de connexion parallèle de plusieurs haut-parleurs, ce paramètre doit être spécifié comme
étant l’impédance d’une seule unité.

Pour plus d’informations, reportez-vous au « ProVisionaire Design DME7 Component Guide ».
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17.8.5. Éditeur de composants « Amplifier »

• Bouton BRIDGE [ON]

Lorsque ce bouton est activé, l’amplificateur est en mode de sortie BRIDGE (Pont).
En mode BRIDGE, les canaux adjacents pairs et impairs sont reliés via une connexion en pont afin de
fonctionner en tant qu’amplificateur de puissance élevée.

• Bouton CHANNEL SLEEP [ON] (Veille du canal)
Lorsque ce bouton est activé, l’amplificateur de ce canal est mis en veille. En mettant les canaux inutilisés
en veille, vous pouvez économiser l’alimentation électrique et réduire les températures excessivement

élevées.
Ce réglage est différent du réglage Auto Sleep (Veille automatique) de la zone « Properties » de la feuille
« Project ».

• « LOAD MONITORING » (Contrôle de charge)
Vous pouvez effectuer ici les réglages de contrôle de l’impédance de sortie du haut-parleur afin de
déterminer si la sortie a été interrompue par un court-circuit électrique, une cassure ou un
dysfonctionnement du haut-parleur. L’émission d’une fréquence pilote permet de détecter l’impédance de

manière stable sans se baser sur la sortie du signal audio.
Cette option ne s’affiche pas pour les canaux spécifiés en tant que connexion Hi-Z.

◦ Bouton [ON]
Active ou désactive la fonction LOAD MONITORING.

◦ Bouton OSCILLATOR [ON]

Spécifie si une fréquence pilote est émise.
Il est également possible d’utiliser une fréquence pilote provenant d’une entrée externe pour
détecter l’impédance.

◦ Bouton OSCILLATOR [Level]
Spécifie le niveau de sortie de la fréquence pilote.

◦ Bouton IMPEDANCE [Detection Freq.] (Fréquence de détection)
Spécifie la fréquence à laquelle l’impédance est détectée. Le champ [Impedance] en-dessous
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affiche l’impédance mesurée.

◦ Bouton/voyant IMPEDANCE [High Threshold] (Seuil supérieur)
Spécifie le seuil supérieur de l’impédance mesurée. Si la valeur spécifiée est dépassée, il est

déterminé qu’un dysfonctionnement du haut-parleur est survenu et le voyant s’allume.
Si la valeur spécifiée est dépassée, il se peut que la connexion soit ouverte, en raison, par exemple,
d’une rupture de câble.

◦ Bouton/voyant IMPEDANCE [Low Threshold] (Seuil inférieur)
Spécifie le seuil inférieur de l’impédance mesurée. Si la valeur mesurée tombe sous la valeur seuil
spécifiée, il est déterminé qu’un dysfonctionnement du haut-parleur est survenu et le voyant

s’allume.
Si la valeur mesurée tombe sous la valeur spécifiée, il se peut que la résistance ait baissé en raison
d’une bobine court-circuitée, etc.
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17.8.6. Éditeur de composants « Speaker Out » (Sortie de haut-parleur)

Permet d’afficher la tension et le courant de sortie de la prise de sortie du haut-parleur.

• Voyant [AMP PROTECT]
S’allume si la fonction de protection de l’unité de la série PC est activée.

• Voyant [AMP LIMIT]
S’allume si le limiteur de l’unité de la série PC est activé.

• Voyant [PEAK LIMIT]
S’allume si le limiteur de crête au sein du processeur de haut-parleur de l’unité PC est activé.

• Voyant [RMS LIMIT]
S’allume en cas de fonctionnement du limiteur RMS au sein du processeur de haut-parleur de l’unité PC.

• Indicateur de niveau [Voltage]
Affiche la tension de sortie sous forme de valeurs de crête et RMS.

• Indicateur de niveau [Current]
Affiche le courant de sortie sous forme de valeurs de crête et RMS.
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18. Amplificateurs de puissance : série XMV

18.1. Présentation

Les produits de la série XMV sont des amplificateurs de puissance de classe D qui allient une efficacité élevée à
un panel de fonctions optimisées pour les espaces commerciaux. En plus des entrées et sorties analogiques, le
système est équipé du nouveau format audio numérique « YDIF » ou du réseau audio « Dante ». Les modèles
compatibles YDIF connectés via des câbles Ethernet facilitent la configuration, tandis que les modèles Dante
favorisent une transmission numérique de haute qualité dans des installations de grande envergure.

18.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités de la série XMV placées sur la feuille d’appareil.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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18.2.1. Zone « Properties »

« Input Source ＆ Redundancy » (Source d’entrée et redondance)

Vous pouvez spécifier ici si la source d’entrée sur le XMV est numérique ou analogique pour chaque canal. Si la
source d’entrée est spécifiée comme étant numérique, vous pouvez indiquer que la source d’entrée passe de
numérique à analogique lorsqu’une fréquence pilote ou une entrée analogique est détectée. Cette section vous

présente l’écran qui s’affiche lorsque l’entrée numérique est au format Dante.
Cliquez sur le champ Value de chaque canal dans la zone Properties « Input Source & Redundancy », puis cliquez
sur l’icône « … » qui s’affiche pour ouvrir la boîte de dialogue « Input Source & Redundancy ».

• Zone de liste [Redundant Mode] (Mode redondant)
Sélectionne la méthode de redondance.

◦ [Off]
La redondance est désactivée.

◦ [Backup]
Bascule sur l’entrée analogique en cas d’interruption de la fréquence pilote de l’entrée numérique
en raison d’une connexion interrompue ou d’un autre problème.

◦ [Override]
Bascule sur l’entrée analogique lorsqu’un signal audio analogique est détecté.

• Case à cocher [Auto Return] (Retour automatique)
Lorsque cette case est cochée, les opérations se déroulent comme suit.

◦ Dans le cas du mode Backup
Lorsque l’entrée numérique est rétablie, la source d’entrée bascule de l’analogique au numérique.

◦ Dans le cas du mode Override
Lorsque l’entrée analogique descend sous la valeur seuil, la source d’entrée bascule de
l’analogique au numérique.

• Index des canaux
Affiche le numéro du canal de sortie pour lequel il faut effectuer des réglages.

• Zone « Primary Input Source » (Source d’entrée principale)
Vous pouvez spécifier ici pour chaque canal si l’entrée est numérique ou analogique.

◦ Case d’option [YDIF (Digital)] (YDIF (Numérique))/[Dante (Digital)] (Dante (Numérique))**
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Le signal du canal correspondant est extrait de YDIF ou Dante.
Pour spécifier l’assignation Dante, effectuez les réglages dans Dante Controller.

◦ Case à cocher [Active Redundant Mode] (Activer le mode Redondant)

Lorsque cette case est cochée, la fonction de redondance est activée.
La zone de liste [Redundant Mode] permet de déterminer le mode de redondance. Lorsque [Off] est
sélectionné, la fonction de redondance est désactivée même si cette case est cochée.

◦ Case d’option [Analog]
Le signal est extrait de la prise d’entrée analogique du canal correspondant.

• Zone « Redundant Mode - Backup » (Mode redondant - Sauvegarde)
Vous pouvez spécifier ici la manière dont la fréquence pilote est détectée pour chaque canal.

◦ Zone de sélection [Frequency]
Spécifie la fréquence centrale de la fréquence pilote.

◦ Zone de sélection [Detection Threshold] (Seuil de détection)
Spécifie la valeur seuil du niveau d’entrée de la fréquence pilote. Si une entrée dépasse la valeur
seuil, elle est considérée comme étant la fréquence pilote.

▪ Zone de sélection [Detection Time] (Temps de détection)
Spécifie le délai de détection de la fréquence pilote. Si la fréquence pilote ne peut pas être
détectée au cours de l’intervalle de temps spécifié, l’entrée est considérée comme
interrompue.

▪ Case à cocher [Notch Filter] (Filtre coupe-bande)
Si cette case est cochée, un filtre coupe-bande est activé pour éliminer le composant de
fréquence de la fréquence pilote pour qu’elle ne soit pas émise depuis l’amplificateur.

◦ Zone de sélection [Q]
Spécifie la largeur de la bande de fréquence du filtre coupe-bande.

• Zone « Redundant Mode - Override » (Mode redondant - Remplacement)
Vous pouvez spécifier ici les conditions sous lesquelles chaque canal bascule sur l’entrée analogique en
mode Override.

◦ Zone de sélection [Override Threshold] (Seuil de remplacement)
Spécifie la valeur seuil de l’entrée analogique. Lorsque la valeur seuil est dépassée, la source
d’entrée bascule en analogique.

◦ Zone de sélection [Auto Return Delay] (Délai du retour automatique)
Lorsque la case [Auto Return] est cochée, cette zone de sélection numérique permet de spécifier le
délai entre la chute de l’entrée analogique sous la valeur seuil et le basculement de l’entrée sur
l’entrée numérique.

• Bouton [Save Changes] (Enregistrer les modifications)
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Annule les modifications et ferme la boîte de dialogue.
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18.3. Feuille Tuning

18.3.1. Éditeur de groupes de liaisons

Pour afficher cet éditeur, double-cliquez sur un groupe de liaisons dans la feuille « Tuning » dans laquelle le canal
d’une unité de la série XMV est enregistré, ou faites un clic droit et sélectionnez [Open Link Group Editor] (Ouvrir
l’éditeur de groupes de liaisons).

18.3.2. « ATT » (Atténuation)

Vous pouvez effectuer ici des ajustements collectifs de l’atténuation des canaux enregistrés dans le groupe.

Utilisez le curseur principal pour contrôler l’atténuation.
Le curseur principal « LINK MAIN » (Liaison principale) applique un réajustement relatif et collectif de

l’atténuation aux canaux enregistrés dans le groupe.
Pour plus de détails sur l’atténuateur, reportez-vous à l'éditeur de composants « Power/ATT/Polarity »
(Puissance/Atténuation/Polarité).

• Zone de liste ATT
Répertorie les amplificateurs enregistrés dans le groupe.

• Index des canaux
Index des canaux de l’appareil.

18.3.3. « LINK MAIN »

Applique un ajustement relatif aux atténuateurs du groupe de liaisons.

• Voyant [AMP PROTECT]
S’allume lorsque la fonction de protection de l’unité XMV est activée.

• Voyant [AMP LIMIT]
S’allume lorsque le limiteur de l’unité XMV est activé.

• Fader principal
Applique un ajustement relatif aux atténuateurs du groupe de liaisons. La plage réglable s’affiche au-

dessus et en dessous en grisé.
Lorsque vous cliquez avec le bouton droit sur le fader et sélectionnez [Match Values], les membres du
groupe de liaisons sont réglés sur la même valeur de l’atténuateur.

•
Bouton 
Permet d’augmenter le curseur principal de 3 dB.

•
Bouton 
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Permet d’augmenter le curseur principal de 1 dB.

• Bouton [RESET]
Permet de placer le curseur principal sur la position 0.

•
Bouton 
Permet de baisser le curseur principal de 1 dB.

•
Bouton 
Permet de baisser le curseur principal de 3 dB.

18. Amplificateurs de puissance : série XMV

354 | ProVisionaire Design V1.2 Guide d’utilisation



18.4. Configuration de l’écran de la feuille d’appareil

Lorsque vous ouvrez la feuille d’un appareil XMV, la feuille d’appareil et la « vue Bird’s Eye » s’affichent.
Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.

① Vue bird’s Eye
Affiche une vue d’ensemble de la feuille.
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18.5. Menu contextuel

18.5.1. Feuille « Tuning »

Le menu contextuel suivant apparaît lorsque vous faites un clic droit sur la feuille « Tuning ».

Menu Description

[Select All] [All Link Groups]
Sélectionne tous les groupes de liaisons dans la feuille.

[Close All Editor Windows] Ferme tous les éditeurs.

[Snap to Grid] Si cette option est cochée, les composants sont alignés sur la grille de la
feuille.

18.5.2. Groupe de liaisons dans la feuille « Tuning »

Le menu contextuel suivant apparaît lorsque vous cliquez avec le bouton droit sur un groupe de liaisons, même
si certains éléments de menu peuvent être présents ou absents.

Menu Description

[Open Link Group Editor] Ouvre l’éditeur de groupes de liaisons Pour en savoir plus sur l’éditeur de
groupes de liaisons, reportez-vous à chaque appareil.

[Open Amplifier Sheet] Ouvre la feuille de l’amplificateur sélectionné.

[Identify] Provoque le clignotement des voyants de l’amplificateur pendant

plusieurs secondes.
Si un canal est sélectionné sur l’amplificateur de la série PC, le voyant du
canal clignote pendant plusieurs secondes.

[Delete] Si un canal est sélectionné, cette option le supprime du groupe de

liaisons.
Si un appareil est sélectionné, cette option le supprime du groupe de

liaisons.
Si un groupe de liaisons est sélectionné, cette option le supprime.

[Bring to Front] Déplace le groupe de liaisons à l’avant-plan.

[Send to Back] Déplace le groupe de liaisons à l’arrière-plan.

18.5.3. Zone « Project Devices »

Le menu contextuel décrit ci-après apparaît lorsque vous faites un clic droit sur un appareil ou un canal dans la
zone « Project Devices ».

Menu Description

[Find] Met en surbrillance le groupe de liaisons dans lequel l’appareil ou le canal
est enregistré.

[Add to Link Group] Enregistre les canaux de l’amplificateur dans un groupe de liaisons. Si le
haut-parleur est raccordé à un amplificateur, cette option enregistre
également le canal de l’ampli raccordé.
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18.5.4. Zone « Link Groups »

Le menu contextuel suivant apparaît lorsque vous faites un clic droit sur un objet dans la zone « Link Groups ».

Menu Description

[Find] Si vous cliquez avec le bouton droit sur un appareil, celui-ci est mis en
surbrillance dans le groupe de liaisons et l’éditeur de composants du

groupe de liaison s’ouvre.
Si vous cliquez avec le bouton droit sur un canal ou un groupe de liaisons,
le canal est mis en surbrillance au sein de ou sur le groupe de liaisons, et
l’éditeur de groupes de liaisons s’ouvre.

[Delete] Si vous cliquez avec le bouton droit sur un canal, celui-ci est supprimé du

groupe de liaisons.
Si vous avez fait un clic droit sur un appareil, cette option permet de le

supprimer du groupe de liaisons.
Si vous cliquez avec le bouton droit sur un groupe de liaisons, cette option
le supprime.
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18.6. Liste des alertes

Les alertes générées par les unités de la série XMV ainsi que leur signification et les mesures à prendre sont

répertoriées ci-dessous.
Une alerte unique s’affiche lorsque l’événement se produit. Une alerte persistante s’affiche quand l’événement se

produit et quand il prend fin.

Certaines alertes et informations sont affichées dans ProVisionaire Design mais pas sur l’unité elle-même.
Si le problème n’est pas résolu, contactez l’un des services techniques Yamaha dont la liste figure à la fin du
mode d’emploi du modèle concerné.

Numé
ro

Gravité Description Mesure Unique/Persi
stante

Anomalie de l’appareil

001～
008

Défaut L’appareil n’a pas démarré
correctement.

Mettez l’appareil hors tension,
patientez au moins cinq secondes,
puis remettez-le sous tension. Si
cela ne résout pas le problème,
réinitialisez la mémoire. Si le
problème n’est toujours pas résolu,
contactez un centre technique
Yamaha.

Persistante

10 Défaut La batterie de secours interne est
complètement déchargée ou n’a pas
été installée.

Lorsque vous mettez l’appareil hors
tension, les réglages actuels sont
perdus et réinitialisés sur leurs
valeurs par défaut. Cessez
immédiatement d’utiliser l’appareil
et contactez un centre technique
Yamaha.

Persistante

11 Erreur La batterie de secours interne est
extrêmement faible et la mémoire a
peut-être été perdue.

Persistante

12 Avertissemen
t

La batterie de secours interne est
faible.

L’unité fonctionnera correctement,
mais si vous continuez à l’utiliser,
les réglages risquent d’être perdus
et réinitialisés. Contactez au plus
vite un centre technique Yamaha.

Unique

13 Défaut Une erreur s’est produite au niveau
de l’horloge interne et celle-ci a été
réinitialisée à sa valeur par défaut
(année 2000, 1er janvier, minuit).

Si ce problème se produit à chaque
mise sous tension, il est possible
que la batterie de secours interne
soit déchargée ou que l’unité
présente un dysfonctionnement.
Contactez un centre technique
Yamaha. Si cela n’arrive qu’une
seule fois, l’horloge a sans doute été
réinitialisée suite à la détection
d’une valeur de paramétrage
anormale. Utilisez la boîte de
dialogue « Clock » (Horloge) pour
régler l’heure.

Persistante

15 Défaut Les réglages enregistrés dans la
mémoire interne sont perdus.

Il est possible que la batterie de
secours interne soit faible ou que
l’unité présente un
dysfonctionnement. Contactez un
centre technique Yamaha.

Persistante
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Numé
ro

Gravité Description Mesure Unique/Persi
stante

16 Défaut Il est possible que la mémoire
interne de l’unité présente un
dysfonctionnement.

Contactez un centre technique
Yamaha.

Persistante

21 Erreur Le signal numérique sélectionné en
tant qu’horloge de mots leader est
déverrouillé.

Vérifiez que le signal de l’horloge de
mots est reçu correctement.

Persistante

22 Erreur Le signal numérique envoyé au
connecteur [YDIF IN] n’est pas
synchronisé avec l’horloge de mots
de cette unité.

Vérifiez que le câble est

correctement branché.
Utilisez un câble conforme aux
caractéristiques techniques
requises.

Unique

23 Erreur Le signal numérique envoyé au
connecteur [YDIF IN] n’est pas
synchronisé en continu avec
l’horloge de mots de cette unité.

Persistante

30 Erreur La connexion du connecteur [YDIF
IN] présente un problème.

Vérifiez que le câble est

correctement branché.
Utilisez un câble conforme aux
caractéristiques techniques
requises.

Persistante

40 Erreur Un conflit d’adresses IP s’est
produit.

Configurez l’adresse IP de façon à
ce qu’elle ne soit pas en conflit avec
d’autres.

Persistante

41 Avertissemen
t

L’adresse IP n’a pas été établie dans
les 60 secondes après le
démarrage.

Si le commutateur DIP 6 (IP
SETTING) de l’appareil est réglé sur
« PC », utilisez le serveur DHCP pour
définir l’adresse IP.

Persistante

43 Erreur Le nombre d’appareils connectés au
réseau est trop élevé.

Réduisez le nombre d’appareils
connectés au réseau.

Unique

46 Erreur Le nombre maximum de flux de
transmission Dante a été dépassé.

Réduisez le nombre de flux, par
exemple, à l’aide de Dante
Controller, afin de convertir une
partie des flux de transmission en
multidiffusion.

Unique

50 Erreur Le paramètre UNIT ID est réglé sur
« 00 ».

Réglez le paramètre UNIT ID sur une
valeur autre que « 00 ».

Persistante

51 Erreur Un autre appareil portant le même
ID d’unité est connecté au même
réseau.

Définissez l’ID de l’unité de façon à
ce qu’il n’entre pas en conflit avec
les autres.

Persistante

72 Erreur La fonction Device Lock ayant été
spécifiée pour Dante, le réglage du
commutateur DIP ne correspond
pas au réglage Dante.

Si la fonction Device Lock est
spécifiée, vous pouvez soit l’annuler
via Dante Controller, soit modifier le
réglage du commutateur DIP de
manière à ce qu’il soit correctement
réglé pour l’état actuel.

Persistante
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Numé
ro

Gravité Description Mesure Unique/Persi
stante

100 Défaut L’alimentation a été coupée car un
composant de courant direct a été
détecté sur la prise de sortie du
haut-parleur.

Il est probable que l’appareil
présente un dysfonctionnement.
Contactez un centre technique
Yamaha.

Persistante

101 Défaut L’alimentation a été coupée car la
température de l’alimentation a
dépassé la valeur nominale.

Coupez l’alimentation, attendez
qu’elle refroidisse, puis rallumez-la.
Diminuez le niveau de sortie car
l’émission continuelle d’une
puissance en watts élevée entraîne
des températures élevées. Si la
température demeure élevée,
vérifiez que le ventilateur n’est pas
obstrué par des poussières ou des
corps étrangers et nettoyez-le, si
nécessaire.

Persistante

103 Erreur Le circuit de protection a coupé
l’alimentation.

Étant donné la poursuite de la
situation de charge élevée, baissez
le niveau de sortie. Pour savoir
pourquoi la protection s’active,
reportez-vous au mode d’emploi.

Persistante

104 Erreur Le circuit de protection s’est activé
et le [ch*] (canal*) de sortie est
assourdi.

Persistante

105 Défaut La sortie a été assourdie car un
court-circuit a été détecté au niveau
du [ch*] (canal*) de la prise de sortie
du haut-parleur.

Il est possible que le + et le – de la
prise de sortie du haut-parleur aient
été court-circuités ou que le haut-
parleur connecté présente un
dysfonctionnement.

Unique

106 Avertissemen
t

La température de la section de
l’amplificateur (dissipateur
thermique) a changé, provoquant
l’état de sortie du haut-parleur

suivant. (*)

* = 0 dB et OK

-1 dB et protection activée
assourdi et protection activée

Diminuez le niveau de sortie car
l’émission en continue d’une
puissance en watts élevée entraîne
des températures élevées. Si la
température demeure élevée,
vérifiez que le ventilateur n’est pas
obstrué par des poussières ou des
corps étrangers et nettoyez-le, si
nécessaire.

Unique

Informations sur l’appareil

200 Information L’unité a été mise sous tension.  —  Unique

201 Information L’unité a été mise hors tension.  —  Unique

202 Information La mise à jour du microprogramme
est terminée.

 —  Unique

203 Information La réinitialisation a été exécutée.  —  Unique

204 Information Le verrouillage du panneau a été
désactivé.

 —  Unique

205 Information L’adresse IP a été établie.  —  Unique

206 Information L’adresse IP du réseau a été allouée
lors du fonctionnement avec le
serveur DHCP.

 —  Unique
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Numé
ro

Gravité Description Mesure Unique/Persi
stante

207 Information L’adresse IP du réseau a été libérée
lors du fonctionnement avec le
serveur DHCP.

 —  Unique

211 Information La synchronisation entre l’éditeur et
les appareils a démarré.

 —  Unique

Informations sur l’amplificateur

102 Information Le circuit de protection a entraîné
l’activation du limiteur [ch*] (canal*).

Étant donné la poursuite de la
situation de charge élevée, baissez
le niveau de sortie. Pour savoir
pourquoi la protection s’active,
reportez-vous au mode d’emploi.

Persistante

110 Erreur La fonction Redundant Backup s’est
activée et le canal * a basculé vers
l’entrée analogique.

Le signal numérique présente un
problème. Vérifiez la connexion du
circuit numérique et assurez-vous
qu’une fréquence pilote est émise
en entrée.

Persistante

219 Information Le mode Power Amp (Amplificateur
de puissance) a été modifié.

 —  Unique

226 Information La fonction Redundant Override
s’est activée et le canal * a basculé
vers l’entrée analogique.

 —  Persistante
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18.7. Éditeurs de composants

Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.
Cette section décrit l’éditeur de composants de la série XMV, ainsi que les boîtes de dialogue et les fenêtres
associées aux composants. Pour plus de détails sur les autres composants, reportez-vous au « ProVisionaire
Design DME7 Component Guide ».

Modèle Dante

N° Nom du composant Description Lien

①

Power Définit la mise veille ou en
marche, l’assourdissement, la
polarité et l’atténuateur de
l’alimentation.

Éditeur de composants
« Power/ATT/Polarity »

②
DANTE IN Envoie l’entrée du signal audio

depuis la borne [Dante].

-

③
ANALOG IN Envoie le signal audio émis

depuis la borne d’entrée
analogique.

-

④
Redundancy Définit le réglage de la détection

de la fréquence pilote en mode
Redundant.

Éditeur de composants « Redundancy »

⑤

ATT Définit la mise veille ou en
marche, l’assourdissement, la
polarité et l’atténuateur de
l’alimentation.

Éditeur de composants
« Power/ATT/Polarity »

⑥

Polarity Définit la mise veille ou en
marche, l’assourdissement, la
polarité et l’atténuateur de
l’alimentation.

Éditeur de composants
« Power/ATT/Polarity »

⑦
SPEAKER OUT Affiche la tension et le courant

de sortie de la borne de sortie du
haut-parleur.

Éditeur de composants « Speaker Out »
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Modèle YDIF

Numér
o

Nom du composant Description Lien

①

Power Définit la mise veille ou en
marche, l’assourdissement, la
polarité et l’atténuateur de
l’alimentation.

Éditeur de composants
« Power/ATT/Polarity »

③
ANALOG IN Envoie le signal audio émis

depuis la borne d’entrée
analogique.

-

④
Redundancy Définit le réglage de la détection

de la fréquence pilote en mode
Redundant.

Éditeur de composants « Redundancy »

⑤

ATT Définit la mise veille ou en
marche, l’assourdissement, la
polarité et l’atténuateur de
l’alimentation.

Éditeur de composants
« Power/ATT/Polarity »

⑥

Polarity Définit la mise veille ou en
marche, l’assourdissement, la
polarité et l’atténuateur de
l’alimentation.

Éditeur de composants
« Power/ATT/Polarity »

⑦
SPEAKER OUT Affiche la tension et le courant

de sortie de la borne de sortie du
haut-parleur.

Éditeur de composants « Speaker Out »

⑧
YDIF IN Envoie le signal audio émis

depuis la borne [YDIF].

-

⑨
YDIF Patch Sélectionne le canal audio YDIF

qui sera envoyé à chaque canal
d’entrée de l’amplificateur.

Éditeur de composants « YDIF Patch »
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18.7.1. Éditeur de composants « Power/ATT/Polarity »
(Alimentation/Atténuation/Polarité)

Ce bouton apparaît lorsque vous double-cliquez sur un composant « Power », « ATT » ou « Polarity ».

• Bouton [STANDBY]/[ON]
Fait basculer l’alimentation entre l’état de veille et de marche.

• Index des canaux
Indique le canal de sortie de la prise du haut-parleur.

• Bouton [MUTE]
Active ou désactive l’assourdissement du canal de sortie.

• Bouton [INVERT]
Inverse la polarité du signal de sortie.

• Attenuator
Permet de définir la valeur de l’atténuateur de sortie du XMV.

• Voyant Redundancy
S’allume lorsque la fonction de redondance bascule l’entrée en analogique.

• Nom du canal
Indique le nom du canal. Vous pouvez le modifier en double-cliquant dessus.
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18.7.2. Éditeur de composants « Redundancy »

Il s’affiche lorsque vous double-cliquez sur le composant « Redundancy ».
Il s’agit de l’éditeur de composants à utiliser si vous souhaitez effectuer des réglages tout en entendant le son
lorsque le mode de redondance est « Backup » (Sauvegarde).

• « REDUNDANT MODE »
Indique l’état du mode de redondance.

• « PILOT TONE DETECTION » (Détection de la fréquence pilote)
Vous pouvez effectuer ici les réglages de détection de la fréquence pilote.

◦ Bouton [Freq.[Hz]]
Spécifie la fréquence centrale de la fréquence pilote.

◦ Bouton [DETECTION THRESHOLD]
Spécifie la valeur seuil du niveau d’entrée de la fréquence pilote. Si une entrée dépasse la valeur
seuil, elle est considérée comme étant la fréquence pilote.

◦ Bouton [DETECTION TIME]
Spécifie le délai de détection de la fréquence pilote. Si la fréquence pilote ne peut pas être détectée
au cours de l’intervalle de temps spécifié, l’entrée est considérée comme interrompue.

• « NOTCH FILTER »
Vous pouvez effectuer ici les réglages du filtre coupe-bande qui empêche la sortie de la fréquence pilote
depuis l’amplificateur.

◦ Bouton [ON]
Lorsque ce bouton est activé, un filtre coupe-bande est activé pour éliminer le composant de
fréquence de la fréquence pilote pour qu’elle ne soit pas émise depuis l’amplificateur.

◦ Bouton [Q]
Spécifie la largeur de la bande de fréquence du filtre coupe-bande.
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18.7.3. Éditeur de composants « Speaker Out » (Sortie de haut-parleur)

Permet d’afficher la tension et le courant de sortie de la prise de sortie du haut-parleur.

• Voyant [AMP PROTECT]
S’allume lorsque la fonction de protection de l’unité XMV est activée.

• Voyant [AMP LIMIT]
S’allume lorsque le limiteur de l’unité XMV est activé.

• Indicateur de niveau [Voltage]
Indique la valeur crête de la tension de sortie.

• Indicateur de niveau [Current]
Indique la valeur crête du courant de sortie.

18. Amplificateurs de puissance : série XMV

366 | ProVisionaire Design V1.2 Guide d’utilisation



18.7.4. Éditeur de composants « YDIF Patch »

Sélectionne le canal audio YDIF qui sera envoyé à chaque canal d’entrée de l’amplificateur.
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19. Interface E/S : Rio3224-D2/Rio1608-D2

19.1. Présentation

Il s’agit d’un rack d’E/S compatible Dante qui peut être utilisé dans les systèmes de mixage. L’entrée provenant
des bornes analogiques peut être convertie en sortie Dante et l’entrée Dante en sortie vers les bornes

analogiques.
Le Rio3224-D2 étant équipé d’une sortie AES/EBU à 8 canaux, il peut également convertir les entrées Dante en
sorties numériques (AES/EBU).

19.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités Rio placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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19.3. Éditeur

Double-cliquez sur un appareil dans la feuille Project pour ouvrir l’éditeur directement.
Le Rio1608-D2 dispose de 16 canaux et le Rio3224-D2 de 32 canaux.

• +48V ACTIVE
Indique si la fonction fantôme de l’appareil est activée ou désactivée.

• Bouton [+48V]
Permet d’activer ou de désactiver l’alimentation fantôme du préampli micro (+48 V). Lorsque la fonction
fantôme de l’appareil est activée, l’activation de ce bouton est possible.

• Bouton [PEAK HOLD]
Lorsque ce bouton est activé, la valeur crête de chaque indicateur de niveau est conservée. Lorsqu’il est
désactivé, les valeurs crêtes conservées sont supprimées.

• Bouton [A.GAIN]
Le gain analogique HA peut être ajusté.

• Valeur du gain / voyant [GC]
L’activation ou la désactivation de la compensation de gain pour la série R (AN/NA) s’affiche. Lorsque la
compensation de gain est sur ON, la valeur du gain fixée par la compensation de gain s’affiche.

• Bouton [HPF]
Lorsque ce bouton est sélectionné, il est possible d’appliquer un filtre passe-haut au signal audio.

• Bouton [Freq.]
La bande de fréquence du filtrage passe-haut peut être ajustée.

19.4. Menu contextuel

Lorsque vous faites un clic droit sur un canal dans l’éditeur, le menu contextuel suivant s’affiche.

Menu Description

Identify L’écran LCD de l’unité principale de l’appareil sélectionné et les voyants
liés au canal clignotent simultanément.
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20. Interface E/S : Tio1608-D / Tio1608-D2

20.1. Présentation

La série Tio est un rack d’E/S compatible Dante avec 16 entrées micro/de ligne et 8 sorties de ligne.
L’utilisation de la série Tio permet d’étendre facilement le système afin de créer un système de boîtiers sur scène
possédant jusqu’à 40 entrées et 24 sorties.

20.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités Tio placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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20.3. Éditeur

Double-cliquez sur un appareil dans la feuille Project pour ouvrir l’éditeur directement.

Les fonctions et la méthode d’utilisation sont identiques à l’éditeur [Rio].
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21. Interface E/S : RSio64-D

21.1. Présentation

Ce rack d’E/S peut être utilisé pour un large éventail d’applications, notamment le son live, la diffusion et
l’enregistrement, et dispose d’une compatibilité de conversion de cartes Dante/Mini-YGDAI maximale de

64 entrées/64 sorties.
L’unité RSio64-D est une interface audio qui peut convertir les formats Dante et Mini-YGDAI pour jusqu’à
64 entrées et 64 sorties.

21.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités RSio placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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21.3. Éditeur

Double-cliquez sur un appareil dans la feuille Project pour ouvrir l’éditeur directement.

• [CARD NAME] (Nom de la carte)

Niveau supérieur

Sélectionnez la carte que vous souhaitez installer sur l’appareil.

La boîte de dialogue « Select Card » (Sélectionner la carte) s’ouvre lorsque vous cliquez dessus.

Niveau inférieur
Indique la carte installée sur l’appareil.

• IN/OUT PORT
Indique le nombre de ports d’entrée et de sortie des cartes installées dans les logements 1 à 4. Si aucune
carte n’est installée, la mention « -- » s’affichera.

• Voyants [LOCK]
Ces voyants indiquent le statut des horloges de mots des logements 1 à 4. Si l’horloge de mots
fonctionne normalement, le voyant correspondant s’allumera en vert.

Éteint Aucune carte n’est installée dans le logement ou la carte
installée n’est pas prise en charge.

Vert

(allumé)
LOCK
(Verrouiller)

Indique qu’une horloge synchronisée avec la source de l’horloge
sélectionnée par la touche de sélection WORD CLOCK est

transmise depuis la carte.
Si un appareil externe est connecté au logement correspondant,
l’entrée et la sortie s’effectueront correctement entre cet

appareil et l’interface RSio64-D.
Si la fréquence d’échantillonnage est similaire, ce statut peut
apparaître même en l’absence de synchronisation.

Vert

(clignotant)
SYNC
ERROR
(Erreur de
synchronis
ation)

Une horloge valide est transmise depuis la carte, mais elle n’est
pas synchronisée avec la source de l’horloge sélectionnée par la
touche de sélection WORD CLOCK. Si un appareil externe est
connecté au logement correspondant, l’entrée et la sortie
s’effectueront correctement entre cet appareil et l’interface
RSio64-D. L’entrée et la sortie s’effectueront correctement si le
paramètre SRC est défini sur ON.
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Rouge

(allumé)
UNLOCK
(Déverrouill
er)

Aucune horloge valide n’est émise depuis la carte. Si un appareil
externe est connecté au logement correspondant, l’entrée et la
sortie ne pourront pas s’effectuer correctement entre cet
appareil et l’interface RSio64-D.

Rouge

(clignotant)
WRONG
WORD
CLOCK
(Horloge de
mots
erronée)

La fréquence de la source de l’horloge sélectionnée par la
touche de sélection WORD CLOCK est en dehors de la plage de
fréquences de fonctionnement de la carte installée dans le
logement. Réglez la fréquence de la source de l’horloge pour
qu’elle corresponde à la plage de fonctionnement de la carte, ou
activez le paramètre SRC. Si la carte est analogique, l’activation
du paramètre SRC la fait fonctionner à la fréquence interne de
l’interface RSio64-D, soit 48 kHz.

• Voyants [SRC]
Ces voyants indiquent l’état du SRC (Convertisseur du taux d’échantillonnage) des logements 1 à 4.

Éteint Le paramètre SRC est désactivé.

Vert
(allumé)

Le paramètre SRC est activé et l’horloge sélectionnée par le
commutateur SRC WCLK DIP est correctement émise en entrée.

Rouge
(allumé)

Le paramètre SRC est activé, mais aucune horloge valide n’est
émise. L’horloge sélectionnée par le commutateur SRC WCLK
DIP n’est peut-être pas transmise ou est en dehors de la plage
de fonctionnement. Désactivez le paramètre SRC ou modifiez
les réglages du commutateur DIP.

• Bouton [SRC]
Ces boutons activent ou désactivent le SRC de l’entrée ou de la sortie du logement correspondant.

• Source WORD CLOCK
Indique l’état de la source de l’horloge de mots du SRC pour les logements 1 à 4 de l’interface RSio64-D.

[SLOT] Lors de l’utilisation du signal de l’horloge de mots émis depuis la
carte dans le logement.

[WCLK IN] Lors de l’utilisation du signal de l’horloge de mots provenant du
connecteur WORD CLOCK IN sur le panneau arrière.

[CARD] Lorsque la fonction SRC de la carte est activée.

[---] Si aucune carte n’est insérée dans le logement.

• Bouton de sélection [WORD CLOCK]
Permet de sélectionner la source de l’horloge de mots du RSio64-D.

WCLK IN Ce voyant s’allume lorsque l’interface RSio64-D utilise l’horloge
de mots transmise par le connecteur [WORD CLOCK IN] du
panneau arrière. Ce voyant clignote si aucune entrée d’horloge
de mots valide n’est détectée*1.
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SLOT1 1/2 Ce voyant s’allume lors de l’utilisation de l’horloge de mots des
canaux 1/2 du logement 1. Ce voyant clignote en l’absence
d’entrée d’horloge de mots valide*1. L’horloge de mots des
canaux 7/8 est utilisée lors de l’utilisation de la MY8-AEB*2. Si le
SRC de la MY8-AE96S est utilisé, vous ne pourrez pas utiliser le
signal d’entrée comme horloge de mots.

DANTE Ce voyant s’allume en cas d’utilisation de l’horloge de mots*3 du
réseau Dante. (En l’absence de réception d’un signal Dante
valide, c’est l’horloge générée par le module Dante interne qui
est utilisée.)

*1 Lorsque ce voyant clignote, l’unité utilise l’horloge de mots Dante pour effectuer des entrées et des sorties.

*2 Pour utiliser une carte MY8-AEB, réglez le commutateur AE ⇔ RSVD sur la position RSVD.
*3 Si vous souhaitez changer la fréquence de l’horloge de mots Dante, utilisez Dante Controller.

• Bouton [CURRENT PATTERN] (Motif actuel)
Affiche le motif d’acheminement actuellement sélectionné sur l’écran RSio64-D. Lorsque vous cliquez sur
le bouton, les détails du motif d’acheminement s’affichent.

• Bouton [Patch]

Lorsque vous cliquez sur ce bouton, la fenêtre d’édition s’ouvre.
Permet de modifier l’assignation à appliquer lorsque 0 (User Pattern) (Motif utilisateur) est sélectionné
sur le commutateur rotatif utilisé pour sélectionner le motif d’acheminement sur l’unité principale.
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• Boutons [User PATTERN] / [Pattern(View Only)] (Motif (Affichage uniquement))

Lorsque User Pattern est sélectionné, l’assignation peut être modifiée.
Lorsque Pattern (View Only) est sélectionné, sept types de modèles sont appelés. Ils ne peuvent pas être

modifiés.
Lorsque vous cliquez sur le bouton [Paste to #0] (Coller vers #0) alors que Pattern (View Only) est

sélectionné, le modèle est collé dans User Pattern.
Lors de la modification, utilisez le modèle comme base.

◦ Bouton [CLEAR]
Lorsque vous cliquez sur ce bouton alors que User Pattern est sélectionné, toutes les assignations
sont effacées.
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22. Haut-parleurs amplifiés : VXL1-16P

22.1. Présentation

Ce produit est un haut-parleur amplifié Dante alimenté via PoE.

22.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités VXL1-16P placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.


Lorsque le commutateur DIP de l’unité principale de l’appareil est réglé sur « RESERVED »
(Réservé), l’ID d’unité de l’appareil peut être réglé sur une valeur autre que 101 à 115
(hexadécimal : 65 à 73) à l’aide du bouton Unit ID de la zone « Network » de la feuille Project.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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22.3. Configuration de l’écran de la feuille d’appareil

À l’ouverture de la feuille d’appareil du XL1-16P, la feuille d’appareil et la « vue Bird’s Eye » s’affichent.
Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.

① Vue Bird’s Eye
Affiche une vue d’ensemble de la feuille.
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22.4. Éditeurs de composants

Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.
Cette section décrit l’éditeur de composants de VXL1-16P, ainsi que les boîtes de dialogue et les fenêtres
associées aux composants. Pour plus de détails sur les autres composants, reportez-vous au « ProVisionaire
Design DME7 Component Guide ».

Numér
o

Nom du composant Description Lien

①
Dante In Affiche le niveau du signal audio

des 2 canaux d’entrée depuis la
borne [Dante] ) et règle le gain.

---

②
Compressor Règle le compresseur qui agit sur

la plage dynamique.
« ProVisionaire Design DME7 Component
Guide »

③

Enhancer (Accentuation) Active ou désactive
l’accentuation. Il s’agit d’un
processus qui mixe les sons au-
delà du ton fondamental des
basses fréquences et des hautes
fréquences qui ne sont pas
produites par les haut-parleurs
afin de les faire retentir comme
si des sons hautes et basses
fréquences étaient produits.

---

④
Fader Ajuste le niveau du signal du

canal d’entrée.
---

⑤
3 Band EQ (Égaliseur à
3 bandes)

Ajuste l’égaliseur à 3 bandes du
canal d’entrée.

« ProVisionaire Design DME7 Component
Guide »

⑥

Oscillator Produit une onde sinusoïdale
utilisée pour vérifier le
fonctionnement des haut-
parleurs connectés et les
caractéristiques acoustiques de
la salle.

---

⑦
Noise Gate (Suppression
des bruits)

Définit la suppression des bruits. ---

⑧
Ducker w/NG (Ducker
avec suppression des
bruits)

Définit le ducker et la
suppression des bruits.

« ProVisionaire Design DME7 Component
Guide »
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Numér
o

Nom du composant Description Lien

⑨
Matrix Affecte les canaux d’entrée et les

sorties d’oscillateur aux canaux
de sortie.

« ProVisionaire Design DME7 Component
Guide »

⑩
10 Band EQ Ajuste l’égaliseur à 10 bandes du

canal de sortie.
« ProVisionaire Design DME7 Component
Guide »

⑪
Delay Définit le retard du canal de

sortie.
« ProVisionaire Design DME7 Component
Guide »

⑫ Main Fader Règle le niveau de sortie. ---

⑬
Analog Out Produit le signal de sortie

analogique vers le composant de
l’amplificateur.

---
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23. Microphones : PGM1

23.1. Présentation

Il s’agit d’un microphone de radiomessagerie à utiliser avec la série MRX7-D/MTX5-D.
Il est possible de créer un système de radiomessagerie à l’aide de l’unité PGM1.



Dans la mesure où réglages du PGM1 sont stockés par le MRX7-D/MTX5-D, il n’est pas

nécessaire que ProVisionaire Design découvre le PGM1.
Lors de la modification de l’adresse IP via ProVisionaire Design, installez Bonjour Print
Service afin de permettre à ProVisionaire Design de découvrir l’unité PGM1.

23.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités PGM1 placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.

Après avoir ajouté l’unité PGM1 au projet, sélectionnez l’unité PGM1 à utiliser par chaque appareil.
Vous pouvez connecter l’équipement et l’unité PGM1 depuis la zone « Properties » > PGM1 sur la feuille Project.

Les réglages de l’unité PGM1 doivent être spécifiés à l’aide de l’éditeur du composant Paging sur chaque feuille

d’appareil.
Pour le MTX5-D, ce composant est lancé à partir de « Paging » dans le composant Zone qui s’affiche dans la
feuille d’appareil.
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Pour consulter des exemples de systèmes, reportez-vous au « Manuel de configuration du MTX ».

23.3. Zone « Properties »

• Utilities

◦ Unlatch Enable (Autoriser le déverrouillage)
Lorsque cette fonction est sur ON, le bouton PTT permet à la fois de verrouiller et déverrouiller.
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24. Microphones : RM-CG

24.1. Présentation

Il s’agit d’un microphone de plafond à configuration fixe.

 Pour contrôler le « RM-CG », vous devez définir un mot de passe initial et vous connecter.

24.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités RM-CG placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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24.3. Menu [System]

Les réglages sont effectués dans RM Series Settings (Réglages de la série RM), qui s’affichent à partir du menu
[System] de la barre de menus.

• RM Series Settings

◦ Sign Up
Permet de définir le mot de passe initial.

◦ Login
Permet de saisir le mot de passe pour pouvoir contrôler l’appareil avec ProVisionaire Design.

◦ Password Settings
Permet de modifier le mot de passe de l’appareil.

◦ Enable SCP remote control access
Activez cette fonction pour contrôler les appareils à l’aide de ProVisionaire Design ou d’une
commande à distance.


Lorsque ProVisionaire Design et les appareils sont en ligne, la fonction « Enable SCP remote

control access » est automatiquement activée.
Une fois le réglage des appareils terminé, réinitialisez-les si besoin.

24.4. Zone « Network »

Pour contrôler le « RM-CG », vous devez définir un mot de passe initial et vous identifier.

Faites un clic droit sur RM-CG dans la zone Network et sélectionnez Sign Up/Login.
Il est aussi possible de le faire dans RM Series Settings, que vous trouverez dans le menu [System] de la barre de
menus.
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
Tant que vous n’êtes pas connecté, vous ne pouvez pas configurer les réglages à l’aide de
ProVisionaire Design.

24.5. Zone « Properties »

Pour plus de détails, reportez-vous au « Manuel de référence du RM-CG ».
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24.6. Configuration de l’écran de la feuille d’appareil

À l’ouverture de la feuille d’appareil du RM-CG, la feuille d’appareil et la « vue Bird’s Eye » s’affichent.
Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.

① Boutons d’outils
Vous trouverez ici les commandes fréquemment utilisées, présentées sous forme de boutons.

② Vue Bird’s Eye
Affiche une vue d’ensemble de la feuille.

24.7. Boutons d’outils

Vous trouverez ici les commandes fréquemment utilisées, présentées sous forme de boutons.

Bouton Commande Description

Assourdissement micro Assourdit le microphone.
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24.8. Éditeurs de composants

Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.
Cette section décrit l’éditeur de composants du RM-CG, ainsi que les boîtes de dialogue et les fenêtres associées
aux composants.

Numér
o

Nom du composant Description Lien

①
Microphone Settings Ajuste la vitesse et la plage de

suivi, ainsi que les réglages de
l’automixeur.

Éditeur de composants « Microphone
Settings »

②
Reference Signal for
AEC (Signal de référence
pour l’AEC)

Affiche le niveau du signal de
référence de la compensation
d’écho adaptative.

---

③

DSP Settings Spécifie les différents réglages
du DSP, tels que la compensation
d’écho adaptative et la réduction
du bruit.

Éditeur de composants « DSP Settings »

④
6Band EQ Ajuste l’égaliseur à 6 bandes. « ProVisionaire Design DME7 Component

Guide »

⑤
Mute Settings (Réglages
de l’assourdissement)

Établit la liaison avec
l’assourdissement de micro pour
chaque canal.

Éditeur de composants « Mute Settings »

⑥ Fader Ajuste le niveau du signal audio. ---

⑦
Router Modifie les affectations des

canaux d’entrée en canaux de
sortie.

---

⑧ Dante Out (Sortie Dante) --- ---
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24.8.1. Éditeur de composants « Microphone Settings »

Vous pouvez vérifier et ajuster la vitesse et la plage de suivi.
Vous pouvez également vérifier et modifier les réglages de l’auto-mixeur.

• Beam Tracking Speed (Vitesse de suivi du faisceau)
Définissez la vitesse à laquelle le faisceau suit le locuteur.

◦ Slow (Lent)
Ce réglage permet d’augmenter la stabilité des changements de volume, mais ralentit le suivi du
locuteur. Sélectionnez ce mode lorsque le volume change fréquemment, comme dans une pièce où
la durée de réverbération est longue.

◦ Fast (Rapide)
Réglage par défaut. Garantit l’équilibre entre la stabilité des changements de volume et le suivi du
locuteur.

• Auto mixing (Mixage automatique)
Définissez le type de mixage audio automatique des faisceaux d’entrée du microphone.

◦ 1Ch.Gating (Gating via 1 canal)
Sélectionnez ce réglage pour le mode faisceau unique. Cela permet d’obtenir une netteté
supérieure mais une variation de volume plus importante pour un petit groupe de locuteurs dans
une pièce réverbérante avec des durées de réverbération longues.

◦ 2Ch.GainSharing (Partage de gain via 2 canaux)
Réglage par défaut. Sélectionnez ce réglage pour le partage du gain de deux faisceaux. Garantit
l’équilibre la netteté et les variations de volume.

◦ 4Ch.GainSharing
Sélectionnez ce réglage pour le partage du gain de quatre faisceaux. Ce mode offre une variation
de volume moindre ainsi qu’une clarté du son moins bonne pour un son plus naturel, avec de
nombreux locuteurs dans une pièce à l’acoustique bonne et aux durées de réverbération courtes.

◦ All Mix (Mixer tout)
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Sélectionnez ce mode pour le mixage de quatre faisceaux. Ce mode offre une variation de volume
moindre ainsi qu’une clarté du son moins bonne, produisant le son le plus naturel possible, avec de
nombreux locuteurs dans une pièce à l’acoustique bonne et peu réverbérante.



Le signal de sortie du canal 1 utilise tous les traitements de signaux et est optimisé pour les

conférences audio.
Le signal de sortie du canal 2 est optimisé pour des applications nécessitant un traitement
linéaire des signaux ou une faible latence.

• Tracking area (Zone de suivi)

Vous pouvez limiter la plage de suivi à une étendue de +4 m (13,1 pieds).
Ce paramètre sert à séparer les zones de suivi dans un environnement utilisant plusieurs unités RM-CG,
ou à limiter le périmètre d’une seule unité RM-CG.

• Focus areas (Zones de focus)
Il est possible de définir jusqu’à 2 zones de focus, ce qui permet au microphone de plafond de capter plus

clairement la parole dans une zone définie, même à un faible volume.

Ce réglage peut être utilisé seul ou en plus du réglage de « Tracking Area ».
Notez que si la [Focus Area] chevauche une [Exclusion Area], la [Exclusion Area] est prioritaire et le suivi
des voix au sein de la zone de chevauchement est interdit.

• Exclusion areas (Zones d’exclusion)
Ce réglage permet de spécifier des zones où les sources sonores sont exclues, par exemple s’il s’agit de
zones où sont installés des projecteurs, des climatiseurs, ou d’autres sources de bruits non souhaités

comme une machine à café.

Pour empêcher le suivi de faisceaux, il est possible de définir un maximum de deux [Exclusion Areas].

Ce réglage peut être utilisé indépendamment du réglage de [Tracking Area].
Notez que si la [Exclusion Area] chevauche une [Focus Area], la [Exclusion Area] est prioritaire et le suivi
des voix au sein de la zone de chevauchement est interdit.

• Bouton Detail
Lorsque vous cliquez sur ce bouton, un écran s’affiche pour vous permettre de saisir des valeurs
numériques pour les réglages de la zone.
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24.8.2. Éditeur de composants « DSP Settings »

Vous pouvez également vérifier et modifier les réglages suivants.

• Input Gain (Gain d’entrée)
Permet de régler le gain d’entrée.

• Adaptive echo canceller (Compensation d’écho adaptative)
Sélectionne l’intensité de la fonction de compensation d’écho.

◦ Off :
Sélectionnez ce réglage pour désactiver la fonction de compensation d’écho interne lorsque vous
utilisez une fonction de compensation d’écho externe, comme celle d’une application de
conférence ou d’un appareil externe.

◦ Low (Faible) :
Sélectionnez ce réglage pour conserver, autant que possible, le son d’origine tout en supprimant
l’écho acoustique.

◦ Medium (Moyen) :
Réglage par défaut. Garantit l’équilibre entre l’intensité de la fonction d’annulation de l’écho et la
qualité du son.

◦ High (Élevé) :
Sélectionnez ce réglage pour les pièces à l’acoustique mauvaise, au niveau d’écho élevé et aux
durées de réverbération longues.

• Noise reduction
Sélectionnez l’intensité de la fonction de réduction du bruit comparativement au bruit ambiant permanent.

◦ Off :
Sélectionnez ce réglage pour désactiver la fonction de suppression du bruit interne lorsque vous
utilisez une fonction de suppression du bruit externe, comme celle d’une application de conférence
ou d’un appareil externe.

◦ Low :
Sélectionnez ce réglage pour une suppression minimale du bruit ambiant tout en conservant,
autant que possible, le son d’origine. Ce réglage produit un son d’ambiance naturel, en quantité
supérieure à celle de bruit supprimée.

◦ Medium :
Réglage par défaut. Garantit l’équilibre entre les effets de suppression du bruit et la qualité du son.

◦ High :
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Sélectionnez ce réglage pour obtenir une réduction maximale du bruit ambiant dans les pièces où il
est élevé (ventilateurs bruyants ou systèmes CVC).

• Dereverberation (Suppression de la réverbération)
Sélectionnez l’intensité de la fonction de suppression de la réverbération.

◦ Off :
Aucune suppression de la réverbération. Permet de traiter les signaux externes d’une application
de conférence ou d’un DSP externe.

◦ Low :
Sélectionnez ce réglage pour une suppression minimale de la réverbération dans les pièces à
l’acoustique bonne et aux durées de réverbération courtes.

◦ Medium :
Réglage par défaut utilisé dans la plupart des pièces ; garantit l’équilibre entre la suppression de la
réverbération et la qualité du son.

◦ High :
Sélectionnez ce mode pour une suppression maximale de la réverbération dans les pièces à
l’acoustique mauvaise et aux durées de réverbération longues. (murs en verre et autres surfaces
réfléchissantes, par exemple)

• AGC type (Type d’AGC)
Réglez l’intensité de la fonction de contrôle de gain automatique de manière à réduire les fluctuations du
niveau de voix, qui est envoyé aux auditeurs distants en ligne.

◦ Off
Sélectionnez ce réglage pour désactiver l’ajustement automatique du volume ou pour utiliser un
autre dispositif de contrôle de gain automatique, comme celui d’une application de conférence ou
d’un appareil externe.

◦ Low
Réglage par défaut. Produit un niveau sonore naturel. Si le volume d’entrée du locuteur est faible, il
restera faible. S’il est trop élevé, le volume du locuteur est atténué.

◦ High
Sélectionnez ce réglage pour compenser les fortes variations de volume des locuteurs. Ce réglage
permet d’augmenter le niveau de volume des locuteurs parlant à voix basse dans la pièce et
d’atténuer la sortie de volume si elle est trop élevée.

• AGC speed (Vitesse d’AGC)
Réglez la vitesse du changement de volume de la fonction de contrôle de gain automatique.

◦ Low :
Réglage par défaut ; garantit l’équilibre entre le changement de volume et l’effet.

◦ High :
Sélectionnez ce réglage pour une compensation du niveau du volume plus rapide.

• Enable Low latency mode (Activer le mode de faible latence)
Sélectionnez cette option pour les applications qui nécessitent des retards audio courts, telles que les

ascenseurs à reconnaissance vocale.
Tout traitement du signal sur le canal 2 (sortie inférieure du composant DSP Settings) est désactivé.
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24.8.3. Éditeur de composants « Mute Settings »

Permet de définir si l’état d’assourdissement est indiqué par le voyant d’état sur l’unité principale RM-CG/RM-TT.

• Bouton ON
Si ce bouton est sur ON, l’assourdissement est activé quand l’unité principale est assourdie.

• Bouton MUTE
Ce bouton permet d’assourdir chaque canal.
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25. Microphones : RM-TT

25.1. Présentation

Il s’agit d’un microphone de table à configuration fixe.

 Pour contrôler le « RM-TT », vous devez définir un mot de passe initial et vous connecter.

25.2. Feuille « Project »

Lorsque vous placez des appareils, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre d’unités RM-TT placées sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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25.3. Menu [System]

Les réglages sont effectués dans RM Series Settings, qui s’affichent à partir du menu [System] de la barre de
menus.

• RM Series Settings

◦ Sign Up
Permet de définir le mot de passe initial.

◦ Login
Permet de saisir le mot de passe pour pouvoir contrôler l’appareil avec ProVisionaire Design.

◦ Password Settings
Permet de modifier le mot de passe de l’appareil.

◦ Enable SCP remote control access
Activez cette fonction pour contrôler les appareils à l’aide de ProVisionaire Design ou d’une
commande à distance.


Lorsque ProVisionaire Design et les appareils sont en ligne, la fonction « Enable SCP remote

control access » est automatiquement activée.
Une fois le réglage des appareils terminé, réinitialisez-les si besoin.

25.4. Zone « Network »

Pour contrôler le « RM-TT », vous devez définir un mot de passe initial et vous identifier.

Faites un clic droit sur RM-TT dans la zone Network et sélectionnez Sign Up/Login.
Il est aussi possible de le faire dans RM Series Settings, que vous trouverez dans le menu [System] de la barre de
menus.
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
Tant que vous n’êtes pas connecté, vous ne pouvez pas configurer les réglages à l’aide de
ProVisionaire Design.

25.5. Zone « Properties »

Pour plus de détails, reportez-vous au « Manuel de Référence RM-TT ».
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25.6. Configuration de l’écran de la feuille d’appareil

À l’ouverture de la feuille d’appareil du RM-TT, la feuille Device et la « vue Bird’s Eye » s’affichent.
Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.

① Boutons d’outils
Vous trouverez ici les commandes fréquemment utilisées, présentées sous forme de boutons.

② Vue Bird’s Eye
Affiche une vue d’ensemble de la feuille.

25.7. Boutons d’outils

Vous trouverez ici les commandes fréquemment utilisées, présentées sous forme de boutons.

Bouton Commande Description

Assourdissement micro Assourdit le microphone.
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25.8. Éditeurs de composants

Lorsque vous double-cliquez sur un composant dans la feuille d’appareil, l’éditeur de composants s’ouvre.
Cette section décrit l’éditeur de composants de RM-TT, ainsi que les boîtes de dialogue et les fenêtres associées
aux composants.

Numér
o

Nom du composant Description Lien

①
Microphone Settings Règle le fonctionnement du

bouton d’assourdissement et la
directivité du microphone.

Éditeur de composants « Microphone
Settings »

②
Reference Signal for
AEC

Affiche le niveau du signal de
référence de la compensation
d’écho adaptative.

---

③

DSP Settings Spécifie les différents réglages
du DSP, tels que la compensation
d’écho adaptative et la réduction
du bruit.

Éditeur de composants « DSP Settings »

④
6Band EQ Ajuste l’égaliseur à 6 bandes. « ProVisionaire Design DME7 Component

Guide »

⑤

Mute Settings Définit si l’état
d’assourdissement s’affiche ou
non sur le voyant en haut de
l’écran.

Éditeur de composants « Mute Settings »

⑥ Fader Ajuste le niveau du signal audio. ---

⑦
Router Modifie les affectations des

canaux d’entrée en canaux de
sortie.

---

⑧ Dante Out --- ---
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25.8.1. Éditeur de composants « Microphone Settings »

Vous pouvez vérifier et ajuster la vitesse et la plage de suivi.
Vous pouvez également vérifier et modifier les réglages de l’auto-mixeur.

• Mute Button Behavior (Comportement du bouton d’assourdissement)

◦ Toggle (Basculer)
Appuyez sur le bouton d’assourdissement pour activer et désactiver la fonction
d’assourdissement.

◦ Push to talk (Appuyer pour parler)
Maintenez ce bouton enfoncé pour désactiver l’assourdissement du microphone.

◦ Disable (Désactiver)
Le bouton d’assourdissement de l’appareil est désactivé et l’état d’assourdissement ne peut être
modifié qu’en externe (contrôleur ou microphone différent d’un même groupe).

• Directivity (Directivité)
Permet de définir la directivité du microphone.

◦ Auto voice tracking (Suivi automatique des voix)
Il s’agit du réglage appliqué par défaut. Sélectionnez ce réglage pour activer le mode de suivi
automatique. Le microphone se concentre automatiquement sur la voix de la personne qui parle.

◦ Omnidirectional (Omnidirectionnel)
Avec ce réglage, tous les éléments du microphone sont toujours actifs. Les données audio sont
captées dans la zone au-dessus du microphone. Ce réglage permet également de capter plusieurs
voix simultanément. Il ne doit être sélectionné qu’en cas d’utilisation dans des pièces silencieuses,
sans réverbérations et aux bonnes conditions acoustiques.

◦ Cardioid (Cardioïde)
Ce réglage permet de sélectionner la direction d’un maximum de 4 motifs de captation cardioïde
actifs. Sélectionnez ce réglage si l’emplacement des participants est toujours le même par rapport
au microphone. Le mode Cardioid nécessite qu’une stratégie de mixage automatique soit
sélectionnée.

◦ Supercardioid (Supercardioïde)
Identique au mode Cardioid, mais la directivité du motif de captation est plus étroite.

◦ Hypercardioid (Hypercardioïde)
Identique aux modes Cardioid et Supercadioid, mais le motif de captation est plus étroit.

25. Microphones : RM-TT

398 | ProVisionaire Design V1.2 Guide d’utilisation



◦ Toroid (Toroïde)
Sélectionnez ce réglage dans les environnements où des sources de bruit se trouvent au-dessus du
microphone. La captation des données audio est limitée à la direction verticale ; le microphone se
concentre sur les sources de voix se trouvant sur un axe horizontal par rapport à lui.

◦ Bidirectional (Bidirectionnel)
Sélectionnez ce réglage pour couvrir les voix de deux locuteurs positionnés en face (180°) l’un de
l’autre.

Lorsque la directivité du microphone est définie sur « Cardioid », « Supercardioid » ou « Hypercardioid », les
réglages de l’auto-mixeur peuvent être vérifiés/modifiés.

• Enable mic channel (Activer le canal du micro)
Permet d’activer ou désactiver le microphone associé au CH sélectionné dans la zone Directivity.

• Direction [deg]
Permet de définir et de modifier l’angle acoustique du microphone associé au CH sélectionné dans la
zone Directivity (Directivité).

• Auto mixing

◦ 1Ch. Gating
Sélectionnez ce réglage pour permettre à un seul canal d’entrée d’être actif à la fois. Ce réglage
permet d’optimiser la clarté de la voix du locuteur actif, mais avec une variation de volume plus
importante. Utilisez ce réglage lorsque plusieurs locuteurs participent à la réunion ou dans des
pièces réverbérantes.

◦ 2Ch. Gating
Réglage par défaut. Sélectionnez ce réglage pour mixer automatiquement jusqu’à deux
microphones via le partage de gain. Ce réglage garantit l’équilibre entre la clarté du son et la
variation du volume.

◦ 4Ch. Gating
Sélectionnez ce réglage pour permettre le mixage des quatre canaux via le partage de gain. Ce
mode améliore l’expérience en matière de variation du volume, mais avec une clarté du son moins
élevée. Ce réglage est recommandé pour les environnements regroupant plusieurs participants
actifs dans une discussion. Utilisez ce réglage uniquement dans une pièce ou l’acoustique est
bonne et ou les durées de réverbération sont courtes.

◦ All Mix
Sélectionnez ce mode pour mixer les quatre canaux sans partage de gain. Les variations du
volume risquent d’être plus importantes, mais le son sera plus naturel avec un grand nombre de
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locuteurs. Utilisez ce réglage uniquement dans une pièce ou l’acoustique est bonne et ou les
durées de réverbération sont courtes.

Pour plus de détails sur les composants autres que l’éditeur de composants « Microphone Settings », reportez-
vous au « RM-CG ».
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26. Appareil externe : haut-parleurs

26.1. Présentation

Pour les haut-parleurs placés sur la feuille Project, il est possible d’ouvrir le processeur de haut-parleur de
l’amplificateur PC-D en le connectant à une unité de la série PC ou à un autre amplificateur.

26.2. Feuille « Project »

Lorsque vous placez les haut-parleurs, l’écran Settings s’affiche comme illustré ci-dessous.

• Number of Devices
Sélectionne le nombre de haut-parleurs placés sur la feuille.

• Cases d’option [4way/3way/2way/1way] (4 voies/3 voies/2 voies/1 voie)
Permet de sélectionner la configuration du haut-parleur.
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26.3. Zone « Properties »

Permet d’afficher et de modifier les informations du haut-parleur.

• Model

Lorsque vous cliquez sur ce champ, le bouton  s’affiche.
Lorsque vous cliquez sur le bouton , la boîte de dialogue s’affiche et le type de haut-parleur sélectionné
peut être modifié.

• Label
N’importe quelle chaîne de caractères peut être affichée ou modifiée pour le haut-parleur.
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26.4. Boîte de dialogue « Recall Speaker Preset(s) » (Rappeler les
présélections du haut-parleur)

Vous pouvez modifier ici la bibliothèque de haut-parleurs.
Cette boîte de dialogue apparaît lorsque vous cliquez avec le bouton droit sur un haut-parleur connecté à un
appareil de la série PC et sélectionnez [Recall Speaker Preset(s)] (Rappeler les présélections du haut-parleur).

• Library
Indique, pour chaque connecteur, l’élément de bibliothèque spécifié. L’élément de bibliothèque par défaut
s’affiche immédiatement après l’ouverture de la boîte de dialogue.

• Bouton [LIST]
Sélectionne et affiche les éléments de la bibliothèque.

• Bouton [OK]
Spécifie un élément de bibliothèque et ferme la boîte de dialogue.

• Bouton [Cancel]
Ferme la boîte de dialogue sans spécifier d’élément de la bibliothèque.
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27. DCP

27.1. Présentation

Les paramètres du DME7/MRX7-D/MTX5-D/MTX3 peuvent être attribués aux opérateurs d’un panneau de
commande numérique (DCP) tel que le DCP1V4S et contrôlés depuis celui-ci. Il est en outre possible de régler la
luminosité des DEL de l’unité DCP, ainsi qu’un verrouillage de panneau. Les réglages ne peuvent pas être
effectués dans l’état en ligne (ils peuvent uniquement être cochés).

27.2. Sélectionner le DCP à connecter

Sélectionnez d’abord DME7/MRX7-D/MTX5-D/MTX3 dans la feuille Project, puis sélectionnez le DCP pour la
zone Properties.

Utilisez ensuite l’écran ci-dessous pour sélectionner le DCP connecté au port DCP.
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Une fois le DCP sélectionné, un module est ajouté pour les réglages DCP de chaque appareil sur la feuille

« Project ».
Cliquez sur le module de réglage DCP pour indiquer les réglages voulus.

Le composant DCP est automatiquement ajouté à la feuille d’appareil. Double-cliquez sur un composant pour
ouvrir l’éditeur de composants.

■ Pour le DME7/MRX7-D

■ Pour la série MTX
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27.3. Méthode de réglage pour DME7

Un composant DCP peut être ajouté à un jeu de paramètres comme n’importe quel autre composant audio et
stocker/rappeler sa valeur actuelle dans un instantané.

■ Comment enregistrer dans un jeu de paramètres
L’enregistrement des paramètres dans un jeu de paramètres s’effectue de plusieurs manières, décrites ci-
dessous.

Source d’enregistrement Méthode d’enregistrement

Feuille d’appareil Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
composant DCP et déposez-le sur le jeu de paramètres dans la
zone « Parameter Sets ».

Sélectionnez « Add to Parameter Set » dans le menu contextuel.

27.3.1. Réglage du composant DCP

Cliquez sur le composant DCP dans la couche Audio et spécifiez les différents réglages.

• Bouton [Clear All]
Permet de supprimer le contenu qui a été réglé.

27.3.2. Onglet [Parameter Assign] (Affectation de paramètres)

La boîte de dialogue de réglages permettant de spécifier les réglages de chaque opérateur s’affiche lorsque
l’icône « No. » de l’opérateur (commutateur ou bouton) que vous souhaitez régler est sélectionnée. Affectez les
paramètres du DME7 à chaque opérateur dans la boîte de dialogue.
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27.3.2.1. Composant DCP : boîte de dialogue « Settings » (Switch)

Cliquez sur l’icône No. de l’éditeur de composants DCP pour l’ouvrir.

• Bouton [OK]
Enregistre les réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Permet de fermer la boîte de dialogue sans enregistrer les modifications.

Function

• [No Assign]
La fonction n’est pas affectée.

• [SD Play]
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◦ SD Song Select & Play

Permet de lire le fichier spécifié dans la liste [Parameter1].
Pour les réglages des fichiers de la carte SD, reportez-vous à la boîte de dialogue « SD Card File
Manager ».

◦ SD Song Pause
Permet de mettre en pause la lecture du fichier.
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• [Snapshot Recall]

Permet de rappeler l’instantané.
L’enregistrement de l’instantané s’effectue de plusieurs manières, comme suit :

Source d’enregistrement Méthode d’enregistrement

Zone « Parameter Sets » Faites glisser l’instantané et déposez-le dans la zone
verte de la boîte de dialogue « Settings ».

• [Parameter]

Permet d’actionner les paramètres à l’aide de commutateurs.
L’enregistrement des paramètres s’effectue de plusieurs manières, comme suit :

Source d’enregistrement Méthode d’enregistrement

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites
glisser un paramètre et déposez-le dans la zone verte
de la boîte de dialogue « Settings ».

Zone « Parameters » Faites glisser un paramètre et déposez-le dans la zone
verte de la boîte de dialogue « Settings ».

L’exemple ci-dessous illustre l’affectation d’un paramètre qui change continuellement.

• Zone de liste [Control Type] (Type de commande)
Si Parameter Value Edit est sélectionné

◦ [Inc] (Augmenter)

Le paramètre est ajouté chaque fois que vous appuyez sur le commutateur.

Vous pouvez définir la plage mobile à l’aide de Minimum/Upper Limit.
Cliquez sur Minimum/Upper Limit pour afficher les commandes.

◦ [Dec] (Diminuer)

Permet de soustraire le paramètre chaque fois que vous appuyez sur le commutateur.

Vous pouvez définir la limite inférieure avec Lower Limit.
Cliquez sur Lower Limit pour afficher les commandes.

▪ Case à cocher [Mute Enable] (Activer l’assourdissement)
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Si cette option est sélectionnée, l’état « Mute » (En sourdine) (–∞ dB) est activé lorsque le
niveau passe sous la valeur spécifiée par [Lower Limit].

◦ Zone de liste [Sensitivity] (Sensibilité)
Permet de définir la sensibilité des changements de paramètres en réponse à un réglage à la
baisse du commutateur DCP.

• Zone de liste [Control Type]

Si Direct Parameter Value est sélectionné
Lorsque vous appuyez sur le commutateur, le paramètre devient la valeur spécifiée par Value.

• Zone de liste [Control Type]

Si Knob Assign (Affectation des boutons) est sélectionné
Lorsque vous appuyez sur le commutateur, vous pouvez utiliser le bouton pour contrôler le paramètre

affecté au commutateur.

Cette fonction ne s’applique qu’au DCP1V4S.
Pour plus de réglages, reportez-vous à la section consacrée aux boutons.
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27.3.2.2. Composant DCP : boîte de dialogue Settings (Knob)

• [Parameter]

Actionnez les paramètres à l’aide des boutons.
L’enregistrement des paramètres s’effectue de plusieurs manières, comme suit :

Source d’enregistrement Méthode d’enregistrement

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites
glisser un paramètre et déposez-le dans la zone verte
de la boîte de dialogue « Settings ».

Zone « Parameters » Faites glisser un paramètre et déposez-le dans la zone
verte de la boîte de dialogue « Settings ».

• [Parameter Range] (Plage de paramètres)

Vous pouvez définir la plage mobile à l’aide de Lower Limit et Upper Limit.
Cliquez sur Lower Limit/Upper Limit pour afficher les commandes.

◦ Case à cocher [Mute Enable]
Si cette option est sélectionnée, l’état « Mute » (–∞ dB) est activé lorsque le niveau passe sous la
valeur spécifiée par [Lower Limit].

• [Nominal]
Le fait de définir la valeur nominale vous permet d’affecter une position de DEL spécifique au réglage du
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volume normal. Par exemple, en spécifiant que la DEL centrale correspond au réglage du volume en
utilisation normale et en réglant la valeur maximale sur le volume maximal autorisé par le système, vous
pouvez éviter d’endommager le système si le volume de la musique de fond augmente lorsque le bruit

ambiant devient fort.

Si cette case est cochée, la fonction « Nominal » est activée.

[Nominal Value] (Valeur nominale) permet de spécifier la valeur nominale.
[Nominal LED Position] (Position nominale de la DEL] permet de spécifier la position de la DEL qui
s’allume lorsque le niveau atteint la valeur nominale.

• [Sensitivity]

Permet de définir la sensibilité des changements de paramètres en réponse à la rotation du bouton DCP.
Si [Acceleration] (Accélération) est activé, le paramètre est modifié plus rapidement si le bouton est
tourné plus rapidement. Si la valeur [Fast] (Rapide) est sélectionnée sous [Sensitivity], le réglage
[Acceleration] est grisé et non disponible.

27.3.3. Onglet [Dimmer & Lock] (Variateur et verrouillage)

Règle la luminosité de l’écran et des commutateurs du MCP1, ainsi que le fonctionnement du verrouillage du
panneau.

• Zone de liste [LED Brightness] (Luminosité des voyants)
Permet de spécifier la luminosité des DEL de l’unité DCP. Plus les valeurs sont élevées, plus les DEL sont
lumineuses.

◦ Case à cocher [Enable Inactive Mode] (Activer le mode inactif)
Si cette case est cochée, l’unité passe automatiquement en mode inactif après une durée spécifiée

dans [Waiting Time] (Temps d’attente).
[Inactive Brightness] (Luminosité inactive) permet de spécifier la luminosité des voyants à l’état

inactif.
Si la case n’est pas cochée, le menu déroulant est grisé et vous ne pouvez pas régler la luminosité.

• Case à cocher [Panel Lock]

Si la case est cochée, le panneau DCP sera verrouillé lors du rappel de la bibliothèque d’instantanés.
Si la case [Enable Temporary Unlocking] (Activer le déverrouillage temporaire) est cochée, appuyez sur le
commutateur DCP 1 pendant plusieurs secondes pour déverrouiller le panneau.

• [Waiting Time]
Permet de spécifier le délai entre la dernière opération et le passage de l’unité en mode inactif ou le
verrouillage du panneau.
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27.4. Méthode de réglage pour MTX5-D/MTX3

Lorsque vous cliquez sur le composant DCP du MTX5-D/MTX3, la boîte de dialogue DCP s’ouvre et vous pouvez
effectuer les réglages voulus.

27.4.1. Réglages du composant DCP

Double-cliquez sur le composant DCP pour ouvrir l’éditeur de composants.

• [Library]

Vous pouvez stocker 32 jeux de réglages DCP dans la bibliothèque.
La bibliothèque stocke les réglages de tous les DCP connectés au MTX. En outre, la bibliothèque DCP
peut être rappelée en même temps que le rappel de la présélection du MTX. Effectuez vos réglages dans
la boîte de dialogue qui s’affiche lorsque vous appuyez sur le bouton [Recall Settings] dans la zone
« Presets ».


Vous pouvez utiliser la bibliothèque sur le DCP en la rappelant en même temps que la
présélection du MTX. Si vous voulez sélectionner le DCP à rappeler, cliquez sur le
bouton [Recall Filter] dans la zone « Presets » et effectuez les réglages de filtre dans la
boîte de dialogue qui apparaît.



Le rappel de la bibliothèque permet de rappeler collectivement tous les DCP (jusqu’à

8 unités) connectés au MTX.
Lorsque vous rappelez une bibliothèque, vous pouvez exclure tout DCP de votre choix

du rappel.
Cliquez sur le bouton Recall Filter dans la zone Presets et définissez le filtre dans la
boîte de dialogue qui apparaît.

◦ Bouton [Save]

Ce bouton permet de stocker un élément dans la bibliothèque.
Les réglages des onglets [Parameter Assign] et [Dimmer & Lock] sont enregistrés.
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◦ Bouton [Load]

Permet de charger la bibliothèque.
Ce bouton applique les réglages aux onglets [Parameter Assign] et [Dimmer et Lock].

◦ Liste [Library]
Sélectionnez l’élément de bibliothèque que vous souhaitez enregistrer ou charger. L’élément de

bibliothèque actuellement chargé s’affiche en caractères gras.
En double-cliquant sur un élément de bibliothèque précédemment enregistré, vous pouvez en
modifier le nom.

◦ Bouton [Copy]

Ce bouton copie l’élément de bibliothèque sélectionné.
La commande Copy n’est pas disponible dans l’état en ligne.

◦ Bouton [Paste]
Ce bouton colle l’élément de bibliothèque copié sur l’élément actuellement sélectionné dans la
liste. La commande Paste n’est pas disponible dans l’état en ligne.

◦ Bouton [Clear]
Ce bouton efface le contenu de l’élément de bibliothèque actuellement sélectionné dans la liste. La
commande Clear n’est pas disponible dans l’état en ligne.

• Case de sélection DCP

Sélectionnez l’unité DCP que vous souhaitez régler.
Le DCP réglé dans la zone « Properties » de la feuille « Project » s’affiche.

● Onglet [Parameter Assign]

La boîte de dialogue de réglages permettant de spécifier les réglages de chaque opérateur s’affiche lorsque
l’icône No. de l’opérateur (commutateur ou bouton) que vous souhaitez régler est sélectionnée. Affectez les
paramètres du MTX à chaque opérateur dans la boîte de dialogue.
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27.4.2. Composant DCP : boîte de dialogue Settings (Switch)

Cliquez sur l’icône No. de l’éditeur de composants DCP pour l’ouvrir.

Function

• [No Assign]
La fonction n’est pas affectée.

• [MTX ON / MTX Send ON / MTX Priority Ducker ON / MTX Dugan Automixer]

Appuyez sur le commutateur pour actionner le paramètre affecté.
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• [SD Play]

◦ SD Song Select & Play

Permet de lire le fichier spécifié dans la liste [Parameter1].
Pour plus de détails sur les réglages des fichiers de lecture, reportez-vous à la boîte de dialogue
« SD Card File Manager ».

◦ SD Song Pause
Appuyez sur le commutateur pour arrêter le fichier en cours de lecture.

• [Preset Recall]
Appuyez sur le commutateur pour rappeler la présélection sélectionnée.

• [External Event]

Appuyez sur le commutateur pour lancer l’événement sélectionné.
Réglez [External Event] sur la boîte de dialogue « External Events ».

◦ [Indicator]
Spécifiez si le voyant du sélecteur doit afficher le statut Activé/Désactivé (Latch) ou s’allumer
uniquement lorsque vous appuyez sur le commutateur (Unlatch).
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[MTX Level / MTX Send Level] (Niveau MTX/Niveau d’envoi MTX)

Lorsque vous appuyez sur le commutateur, le paramètre affecté est automatiquement affecté au bouton avec

lequel il peut être utilisé.

Cette fonction ne s’applique qu’au DCP1V4S.
Si vous affectez ce paramètre à un commutateur, le bouton indique « Occupied by sw » (Occupé par
commutateur) et ne sera pas affectable à un autre paramètre. Pour plus de paramètres, reportez-vous à la
section consacrée aux boutons.

[MTX Level Inc/Dec / MTX Send Level Inc/Dec] (Aug/Dim du niveau MTX/niveau d’envoi MTX)

• [Inc]

Si cette case est cochée, la valeur augmente lorsque vous appuyez sur le commutateur.
Vous pouvez définir la plage mobile à l’aide de Upper Limit/Minimum.

• [Dec]

Si cette case est cochée, la valeur diminue lorsque vous appuyez sur le commutateur.
Vous pouvez définir la limite inférieure avec Lower Limit.

◦ Case à cocher [Mute Enable]
Si cette option est sélectionnée, l’état « Mute » (–∞ dB) est activé lorsque le niveau passe sous la
valeur spécifiée par [Lower Limit].

• Zone de liste [Sensitivity]
Permet de définir la sensibilité des changements de paramètres en réponse à un réglage à la baisse du
commutateur DCP.

27. DCP

ProVisionaire Design V1.2 Guide d’utilisation | 417



[MTX Source Select] (Sélection de la source MTX)

Il s’agit d’une fonction de sélection de la source qui utilise le composant Matrix Mixer.
Utilisez Input Ch Send ON (Envoi du canal d’entrée activé) en combinaison avec Input Ch Send Level (Niveau

d’envoi du canal d’entrée).
Spécifiez le niveau d’envoi à contrôler par le commutateur auquel Input Ch Send ON est affecté, et actionnez ce
niveau d’envoi à l’aide du bouton ou du commutateur auquel Input Ch Send Level est affecté.

Input Ch Send ON

Permet d’activer/de désactiver la source (Parameter2) pour n’importe quelle sortie (Parameter1) du composant

Matrix Mixer en une seule opération.

Parameter2 passe à l’état « ON », « OFF » et « IGNORE » chaque fois que vous cliquez sur la case à cocher.
Une seule source peut passer à l’état « ON ».

Exemple :
Affectez les commutateurs 1 et 2 du DCP4V4S à [MTX Source Select] > Input Ch Send ON et le bouton 1 à [MTX

Source Select] > Input Ch Send Level.
Ils sélectionnent tous la même sortie (Parameter1).

Si vous appuyez sur le commutateur 1, le niveau d’envoi de CH1 pour la zone 1 est affecté au bouton 1.

Si vous appuyez sur le commutateur 2, le bouton 1 passe au niveau d’envoi CH2 pour la zone 1.
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Étant donné que le commutateur modifie automatiquement le niveau d’envoi affecté au bouton, vous pouvez
contrôler le niveau d’envoi de plusieurs points à l’aide d’un unique bouton.

Input Ch Send Level

Sélectionnez la sortie (Parameter1) du composant Matrix Mixer.
Pour plus de détails sur l’utilisation, reportez-vous à [MTX Source Select] dans la section Composant DCP : boîte

de dialogue Settings (Switch).
Pour plus de détails sur les paramètres, reportez-vous à [MTX Level Inc/Dec/MTX Send Level Inc/Dec] (Aug/Dim
du niveau MTX/niveau d’envoi MTX).
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27.4.3. Composant DCP : boîte de dialogue Settings (Knob)

Cliquez sur l’icône No. de l’éditeur de composants DCP pour l’ouvrir.

Function

• [No Assign]
La fonction n’est pas affectée.

• [MTX Level / MTX Send Level]

• [Parameter Range]
Servez-vous des réglages [Upper Limit] et [Lower Limit] pour définir la plage au sein de laquelle le niveau
peut varier.

◦ [Mute Enable]
Si [Mute Enable] est activé, l’état « Mute » (–∞ dB) est activé lorsque le niveau passe sous la valeur
spécifiée par [Lower Limit].

27. DCP

420 | ProVisionaire Design V1.2 Guide d’utilisation



• [Nominal]

Vous pouvez effectuer ici les réglages de la fonction Nominal.
Le fait de définir la valeur nominale vous permet d’affecter une position de DEL spécifique au réglage du
volume normal. Par exemple, en spécifiant que la DEL centrale correspond au réglage du volume en
utilisation normale et en réglant la valeur maximale sur le volume maximal autorisé par le système, vous
pouvez éviter d’endommager le système si le volume de la musique de fond augmente lorsque le bruit

ambiant devient fort.

Si cette case est cochée, la fonction « Nominal » est activée.

[Nominal Value] (Valeur nominale) permet de spécifier la valeur nominale.
[Nominal LED Position] (Position nominale de la DEL] permet de spécifier la position de la DEL qui

s’allume lorsque le niveau atteint la valeur nominale.
Si cette case n’est pas cochée (fonction Nominal désactivée), les deux paramètres seront grisés et
indisponibles.

◦ Zone de liste [Sensitivity]
Permet de définir la sensibilité des changements de paramètres en réponse à la rotation du bouton

DCP.
Si [Acceleration] est activé, le paramètre est modifié plus rapidement si le bouton est tourné plus
rapidement. Si la valeur [Fast] (Rapide) est sélectionnée sous [Sensitivity], le réglage [Acceleration]
est grisé et non disponible.

• [MTX Source Select] (Sélection de la source MTX)

Pour plus de détails sur l’utilisation, reportez-vous à [MTX Source Select] dans la section Composant DCP : boîte

de dialogue Settings (Switch).
Pour plus de détails sur les paramètres, reportez-vous à [MTX Level / MTX Send Level] (Niveau MTX/Niveau
d’envoi MTX).

● Onglet [Dimmer & Lock]
Cet onglet permet de définir la luminosité des DEL de l’unité DCP ainsi que les réglages de l’état de veille.
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• Zone de liste [LED Brightness]
Permet de spécifier la luminosité des DEL de l’unité DCP. Plus les valeurs sont élevées, plus les DEL sont
lumineuses.

• Case à cocher [Enable Inactive Mode]
Si cette case est cochée, l’unité passe automatiquement en mode inactif après une durée spécifiée dans

[Waiting Time].

[Inactive Brightness] (Luminosité inactive) permet de spécifier la luminosité des voyants à l’état inactif.
Si la case n’est pas cochée, le menu déroulant est grisé et vous ne pouvez pas régler la luminosité.

• Case à cocher [Panel Lock]

Si cette case est cochée, le panneau DCP sera verrouillé lors du rappel de la bibliothèque présélectionnée.
Si la case [Enable Temporary Unlocking] est cochée, appuyez sur le commutateur DCP 1 pendant
plusieurs secondes pour déverrouiller le panneau.

• [Waiting Time]
Permet de spécifier le délai entre la dernière opération et le passage de l’unité en mode inactif ou le
verrouillage du panneau.

Bouton Menu
Cliquez sur ce bouton pour exécuter les fonctions suivantes.

• [Copy]
Permet de copier les réglages « Parameter Assign », « Dimmer & Lock » et « Source Select » du DCP
affiché dans le tampon de copie.

• [Paste]
Permet de remplacer les réglages « Parameter Assign », « Dimmer & Lock » et « Source Select » du même

modèle stockés dans le tampon de copie sur le DCP affiché.
Il est uniquement possible de coller des réglages copiés dans un même système MTX.
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• [Initialize]
Permet d’initialiser les réglages « Parameter Assign », « Dimmer & Lock » et « Source Select » du DCP
affiché.

• [Clear [Parameter Assign]] (Effacer l’affectation de paramètres)
Permet d’initialiser les réglages « Parameter Assign » du DCP affiché.

Bouton [Close]
Ferme la boîte de dialogue.
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27.5. Méthode de réglage du MRX7-D

Double-cliquez sur le composant DCP et configurez divers paramètres.

Pour d’autres opérations, reportez-vous à la section Réglages du composant DCP du MTX5-D/MTX3.

27.5.1. Réglages du composant DCP

Double-cliquez sur le composant DCP pour ouvrir l’éditeur de composants.

[Library] (Bibliothèque)

Il est possible d’enregistrer jusqu’à 32 paramètres liés au DCP en tant que [Library].
La bibliothèque stocke les réglages de tous les DCP connectés au MRX7-D.


Vous pouvez utiliser la bibliothèque sur le DCP en la rappelant en même temps que les
présélections du MRX7-D. Configurez les réglages dans la boîte de dialogue qui s’affiche
lorsque vous appuyez sur le bouton [Recall Settings] dans la zone Presets.



Lorsque la bibliothèque est rappelée, tous les DCP (jusqu’à 8 unités) connectés au MRX7-D

sont rappelés en même temps.
Lorsque vous rappelez une bibliothèque, vous pouvez exclure tout DCP de votre choix du

rappel.
Cliquez sur le bouton [Recall Filter] dans la zone Presets et définissez le filtre dans la boîte de
dialogue qui apparaît.

Pour d’autres opérations, reportez-vous à la section Réglages du composant DCP du MTX5-D/MTX3.
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27.5.2. Onglet [Parameter Assign]

27.5.2.1 Boîte de dialogue Settings (Switch)

Cliquez sur l’icône No. dans l’éditeur de composants DCP pour afficher la boîte de dialogue Settings.

Reportez-vous à la section Boîte de dialogue Settings (Switch) du DME7.
Les différences par rapport au DME7 sont répertoriées ci-dessous.

[Snapshot Recall] (Rappel d’instantané)

[Snapshot Group Recall]
[Preset Recall] (Rappel de présélection)

Source d’enregistrement Méthode d’enregistrement

Zone Parameter Sets Faites glisser l’instantané et déposez-le dans la zone verte de la boîte de
dialogue Settings.

Faites glisser le groupe
d’instantanés et déposez-le dans la
zone verte de la boîte de dialogue
Settings.

Zone Presets

[Parameter]

Source d’enregistrement Méthode d’enregistrement

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le paramètre
et déposez-le dans la zone verte de la boîte de dialogue Settings.

Éditeur de commandes de liaison Tout en maintenant la touche < Ctrl > enfoncée, faites glisser la
commande de liaison et déposez-la dans la zone verte de la boîte de
dialogue Settings.

Zone Parameters Faites glisser le paramètre et déposez-le dans la zone verte de la boîte de
dialogue Settings.
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 [Control Type] ne peut pas être défini.
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[MRX Source Select] (Sélection de la source MRX)

Cette fonction permet de changer la source du composant Source Selector (Sélecteur de source) à l’aide du
commutateur, ainsi que de modifier les niveaux liés à la source à l’aide du bouton. Utilisez une configuration qui

combine les composants Source Selector et Fader.
Assignez la fonction Source Selector à la fois au commutateur et au bouton.

Procédure

1. Ajoutez un composant Fader et un composant Source Selector à la feuille d’appareil et connectez-les.

2. Sélectionnez un des composants Source Selector placés dans l’onglet Source Select de l’éditeur de
composants DCP.

3. Attribuez la source du composant Source Selector au commutateur.
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4. Attribue le niveau du composant Fader connecté au composant Source Selector au bouton.
Lorsqu’une source est sélectionnée, attribuez la sortie du paramètre de niveau du composant Source
Selector en le faisant glisser et en le déposant dans la zone verte. Effectuez le réglage pour chaque
source.

Par exemple, si vous sélectionnez la source 1 avec le commutateur 1, 1 canal du composant Fader sera
attribué au bouton 1, et si vous sélectionnez la source 2 avec le commutateur 2, 2 canaux du composant
Fader seront attribués au même bouton 1.
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27.5.2.2 Boîte de dialogue Settings (Knob)

Cliquez sur l’icône No. dans l’éditeur de composants DCP pour afficher la boîte de dialogue Settings.
Reportez-vous à la section Boîte de dialogue Settings (Knob) du DME7.

Les différences par rapport au DME7 sont répertoriées ci-dessous.

[Parameter]

Source d’enregistrement Méthode d’enregistrement

Éditeur de composants Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le paramètre
et déposez-le dans la zone verte de la boîte de dialogue Settings.

Éditeur de commandes de liaison Tout en maintenant la touche < Ctrl > enfoncée, faites glisser la
commande de liaison et déposez-la dans la zone verte de la boîte de
dialogue Settings.

Zone Parameters Faites glisser le paramètre et déposez-le dans la zone verte de la boîte de
dialogue Settings.

[MRX Source Select]
Reportez-vous au paramètre MRX Source Select dans la section « Boîte de dialogue Settings (Switch) ».

27.5.3. Onglet [Dimmer & Lock]

Reportez-vous à la section Onglet Dimmer & Lock du MTX5-D/MTX3.

27.5.4. Onglet [Source Select]

Sélectionnez un des composants Source Selector placé sur la feuille d’appareil.
Pour une description des fonctions, reportez-vous à la section « Boîte de dialogue Settings (Switch) ».
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28. Contrôleur mural : MCP1

28.1. Présentation

Le MCP1 est un panneau de commande mural permettant de commander les paramètres de l’appareil, les

présélections, etc.

La fonction External Event permet de commander des produits non pris en charge par ProVisionaire Design.
Une page d’accueil et six autres pages peuvent être définies, et jusqu’à 36 paramètres peuvent être attribués aux

commutateurs.
Veuillez également vous reporter au Manuel d’installation du MCP1 pour en savoir plus sur la manipulation du
MCP1.

28.2. Feuille Project

Il s’agit de la feuille sur laquelle les appareils sont placés. Lorsque vous placez des péripériques, l’écran
« Settings » s’affiche comme illustré ci-dessous.

• Number of Devices
Permet de sélectionner le nombre d’unités MCP1 à placer sur la feuille.

• Unit ID Starting From
Vous pouvez sélectionner le numéro de départ des ID d’unité des appareils.

• Device Name
Vous pouvez afficher et modifier le nom de l’appareil.
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28.2.1. Zone Properties

Permet d’afficher et de modifier les informations du MCP1.

• Utilities

◦ Administrator PIN
Ce code permet d’ouvrir la page Settings sur l’unité principale. Il s’agit d’un numéro à quatre

chiffres.
Il peut également être utilisé comme code PIN de superutilisateur et code PIN de déverrouillage du
panneau.

◦ Power User PIN (Code PIN de superutilisateur)
Ce code permet d’ouvrir la page lorsque l’option « Power User Page (PIN required) » (Page
superutilisateur (code PIN requis)) est activée. Il s’agit d’un numéro à quatre chiffres.

◦ Panel Unlock PIN (Code PIN de déverrouillage du panneau)
Ce code permet de désactiver le verrouillage du panneau. Il s’agit d’un numéro à quatre chiffres.
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28.3. Méthode de réglage

1. Double-cliquez sur le MCP1-D placé sur la feuille Project.
L'éditeur de composants s’affiche.

2. Cliquez sur le bouton [Controlled Devices] (Appareils contrôlés) dans l’éditeur de composants.

La boîte de dialogue Controlled Devices s’affiche.
Sur cet écran, enregistrez les appareils devant être commandés par le MCP1.



Pour les appareils dotés de configurations fixes, tels que les séries MTX5-D et PC-D,

l’appareil ne doit pas nécessairement être placé sur la feuille Project.
Par contre, des appareils tels que le DME7 et le MRX7-D, dont les configurations
peuvent être modifiées librement par l’utilisateur, doivent être placés sur la feuille
Project. Cela permet d’attribuer des paramètres en les faisant glisser et en les
déposant depuis l’éditeur de composants de la feuille d’appareil, la zone Parameter
Sets, etc.
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3. Cliquez sur le bouton [Switch Selection Button] (Changer le bouton de sélection) dans l’éditeur de
composants.

La boîte de dialogue Settings s’affiche.

4. Faites glisser les paramètres depuis la liste des paramètres de la boîte de dialogue Controlled Devices
et déposez-les dans la boîte de dialogue Settings pour les attribuer aux commutateurs.

Pour le DME7 et le MRX7-D, faites glisser les paramètres depuis l’éditeur de composants ou la zone

Parameters.
Même si vous accédez à la feuille d’appareil du DME7 ou du MRX7-D, la boîte de dialogue Settings reste
affichée.

Reportez-vous à la boîte de dialogue Settings pour plus d’informations sur la façon d’attribuer des
paramètres.


Pour contrôler un produit qui n’est pas pris en charge par ProVisioniare Design, utilisez
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Function > External Event.
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5. Cliquez sur le bouton [Preset].
La boîte de dialogue Preset List s’ouvre. Les présélections enregistrent toutes les pages et les paramètres

Dimmer & Lock.
Le chargement d’une présélection charge la page et les paramètres Dimmer & Lock dans l’éditeur MCP1.
Si vous rappelez une présélection alors que vous êtes en ligne, les paramètres du panneau de l’unité
principale MCP1 changent également.
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28.4. Éditeur de composants

Double-cliquez sur un appareil dans la feuille Project pour ouvrir l’éditeur.

① Bouton [Controlled Devices]
Ouvre la boîte de dialogue Controlled Devices.

② Liste Preset
Rappelle les présélections.

③ Bouton [Preset]
Ouvre la boîte de dialogue Preset List.

④ Onglets [Home]/[Page 1] à [Page 6]

Définissez les pages du MCP1.
La page [Home] est la page qui s’affiche au démarrage du MCP1 ou lorsque vous appuyez sur le commutateur

Home.
Sur la page [Home], vous pouvez changer de page en attribuant [Open Page] (Ouvrir la page) à un commutateur.

L’onglet [Page 1] est expliqué ici.
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• Case à cocher [Power User Page (PIN required)] (autre que la page [Home])
Lorsque cette case est cochée, vous devez saisir le code PIN du superutilisateur lors de l’ouverture d’une

page sur l’unité principale MCP1.
Le code PIN du superutilisateur est défini dans la zone Properties > Utilities de l’appareil.

⑤ Bouton Label [Edit]
Ouvre la boîte de dialogue Label.

⑥ Bouton de sélection Function [Switch]
Cliquez pour ouvrir la boîte de dialogue Settings.

⑦ [Function]/[Model]/[Match device by] (Faire correspondre l’appareil par) [Parameter]
Affiche un aperçu des réglages effectués sur l’écran Settings.

28.4.1. Onglet [Dimmer & Lock]

Règle la luminosité de l’écran et des commutateurs du MCP1, ainsi que le fonctionnement du verrouillage du
panneau.

• Case à cocher [Brightness]
Lorsque cette case est cochée, la luminosité et le contraste de l’écran ainsi que la luminosité des

commutateurs peuvent être modifiés lorsqu’une présélection est rappelée.
[LCD Brightness] permet de régler la luminosité de l’écran. Plus le nombre est élevé, plus l’affichage est

lumineux.
[LCD Contrast] permet de régler le contraste de l’écran. Plus le nombre est élevé, plus la différence entre

la luminosité et l’obscurité est importante.
[LED Brightness] permet de régler la luminosité des commutateurs. Plus le nombre est élevé, plus les
commutateurs sont lumineux.

• Case à cocher [Panel Lock]
Lorsque cette case est cochée, le panneau du MCP1 est verrouillé lorsque vous rappelez une présélection.
Si la case [Enable Temporary Unlocking] (Activer le déverrouillage temporaire) est cochée, le panneau
peut être déverrouillé en appuyant sur le commutateur Home du MCP1 et en le maintenant enfoncé

pendant plus de 2 secondes.
Si la case [Enter PIN to unlock MCP1] (Entrer le code PIN pour déverrouiller le MCP1) est cochée, vous
serez invité à saisir le code PIN de déverrouillage du panneau lors du déverrouillage du panneau.

• [Waiting Time]
Définit le temps écoulé entre la dernière opération et le moment où le MCP1 bascule en veille prolongée
ou dans l’état verrouillé.
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28.4.2. Boîte de dialogue Controlled Devices

Cette boîte de dialogue s’affiche lorsque vous cliquez sur le bouton [Controlled Devices] dans l'éditeur de

composants.'
Enregistrez les appareils qui doivent être contrôlés par le MCP1.

• Bouton [Add Device]

Cliquez pour ouvrir la boîte de dialogue Add Device.
Enregistrez les appareils qui doivent être contrôlés par le MCP1.

Sélectionne la manière dont le MCP1 recherche les appareils sur le réseau dans [Match Device by].
Sélectionnez [IP Address] pour effectuer une recherche par adresse IP de l’appareil, ou sélectionnez [ID
d’unité] pour rechercher par ID d’unité de l’appareil.


L’ID d’unité peut être utilisé comme identifiant d’appareil lors de l’ajout d’appareils à une
feuille.

• Bouton [Edit]
Cliquez pour ouvrir la boîte de dialogue Match Device by.

Cette boîte de dialogue permet de modifier les paramètres [Unit ID] et [Match Device by] de l’appareil
sélectionné dans la liste des appareils.

• Bouton [Clear]
Supprime l’appareil sélectionné dans la liste des appareils.
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• Liste des appareils
Affiche les appareils enregistrés.

• Liste des paramètres

Affiche les paramètres de l’appareil sélectionné dans la liste des appareils.
Les paramètres peuvent être enregistrés dans la boîte de dialogue Settings par glisser-déposer.


Enregistrez les paramètres des modèles dont les configurations peuvent être modifiées
librement, tels que le DME7 et le MRX7-D, en les faisant glisser depuis l’éditeur de
composants ou la zone Parameters et en les déposant dans la boîte de dialogue Settings.
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28.4.3. Boîte de dialogue Preset List

Il est possible d’enregistrer jusqu’à huit paramètres liés au MCP1 en tant que présélections.
Les présélections peuvent être rappelées à partir d’appareils externes. Il est également possible de les rappeler
avec d’autres commutateurs du MCP1.

• Bouton [Store]
Enregistre les paramètres [Home]/[Page 1] à [Page 6]/[Dimmer & Lock] dans une présélection.

• Bouton [Recall]

Permet de rappeler la présélection sélectionnée.

Les réglages sont développés en [Home]/[Page 1] à [Page 6]/[Dimmer & Lock].
Si vous rappelez une présélection alors que vous êtes en ligne, les paramètres du panneau de l’unité
principale changent également.

• Bouton [Copy]
Copie la présélection sélectionnée.

• Bouton [Paste]
Colle la présélection copiée dans la présélection sélectionnée.

• Bouton [Clear]
Permet d’effacer la présélection sélectionnée.
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28.4.4. Boîte de dialogue Label

Crée une image pour chaque page à afficher sur l’écran de l’unité principale MCP1.

• [Cell] (Cellule)

Modifie l’écran de la page.
Pour modifier le texte, double-cliquez sur la cellule ou sélectionnez la cellule et appuyez sur la touche < F2

>.

Appuyez sur la touche < Entrée > ou utilisez la souris pour sélectionner une autre cellule pour confirmer.
Si vous incluez une image d’arrière-plan dans une cellule, sélectionnez la cellule et cochez la case [Image

Settings] (Réglages de l’image). Appuyez sur le bouton [Import] et sélectionnez le fichier image.
Les cellules peuvent être déplacées non seulement avec la souris, mais aussi avec les touches du

curseur,la touche < Tab > et la touche < Entrée >.
Il est également possible de sélectionner une plage de cellules en les parcourant tout en maintenant la
touche < Maj > enfoncée.

• Bouton [Merge Cells] (Fusionner les cellules)
Sélectionnez plusieurs cellules et cliquez dessus pour les fusionner.

• Bouton [Unmerge Cells] (Défusionner les cellules)
Sélectionnez des cellules fusionnées et cliquez dessus pour les séparer.

• [Preview] (Aperçu)

Affiche l’image de la page.
Cela vous permet de vérifier le texte et les images définis dans [Cell].

• Zone Font Settings (Réglages de la police)
Définit la police du texte affiché dans la cellule sélectionnée.

◦ Zone de liste des polices
Sélectionne une police. Vous pouvez faire votre choix parmi les polices installées sur l’ordinateur.
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◦ Zone de liste de la taille de la police
Sélectionne la taille de la police.

◦ Boutons [B]/[I]/[U]
Cliquez pour mettre le texte de la cellule en gras, en italique ou en souligné.

◦ Color
Affiche la couleur du texte dans la cellule. Cliquez sur le bouton pour basculer entre le blanc et le
noir.

◦ Zone de liste [Alignment] (Alignement)
Sélectionne l’alignement du texte dans la cellule.

◦ Zone de sélection [Character Spacing] (Espacement des caractères)
Définit l’espacement entre les caractères dans une cellule.

◦ Zone de sélection [Line Spacing] (Espacement des lignes)
Définit l’espacement entre les lignes dans une cellule.

◦ Boutons [Up]/[Left]/[Right]/[Down]/[Reset]
Ajustez la position du texte dans la cellule. L’ampleur du déplacement est affichée sous forme de
valeur numérique. Cliquez sur le bouton [Reset] pour rétablir la valeur initiale.

• Image Settings
Lorsque cette case est cochée, vous pouvez définir l’image d’arrière-plan de la cellule sélectionnée.

◦ Bouton [Import]

Cliquez pour ouvrir la boîte de dialogue Open File (Ouvrir le fichier).

Les extensions d’image sélectionnables sont .png, .bmp et *.jpg.
Après avoir sélectionné les données de l’image, cliquez sur le bouton [OK] pour ouvrir la boîte de
dialogue Re-size Image (Redimensionner l’image), dans laquelle vous pouvez sélectionner
l’agencement de l’image dans la cellule.

◦ Bouton [Clear]
Cliquez pour supprimer l’image d’arrière-plan.

◦ Boutons [Up]/[Left]/[Right]/[Down]/[Reset]
Ajustez la position de l’image d’arrière-plan dans la cellule. L’ampleur du déplacement est affichée
sous forme de valeur numérique. Cliquez sur le bouton [Reset] pour rétablir la valeur initiale.

• Bouton [All Clear]
Initialise toutes les informations de la cellule.

• Bouton [OK]
Conserve les informations des réglages et ferme la boîte de dialogue.

• Bouton [Cancel]
Supprime les informations des réglages et ferme la boîte de dialogue.
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28.4.5. Boîte de dialogue Settings

Enregistre les paramètres et les présélections qui seront contrôlés par le MCP1.

Vous pouvez enregistrer les paramètres et les présélections sur les commutateurs en les faisant glisser et en les
déposant dans la zone verte.

Source d’enregistrement Méthode d’enregistrement

Liste des paramètres dans la boîte de
dialogue Controlled Devices

Faites glisser le paramètre ou la présélection et déposez-le dans
la zone verte de la boîte de dialogue Settings.

Éditeur de composants du DME7 et du
MRX7-D*1

Tout en maintenant la touche < Ctrl > enfoncée, faites glisser le
paramètre et déposez-le dans la zone verte de la boîte de dialogue
Settings.

Zone Parameters du DME7 et du MRX7-D Faites glisser le paramètre et déposez-le dans la zone verte de la
boîte de dialogue Settings.

Éditeur de commandes de liaison du MRX7-
D

Tout en maintenant la touche < Ctrl > enfoncée, faites glisser la
commande de liaison et déposez-la dans la zone verte de la boîte
de dialogue Settings.

Zone Parameter Sets du DME7 Faites glisser l’instantané et déposez-le dans la zone verte de la
boîte de dialogue Settings.

Zone Parameter Sets du MRX7-D Faites glisser l’instantané et déposez-le dans la zone verte de la

boîte de dialogue Settings.
Faites glisser le groupe d’instantanés et déposez-le dans la zone
verte de la boîte de dialogue Settings.

Zone Presets du MRX7-D Faites glisser la présélection et déposez-la dans la zone verte de
la boîte de dialogue Settings.

*1 Pour les appareils autres que le DME7 et le MRX7-D, les paramètres peuvent uniquement être enregistrés à
partir de la liste des paramètres dans la boîte de dialogue Controlled Devices.
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Function (Fonction)

• [No Assign]
La fonction n’est pas affectée.

• [Open Page] (page Home uniquement)

Appuyez sur le commutateur pour changer la page du MCP1.

• [Parameter]

◦ Zone de liste Control Type

Si Parameter Value Edit est sélectionné

Applique le paramètre attribué dans la plage spécifiée par Lower Limit et Upper Limit.
Sélectionnez le paramètre que vous souhaitez utiliser sur l’unité principale MCP1 en le touchant, et
exécutez-le à l’aide des commutateurs L1/2/3 et R1/2/3 et du commutateur de retour.
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◦ Parameter Range

Définit la plage de déplacement du paramètre.
Cliquez sur Lower Limit/Upper Limit pour afficher les commandes.

◦ Case à cocher Mute Enable
Lorsque cette option est activée, le son est coupé (–∞ dB) lorsque le niveau tombe en dessous de
la valeur définie dans [Lower Limit].

◦ [Sensitivity]
Définit la sensibilité avec laquelle le paramètre change en réponse aux opérations des
commutateurs.

Si Direct Parameter Value est sélectionné

Règle le paramètre affecté sur la valeur spécifiée par Value.
Cliquez sur Parameter Value pour afficher les commandes.
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• [SD Card File Manager]

Pour le DME7/MRX7-D ou le MTX3/MTX5-D placé sur la feuille Project
Lorsque SD Card File > Sel & Play est attribué à partir de Controlled Devices, la boîte de dialogue SD Card

File Manager s’ouvre.

Pour le DME7, il est possible de sélectionner un fichier unique ou plusieurs fichiers consécutifs.
Pour le MTX3, le MTX5-D et le MRX7-D, un seul fichier peut être sélectionné.

Pour le DME7, plusieurs fichiers peuvent être sélectionnés.

Lorsque plusieurs fichiers sont sélectionnés (pour le DME7 uniquement)
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Lorsqu’un seul fichier est sélectionné

Pour le MTX3/MTX5-D non placé sur la feuille Project
Après avoir attribué SD Card File > Sel & Play depuis Controlled Devices en le faisant glisser et en le
déposant, configurez les paramètres liés à la reproduction du fichier.

Pour plus de détails sur les réglages, reportez-vous à la section Boîte de dialogue « SD Card File
Manager » du DME7.
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• [External Event]

◦ Zone de liste [Event Mode]

Lorsqu’un événement est affecté à un commutateur, il fonctionne comme suit.
[On/Off] : Le MCP1 envoie tour à tour des commandes On et Off à chaque pression sur le

commutateur.
[1shot] : Le MCP1 envoie la commande définie à chaque pression sur le commutateur.

◦ Controlled Devices

Définit les informations de l’appareil qui reçoit les commandes.
Pour en savoir plus sur la configuration de l’appareil récepteur, reportez-vous à la documentation
relative aux commandes de chaque appareil.

▪ Protocol
Sélectionne le protocole pris en charge par l’appareil qui reçoit les commandes.

▪ IP Address
Spécifie l’adresse IP de l’appareil qui reçoit les commandes.

▪ Port No.
Spécifie le numéro de port de l’appareil qui reçoit les commandes.

▪ Delay
Définit le délai pour chaque commande, le temps pendant lequel le commutateur est
enfoncé étant défini à 0.

▪ Comments
Permet la saisie de texte.

◦ Command On/Off

S’affiche en cas de réglage sur On/Off dans la zone de liste [Event Mode].

Définit les commandes respectives lorsque le commutateur est activé et désactivé.
Les commandes sont saisies dans un format hexadécimal à deux chiffres.
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▪ Overwrite/Insert
Lorsque ce paramètre est défini sur [Insert], la saisie dans la zone de texte Command
devient une insertion et des nombres hexadécimaux peuvent être ajoutés au début ou au
milieu.

▪ Hex
Règle la commande de façon à contrôler l’appareil en hexadécimal.

▪ Clear
Supprime la commande.

▪ Ascii
Si les commandes pour contrôler l’appareil sont fournies sous forme de chaînes de
caractères dans les caractéristiques techniques, etc., saisissez-les et utilisez le bouton
[Convert] pour les convertir en hexadécimal.

▪ Bouton [Convert]
Convertit les commandes en chaînes de caractères au format hexadécimal et les saisit en
« Hex ».

• [Presets/Snapshots]

◦ Control Type

Si Parameter Value Edit est sélectionné
Des présélections ou des instantanés numérotés de manière séquentielle peuvent être attribués à
un seul appareil.

Si Direct Parameter Value est sélectionné
Plusieurs présélections, instantanés ou groupes d’instantanés peuvent être attribués au même
commutateur en même temps en répétant l’opération d’attribution. Des présélections pour
différents appareils peuvent également être attribuées en même temps.


Pour les séries Rivage PM et DM7, seul Direct Parameter Value peut être
sélectionné.
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
Pour le groupe d’instantanés du MRX7-D, seul Direct Parameter Value peut être
sélectionné.

28.5. Liste des alertes

Reportez-vous à la section Liste des alertes du MTX5-D/MTX3.
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29. YDIF

29.1. YDIF

YDIF est un format de transmission audionumérique permettant d’émettre et de recevoir jusqu’à 16 canaux de
données audio et d’horloges de mots via un câble Ethernet. En connectant des appareils (série
MTX/XMV/EXi8/EXo8) via un câble Ethernet, il est possible de transférer jusqu’à 16 canaux de signaux audio
sans les dégrader.

L’utilisation de YDIF permet de commuter aisément l’acheminement du signal sans changer les connexions par
câble.

Par exemple, comme le montre le schéma ci-dessous, il suffit de définir l’acheminement YDIF pour répondre à
une situation où il est nécessaire d'« émettre le même signal d’entrée de microphone depuis plusieurs haut-
parleurs ».

29.2. Méthode de réglage YDIF (feuille Project)

Placez le composant YDIF dans la zone Device de la feuille Project. L’écran de réglage YDIF basé sur l’assistant

s’affiche.
Sur l’écran YDIF Connected (YDIF connecté), sélectionnez le modèle en cours d’utilisation dans le menu
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déroulant, puis cliquez sur [Next] (Suivant).

Le schéma de câblage et la Clock Source (Source de l’horloge) s’affichent.

Suivez le schéma de câblage affiché pour connecter les appareils entre eux à l’aide de câbles YDIF.
Notez qu’il existe deux motifs : l’un pour lequel une connexion en anneau n’est pas requise (schéma de gauche)
et l’autre pour lequel elle s’impose (schéma de droite).

Lorsque vous cliquez sur le bouton [Finish], un groupe d’appareils connectés YDIF est créé dans la feuille Project.

La configuration basée sur l’assistant présente les deux avantages suivants :
(1) La sélection d’une combinaison erronée d’appareils empêche l’assistant de terminer l’exécution, ce qui vous

permet de vérifier la présence d’erreurs de connexion à l’avance.
(2) Les choix de connexion en anneau sont également effectués automatiquement.

Des réglages similaires sont également possibles en branchant des connecteurs YDIF entre les appareils sans

avoir recours à l’assistant.
Notez que dans ce cas, l’assistant ne sera pas en mesure de vous avertir en cas de connexion erronée. Dans ce
cas, une connexion en anneau est recommandée comme d’habitude.
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29.3. Méthode de réglage YDIF (feuilles d’appareil)

Dans chaque feuille d’appareil, spécifiez les réglages tels que YDIF Patch et définissez les réglages de
l’acheminement souhaité.

(Exemple : XMV4140)
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30. Paramétrer la gestion des périphériques sur
plusieurs sous-réseaux
Si vous gérez des périphériques sur un sous-réseau différent de celui de ProVisionaire Design, tous les

périphériques seront identifiés par leur adresse IP.
C’est la raison pour laquelle il est nécessaire d’effectuer des réglages de sorte que les paramètres IP des
périphériques placés dans ProVisionaire Design (dits « périphériques virtuels ») correspondent aux

paramètres IP des périphériques du réseau (dits « périphériques réels »).
Les paramètres IP des périphériques virtuels sont définis dans la boîte de dialogue « Match Device by IP
Address » (Trouver des périphériques par leur adresse IP et les paramètres IP des périphériques réels sont
définis dans la boîte de dialogue « IP Address » (Adresse IP).

Définissez les adresses IP de manière à ce qu’elles soient uniques pour l’ensemble du chemin de
communication. Si des périphériques ayant la même adresse IP existent sur le chemin de communication, il est

possible qu’ils ne puissent pas être identifiés.
Utilisez d’abord la boîte de dialogue « Match Device by IP Address » (Trouver des périphériques par leur
adresse IP) pour spécifier les adresses IP des périphériques virtuels.

1. Placez un périphérique dans la feuille « Project » (Projet).

2. Cliquez sur [Match Device by IP Address] (Trouver des périphériques par leur adresse IP), dans le menu

[System] (Système) de ProVisionaire Design.
La boîte de dialogue « Match Devices by IP Address » (Trouver des périphériques par leur adresse IP)
s’ouvre.

3. Dans la zone « IP Address Range Finder » (Trouver une plage d’adresses IP), utilisez la zone de texte [IP
Address] (Adresse IP) pour saisir l’adresse IP du sous-réseau auquel le périphérique à rechercher est
connecté.

4. Dans « IP Address Range Finder » (Trouver une plage d’adresses IP), utilisez la zone de liste [Subnet
Mask] (Masque de sous-réseau) pour sélectionner le masque de sous-réseau.

5. Dans la zone « IP Address Range Finder » (Trouver une plage d’adresses IP), cliquez sur le bouton [Find

Range] (Trouver une plage).
La plage des adresses IP valides s’affiche dans le champ « Range » (Plage) et une adresse IP
correspondant à la passerelle par défaut s’affiche dans la zone de texte [Default Gateway] (Passerelle par

défaut).
Si l’adresse IP de la passerelle par défaut est erronée, modifiez-la.
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6. Cochez la case du périphérique virtuel dont vous souhaitez définir l’adresse IP.

7. Cliquez sur le bouton [Apply IP Address] (Appliquer l’adresse IP).

Une adresse IP statique est définie pour le périphérique virtuel.

8. Cliquez sur le bouton [OK].

Pour attribuer une adresse IP à un périphérique réel, vous pouvez soit effectuer les réglages en exécutant le

périphérique réel, soit utiliser la boîte de dialogue « IP Address » (Adresse IP).
Cette section vous explique le fonctionnement de la boîte de dialogue « IP Address » (Adresse IP).

Nous verrons ensuite la procédure à suivre pour définir l’adresse IP affectée au périphérique virtuel comme celle
du périphérique réel.

1. Définissez l’ID d’unité du périphérique réel en correspondance avec le périphérique virtuel.

2. Connectez le périphérique réel au même sous-réseau que ProVisionaire Design pour qu’il puisse y être

détecté.
Pour plus de détails, reportez-vous au mode d’emploi de chaque périphérique.

3. En travaillant toujours hors ligne, cliquez sur [IP Settings] (Réglages IP) dans le menu [System]

(Système) de ProVisionaire Design.
Si la boîte de dialogue « Network Setup » (Configuration réseau) apparaît, sélectionnez le même réseau
que ProVisionaire Design.
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4. Lorsque tous les périphériques réels apparaissent dans la boîte de dialogue « IP Settings »

(Réglages IP), cliquez sur le bouton [Set IP Address] (Définir l’adresse IP).
La boîte de dialogue « IP Address » (Adresse IP) s’ouvre.

5. Cliquez sur le bouton [Auto-Assign IP Addresses] (Affecter automatiquement les adresses IP).
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Une liste d’adresses IP définies pour les périphériques virtuels s’affiche dans la boîte de dialogue Match

Device (Associer des périphériques).
Configurez le serveur DNS selon vos besoins.

6. Cliquez sur le bouton [Assign IP Addresses] (Affecter les adresses IP).
Permet de reproduire les réglages du périphérique virtuel sur le périphérique réel dont le Model (Modèle)
et l’Unit ID (ID d’unité) correspondent à ceux du périphérique virtuel.

7. Cliquez sur le bouton [OK].
Les paramètres de l’adresse IP, du masque de sous-réseau et de la passerelle par défaut sont envoyés
vers les périphériques réels.
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